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Warranty 2

Tektronix warrants that this product will be free from defects in materials and workmanship for a period of one (1)
year from the date of shipment. If any such product proves defective during this warranty period, Tektronix, at its
option, either will repair the defective product without charge for parts and labor, or will provide a replacement in
exchange for the defective product. Parts, modules and replacement products used by Tektronix for warranty work
may be new or reconditioned to like new performance. All replaced parts, modules and products become the
property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration
of the warranty period and make suitable arrangements for the performance of service. Customer shall be
responsible for packaging and shipping the defective product to the service center designated by Tektronix, with
shipping charges prepaid. Tektronix shall pay for the return of the product to Customer if the shipment is to a
location within the country in which the Tektronix service center is located. Customer shall be responsible for
paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate
maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage
resulting from attempts by personnel other than Tektronix representatives to install, repair or service the product;
b) to repair damage resulting from improper use or connection to incompatible equipment; c) to repair any
damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a product that has been
modified or integrated with other products when the effect of such modification or integration increases the time
or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX’ RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND
EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY.
TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL,
OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS
ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.



Warranty 9(b)

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on
the media will be free from defects in materials and workmanship for a period of three (3) months from the date of
shipment. If any such medium or encoding proves defective during the warranty period, Tektronix will provide a
replacement in exchange for the defective medium. Except as to the media on which this software product is
furnished, this software product is provided “as is” without warranty of any kind, either express or implied.
Tektronix does not warrant that the functions contained in this software product will meet Customer’s
requirements or that the operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration
of the warranty period. If Tektronix is unable to provide a replacement that is free from defects in materials and
workmanship within a reasonable time thereafter, Customer may terminate the license for this software product
and return this software product and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX’ RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER’S
PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF
THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX
OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

Use Proper Power Cord. Use only the power cord specified for this product and
certified for the country of use.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

Power Disconnect. The power cord disconnects the product from the power
source. Do not block the power cord; it must remain accessible to the user at all
times.

Do Not Operate Without Covers. Do not operate this product with covers or panels
removed.

Do Not Operate With Suspected Failures. If you suspect there is damage to this
product, have it inspected by qualified service personnel.

Avoid Exposed Circuitry. Do not touch exposed connections and components
when power is present.

Use Proper Fuse. Use only the fuse type and rating specified for this product.

Do Not Operate in Wet/Damp Conditions.

Do Not Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.

Provide Proper Ventilation. Refer to the manual’s installation instructions for
details on installing the product so it has proper ventilation.

To Avoid Fire or
 Personal Injury
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These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result
in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in
damage to this product or other property.

These terms may appear on the product:

� DANGER indicates an injury hazard immediately accessible as you read the
marking.

� WARNING indicates an injury hazard not immediately accessible as you
read the marking.

� CAUTION indicates a hazard to property including the product.

The following symbols may appear on the product:

CAUTION
Refer to Manual

Protective Ground
(Earth) Terminal

Terms in this Manual

Symbols and Terms
 on the Product
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Service Safety Summary

Only qualified personnel should perform service procedures. Read this Service
Safety Summary and the General Safety Summary before performing any service
procedures.

Do Not Service Alone. Do not perform internal service or adjustments of this
product unless another person capable of rendering first aid and resuscitation is
present.

Disconnect Power. To avoid electric shock, switch off the instrument power, then
disconnect the power cord from the mains power.

Use Care When Servicing With Power On. Dangerous voltages or currents may
exist in this product. Disconnect power, remove battery (if applicable), and
disconnect test leads before removing protective panels, soldering, or replacing
components.

To avoid electric shock, do not touch exposed connections.

Use only Tektronix approved components when servicing the unit.
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Preface

This manual describes the functions and use of the Tektronix MTS400 Series
MPEG Test System. After the introduction, each section of the manual describes
one of the software applications or tools that make up the MTS400 Series
system.

Other documents are available on the Tektronix Web site (www.tektronix.com):

� MTS400 Series MPEG Test System Getting Started Manual (071-1505-xx).

� MTS400 Series MPEG Test System Programmer Manual (071-1725-xx).
This manual specifies the remote control and status monitoring interfaces
available to a management application.

Related Material

Additional documentation, such as Read Me files, may be included on the
installation disks.

The following URLs access the Web sites for the standards organizations listed
(the URLs listed were valid at the time of writing):

� MPEG-2 standards (International Organization for Standards)
http://www.iso.ch/

� DVB standards (European Technical Standards Institute)
http://www.etsi.org/

� ATSC standards (Advanced Television Systems Committee)
http://www.atsc.org/

� ISDB/ARIB standards (Association of Radio Industries and Businesses)
http://www.arib.or.jp/english/

� SCTE Society of Cable Television Engineers
http://www.scte.org/
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Manual Conventions

Naming conventions for the interface elements are based on standard Microsoft
Windows naming conventions. Naming conventions for MPEG−2, ATSC, and
DVB structures follow the conventions derived from the standards listed above.
In addition, the following formatting conventions apply to this manual:

� Bold text refers to specific interface elements that you are instructed to
select, click, or clear.
Example: Select Settings from the Configuration menu.

� Mono−spaced text can indicate the following:

� Text you enter from a keyboard
Example: Enter the network identity (http://TSMonitor01)

� Characters you press on your keyboard
Example: Press CTRL+C to copy the selected text.

� Paths to components on your hard drive
Example: The program files are installed at the following location:
C:\Program Files\Tektronix\
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Introduction

Table 1−1 summarizes the software applications that make up the MTS400
Series MPEG Test Systems. Options are enabled by a software key; not all
options may be enabled. Detailed descriptions of all applications can be found in
the remainder of this manual.

See also the MTS400 Series MPEG Test Systems Getting Started manual 
(071-1507-xx).

The MTS4EA Compressed Video ES Analyzer options are described in the
MTS4EA User Manual (071-1641-xx).

(The applications are shown in the same order that they appear in the Windows
Start menu.)

Table 1−1: MTS430 / MTS400 / MTS4SA / MTS4UP / MTX100B Installed
Applications 

Application
Desktop Icon 
(where installaed)

Analyzers

Transport Stream Compliance Analyzer (TSCA) - Real Time

Real-time transport stream analysis with user-selectable MPEG-2, DVB,
ATSC and ISDB conformance tests. Shows transport structure, header
contents, hexadecimal packet contents, PCR timing /transport rate
graphs and error message logs.

Transport Stream Compliance Analyzer (TSCA) - Deferred

D.eferred transport stream analysis with user-selectable MPEG-2, DVB,
ATSC and ISDB conformance tests. Shows transport structure, header
contents, hexadecimal packet contents, PCR timing /transport rate
graphs and error message logs.

Transport Stream Compliance Analyzer Lite (TSCA) - Deferred

Same as for the TS Analyzer except that the file size of transport
streams to be analyzed is limited to 192 MB.

Packetized Elementary Stream (PES) Analyzer

PES analysis with selectable test options. Shows PES program
structure, header contents, packet contents, PTS/DTS timing graphs
and analysis reports.
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Table 1−1: MTS430 / MTS400 / MTS4SA / MTS4UP / MTX100B Installed
Applications (Cont.)

Application
Desktop Icon 
(where installaed)

Transport Stream - System Target Decoder (T-STD) Buffer Analyzer

Analyzes program streams modeling their behavior in, and their
conformance to, the MPEG 2 T STD Buffer Model.

Elementary Stream Analyzer

Elementary Stream analysis at video picture and audio level. This
includes vector graphs and macroblock picture quality.

Carousel Analyzer

Data analysis showing structure, bit rate, repetition rate, syntax and
semantics of data items.

Generators

Carousel Generator

Provides in-depth off-line generation of MPEG-2, DVB transport
streams containing a range of data broadcast protocols.

Multiplexer

Multiplexes table information and packetized elementary streams
together to synthesize new transport streams. A fine level of control is
provided to allow non-conformances and test cases to be specified for
new transport streams.

TS Editor

Viewing and Editing of transport stream packets, using a hexadecimal
view of the packet contents and semantic interpretation of the header.
Provides facilities to remap PIDs, recalculate PCR values, and
introduce PCR inaccuracies.

Players

MPEG Player

Records and Plays out MPEG-2 streams.

(The MTX100B MPEG Player and Recorder is described in the
MTX100B User Manual, Tektronix part number 071-1927-xx.)
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Table 1−1: MTS430 / MTS400 / MTS4SA / MTS4UP / MTX100B Installed
Applications (Cont.)

Application
Desktop Icon 
(where installaed)

Utilities

Make Seamless Wizard

Guides the user through the process of creating an MPEG-2 file for use
by Stream Player in continuously looped operation.

Stream Cutter

Extracts sections of MPEG-2 files to new files.

Script Pad

Enables users to create and modify System Information (SI) scripts.
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Transport Stream Compliance Analyzer - Getting Started

The MTS400 MPEG Transport Stream Compliance Analyzer (TSCA) enables
you to monitor and interpret the contents of real-time, previously recorded or
synthesized transport streams using the latest MPEG, DVB, ATSC, ISDB-T, and
ISDB-S standards.

The TSCA is specifically designed to enable you to quickly locate and identify
problems within a transport stream using a minimum number of mouse clicks.
By quickly identifying the problem areas, the TSCA software helps you save
time during the development and test of equipment, networks, and services. You
can configure the TSCA software to display stream information in user-selected
fonts. This feature enables you to view stream information in your local language
or to use custom fonts.

The TSCA software will run stand-alone on computers with Microsoft Win-
dows 2000 or Windows XP operating systems.

Figure 2−1: TSCA Program view - Deferred analysis
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TSCA Features

� Easy “program centric” user interface quickly isolates information of interest

� CaptureVu� technology captures and analyzes system events in real or
deferred time

� In-depth analysis of stored transport streams including support for MPEG,
ATSC, DVB, ISDB-T and ISDB-S table types

� Data summaries and automated filters simplify the analysis of complex
transport streams

� TR 101 290 Priority 1, 2 and 3 tests 
(European Telecommunications Standards Institute (ETSI) TR 101 290:
Digital Video Broadcasting (DVB); Measurement Guidelines for DVB
Systems.)

� Syntax analysis and display supported for TMCC and IIP data

� Consistency checks performed between SI, TMCC, and IIP data

� Proprietary PSI/SI syntax section rate error testing

� Error logging

� Suspension of all tests at program changeover based on PMT version change

� DII and DDB error checking

Deferred and Real-Time Modes

The TSCA can be run in Deferred or Real-Time mode.

The Deferred mode is available on any recommended platform (including the
user’s own PC). In Deferred mode, a static stream can be analyzed and dis-
played; the content can then be inspected at leisure.

The Real-time mode, with which a live stream can be analyzed, is available
when the TSCA is installed on a Tektronix MTS400 series MPEG Test System
or an MTX100B with an Option 7 interface card. Real-time streams can be
paused for detailed offline analysis and then when the issue has been found,
real-time analysis can be resumed. Real-time monitoring of Video over IP
(internet protocol) is also available as a standalone application on a user’s own
PC.
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Technical Background

The analyzer has a client-server architecture. Every time the analyzer opens, it
starts two processes: tsca.exe, which is the client, and MpegCore.exe, which is
the MPEG analysis engine. Additionally, when the analyzer opens for the first
time, another single process, CoreManager.exe, is started. CoreManager.exe
forms an intermediary between TSCA clients and MPEG cores.

The tsca.exe, MpegCore.exe, and CoreManager.exe processes use SNMP
(Simple Network Management Protocol) and HTTP (Hypertext Transfer
Protocol) to communicate. The port numbers used for communication are read
from a configuration file, CoreInfo.xml. In a default installation, this file can be
found in c:\program files\tektronix\mpeg\mts400\apps\tsca\xml\. The default
port range is 15700-15800. These values can be changed if they conflict with
other applications.

On the MTS400 platform, another process, mint.exe, runs from system startup.
This process controls shared access to the MTS400 Series hardware by the
analyzer and player.

You must have local administrator rights to be able to use IP analysis. If you
need to change your rights , please consult your system administrator.

User Interface

The TSCA software uses a single main program summary window with different
context sensitive views contained within tabbed frames. This provides the
maximum amount of useful information while keeping the screen from appearing
cluttered. From the main window, you can access the following views: Program,
Tests, Tables,PID, Packets, and Interface.

The Program view provides a fast overview of the transport stream contents in
terms of program content, bit rate use by each program, and TR 101 290 test
results. Red, amber and green LEDs highlight errors associated with each
program, or element of a program, within the transport stream. Red LEDs
indicate that there are current errors in the stream, amber LEDs indicate that
errors have occurred but are now clear, and green LEDs indicate that no errors
have been detected.

Errors that are detected at lower levels in the program stream hierarchy propagate
up to the highest level. This allows you to monitor all of the programs in the
stream at a high level and then quickly go to lower levels as necessary to locate a
problem.

Program View
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The Tests view enables you to isolate errors to the specific tests that have been
applied to the transport stream. The error log is automatically filtered by the
selected test, and can also be filtered by Packet Identifier (PID). In addition to
the standard first, second, and third priority tests included in TR 101 290
standard, tests are available for Program Clock Reference (PCR) jitter and
program/PID bit rate. A variability test enables you to test the changes in the bit
rate of a specific PID, and there are many tests that are specific to ISDB-T and
ISDB-S streams.

The SI/PSI (Tables) view displays the service information tables that have
occurred in the analyzed stream which comply with the selected digital video
standard. This includes MPEG-specific program information, DVB service
information, and ATSC, ISDB program, and system protocol information. The
tables are grouped together by function and hyperlinks enable you to quickly
access related information within other tables.

The PID view displays information about all of the PIDs found in the transport
stream. When you select the transport stream, the associated summary view
provides a PID-oriented overview of the transport stream, displaying the relative
data rates of all of the PIDs contained within the stream. The information can be
displayed as either a bar chart or as a pie chart. Pop up menus enable fast limit
selection and links.

Each PID is associated with a number of tests. When one or more tests fail, each
failed test will be listed under the relevant PID. Select a specific PID to display a
summary of all the associated tests. Select a specific test to display the Event
Log and Parameters for only that test.

The Packets view displays information about all of the packets found in the
transport stream grouped according to content. These groups include PID value,
SFN mega-initialization packets (MIPs) (DVB only), and ISDB-T information
packets (IIPs). When you select a specific PID or MIP, only packets carrying that
particular PID or MIP are displayed. A section view is also available.  Deferred
analysis of PCAP files allows you to see the ethernet packets.

The Packets view is not available in real-time mode. However, packets in a
real-time stream can be examined using the CaptureVu feature.

The Interface view provides a central location for information related to the RF
interface card (where installed).

� Test results

� Graphical representation of specific RF card readings

� RF card readings and control settings

Tests View

SI/PSI (Tables) View

PID View

Packets View

Interface View
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The graphical views display a selection of graphs of instantaneous measurements
and measurement trends. Also available are an Event Log and a Parameter view.

The Interface tab is displayed only when an interface is installed.

CaptureVu Feature

The CaptureVu feature captures a snapshot of system events in real and deferred
time, and allows you to debug the intermittent and complex problems that
traditional analyzers miss. You can initiate CaptureVu either manually or
automatically by associating a CaptureVu Breakpoint with any test event. When
a breakpoint is detected, either manual or automatic, the stream is paused and an
in-depth deferred time analysis can be performed on stored data. This powerful
debug mode enables fast debugging of troublesome intermittent problems.

Triggered Recording

During real-time analysis, stream information can only be held for a finite time -
eventually it will be overwritten by more up-to-date information. Triggered
recording allows a portion of a stream to be recorded and subsequently analyzed
in detail.

The following trigger sources and conditions apply:

� Any test event

� External input; (TTL) edge specifiable

� Date and time

� Recorded file size can be specified

� Pretrigger buffer size can be specified as a percentage of the overall file size
range from 0 – 100%
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Starting the TSCA Software

The TSCA can analyze transport streams in either real-time or off-line (deferred)
mode.

From the Windows Desktop, select Start > Programs > Tektronix MTS400 >
Analyzers > TS Compliance Analyzer.

The TSCA is opened, initially overlaid with the Open Transport Stream...
dialog box.

Click File Analysis to select the trans-

port stream file to analyze and to se-

lect the method for calculating the

rate of the stream.

Click Real-time Analysis to select an

input source (IP or hardware inter-

face) for real-time analysis.

Figure 2−2: TSCA Start-up

The Open Transport Stream... dialog box allows you to:

� Select the interpretation standard to be used for analysis. 
(The stream interpretation should be checked and, if necessary, set first.)

� Identify a stream file for deferred analysis. Files can be selected either
directly from the disk drive or using previously set up shortcuts.

� Identify an input (IP, ASI or SMPTE or DVB Parallel) receiving a stream
and start real-time analysis.

Opening the TSCA
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You can set up the stream interpretation standard in the following way:

1. Click Change... in the Open Transport Stream dialog box to open the Stream
Interpretation dialog box.

NOTE. The TSCA software analyzes streams in strict accordance with the
standards defined by the digital television authorities: DVB (Digital Video
Broadcasting), ATSC (Advanced Television Systems Committee), and ISDB
(Integrated Services Digital Broadcasting).

The TSCA software uses preloaded scripts which establish the expected content
and syntax of the analyzed stream. The analyzer is supplied with a comprehen-
sive range of scripts, which, in different combinations, can interpret the full
range of digital television standards.

2. Select the Base Standards and then (if available) select the Region. The
analysis scripts that will be used are displayed in the Script Files pane.

Figure 2−3: Stream Interpretation dialog box

3. Select OK.

Interpreting a Stream
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4. The stream interpretation is now set. Choose one of the analysis options to
select a file or real-time analysis.

(For details of the Stream Interpretation management, see Script Files on page
2−135.)

NOTE. The selected stream interpretation standard is not implemented until
stream analysis is started. If the Open Transport Stream dialog box is closed
without starting analysis, the stream interpretation settings are lost; they revert
to the settings that were in effect when the application was last closed.

Perform the following steps to start analyzing a transport stream file:

1. In the Open Transport Stream dialog box, with File Analysis selected,
browse to a transport stream file.

If necessary, select a file type from the Files of type drop−down list.
Currently, two types are available: MPEG Transport Stream files and PCAP
files.

� MPEG transport stream files contain interlinked tables and coded
identifiers, which separate the programs and the elementary streams
within the programs.

� PCAP files contain raw packets of network data. A PCAP may contain
more than one session. You will need to select a session using the
Browse dialog box.

2. When you select a stream, the stream name appears in the field at the bottom
of the window.

Off-Line (Deferred)
Analysis
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Figure 2−4: TSCA File Analysis (Offline) dialog box

3. Calculating the Transport Rate. To analyze a transport stream correctly, you
must do one of the following:

� Calculate the bit rate from PCRs (Program Clock Reference) carried in
the stream

NOTE. When the TSCA software analyzes a transport stream, it compares the
bit rate of the stream to the expected rate. Errors are reported based on the
expected rate of the stream. To analyze a stream correctly, it is necessary to
know the original bit rate of the stream or to calculate the bit rate from
PCRs (Program Clock Reference) carried in the stream. PCRs are generated
as a stable clock reference and are added to the stream during its genera-
tion. During analysis, the PCRs are extracted and synchronized with a local
clock reference.

� Know the original bit rate and enter it manually

� Use timestamps included with the stream

4. After you select the desired stream, select one of the following methods for
calculating the rate of the transport stream:

� Prescan the first nnn PCRs. When you select this method, the TSCA
software calculates the rate of the stream by prescanning the stream for
embedded PCRs. The entry box lists the number of PCRs that the TSCA
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software recommends are necessary to determine the stream rate. You
can use the entry box to enter a different number.

� Prescan all PCRs in a file. When you select this method, the TSCA
software calculates the rate of the stream by prescanning the stream for
all of the embedded PCRs.

� Manually set nnnn Mbps. When you select this method, the TSCA
software uses the absolute value (in Mbps) that you enter as the expected
stream rate.

NOTE. Timestamps, which are added when the stream is generated, will be
used, if present, and if the Use Timestamps checkbox is enabled. Using
timestamps will override the PCR options (Prescan PCRs and Scan entire
file). The manual bit rate setting will override both PCRs and timestamps.

5. If the TSCA software cannot calculate the bit rate from the embedded PCRs,
or timestamps, a message box is displayed. You must enter an estimated bit
rate before the TSCA software can analyze the stream.

If the CaptureVu feature is to be used, the whole file can be captured or
analysis can be stopped either by a previously set CaptureVu breakpoint or at
a specific packet.

6. To stop analysis at a specific packet, enable Stop Analysis at Packet Index
and enter a packet number.

With a file selected and the transport rate calculation set up, you can start the
analysis (see page 2−12).
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Perform the following steps to start analyzing a transport stream received
through an IP or a hardware interface.

1. In the Open Transport Stream dialog box, with Real-time Analysis selected,
select an interface from the drop-down list.

NOTE. For stand-alone installations, only the IP interface is available.

Figure 2−5: TSCA Real-time Analysis dialog box

Real-time analysis will not be available if the appropriate software key permis-
sions are not found. A warning message is displayed when real-time analysis is
not available.

Make any necessary interface settings. During analysis, the interface selected
will be shown in the status bar. (The IP interface settings are described on
page 2−13.)

Real Time Analysis
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To start the analysis, follow these steps:

1. After you have selected the interpretation standard and the stream source,
click OK to continue.

The TSCA software starts analyzing the selected stream. During deferred
analysis, a progress bar is displayed. The TSCA starts reporting analysis
results (see Figure 2−6).

Figure 2−6: TSCA window showing analysis progress

2. When sufficient data has been gathered and the display has stabilized, you
can start using the TSCA to view the analysis.

3. To analyze another stream file or to reanalyze the current stream using
different standards, use the File > Open Transport Stream menu selection.

Start the Analysis
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Setting Up the IP Interface

Two Ethernet interfaces are standard on the MTS400 Series systems (one 10/100
Base T and one 10/100/1000 Base T GigE). A high performance Gigabit
Ethernet interface (1000 Base T GigE) can be acquired as an option; this
provides accurate hardware timestamping, hardware filtering and a variety of
connection options, including copper and optical. These allow for basic detection
and display of all UDP (User Datagram Protocol) traffic on a network. Extraction
of an MPEG over IP stream is possible (if the licensed option is enabled).

� IP multicast addresses are indicated.  Note that the TSCA will not automati-
cally join a multicast group (see IGMP Group Membership, page 2−14).

� UDP streams carrying MPEG TS traffic are indicated.

� A selected UDP stream carrying TS traffic may be selected for analysis and
recording, in a similar manner to any other physical interface.

Figure 2−7: Setting up the IP interface

In the Open Transport Stream… dialog box with IP selected in the Select
Interface drop-down menu, the current settings for the selected configuration are
shown. The individual settings are described next.

Select OK to confirm the IP setting and start analysis.
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You can save individual IP settings configurations to disk; they can be recalled
when required. Up to 128 configurations can be specified.

The Open Transport Stream − Real-time Analysis dialog box shows the settings
associated with the currently selected configuration.

Different settings can be entered on this screen; the new settings will be used
when OK is selected. The new settings can also be saved as a new configuration
for future use if required.

IGMP Group Membership. Multicast broadcasts can be joined by entering the
multicast address in the IGMP Group Membership field in the Browse dialog
box. The sessions detected will be listed in the dialog box.

Create a New IP Configuration. In the Open Transport Stream − Real-time
Analysis dialog box, select the plus button to create a new configuration.

A default configuration name is allocated and displayed in the IP Configuration
Name field. You can enter a more meaningful name. New values can be entered
as required. This name and the settings associated with it will remain available
for recall.

Alternatively, the streams available can be viewed and a new one selected.

Select New to open the Edit IP Configuration dialog box.  Select Browse and the
Browse for UDP flow... dialog box will be displayed (see Figure 2−8).

Interface Settings
Configurations
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Figure 2−8: UDP flow selection dialog box

The names of any network devices installed in the instrument are displayed in
the Browse Device field. Select the network device required from the drop-down
list. The traffic present on the selected interface is displayed in the bottom half of
the dialog box. A summary of the UDP flows detected is displayed in the table
header. The bit rates given are UDP bit rates, not transport stream bit rates.

The settings (Source and Destination addresses) can be set up in two ways:

� In the Open Transport Stream, Real-time Analysis, Selected Configuration
area, enter data into the Stream Settings fields. 

Multicast sessions can be identified by entering the appropriate address in
the IP Destination Address field.
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� In the Browse for UDP Flow dialog box, highlight a session in the current
traffic area; the values are entered automatically in the Selected Configura-
tion, Stream Settings fields. Traffic carrying transport streams will have a
check mark in the Has TS column.

The TSCA should detect whether  traffic is transmitted over UDP or RTP; this
will be indicated in the Transport column. The Use RTP check box will be
updated to match the protocol indicated for the selected session; this setting can
be overridden by selecting or clearing the Use RTP setting if it is believed that
the protocol indicated is incorrect.

When the settings are correct, select OK to confirm and save the configuration.
The Edit IP Configuration dialog box closes and the new configuration is
immediately available in the Open Transport Stream dialog box.

Edit an Existing IP Configuration. An existing IP configuration can be modified as
required.  Modify the individual fields in the Selected Configuration, Stream
Settings fields or select a new entry in the Browse for IP Flow dialog box.
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Select an Alternative IP Connection. Select a new configuration from the Interface
Settings drop-down list. Note the change in the Current Settings section of the
window.

Delete an IP Configuration. To delete an IP configuration, ensure that the
configuration to be deleted is displayed in the Open Transport Stream dialog box
and select the minus button. The selected IP configuration is deleted and the next
available IP configuration is displayed.
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Setting the Stream Content Font

You can configure the TSCA software to display stream content information in a
user-defined font style or language, such as Japanese or Chinese.

NOTE. How the TSCA displays the text strings carried in the stream itself is
dictated by the TSCA font setting and by the interpretation standard used during
the analysis.

How the TSCA displays entries in the Event Log is dictated by the TSCA font
setting and fonts used by a local computer. For example, if the default language
of the TSCA computer is Japanese, the event log will be displayed in Japanese
characters. You must choose a suitable font for the characters to display
correctly.

Perform the following steps to set the font that will be used by the TSCA
software to display stream content. You can configure the TSCA software to
display stream content using any font that is installed on your computer.

1. Select Settings > Preferences… to open the Preferences dialog box.

2. Select Font at the left of the Preferences dialog box to display the window
shown in Figure 2−9.

Figure 2−9: Selecting a display font from the Preferences dialog box

Selecting the Display Font
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3. The dialog box lists the default font used by your computer for the Log
Entries and Stream Content displays on the TSCA software. Use the Font
Name and Font Size drop-down boxes to select a desired font style and size.

4. Click OK to accept and save any changes.

Computers that are using local versions of MS Windows 2000 (such as Japanese
or Chinese), or MS Windows XP, should have the Asian language fonts already
installed on their systems.

If your computer or MPEG test system does not have Asian fonts installed,
perform the following steps to install the Asian fonts:

1. Insert the MS Windows OS CD-ROM, which was supplied with your
computer or MPEG test system, into the CD-ROM drive.

2. Locate the LangPack directory on the CD-ROM. This directory contains a
number of *.inf files for various languages. For example, you may want to
install japanese.inf and tchinese.inf, for Japanese and Traditional Chinese
language fonts.

3. To install new fonts, right click on each desired font file in the LangPack
directory and select Install.

4. The new fonts you installed should now appear as possible font selections in
the Preferences dialog box. You must select the new font in the Preferences
dialog box before the new font will be used to display stream content.

The ARIB specifications for the ISDB standards make use of private extensions
to the standard Unicode character set [0xE000-0xF8FF]. These extensions allow
you to add additional characters and nonstandard proprietary characters to an
existing font. The extension sets are provided as TrueType Extension files (*.tte).
Any extension sets should be installed using the Private Character Editor which
is supplied as part of the standard MS Windows installation.

To install a font extension set on your computer:

1. Open the MS Windows Private Character Editor.

a. Select Run from the Start menu.

b. Enter eudcedit in the Run dialog box and click OK.

2. After the Private Character Editor opens, close the Select Code dialog box.

3. Select Font Links� from the File menu.

Installing Asian Language
Fonts

Loading a Custom
Extension Font
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4. In the Font Links dialog box, select Link with Selected Fonts.

NOTE. If you select Link with All Fonts, the following actions will overwrite any
existing font extension sets.

5. In the Select Fonts box, find and highlight the font to which you are adding
the extension. This font should be the one you selected in the TSCA font
preferences dialog box.

6. After you select the font to which you are adding the extension, click on
Save As….

7. In the Modify Private Character Filename dialog box, browse to the
TrueType extension file you are adding (*.tte) and click Save.

8. In the Font Links dialog box, click OK.

9. Close the Private Character Editor window.

10. To verify that the font extension has been successfully installed, open the
Character Map application.

a. Select Run from the Start menu.

b. Enter charmap in the Run dialog box and click OK.

11. Browse through the font list for the name of the font to which you added the
extension. The term “Private Characters” should follow the font name. When
you select the font name in the list, you can view the extended character set.

12. Close the Character Map application.

The new font extension you installed should now appear as a possible font
selection in the Preferences dialog box. You must select the new font in the
Preferences dialog box before the new font will be used to display stream
content.
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Understanding the Analyzer Window

On start up, you can immediately open and analyze a transport stream 
(see Starting the TSCA Software on page 2−6). This will result in a display
similar to that shown in Figure 2−10. This is the working display.

Menu bar

Toolbar

Navigation view

Detail views/panes

Status bar

Figure 2−10: Analyzer window



TSCA - Understanding the Analyzer Window

2−22 MTS400 Series MPEG Test System User Manual

TSCA Window Components

The TSCA window contains the following components:

 The Menu Bar provides access to a selection of system options using drop-down
menus (see Menu Bar and Options, page 2−130).

The buttons displayed on the toolbar provide shortcuts to often-used menu
options. Additional buttons displayed during real-time analysis are shown in
Table 2−1:

Table 2−1: Toolbar icons 

Deferred and Real-time Analysis

Opens the Open Transport Stream dialog box.

Restarts analysis.

User actions are recorded during a session. The forward and back
buttons allow you to step through the actions in order to review or
repeat them.

Opens the Preferences dialog box from which you can set your
preferences.

CaptureVu

View CaptureVu status.

Resume file analysis.

Stop and capture analysis.

Real-time analysis

View record setting.

Arm record feature.

Start recording.

Stop recording.

Menu Bar

Toolbar
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The progress bar indicates the progress of processing during deferred analysis of
a stream.

To stop the analysis process, click the Stop button on the toolbar.

The left side pane in the main window is the navigation view and provides the
main analysis information for the transport stream in a number of forms:
Programs, Tests, SI/PSI, PID, Packets and Interface. Views are selected using the
tabs at the top of the pane. The background of each view is color-coded to aid
identification.

The right side pane in the main window is the detail view and provides details
related to the selection made in the current navigation view. The overall view
may be subdivided into one or more panes; you can access individual views in
multiple pane views using tabs.

The status bar, when not hidden, is displayed at the bottom of the main window
and shows a summary of stream statistics.

The fields, from left to right, are as follows:

TS Availability Indicates that either the stream bit rate has fallen below
the minimum value or that synchronization has been lost
(see also Sync below). The minimum stream bit rate is
set using the “Min stream bit rate for processing”
parameter, see Parameter Edit, page 2−104.

Sync Shows the status of the MPEG sync loss test. Loss of
sync during analysis of a stream may mean that analysis
of the complete stream was not possible.

Bit rate Total bit rate of the transport stream. 
The packet value (188 or 204) is set using the Prefer-
ences feature (see page 2−133).

Progress bar

Navigation View

Detail View/Panes(s)

Status Bar
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Packet Size Packets in a stream can be either 188 or 204 bytes long.
This is detected automatically.

Stream Interpretation, Base Standard 
This is the set of tests that is being used to analyze the
stream.

Stream Interpretation, Region 
This subset of tests modifies the base standard; it may
add tests or modify existing ones.

Physical Interface The current interface for real-time analysis.

Partial Reception Availability 
(Available only for ISDB-T streams.) This icon indicates
the presence of partial reception data in the stream. The
colors indicate the status as follows:

Gray: Partial reception availability is unknown.

Green: Partial reception data is available.

Gray +
red cross:

Partial reception data is not available.

Processing Throttle Indicator  
This icon consists of two adjacent LED indicators which
show the status of the TSCA processing engine. The left
indicator shows the “strained” status; that is whether
throttling is being applied to cut down on the informa-
tion being processed. The right indicator shows the
“overwhelmed” status; that is whether the processing
engine is able to cope with the amount of information in
the stream even after throttling. The colors indicate the
status as follows (The general color coding scheme is
described in Error Status LEDs, see page 2−26):

Green: OK

Amber: Processing was strained/overwhelmed but is
currently OK

Red: Processing is currently strained/over-
whelmed

White: Processor state is unknown

Gray: Test disabled
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System Log Status Shows the status of the system log which records
system-wide events, for example, scripting errors. The
color of the LED (in the body of the icon) indicates the
most serious event state in the log. When the top surface
of the icon is gray, it indicates that all entries in the log
have been viewed.
Double-click the icon to view the log.

Gray: The log is empty

Amber: There are entries in the log, but none since
the log was last viewed

Red: There are new entries in the log

If you choose not to select and analyze a stream, the screen will appear as shown
in Figure 2−11. The analysis structure is present, but with no stream content.

Figure 2−11: Analyzer window - no file

Analyzer Window − No
Stream Available
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Error Status LEDs

A major feature used throughout the TSCA interface is error status LEDs that
represent the status of the tests applied to associated items, for example,
programs, tests and PIDs. Colors used are as follows:

(Red) Error; test failed

(Yellow) Transient error (error not currently being detected but has
been seen since last reset)

(Green) No error; test passed

(Dark Blue) Warning (Interface tab only)

(Light Blue) Transient warning (warning not current, but has been
detected since last reset) (Interface tab only)

(Gray): Test disabled

(White) Test not applicable or unknown state

(Red) PID referenced but not found in the stream

(Green) PID referenced but not found in the stream. 
Applicable test disabled.

When an LED represents a parent node in a tree (for example, a program node is
the parent of elementary stream nodes), the color represents the worst case of all
of its tests and the worst case of all of the tests represented by its child nodes.

Similarly, when an LED representing a parent node in a tree is disabled or
enabled, all subsidiary (or child) nodes are also disabled or enabled to reflect the
state of the parent node. When an LED representing a parent node is reset, all the
child nodes are also reset.

NOTE. The color scheme described here is used throughout the TSCA interface,
for example, the bit rate bars in the navigation views.
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Tests can be disabled and enabled as required using the shortcut menu associated
with the LED icon. However, it is important to note that the extent of the action
depends on the hierarchical level of the icon chosen. For example, choosing
Disable from a program node shortcut menu will disable all tests in the program
group.

NOTE. In deferred time, if any disabled events are reenabled at the end of
analysis, the LEDs will become green. You will have to restart the analysis if you
wish to see the status of the test when the test is enabled.

Shortcut Menus

Shortcut menus provide an important way of navigating around the TSCA
application. They are available on most displayed objects, for example, program
tree nodes. These menus provide options relevant to the selected object. For
example, after failure, all tests associated with a node can be reset, by selecting
the shortcut menu option Reset All Tests. The shortcut menu options provide
both actions (for example, enable and disable a function) and quick links to
associated objects in other views.

Nodes
Shortcut menu (title bar)

Shortcut menu options

Navigation view tabs

Figure 2−12: Shortcut menu (example)

To view shortcut menus, right-click an object. The menus are associated with
node types (for example, a PID node). Note that node types can be displayed in
more than one view; for example, PID nodes are displayed in the Program view
and the PID view. All shortcut menus have a title bar that indicates the node
selected.

Test Management
Shortcut Menu Options
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Using the Program View

The Program view is displayed when the Program tab is selected in the
navigation tabbed pane. The navigation view initially displays the top node of
the program tree, which represents the analyzed transport stream from a program
perspective.

Figure 2−13: Program view

The detail view shows details of the node highlighted in the navigation view.

With the tree expanded, the navigation view shows the makeup of the stream as
shown in Figure 2−13; the stream display consists of the nodes shown in
Figure 2−14.
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Transport stream node

Program node

Elementary stream node

Figure 2−14: Program view nodes

 Table 2−2 shows which information is available for each node.

Table 2−2: Program view tabs 

Tabs / 
Node Summary

Now 
Playing IP Graphs

MPE 
Sessions

Summary /
Associated
Tests

Graph - 
Bit Rate

Graph -
Timing

Event
Log Parameters

Transport
Stream

� � � � � − − � −

Program � � − − � � − � �

Elementary
Stream

− − − − � � � � �

In DVB analysis mode, the MPE tab is always present. However, the MPE view
will be populated only when MPE data is present in the stream (see page 2−119).

Pressing the F3 key on the keyboard (or selecting Go to the next red LED in
current tree from one of the shortcut menus) will highlight the next red LED in
the current view. Only the lowest level nodes will be considered and highlighted
in the search since the parent nodes simply reflect the state of the lowest level
nodes.
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Program Navigation - Transport Stream Node

The transport stream node represents the entire transport stream in terms of the
programs that it contains. The adjacent LED icon represents the status of the
entire transport stream; any status error in the stream will be represented by this
LED. When this node is selected, the detail view displays the transport stream
summary.

The associated detail view provides a program-orientated overview of the
transport stream, allowing you to see the relative data rates of all of the programs
contained within the transport. A summary of the overall stream is also
displayed. The information can be displayed as either a bar chart or as a pie
chart.

The data rate of a program is the cumulative data rate of all the PIDs that are
associated with that particular program, including PCR and ECM PIDs.

NOTE. Components can be shared between programs, so the overall data rate of
all of the programs may appear to be greater than the total data rate of the
transport stream as shown in the status bar.



TSCA - Using the Program View

2−32 MTS400 Series MPEG Test System User Manual

You can display the transport stream bar chart by selecting the bar chart icon.

Each program identified in the stream is allocated one row of the table. Related
information includes the overall program status (icon), the program name,
program number, and the maximum, minimum and average bit rates.

In addition to the basic display, you can associate a maximum and minimum
threshold value with each program in the bar chart (see page 2−111). For deferred
analysis, where these values are set after analysis, the stream must be reanalyzed
for the new values to be applied. In real-time analysis, the new values will take
effect immediately. The color of the bit rate bar indicates that the program has
stayed within the bit rate limits (green) or exceeded the limits (red).

Bar Chart
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You can display the transport stream pie chart by selecting the pie chart icon.

The pie chart view is divided into two panes. The left pane shows the pie chart,
and the legend on the right provides a list of the component programs. Each
program is color-coded. Related information given includes the overall program
status (icon), the program name and number, and the bit rate. The values given in
the pie chart labels are bit rates expressed as percentages of the overall bit rate.
The Null PID is shown in this view.

The color of the bit rate labels (and the bit rate values in the legend) reflects the
status of the bit rate measurement, for example, green indicates that the program
has stayed within the bit rate limits, and red indicates that the bit rate has
exceeded the limits.

Pie Chart
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You can toggle the bit rate displays between the mean bit rate and the current bit
rate by selecting or clearing the Show Mean Values option on the detail view
shortcut menus (see Figure 2−15). A check mark adjacent to the option indicates
that mean values are to be displayed.

Figure 2−15: Bit rate values display

NOTE. The bit rate value shown in the Status Bar is always the mean bit rate. It
is unaffected by the mean/current selection.

The lower view pane allows you to see a summary of the states of all the
associated tests as well as the event log for the entire transport stream (an
unfiltered event log). The test tabs available will depend on the interpretation
standard chosen. For example, with the DVB interpretation standard, the
available tabs are TR 101 209 and Other. Other interpretation standards will
generate different tabs and different sets of tests (see SI/PSI Nodes, page 2−157).
When any test in the transport stream has failed (and has not been reset), you can
identify which individual tests have failed by observing the red LEDs.

You can use the shortcut menus to reset and disable tests, to set alarms,
CaptureVu Breakpoints and record flags, and to jump to associated tests.

Bit Rate Value Display

Test Status Panes
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The Event Log (Figure 2−16) displays the log entries for the whole transport
stream. In deferred mode, the packet generating the error report can be inspected
by highlighting the error and selecting Go to packet from the shortcut menu.
Similarly, in real-time analysis mode, and where an event concerns a PID
carrying a PCR, you can use the shortcut menu to jump to the relevant PCR
graph. Deferred PCAP file analysis enables a shortcut that allows Ethernet
packets to be viewed.

Figure 2−16: Event log

Two buttons are available in the Error Log toolbar:

 /  Pin log / Log is Pinned.

Export Log.

The buttons are described in detail in Event Log, page 2−107.

Event Log
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The IP graphs available are as follows:

� Packet Interarrival Time (PIT):
Shows the mean interarrival time of IP packets.

� PIT histogram:
Shows the distribution of packet arrival intervals. The X axis contains
accumulators where interval times are collected. The Y axis corresponds to
number of intervals that collect in each accumulator.

� Ethernet flow rate:
Bit rate of the Ethernet flow being analyzed.

� Delay factor:
A measurement which characterizes IP packet cumulative jitter and delay.
(Delay factor is the amount of buffer, in milliseconds, that would be required
to subtract IP packet arrival deviations from the rate determined by the
media payload.)

� Media loss rate:
Media packets lost per second.

The graphs actually available are dependent upon the IP interface options being
used. Unavailable graph names will be grayed out in the selection menu.

NOTE. Graph management and timing graphs are described in more detail in the
Common User Interface Concepts section of this manual (see page 2−85).

IP Graphs
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Program Navigation - Program Nodes

Each of the program nodes in the transport stream represents a single program
referenced within the stream. When a program node is selected in the navigation
view, the detail pane displays the details of the program. The LED adjacent to
the program node represents the status of its child nodes (elementary streams)
and the related tests.

The program detail view provides you with an overview of the selected program,
allowing you to see the relative data rates and stream types of all of the PIDs that
are associated with the program (including PCR and ECM PIDs). If the program
contains an MPEG2 or H.264 video stream, it is decoded to produce a thumbnail
picture of the content; this is updated during real time analysis. Similarly, where
EPG information is associated with the program, a summary (Now and Next
program) is displayed. PID content is indicated using icons, which are described
on page 2−87. Bar chart and pie chart views are available.

PID related information is available under the Summary tab.

The Now Playing tab displays details of the streams and thumbnails for each of
the programs (where available). (See also Now Playing Views, page 2−102).

The Associated Test tab shows tests related to the program. Similarly, the Bit
rate Graphs tab displays the program bit rate in graph form.
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The Parameters view displays the parameters associated with the currently
selected test in the Associated Tests pane (if applicable). You can change the
parameter values, as well as display the current, minimum and maximum values
for each of the test parameters. For deferred analysis, where these values are set
after analysis, the stream must be reanalyzed for the new value to be applied. In
real-time analysis, the new values will take effect immediately.

The Event Log shows the errors for the highlighted test. When no tests are
selected, the event log will show the events related to all tests associated with the
elementary stream selected in the program tree.

The VLC Media Player is a portable multimedia player for various audio and
video formats. The player allows program content displayed in the TSCA
thumbnails to be played in a larger window. The media player is automatically
accessed from the TSCA when you want to view or listen to the video and audio
content of program streams.

NOTE. The VLC Media Player is not installed as part of the MTS400 Series
system. Installation of the player is described in the MTS400 Series Getting
Started manual (Tektronix part number: 071-1505-xx). 

You can find full documentation of VLC on the http://www.videolan.com.

To start the media player, click the start button (below the thumbnail) in the
Program Summary view.

The VLC Media Player is opened automatically and the selected program
content (video and/or audio) will be played. You can close the player by clicking
the stop button (below the thumbnail). The player will close automatically.

VLC Media Player
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NOTE. The VLC Media Player may open “behind” the TSCA window. Use the
Windows controls to bring it forward.

NOTE. If the VLC Media Player is installed on the MTX100B instrument, the
audio feature in the media player must be disabled. Refer to the MTS400 Series
Getting Started manual (Tektronix part number: 071-1505-xx).

Program Navigation - Elementary Stream Node

Each of the elementary stream nodes in the program tree represents a single
elementary stream referenced by the parent program. When this node is selected,
the view pane displays the Elementary Stream summary view.

In addition, when the cursor hovers over the elementary stream node, a tooltip is
displayed giving stream type and description.
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An LED associated with each elementary stream node indicates the status of the
tests relating to the elementary stream.

When the selected elementary stream PID contains timing information, PCR
trend analysis views are also available, allowing you to display graphs of PCR
accuracy and PCR interval data. When the transport stream contains
timestamped data, the PCR overall jitter, PCR frequency offset, PCR arrival
time, and PCR drift rate graphs are also available.

NOTE. Graph management and timing graphs are described in more detail in the
Common User Interface Concepts section of this manual (see page 2−85).

Figure 2−17: PCR Graphs view
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The Associated Tests tab shows tests related to the elementary stream node.

The Parameters view displays all of the parameters for the currently selected test
in the Associated Tests pane (if applicable). As well as displaying the current,
minimum and maximum values for each of the test parameters, you can change
the parameter value. For deferred analysis, when values are changed, the stream
must be reanalyzed for the new values to be applied. In real time, the changes
will take effect immediately.

Similarly, the Event Log shows the errors for the highlighted test. When no tests
are selected, the event log will show the events related to all tests associated with
the elementary stream selected in the program tree.
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Using the Tests View

The Tests view displays test information relevant to the transport stream being
analyzed. The view is displayed when the Tests tab is selected in the Navigation
tabbed pane (see Figure 2−18).

Figure 2−18: Tests Navigation view

The view displays a test tree which represents all the tests that have been applied
to the analyzed transport stream. Figure 2−19 shows the nodes available in the
navigation view.
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Group
Priority

Test

Associated PIDs

Subset

Group �Other"

All Tests

Figure 2−19: Test view nodes
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The test tree structure represents all of the tests that can be applied to a transport
stream complying with a particular digital video standard: MPEG, DVB, ATSC,
ISDB-S, and ISDB-T. The standard must be selected before beginning analysis.
The test tree contains nodes for each test that the analyzer can implement.

An example of a tree structure for a selected standard is the TR 101 290 group of
tests for DVB transport streams (shown in Figure 2−19). The Group node is split
into priority groups: First Priority, Second Priority, and Third Priority. Each of
these priority groups contains a number of individual tests.

Test grouping differs between digital video standards. However, all of the
currently implemented standards contain a subset of the relevant TR 101 290
tests. Note that in standards other than DVB, the tests are not numbered.

Where relevant, PIDs will be associated with a test in the test tree when the test
has either been disabled, or when it has failed.

The LED associated with each node indicates the status of the node and its child
node tests (see Error Status LEDs on page 2−26). Total entries in the Event Log
for each group of tests and for each test are are indicated in parenthesis; resetting
a group of tests or a test restarts the count in parenthesis.

Test Structure
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Interpreting theh display of tests can be made easier using the three filter buttons
at the top of the Tests navigation view.

Grey White Green

Figure 2−20: Test filtering buttons

Each button, when selected, will hide a category of tests in the display.

� When you select the grey button, tests that are currently disabled will not be
displayed in the test tree.

� When you select the white button, tests that currently have either unknown
or not applicable status will not be displayed in the test tree.

� When you select the green button, tests that currently have OK status will
not be displayed in the test tree.

Test Filtering



TSCA - Using the Tests View

MTS400 Series MPEG Test System User Manual 2−47

Tests Navigation - All Tests

The detail view when the All Tests node is selected is shown in Figure 2−18 on
page 2−43. In addition to a summary of all tests, the event log shows the most
recent 10000 events that have occurred during analysis of the stream.

Figure 2−21: Test Failures screen

The Test Failures view provides an overview of the tests that have failed during
stream analysis. The view is divided into two panes. The left panes shows those
tests that have failed in the last second. The right pane shows those tests that
have failed, not including those that have failed in the last second, and are
displayed on the left side.

If a test fails, it will be displayed on the left side. When it no longer fails, it will
be removed from the left side and listed on the right side as a test that has
previously failed. If the test fails again, it will be removed from the left side and
redisplayed on the right side until it no longer fails.

Additionally, tests that have been listed (in either pane) in the last second are
displayed at the top of the list and shaded.

Test Failures View
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Test Navigation - Test Nodes

When you select a test node, the Associated PIDs pane displays a summary of all
of the PIDs and an event log listing all events that are associated with the test.
Where parameters are applicable to the test, you can modify them under the
Parameters tab.
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Test Navigation - PID Nodes

Where tests have failed, the PIDs affected are listed under the test node in the
Tests navigation view. Selecting a PID will display the Event Log, Parameters
for the PID, and the test in the detail view.
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Using the Tables View

The Tables view (SI/PSI tab) displays service information in tree form, as in the
other navigation views. The tree represents the service information tables that
have occurred in the analyzed stream and which comply with the selected digital
video standard. This includes MPEG program specific information, DVB service
information, ATSC and ISDB program information, and system information
protocol. The tree contains nodes for each table found; tables/nodes are grouped
together by functionality. Figure 2−22 shows an example of the Table navigation
view with DVB stream interpretation selected.

Figure 2−22: Tables view

Every node within the service information tree has a corresponding summary
view. Nodes that represent tables will also provide you with access to the table
structure and hex data (see Tables Detail View - Section View on page 2−53), and
graphical displays of data rates and interval data (see Tables Detail View - SI
Repetition Graphs on page 2−55).
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Some of the nodes that represent less common tables or table groups may not
have specific summary views available in the analyzer. In these cases, a generic
summary view is used.

Table Summary Pane

The table summary view provides a summary of the table related information for
the analyzed transport stream. There is a table summary view for every node of
the service information. The content is dictated by the selected node.

All summary views for nodes that represent an individual table or subtable will
display the table identity and version number of the table from which the
information is extracted. Where relevant, links (underlined text) are provided to
associated objects, for example, in the programs summary (Figure 2−23), links
are provided to the individual program summary views. Similarly, arrow icons
provide links to the electronic program guide (EPG) tables. Where the section is
carried on a PID, a link is also provided to the PID view.

Figure 2−23 shows an example of the summary pane with the PMT PIDs node
selected in the navigation view.

Figure 2−23: Tables view - Programs (example)



TSCA - Using the Tables View

MTS400 Series MPEG Test System User Manual 2−53

A specific departure from the Table Summary view described previously is the
EPG view that is displayed when a section of the EPG table is highlighted. For a
description of the general presentation of the EPG view, see page 2−115.

Tables Detail View - Section View

The detailed section view is available when the selected node in the service
information tree represents a table or subtable in the transport stream. During
real-time analysis the view is continually updated.

The subtable identity, version, and section are displayed at the top of the table
pane.

NOTE. In deferred mode, where two or more subtables, versions or sections are
found in the stream, the relevant field is active and an alternative selection can
be made from the drop-down list.

In real-time mode, only the latest version and section can be viewed.

EPG Views
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The table pane shows all fields that make up a section (for example, PMT). The
fields are arranged in a hierarchical order. The presence of subordinate fields is
indicated using { } bracket symbols adjacent to the container field. The container
can be expanded or collapsed by clicking the + or – icon.

Below the table pane, the data source is displayed. The data pane shows the data
bytes (in both hexadecimal number format and ASCII character format) for the
selected table, version, and section. When a node is selected in the table pane,
the bytes that make up the selected node (including the subordinate nodes) are
highlighted in the hexadecimal data pane (refer to Figure 2−24).

Figure 2−24: Section payload

If the section is corrupt or empty, the hexadecimal view background is red
instead of blue.
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Tables Detail View - SI Repetition Graphs

The section graph view will be available when the selected node in the service
information tree represents a table or subtable in the transport stream. You can
view graphs of the following data:

� Section repetition interval:
This graph displays the interval between two sections of a table on a
particular PID.

� Subtable intersection gap:
This graph displays the interval between sections in a particular subtable.

� Subtable repetition interval:
This graph displays the time between receiving one complete subtable and
receiving the next complete subtable.

NOTE. Not all of the above graph types are relevant to all table types.

Graph Management is described in more detail in the Common User Interface
Concepts section of this manual (see page 2−85).
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Using the PID View

The PID view displays information about all of the PIDs found in the transport
stream being analyzed. The navigation view contains the PID tree structure
representing all of the PIDs that have occurred within the transport stream.

In DVB analysis mode, the MPE tab is always present. However, the MPE view
will only be populated when MPE data is present in the stream (see page 2−119).
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PID View - All PIDs

In the navigation view, PIDs are grouped under the following subordinate nodes:

� Reserved PIDs

� Referenced PIDs

� Unreferenced PIDs

� User PIDs

� Obsolete PIDs (deferred analysis only)

The number of PIDs in each group is shown adjacent to the node. The root node
label shows the total number of PIDs found and the Network Name.

When highlighted, the All PIDs node displays in the detail pane all of the PIDs
found in the analyzed stream.

Each of these subordinate nodes contains PIDs belonging to that group. PIDs are
allocated during analysis, and the number of PIDs is identified for each node.
You can also allocate PID numbers to the User PID node, although User PIDs
may not necessarily have been found in the stream. This feature allows you to
compare the properties of one or more PIDs more easily.

The associated summary view provides a PID-oriented overview of the transport
stream, allowing you to see the relative data rates of all of the PIDs contained
within the transport stream. The information can be displayed as either a bar
chart, or as a pie chart. Columns in the summary views can be sorted in
ascending or descending order by clicking on the column header. PID related
information is available under the PID Information tab.

Each PID is associated with a number of tests. If one or more tests fail, they will
be listed under the relevant PID node in the navigation view. Selecting the PID
node will display a summary, in the detail view, of all associated tests that have
been found. Selecting a specific test in the Associated Tests pane will display the
Event Log and Parameters for only that test.
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PID View - Detail View (All PID and PID Group)

The All PID and PID Group detail view provides you with a PID-oriented
overview of the transport stream. This view is displayed when any of the main
nodes is selected in the navigation pane: All PIDs, Referenced PIDs, Unrefer-
enced PIDs, or User PIDs.

The view shows the relative data rates of all of the PIDs contained within the
selected node. You can display the information in either a bar chart or a pie
format. The associated test states are shown in all views.

Figure 2−25: PID Summary view

The PID Information view (see Figure 2−26) provides PID related information,
for example, PID type stream type, scrambled status and the presence of PCRs.
Layer information is also shown when analyzing ISDB streams. The icons
provide an indication of the PID content (see Icons, page 2−87).

Where a PID carries video or audio, thumbnails are displayed under the Now
Playing tab.

In deferred mode (or during CaptureVu analysis), you can view the packets
carrying a PID by highlighting the PID, and selecting the Go To Packets view
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from the shortcut menu. The packet will be added to the PIDs list (in the Packets
view).

Figure 2−26: PID Information view

PID View - Detail View (PIDs)

The individual PID detail view provides you with information about the selected
PID. This view will be visible when you select an individual PID node in the
PID tree. Where a PID has failed a test, one or more test nodes are displayed as
child nodes of the PID.

The combination and detail of the views vary depending on the selected PID type
and node.

During deferred or captured analysis, the packets carrying the PID can be
examined in more detail by highlighting a PID, and selecting the Go to Packets
view from the shortcut menu.
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When a PID does not contain PCRs, the main view in the PID pane is the
Associated Tests view. This view lists the tests associated with the selected PID.
The status of the individual tests is indicated with LED icons. Also available are
Bit rate Graphs which show the bit rate of the selected PID in graphical form.

Also on the Associated Tests tab is an event log and a parameters pane. The
event log shows all PID related events. If a test is selected in the PID pane, only
the events associated with that test on that PID are shown. Similarly, when a test
is selected, the Parameters pane shows the parameters associated with that test
(when applicable).

When the selected PID contains PCR information, PCR inaccuracy and PCR
interval data graphs will be displayed in addition to a bit rate graph. When the
transport stream contains time stamped data, the PCR overall jitter, the PCR
frequency offset, and the PCR drift rate graphs will also be available. For
real-time IP analysis, the Packet Interval Timing (PIT) graph is also available
(see page 2−101).

A Presentation Time Stamp (PTS) graph may also be available on PIDs carrying
audio and video information.

(See also Graph Management, page 2−91 and Timing Graphs, page 2−97.)

Ordinary PID Selected

PCR PID Selected
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Using the Packets View

NOTE. The Packets view is available only during deferred analysis and
CaptureVu analysis.

Data in the stream is carried in 188- or 204-byte packets. The Packets view
allows you to examine the contents of each packet in the analyzed stream.

The packet navigation view shows a tree structure which represents the packets
within a stream grouped according to content, including PID value, SFN
mega-initialization packets (MIPs) (DVB only), and ISDB-T information packets
(IIPs).

The All Packets, MIP and IIP nodes do not have any child nodes. The All
Packets node represents all of the packets in the transport stream. The MIP node
represents all of the DVB SFN MIPs in the transport stream. The IIP node
represents all of the ISDB-T information packets in the transport stream.

The PIDs node represents all of the PIDs that are of interest. You can add PIDs
in the transport stream to this node, and to PIDs that are contained within the
user PID list.
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Selecting any leaf node in the packet tree will apply a packet filter to the
associated packets. For example, selecting a PID node will only allow packets
carrying that particular PID to be displayed in the associated summary view.
Similarly, selecting the MIP node will only allow MIP information to be
displayed in the associated summary view.

Packet Navigation Bar

In the packet summary view, you can use the top bar to navigate the packets in
the stream.

The packet position bar shows the position of the selected packet in the stream.

Current packet position

The navigation bar functionality depends on the selection in the packet naviga-
tion view. If you select All Packets, the controls will operate on all packets. If
you select a single PID, a filter is in operation, and the controls will work only
for those packets carrying that PID.

Selects the first available packet (in the stream or carrying the selected PID)

Selects the previous available packet (in the stream or carrying the selected PID)

Selects the next available packet (in the stream or carrying the selected PID)

Selects the last available packet (in the stream or carrying the selected PID)

Opens the Go To Packet dialog box

You can also use the packet position bar to navigate through the stream. To do
so, use the cursor to point to and click the next packet to be displayed. Double-
click the packet number in the bar to open the Go To Packet dialog box. Enter
the required packet number and select OK. For both methods, remember that the
destination packet is dependent on the node selected in the navigation view.
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Packet Navigation - Filter Nodes

The packet filters allow you to view packets carrying PID.

To inspect the sequence of packets carrying a particular PID, you must add the
PID to the PID Filters node in the Packet Navigation view. PIDs carrying
sections can also be viewed. You can add as many PIDs as are required. There
are a number of ways to add a PID to the node; as described in the following
paragraphs.

1. In the Packet view, expand the PIDs node by doing one of the following:

� Double-click the child node (double-click to add a PID)

� Select Add PID... from the PIDs node shortcut menu

2. In the Add PID... dialog box, expand the nodes, locate and select the
required PID.

3. Click OK.

The selected PID is added to the PIDs node, and the first occurrence of a
packet carrying the selected PID is displayed in the summary view.

Added PIDs will be stored when the application is closed. They will be
reinstated when the application is reopened. However, if a different stream is
analyzed, the stored PIDs may not be used.

All PIDs previously added to the PID node can be removed by selecting Remove
All from the PIDs node shortcut menu.

Adding a PID in the Packet
View

Removing PIDs



TSCA - Using the Packets View

2−66 MTS400 Series MPEG Test System User Manual

Packet Detail View

The detail view shows the fields and data that are contained in a packet. The
fields are arranged in a hierarchical order. The presence of subordinate fields is
indicated using { } bracket symbols adjacent to the container field. To expand or
collapse the container, click the + or - icon.

Below the table pane, the data source is displayed. The data pane shows the data
bytes (in both hexadecimal number format and ASCII character format) for the
selected packet. When you select a node in the table pane, the bytes that make up
the selected node (including the subordinate nodes) are highlighted in the
hexadecimal data pane.

The packet transport header bytes are displayed in red. Similarly, bytes greater
than 188 are displayed in gray. The adaptation field, where present, is displayed
in blue.

If the section is corrupted or empty, the background of the hex view is red
instead of blue.
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Figure 2−27 and Figure 2−28 show an example of the packet detail view with an
analyzed ISDB-T stream. Note the IIP tab and the additional TMCC and IIP
nodes.

Figure 2−27: Packet view - ISDB detail -IIP

ISDB Streams
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Figure 2−28: Packet view - ISDB detail - Transport packet
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Using the Interface View

If real time analysis using an interface card is invoked, the Interface tab is
displayed in the Navigation view of the TSCA window.

NOTE. The Interface view is available only if an interface card is selected for
real-time analysis.

Figure 2−29: Interface View - Example

Two interface card test nodes are displayed in the navigation view: IF Error
Collection and IF Warning Collection. Each collection contains a range of tests
(see Figure 2−29).

The detail of the interface view is different for each interface type.
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Detail View Tabs

The detail view contains four tabs: Instantaneous graphs, Trend graphs, Event
Log, and Parameters. This section describes the tabs in general terms. The
following sections describe in detail the tabs associated with each interface type.

The instantaneous graphs display instantaneous measurements in graphical form.

The trend graphs display trends in measurements in graphical form.

The event log displays a history of the events related to the item selected in the
navigation view.

The parameters tab display the parameters associated with the test highlighted in
the navigation view. Parameter editing is described in the Common User
Interface Concepts section, page 2−104.

Readings and Controls

The right panel contains Readings and Controls. The Readings area displays
values received from the card itself.

The RF Lock LED conveys different types of information. If full lock onto the
channel is acquired and it is receiving the signal correctly, the LED will light up
green. When a signal is present but no lock is achieved, the indicator is red.
When no signal is found, the indicator is gray.

In the Readings area, the LED colors are as follows:

Green On

Red Out of range or failed test

Gray Off or not applicable

Instantaneous Graphs

Trend Graphs

Event Log

Parameters
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The Readings background colors are as follows:

White In range

Red Out of range; for example, too much or too little power or out of order packets
per second being greater than zero

Yellow Not recently updated

Gray Not applicable; for example, out of order packets not being available when the
UDP protocol is selected

The Controls area contains user controls. Values entered here will be applied to
the card and will affect its performance. These controls correspond exactly with
those on the Open Transport Stream dialog box.

RF Interface Card Overview

This section describes the configuration and interpretation of results of the  RF
interface cards that may be installed in MTS400 Series MPEG Test Systems.

The interface settings described are as follows:

� QAM (Quadrature Amplitude Modulation) (Annex B II)  (see page 2−74)

� COFDM (Coded Orthogonal Frequency Division Multiplexing)
(see page 2−77)

� QPSK/8PSK (Phase Shift Keying) (see page 2−82)

� 8VSB (Vestigial Side Band) (see page 2−80)

(Refer to the MTS400 Series Technical Reference, 071-1724-xx for the interface
technical specifications.)

Only one RF interface card can be installed in the MTS400. All RF interface
measurements and graphs include a constellation diagram with MER rings,
EVM, SNR, and BER measurements. The installed interface can be used
simultaneously with an IP input. All interfaces have dual-level warning and
failure alarms plus RF drift tests for long term trend monitoring.

The input card screen and configuration of the card will depend on which
interface card is installed.
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The RF interface card configuration is set up when analysis is started using the
Open Transport Stream dialog box. The settings can subsequently be changed
during analysis from the Interface View.

When real-time analysis is selected and an RF interface is selected from the
Interfaces drop-down list. The Firmware Version and the current Interface
Settings of the card are displayed.

Figure 2−30: Open Transport Stream dialog box

If the firmware version is incorrect, the Update Firmware... button is enabled,
and you will not be able to proceed with the setup and analysis until the
firmware is updated (see page 2−73).

1. In the Open Transport Stream dialog box, select Real-time Analysis.

2. Select the RF interface from the Interfaces drop-down list.

3. Enter the interface settings required (see the following pages for descriptions
of the settings for each RF interface card).

4. Select OK to start the analysis.

The name of the interface selected is displayed in the TSCA status bar.

RF Interface Card Set Up
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If the interface card firmware needs updating, a message will be displayed when
real-time analysis is selected. The Update Firmware... button will also be
enabled.

Update the interface card firmware as follows:

1. Select Update Firmware....

2. In the Update Firmware dialog box, select Start.

Figure 2−31: RF Firmware update

3. The dialog box will display progress of the update. The box will close when
the update is complete.

CAUTION. Removing power from the MTS400 while the firmware upgrade is in
progress can cause fatal corruption of the firmware files.

RF Interface Card
Firmware Update
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RF Interface View Screens

This section describes the settings and displays associated with the RF interface
cards.

The settings and displays of the QAM (Annex B) RF interface card are as
follows: QAM(B) Interface Settings, QAM(B) Instantaneous Graphs, and
QAM(B) Trend Graphs.

Figure 2−32: Interface View - RF - QAM (Annex B)

QAM(B) Interface Settings. The following QAM (Annex B) settings are available
on the Open Transport Stream - Real Time Analysis dialog box, and also in the
Interface tab - Controls area.

Tuner Frequency (kHz): This value, set in kHz units, is the center frequency of
the channel to be received. Any frequency can be en-
tered. There is no need to follow a channel plan. The
frequency resolution is determined by the tuner step size
of 62.5 kHz.

RF Interface - 
QAM (Annex B)
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Modulation Format: This drop down list allows 64 QAM or 256 QAM opera-
tion to be selected. Note that SCTE07 and ITU-Tj83
annex B specify exact symbol rates for the two modula-
tion formats, so there is no dialog box to enter the sym-
bol rate separately.

Interleaving Mode: Interleaving assists in the correction of burst noise in-
duced errors. All interleaving modes mentioned in
SCTE 07 are supported, including all Level II modes up
to I = 128 J = 6.

Carrier Lock: This allows the carrier lock range to be increased from
the normal ±150 kHz to approximately ±500 kHz. This
is useful if you are attempting to lock on to badly mis-
tuned or wandering carriers.

Tuner Phase Noise: This control modifies the carrier loop bandwidth to al-
low the acquisition of noisy carriers. Normal mode is
recommended for general use.

Equalization Range: The channel equalizer can be configured to give a long
equalization range, at the expense of equalizer resolu-
tion, or, in normal mode, optimized for typical cable
environments. Normal mode is recommended for gener-
al use.

QAM(B) Instantaneous Graphs. The following instantaneous graphs are available
for the QAM (Annex B) RF interface card.

RF Constellation: I and Q data are collected from the QAM front end and
displayed as a conventional constellation of 256 points
by 256 points. The samples collected are not real time,
so there is some dwell (delay) before a complete constel-
lation is displayed. The persistence of the display can be
varied using the Persist slider control at the bottom of
the graph.

MER (Modulation Error Ratio) and EVM (Error Vector
Magnitude) calculations are performed on the constella-
tion data according to the formulas in ETR290-101.

SNR after equalizer: This graph represents the signal-to-noise ratio over time,
typically over 256 seconds. It is useful for examining
signal-to-noise trends, for example, if an alarm condition
has been breached, the graph can be used to examine
trends in the signal-to-noise performance before the
alarm occurred.
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MER: This graph gives a time record of MER over the last
255 seconds.

Equalizer: This graph shows the status of the equalizer taps, and
gives an estimate of the channel state. If there are echoes
or other time related distortions on the signal, the Equal-
izer display will display the amplitude of the corre-
sponding tap correction values versus time.

NOTE. The Equalizer graph amplitude values are approximate.

QAM(B) Trend Graphs. The trend graphs extend the principle of the instantaneous
graphs by graphing measurements over longer periods. Each graph is associated
with a measurement that is also displayed in the Readings panel on the right side
of the display. The measurements have status LEDs associated with them.

Individual trend graphs can be opened by making a selection from the drop-down
menu of the Trend graph or from the context menu of the measurement in the
Readings panel.

The following trend graphs are available for the QAM B interface card: RF
Lock, MER, EVM, Pre-RS BER, Input Level, SNR after Equalizer, and Carrier
Offset.
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The settings and displays of the COFDM RF interface card are as follows:
COFDM Interface Settings, COFDM Instantaneous Graphs, and COFDM Trend
Graphs.

Figure 2−33: Interface View - RF - COFDM

COFDM Interface Settings. The following COFDM settings are available on the
Open Transport Stream - Real Time Analysis dialog box, and also in the
Interface tab - Controls area.

Nominal Tuner Frequency:
This value, set in kHz units, is the center channel fre-
quency of the DVB-T channel to be received. For exam-
ple, to receive channel E21, set this value to
474000 kHz. Any frequency can be entered. There is no
need to follow a channel plan. The frequency resolution
is determined by the tuner step size.

Channel Bandwidth: The COFDM interface card supports operation in
8 MHz, 7 MHz, and 6 MHz channels. Select the desired
channel bandwidth from the drop-down menu.

RF Interface - COFDM
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Receiver Mode: To achieve high accuracy measurements, particularly for
MER and SNR measurements, the COFDM IF card sup-
ports two modes of operation.

For conventional COFDM reception, a relatively low
ultimate SNR is acceptable. For example at 64 QAM, an
ultimate receiver SNR of 30 dB can result in a reduction
in system performance of only 0.5 dB. However, for
more detailed analysis of COFDM constellations, a
much higher ultimate SNR is required, preferably in ex-
cess of 40 dB. For this reason, two modes of COFDM
operation are provided.

High Sensitivity mode gives the full dynamic range of a
conventional COFDM receiver, but at the expense of
ultimate SNR. The High Resolution mode modifies the
signal path to dramatically reduce the noise generated in
the receiver, giving a much higher ultimate SNR, but at
the expense of receiver sensitivity. So for general pur-
pose monitoring where the input signal may vary over a
wide range, typically -75 dBm and lower, high sensitiv-
ity mode is preferred.

If the signal is consistently greater than -50 dB, high
resolution mode provides better RF measurement perfor-
mance.

IF Filter: The COFDM receiver incorporates two stages of selec-
tivity. One of these can be bypassed in WIDE mode to
give a more accurate representation of the input spec-
trum flatness (at the expense of overall selectivity).

Stream Priority: When hierarchical modulation is present, the transport
stream priority, HIGH or LOW, can be selected for anal-
ysis by the MPEG analyzer tools. When no hierarchy is
present, this defaults to HIGH priority.

Carrier start: When observing carrier amplitudes ahead of the channel
equalizer, this value sets the numerical value of the first
carrier to be displayed, and defaults to zero.

Carrier end: When observing carrier amplitudes ahead of the channel
equalizer, this value sets the numerical value of the last
carrier to be displayed, and defaults to the maximum
carrier number in the COFDM signal (1704 for 2K,
6816 for 8K modes).
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COFDM Instantaneous Graphs. The following instantaneous graphs are available
for the COFDM RF interface card.

RF constellation (all data carriers) 
When the receiver is in RF lock, the constellation points
are displayed. According to ETR290, only the data pi-
lots are used for MER and EVM calculation. The sam-
ples collected are not real time, so there is some dwell
(delay) before a complete constellation is displayed. The
persistence of the display can be varied using the Persist
slider control at the bottom of the graph.

MER and EVM calculations are performed on the
constellation data according to the formulae given in
ETR290-101. This calculation specifically excludes the
TPS carriers.

Overall SNR (all continuous pilots) 
A time line graph of measured Signal to Noise Ratio is
displayed, over the preceding 255 seconds.

Overall MER (all data carriers) 
A time line graph of measured Modulation Error Ratio
is displayed, over the preceding 255 seconds.

Linear Amplitude response (selected carriers) 
A linear amplitude response is shown for the carriers
selected using the carrier START and STOP controls.
Allows you to view and zoom in on frequency depen-
dent amplitude distortions.

Impulse response A channel response graph is shown, allowing time re-
lated distortions, particularly echoes, to be displayed
relative to the main signal. Echoes occurring before and
after the main signal are displayed. The graph is derived
form the linear amplitude response, transformed into the
time domain.

COFDM Trend Graphs. The trend graphs extend the principle of the instantaneous
graphs by graphing measurements over longer periods; periods range from one
minute to . Each graph is associated with a measurement that is also displayed in
the Readings panel on the right side of the display; the measurements have status
LEDs associated with them.

Individual trend graphs can be opened by making a selection from the drop-down
menu of the Trend graph or from the context menu of the measurement in the
Readings panel.
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The following trend graphs are available for the COFDM interface card: Overall
RF lock, MER post-equalizer, EVM post equalizer, Pre-RS BER, Pre-Viterbi
BER, Input level, SNR, and RF Carrier Offset Frequency.

The settings and displays of the 8VSB RF interface card are as follows: 8VSB
Interface Settings, 8VSB Instantaneous Graphs, and 8VSB Trend Graphs.

Figure 2−34: Interface View - RF - 8VSB

8VSB Interface Settings. The following 8VSB settings are available on the Open
Transport Stream - Real Time Analysis dialog box, and also in the Interface tab -
Controls area.

Tuner Frequency (kHz): Enter the required tuned (channel) frequency. Remem-
ber to enter the center channel frequency, not the “pilot”
frequency.

IF Spectrum: This can be set to Normal or Inverse, to allow for fre-
quency conversions in the signal chain. Conversions that
use difference frequencies invert the spectrum; additive
conversions do not.

RF Interface - 8VSB
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Channel State: Available options are auto, static, dynamic and fast dy-
namic. Using these options you can match the receiver
equalizer to the expected channel conditions. The rec-
ommended default setting is auto.

NTSC Rejection Filter: This setting gives you control over the integrated co-
channel NTSC reject filter. Options are On, Off and
Auto. The recommended default setting is Auto.

Carrier Lock: This setting allows you to control the carrier lock range.
The Normal setting allows lock over a ±150 kHz range;
Wide extends the range to ±500 kHz. The recommended
default setting is Normal.

Tuner Phase Noise: (Normal and High) This control modifies the carrier
loop bandwidth to allow the acquisition of noisy carri-
ers. Normal mode is recommended for general use.

Signal Detection NTSC: (National Television Standards Committee) and VSB
(Vestigial Side Band).

8VSB Instantaneous Graphs. The following instantaneous graphs are available for
the 8VSB RF interface card.

Symbol Distribution: This graph shows the samples received over time in a
falling vertical line display. In a noise free system, all
samples would fall on one of the eight vertical lines.
However, in normal systems the samples will be dis-
played distributed around the vertical lines. At the bot-
tom of the graph display, the sample values are
accumulated into a distribution histogram. The histo-
gram can be displayed in a linear or logarithmic format.

Signal to Noise (SNR) (after equalizer):
The SNR values are plotted in a pen-trace style, giving a
brief history of the collected values.

Equivalent MER: An MER (Modulation Error Ratio) calculation is per-
formed on the in-phase (I) data samples. The quadrature
data samples are ignored in this calculation.

Equalizer: The equalizer coefficients are plotted across the graph
display. The display illustrates the presence of multi-
path echoes by indicating how the equalizer is adjusting
to cancel them out.

NOTE. The Equalizer graph amplitude values are only approximate.
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8VSB Trend Graphs. The trend graphs extend the principle of the instantaneous
graphs by graphing measurements over longer periods. Each graph is associated
with a measurement that is also displayed in the Readings panel on the right side
of the display. The measurements have status LEDs associated with them.

Individual trend graphs can be opened by making a selection from the drop-down
menu of the Trend graph or from the context menu of the measurement in the
Readings panel.

The following trend graphs are available for the 8VSB interface card: RF Lock,
Equiv. MER, EVM, Pre-RS BER, Input Level, SNR after Equalizer, and Carrier
Offset.

The settings and displays of the QPSK/8PSK RF interface card are as follows:
QPSK/8PSK Interface Settings, QPSK/8PSK Instantaneous Graphs, and
QPSK/8PSK Trend Graphs.

Figure 2−35: Interface View - RF - QPSK/8PSK

RF Interface - QPSK/8PSK
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QPSK/8PSK Interface Settings. The following QPSK/8PSK settings are available
on the Open Transport Stream - Real Time Analysis dialog box, and also in the
Interface tab - Controls area.

Tuner Frequency (kHz): This value is the center frequency of the IF channel to
be received (that is, after downconversion in the LNB
where applicable). Any frequency can be entered; there
is no need to follow a channel plan. The frequency reso-
lution is determined by the tuner step size of 1 MHz.

Symbol Rate (kBaud): This value is the symbol frequency (Baud rate) of the
signal to be received, over a range of 1 to 30 MBaud.
You need to enter the symbol rate to a typical accuracy
of 1000 ppm to ensure successful lock.

Modulation Format: The card supports a number of modulation formats: Tur-
bo FEC 8PSK, Turbo FEC QPSK, DVB QPSK and Di-
gicipher� II. Enter the appropriate format and puncture
rate (also known as the code rate) into the modulation
dropdown dialog box. A Scan function is also provided,
allowing automatic acquisition if the precise code rate is
not known.

LNB Power: The QPSK/8PSK card incorporates a regulated power
supply for control of a LNB (Low Noise Block) or simi-
lar equipment. The supply voltage, using the drop down
dialog box, is selectable between Off (default), 13V and
18V. The output current is limited to 200 mA maximum,
and is foldback limited to a low value in the event of an
overload.

LNB 22 kHz Tone: A 22 kHz tone is provided for control of an LNB (Low
Noise Block) or similar equipment. The tone, using the
drop down dialog box, is selectable between Off (de-
fault) or On.

QPSK/8PSK Instantaneous Graphs. The following instantaneous graphs are
available for the QPSK/8PSK RF interface card.

Constellation: I and Q data are collected from the QAM front end and
displayed as a conventional constellation of 256 points
by 256 points. The collected samples are not real time,
so there is some dwell (delay) before a complete constel-
lation is displayed. The persistence of the display can be
varied using the Persist slider control at the bottom of
the graph.
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MER and EVM calculations are performed on the
constellation data according to the formulas given in
ETR290-101

QPSK/8PSK Trend Graphs. The trend graphs extend the principle of the instanta-
neous graphs by graphing measurements over longer periods. Each graph is
associated with a measurement that is also displayed in the Readings panel on
the right side of the display. The measurements have status LEDs associated with
them.

Individual trend graphs can be opened by making a selection from the drop-down
menu of the Trend graph or from the context menu of the measurement in the
Readings panel.

The following trend graphs are available for the QPSK/8PSK interface card: RF
Lock, MER, EVM, Pre-RS BER, Input power, and SNR.
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Common User Interface Concepts

Many user interface concepts are used throughout the analyzer. The following
common elements are described in this section:

� Windows Management

� Icons

� Graph Management

� Timing Graphs

� Bit Rate Graphs

� PIT Graph

� Now Playing Views

� Parameter Edit

� Event Logs

� Bit Rates

� EPG View

� MPE Views

� CaptureVu Features

� Triggered Recording

� Menu Bar and Options

� Preferences

� Script Files



TSCA - Common User Interface Concepts

2−86 MTS400 Series MPEG Test System User Manual

Windows Management

NOTE. For basic Windows operations, such as minimizing windows or using the
scroll bars, refer to the MS Windows documentation.

In addition to the standard windows management methods, the following
controls are added which allow the windows panes to be resized.

Horizontal and vertical control icons are placed between adjacent panes. Clicking
on an icon will expand the adjacent pane in the direction shown by the icon.

The size of panes can also be controlled by placing the cursor over the horizontal
or vertical dividing bar so that it changes to a bidirectional arrow. The dividing
bar can then be dragged to the required position, as shown in Figure 2−36.

Horizontal and Vertical
Controls
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Figure 2−36: Window size adjustments

In views such as the PID summary view, which take the form of a table, the
columns can be sorted in ascending or descending order by clicking the section
of the header bar on which the table is to be sorted. Similarly, column widths can
be adjusted by dragging the column divider bar to the required column width.

Icons

Icons are used in the TSCA to convey information about a node or function.

Table 2−3 and Table 2−4 show the icons used in the TSCA with a brief descrip-
tion of each. Table 2−5 shows the icons used in the quick link section of shortcut
menus.

NOTE. The display of all icons is context-dependent. Not all icons will be visible
in all views.

Table Manipulation
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Table 2−3: Object identification icons 

Icon Description

Application Information Table (MHP)

Audio

Conditional Access PID

Data stream

Packet

PCR

Program

Programs

SI table

SI table container

SI tables

Stream scrambled

Subtitles

Teletext

Video

Video + audio

Closed caption - CC-EIA608

Closed caption - CC-EIA708
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Table 2−4: Interface management icons 

Icon Description

Open transport stream

View CaptureVu settings

Capture analysis

Bar chart

Pie chart

Link to

Preferences

Audible alarm

CaptureVu breakpoint

Graph management

Graph selection

Zoom in

Zoom out

Show full dataset

Hide/show limits

Hide/show settling time indicators

Rotate graph view

Packet management

Remove all PID packets

Remove PID packet

Add PID packet

PID packet group

PID packet placeholder
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Table 2−4: Interface management icons (Cont.)

Icon Description

Go to first packet

Go to previous packet

Go to next packet

Go to last packet

Open Go To Packet dialog box

Action control

Go to previous view

Go to next view

Table 2−5: Quick link icons 

Icon Description

Go to next red LED in current tree

View this PID in PID tree

View packets with this PID

View packets in Packet tree

View PCR graphs

View this program’s PMT in SI tree

View this test in Tests tree
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Graph Management

A number of screens displaying graphs are available in the analyzer. The graphs
are described in the relevant sections of this manual. This section describes the
management of the graphs user interface.

Four categories of graph are available: those relating to PCR measurements,
section timing, bit rates, and PTS (Presentation Time Stamps).

PCR measurement graphs include:

� PCR Drift

� PCR Inaccuracy

� PCR Arrival Interval

� PCR Frequency Offset

� PCR Jitter

Section timing graphs include:

� Section Repetition Interval

� Subtable Inter Section Gap

� Subtable Repetition Interval

For streams received over IP, the PIT (packet interarrival time) graph is
available.

The graphs that can be displayed depend on the selection made in the navigation
view. However, the menus and options for the graphs are similar and as
described in the following pages.
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Measurement points (2048 maximum) are held in a circular buffer.

NOTE. A circular buffer is an area of memory used to store a continuous stream
of data by starting again at the beginning of the buffer after reaching the end.

A graph set for full display will show the current measurement points. During
real-time analysis, the graph is constantly being filled (from the right to left), and
measurements moving off the left side of the display are lost. The time scale
(Y-axis) is started from zero each time that the node is accessed.

For some of the graphs, sufficient data must be gathered before meaningful
results can be displayed. The phrase “Settling Time” will be displayed briefly in
the graph area while the necessary data is gathered.

Figure 2−37 shows a typical timing graph display. In this example, a PID
carrying PCR has been selected, and two graphs are displayed: PTS Arrival
Interval and PCR Arrival Interval.

Figure 2−37: Timing graphs

Measurement Background

Overview
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Within the category, the X axis is common to the all graphs. A horizontal scroll
bar allows you to select an area for inspection when the graph extends beyond
the display area.

A cursor can be displayed on the graphs allowing you to see accurate measure-
ments in the adjacent data panel. You can place the cursor by clicking any data
point on one of the graphs. Note that the cursor is displayed at the same point on
all of the visible graphs.

Figure 2−38: Graphs - cursor

A tooltip is displayed when a point is selected giving the X and Y coordinates of
the point; the values of these will vary depending on the graph.

Data associated with the selected point will also be displayed in the statistics
panel (above the graphs). The displayed values (maximum, minimum, mean and
standard deviation) are calculated for all of the data that is received while the
navigator node is highlighted.

Similarly, data for all graphs is displayed in the Data at Cursor panel. A link to
the associated packet is provided in the shortcut menu.

Cursor Data and Control



TSCA - Common User Interface Concepts

2−94 MTS400 Series MPEG Test System User Manual

The cursor can be moved either by clicking a new position on the graph, or one
point at a time by using the left or right controls on the keyboard.

The Graph Toolbar allows you to select and control the available graphs (see
Figure 2−39).

Figure 2−39: Graph toolbar

At the left end of the toolbar, a drop-down menu allows you to select which
graphs are to be displayed. Only graphs for which data is available are listed. See
Timing Graphs, page 2−97 for an explanation of the graphs.

The remaining graph controls are as follows:

Icon Description

Zoom in

Zoom out

Return graphs to full scale display 
(All graphs can be returned to full display by double-clicking
anywhere in the graph display area.)

Hide/show out-of-range indicators

Hide/show settling time

Rotate graph layout

Graph Menu and Toolbar
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The graph shortcut menu can be displayed by right-clicking anywhere in a graph
display area. The options on the menu are applicable to only the graph from
which the menu was selected.

Figure 2−40: Graph Shortcut menu

The title bar displayed at the top of the menu shows which object the graph
applies to (for example, PID 600).

Graphs can be added by selecting them from the shortcut menu or from the
drop-down menu either in the toolbar or from the top right corner of any
displayed graph. All graphs can be opened by selecting Add All Graphs from the
same menu. Each graph type can only be displayed once.

Graphs can be removed by clearing them from the shortcut menu or by clicking
the close icon in the top right corner of the graph to be closed.

Each graphed measurement has limits set either by default (derived from the
stream interpretation standard) or as modified by the user (see Parameter Edit,
page 2−104). If the limit is exceeded, an error is flagged.

Limits imposed by the test parameters can be displayed on a graph by clicking
the Out of Range indicator icon (see Figure 2−41). In this example, the PTS
Arrival Interval has been set at 700 ms. The area outside the limits is shaded
(red). The Y axis is rescaled to show the maximum and minimum data points.

Adding and Removing
Graphs

Out of Range Indicators
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Figure 2−41: Out of range indicator

Some of the graphs in the TSCA require a number of samples to be available
before meaningful results can be displayed. The period during which sufficient
samples are being gathered is referred to as the settling time. During this settling
time, the graph is grayed out and displays the phrase “Settling Time”.

You can zoom graphs in and out using the controls on the menu bar or from the
Graph Menu. An area of a graph can also be expanded by holding the right
mouse button and dragging a rectangle around the area of interest.

Zooming (in or out) is centered on the middle point of the graph, irrespective of
the cursor position. Both axes are expanded/contracted to accommodate the
revised display. The graph is expanded or contracted by 25% of the displayed

Settling Time

Zoom Feature



TSCA - Common User Interface Concepts

MTS400 Series MPEG Test System User Manual 2−97

area each time that the control is used. Double-clicking on a graph rescales the
axes to show the complete plotted data set.

If you hold the shift key when the zoom control is clicked, the Y axis is locked
while the X axis is expanded or contracted.

If you hold the control key when the zoom control is clicked, the X axis locked
while the Y axis is expanded or contracted.

During real-time analysis, expanding (zooming in) an area of a graph generates a
static snapshot of the graph. Because of the way that the measurements are stored
in the circular buffer, the display will eventually clear. The only way to redisplay
the graph is to return to full-scale display.

Timing Graphs

Table 2−6 shows the timing graphs that are available for PIDs carrying PCR and
PTSs. If a PCR PID is also carrying time stamp information, the full set of
graphs will be available.

The graphs available will depend on whether the PID is carrying PCR and/or
time stamp (TS) information.

Table 2−6: Timing measurement graphs 

Graph Type PID + PCR PID + PCR + TS

PCR Inaccuracy � �

PCR Arrival Interval � �

PCR Drift Rate − �

PCR Frequency Offset − �

PCR Overall Jitter − �

PTS Arrival Interval - �

Descriptions follow of each of the measurements. Adjustments can be made to
each of the measurement parameters.

If the interval exceeds the limits displayed on the screen, the scale is adjusted
automatically as necessary to include the maximum displayed values.
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NOTE. As with other parameter value adjustments, it is important to note where
the adjustment is being made from. If the adjustment is made with a test node
highlighted, all PIDs will be measured against that value. If the adjustment is
made with a PID highlighted, only that PID will be measured against the
modified value.

The PCR Inaccuracy graph shows the difference between the actual and expected
values for each PCR on the Y-axis. Expected PCR values are calculated from the
byte index of the PCR.

The default limits are set to ±500 ns.

The Maximum PCR Accuracy Error limit can be adjusted by modifying the Max
PCR accuracy error.

The PCR Arrival Interval graph provides a display of the time interval between
successive PCRs, during the last 256 PCRs. The interval is displayed on the
Y-axis. The default limit (Maximum Repetition Period set in ETR 101 290
test 2.3) is 40 ms.

The PCR Maximum Repetition Interval limit can be adjusted by modifying the
PCR max repetition interval.

This Drift Rate graph shows the rate of change of PCR Frequency Offset, which
is often very small. It is calculated using PCR Frequency Offset measurements.

The maximum PCR Drift Rate limit can be adjusted by modifying the Max PCR
frequency drift rate parameter.

The Frequency Offset graph shows the difference between the program clock
frequency and the nominal clock frequency (measured against a reference that is
not PCR or transport stream derived).

PCR Frequency Offset is a measurement of the error in the PCR frequency from
the specified 27 MHz; the MPEG specification sets the limits at ±810 Hz.

The Maximum PCR Frequency Offset limit can be adjusted by modifying the
“Max PCR frequency offset” parameter.

The PCR Overall Jitter graph shows the time interval between the actual value of
the PCR and its expected value based on its arrival time.

The Maximum PCR Accuracy Error limit can be adjusted by modifying the Max
PCR overall jitter parameter.

PCR Inaccuracy
(PCR_AC)

PCR Arrival Interval

PCR Drift Rate (PCR_DR)

PCR Frequency Offset
(PCR_FO)

PCR Overall Jitter
(PCR_OJ)
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Demarcation Frequency. The PCR measurements provided by the MTS400
Transport Stream Compliance Analyzer are defined by TR 101 290. Appendix I
of TR 101 290 describes the measurements in detail, and also introduces the
concept of the “demarcation frequency” at which PCR errors are separated into
drift errors or jitter errors. Errors below the demarcation frequency are measured
as drift, while errors above that frequency are measured as jitter.

TR 101 290 also defines three standard demarcation frequencies, MGF1
(10 mHz), MGF2 (100 mHz), and MGF3 (1000 mHz), at which the PCR
measurements can be made, and provides for a user-definable demarcation
frequency, MGF4.

From the menu bar, select Settings > PCR filter settings... to open the PCR
Drift/Jitter Demarcation Filters dialog box (see Figure 2−42). Any PCR error
below the low-pass filter cutoff frequency will be measured as drift; any error
above the high-pass filter cutoff will be measured as jitter.

Figure 2−42: PCR Drift/Jitter Demarcation Filters dialog box

The filters can be set to any of the standard MGF profiles, or a user desired
cut-off frequency, by selecting MGF4 and entering a value between 1 mHz and
10000 mHz (10 Hz).

Alternatively, these filter values can be changed by selecting Settings >
Parameters... from the menu bar, scrolling to the appropriate parameters, and
making the required changes.

MTS400 PCR
Measurements and

Settling Time
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Figure 2−43: PCR parameters - Filter settings

Please note that the TR 101 290 drift limit of ±75 mHz/s is only defined at a
demarcation frequency of 10 mHz. As the low-pass filter frequency is increased
above that value, more of the PCR jitter will be measured as drift, and so the
measured drift values will increase. If you are attempting to check that your
source PCR clock is compliant with the TR 101 290 limits, the low-pass filter
cut-off frequency should be set to 10 mHz.

Settling Time. All of the PCR measurements that depend on demarcation filters
have a settling time. The measurements will not return valid values before this
time elapses. The settling time is indicated on the PCR graphs in the TSCA.

This settling time is inversely proportional to the cut-off frequency of the
demarcation filter. This means that there is a trade-off between reducing the filter
frequency to improve drift measurement accuracy and increasing the time it takes
to obtain any drift measurements at all.

Table 2−7: PCR settling times 

Filter cut-off Settling time
TR101-290
profile Comments

10 mHz 500 s MGF1 TSCA default for PCR_FO/DR
low-pass filter cut-off; drift limit of
±75 mHz/s is only applicable at this
level

100 mHz 50 s MGF2 TSCA default for PCR_OJ/AC high-
pass filter cut-off.

1000 mHz (1Hz) 5 s MGF3 -

1 mHz − 10,000 mHz 5000 s – 0.5 s MGF4 User-defined profile

For more information about PCR measurements, please read the PCR Measure-
ments Primer, available on the Tektronix Web site (www.tektronix.com).
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Presentation Time Stamps (PTS) indicate the exact moment where a video frame
or an audio frame has to be decoded or presented to the user respectively. The
PTS graphs show the PTS arrival intervals. (See also Graph Management,
page 2−91.)

Bit Rate Graphs

Bit rate graphs are available on program and PID nodes. (See also Graph
Management, page 2−91.)

Figure 2−44: Bit rate graph

PIT Graph

The PIT Graph displays the mean interarrival time of IP packets. This can be
viewed from the Transport Stream node in the Program view. It can also be
viewed alongside other timing graphs for PIDs with PTS and/or PCR informa-
tion. This can help you coordinate apparent problems with PCR and PTS timing
with IP packet timing.

PTS Graph
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Now Playing Views

The Now Playing tab provides thumbnails of the video content at the transport
stream and program node levels. Icons at the top right of the now playing screen
provide three levels of detail and layout of the thumbnails. Thumbnails,
Summary, and Details. Figure 2−45 to Figure 2−47 illustrate the level of detail
provided by each icon.

Figure 2−45: Now Playing - Thumbnail view
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Figure 2−46: Now Playing - Summary view

Figure 2−47: Now Playing - Detail view
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Parameter Edit

Each of the error states displayed on the user interface are the result of making
one or more measurements or tests on the analyzed transport stream. The
displayed tests are derived from the selected interpretation standard. Additional
proprietary tests are also included.

Some measurements and tests translate directly to an error state, and others are
the result of a combination of tests. For many of the tests, you can affect the
result by varying parameters that influence the test result, for example, maximum
and minimum bit rate values, although the test result may not then conform to
the chosen interpretation standard.

Figure 2−48 shows the parameters that are available for the ETR 101 290
test 2.5. Figure 2−49 shows the parameters that are available for a single PID
under ETR 101 290 test 2.5. Not all parameters applied to a test are necessarily
applied to a PID.

Figure 2−48: Test parameters
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Figure 2−49: PID test parameters

Each test parameter entry includes the following fields:

� Description of the parameter.

� Value - the current setting. If the setting is the same as the nominal value, an
icon will also be displayed in this field.

� Units in which the measurement is made.

� Maximum and minimum values. These are the maximum and minimum
values recommended by the selected standard.

� Nominal value. This is the value or setting recommended by the selected
interpretation standard.

It is important to understand the difference between default and nominal values.
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If a parameter value is set for a test, it becomes the default value for the test and
for all PIDs subject to that test. PIDs using the default value will have a bullet
icon displayed in the Value field (see Figure 2−50).

Figure 2−50: Parameter value - default icon

However, you can also set individual PID parameter values. The value set is
applied to only that PID, not to the other PIDs using the same test or the test
default value.

The nominal value is provided by the interpretation standard; it cannot be
changed using the user interface.

To change the value of a test parameter:

1. Click in the Value field.

2. Enter the required value.

3. Press Enter.

NOTE. For a new value to take effect during deferred analysis, the stream must
be closed. Select Restart Analysis to open and reanalyze the stream.

Changing a Test
Parameter Value
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All parameters are accessible from the Parameters menu option (Settings >
Parameters…). Parameters are initially listed in alphabetical order. To quickly
search for a parameter, enter text in the search field, for example ‘BER’. Only
parameters containing the entered text in their description will be displayed. You
can clear search text by selecting the button adjacent to the search field.

Parameter values can be changed in the same way as individual parameters.
Changes made to values in this dialog box are also applied to the individual PID
parameters, since changes made here become the default value for the parameter.

Select the Set All to Nominal button to return all parameter values to their
factory settings. During deferred analysis, the current stream will need to be
closed and reopened (reanalyzed) for the new parameter settings to take effect.

Event Log

The event log displays a history of events related to a selected item. When no log
is available, the message “No log entries were found” is displayed. In a log,
events are placed in chronological order (with the most recent at the top).

Event log displays are context-dependent; the view and object that is currently
selected will dictate the content of the associated log. For example, with the
transport stream node selected in the Programs navigation view, the associated
event log displays all events. Similarly, with a single PID selected, the associated
event log only displays events relevant to that PID. Exported logs are similarly
context-dependent; only currently displayed events will be exported.

Access to All Parameters
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The event log will normally display the most recent event at the top of the log.
Past events will be scrolled down the screen; not all of these event entries can be
viewed on a single screen, even in a maximized Log View window.

If events are constantly being generated, an event entry may pass out of view
before you have a chance to examine it.

However, if you scroll down to view a past event, the viewing window will
remain fixed on that entry, even though events entries are still being added at the
top of the log view. This is evident by the scroll box continuing to advance
towards the bottom of the screen.

The event entry being viewed will eventually move to the bottom of the event
log. At this point the entry will be lost, the view will return to the most recent
entries at the top of the screen, and automatic scrolling will recommence.

Another way of viewing a single event in a stream of log events is by pinning the
log. By pinning the log, you are taking a snapshot of the log at a particular
moment in time; you can then move up and down the pinned log as required.
Newly generated events will continue to be generated but will not be displayed
until the log is unpinned.

You can pin the log by selecting the Pin icon or Pin Log from the shortcut menu.

Shows that the log is not pinned

Select to pin the log

Shows that the log is pinned

Select to unpin the log

When the log is pinned, it is displayed against a blue background and the pin
icon is changed.

Note that pinning the log may take a few seconds. The whole log is saved, up to
1000 entries.

The log will remain pinned until you select the Pin icon or display another
TSCA view.

Event Log Control

Event Log Pinning
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You can export the log (pinned or unpinned) in either XML or CSV format.

You can export the log by selecting the Export icon or Export  Log from the
shortcut menu.

Select the format in which the log file is to be saved, either xml or csv, and a
location for the file.

Specific event types can be color-coded in the display to allow them to be
identified more easily (as shown in Figure 2−51). Color-coding can be done from
any event log display. The color-coding dialog box is available from the event
log shortcut menu.

Figure 2−51: Event log - color coding

Exporting the Event Log

Color-Coding Events



TSCA - Common User Interface Concepts

2−110 MTS400 Series MPEG Test System User Manual

1. Highlight the event type and select Color from the shortcut menu 
(see Figure 2−52).  Figure 2−53 shows the Color dialog box.

Figure 2−52: Event log - shortcut menu - color

Figure 2−53: Event log - color dialog boxes
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2. Select the primary display color.

The color can be specified from the Swatches tab. It can also be specified in
HSB (Hue, Saturation, Brightness) or RGB (Red, Green, Blue) terms by
selecting the appropriate tab and entering the required values.

3. Select OK. All events of the same type are now highlighted in the selected
color.

The color-coding on a single event type can be removed by selecting Reset Color
from the Event Log shortcut menu. Color-coding can be removed from all event
types by selecting Reset All Colors from the shortcut menu.

Bit Rates

In a stream, bit rates are calculated and displayed for the following:

� Transport stream

� Programs

� PIDs

The display choices (bar chart or pie chart) and management of the display are
similar for each type.

Select the appropriate icon to switch charts:

Bar chart Pie chart

Figure 2−54: Bit Rate display selection

The following information is included with the bit rate bar charts:

� Error status (LED)

� Object name (Program or PID name)

� Stream type (PIDs only)

� Bit rate bar including change bars and limit markers, where relevant

� Bit rate statistics (including the current bit rate, the bit rate expressed as a
percentage of the overall bit rate, and the maximum and minimum values
reached during analysis).

Bar Charts
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Figure 2−55: Bar chart

The bit rate bars are scaled so that all bars are displayed relative to the one with
the highest bit rate.

Column widths can be adjusted by dragging the line dividing the title bar to the
left or right with the mouse.

Two levels of error status are displayed in each row. The error status LED shows
the test status of the element, for example, a program. The color of the bit rate
bar indicates the bit rate status and whether the rate has exceeded the limits set.

A range bar indicates the variation of bit rate in each program or PID. The ends
of the bar show the maximum and minimum values of the bit rate since
monitoring started.

Range bar

Error Indication

Range Bar



TSCA - Common User Interface Concepts

MTS400 Series MPEG Test System User Manual 2−113

Bit rate limits can be set on a program or PID bar. An error will be indicated
when the bit rate exceeds the limits set.

You can highlight the program or PID and select Set Bit Rate Limits... from the
shortcut menu.

The Set Bit Rate Limits dialog box is opened:

You can enable the limits by selecting the Enable Limits checkbox and enter the
required values. The cursor in the bar indicates the current bit rate. The limits
can also be changed by dragging the limit icons in the dialog box to the required
positions. The color of the overall bar in the limits dialog box indicates whether
the current bit rate is within the proposed limits. Select OK to close the dialog
box. The limit icons will now be displayed on the bit rate bar. The scaling of all
bars is recalculated to ensure that the maximum limit is displayed.

Bit Rate Limits
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During deferred analysis, the stream must be closed and reopened to reanalyze it
and view the effects of the limits. Real-time limits take effect immediately. Limit
values are retained when the application is closed. Limits set for specific PIDs
will be applied (to a PID with the same number) irrespective of the stream being
analyzed.

Setting (and resetting) the bit rate limits for programs and PIDs will automatical-
ly update the Program Occupancy and PID Occupancy tests. To change the
transport stream bit rate limits, the parameters must be altered directly in the
Transport Stream Occupancy test. This can be found under the Other tab in the
Tests view.

The Bit Rate Limits of all programs in a stream can be disabled and reset by
selecting the Clear Limits button at the top of the Programs screen.

The pie chart shows similar information as the bar chart.

Figure 2−56: Pie chart

The pie chart view is divided into two panes. The left pane shows the pie chart,
and the right pane provides a list of the component programs. Each program is
color-coded. Related information given includes the overall program status
(icon), the program name and number, and the bit rate (bps). The bit rate
expressed as a percentage of the overall bit rate is displayed in the segment
labels. The maximum and minimum values are not shown.

If a segment label is hidden at the edge of the window, click on a segment to
display the label in full.

Pie Charts
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EPG View

An electronic program guide (EPG), where present, is a schedule of events, and
programs, that are or will be available on each service. A short summary or
commentary for each event may also be included. Events for services which are
actually carried in the stream are referred to as “actual” and as “present” or as
“following” (labeled as “EIT actual p/f” in the navigation view).

A transport stream may also carry EPG information for other network services,
referred to as “other” (labeled as “EIT other p/f” in the navigation view).

NOTE. The examples shown in the figures in this section are of DVB transport
streams. The construction of SI and node names in ATSC and ISDB streams
differ.

The EPG node in the navigation view contains and displays all of the program
information carried in the transport stream.

The content of the Detail view will depend on the currently highlighted EPG
table node. Nodes representing an individual table or subtable will offer the usual
Summary, Section, and SI Repetition graph detail views. However, the higher
nodes will display the programming information graphically as shown in
Figure 2−57.
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Display time zone Display rangeStart timeTitle bar

Time scale
Service/Subtable pane

Event pane

Event detail pane

Figure 2−57: EPG Summary view
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Figure 2−58: EPG nodes

For each node type, the detail view shows the following information:

EPG node: Links to the EPG information for all the
transport streams described in this stream.

Transport stream 
summary nodes:

Graphical view of the events identified in the
service(s) belonging to a specific transport
stream.

SDT nodes
(Service Description Table):

Links to services identified in the SI for a
specific transport stream.

Service summary nodes: Graphical view of the events identified in the
service.

EIT nodes: Detailed view of event information for a single
EIT subtable.

EPG Node Summary
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The screen elements highlighted in Figure 2−57 are described below:

Title bar: Displays the title of the currently highlighted service or
transport stream.

Displayed Time Zone: Select the required time zone from the drop-down list.
The time scale will change accordingly. The time zone
may be derived either from the transport stream, UTC
(Co-coordinated Universal Time), or local time (as set
on the host computer).

Start Time: Shows the event panel start time and date. Other dates
can be selected from the drop-down calendar, and the
display will scroll to the selected date.

In deferred mode, the initial date and time will be dic-
tated by the information found in the stream. If the se-
lected date is beyond that held in the EPG information,
the date will be automatically set to the last date held in
the information.

Note that in real-time mode, this information is updated
regularly.

Display: Shows the extent of the event panel. More detail can be
displayed by choosing a shorter time period. Select the
required range from the drop-down list.

Timescale: Shows the start and end time of the current event panel.
The range is dictated by the Display field selection.

Service/Subtable panel: When a transport stream EPG is selected, this panel
shows the names of the services currently displayed in
the event panel. The displayed services will vary de-
pending on which node is selected in the navigation
view.

Event panel: This panel shows the events for one or more services,
depending on the selected node. Individual events are
color-coded and shown as blocks; each block (and its
associated tooltip) displays event information that is ex-
tracted from the EIT. When a block is selected, the com-
plete event information is shown in the event detail
panel, including a link to the section carrying the infor-
mation.

EPG Summary View
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Events are color-coded as follows:

� Red: Present event

� Green: Following event

� Blue: Schedule event

� Yellow: (ISDB only) After event

Event detail panel: Shows details of the selected event. The details are con-
tained in the EIT (event information table).

MPE Views

Multi-Protocol Encapsulation (MPE) provides a mechanism for transporting data
network protocols on top of the MPEG-2 transport streams in DVB networks.
MPE data has been optimized to carry the internet protocol (IP). MPE covers
unicast (datagrams targeted to a single receiver), multicast (datagrams targeted to
a group of receivers), and broadcast (datagrams targeted to all receivers). The
48 bit MAC (Media Access Control) addresses are used for addressing receivers.

The MPE views display the MPE data flow currently available in the stream.

Figure 2−59: MPE view
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CaptureVu Feature

The CaptureVu feature allows you to capture and analyze system events during
deferred or real-time analysis to debug the intermittent and complex problems
that traditional analyzers miss.

The feature can be activated either manually by selecting the Capture button
during analysis or automatically by a CaptureVu breakpoint preset on a test. For
deferred analysis, a packet number can be identified at which analysis will stop.
Any of these actions freezes the analysis and allows details of the analysis up to
that moment to be examined.

Links to the packet and the test (where applicable) at the point at which the
Capture button was pressed or a designated test failed are displayed in the
CaptureVu Settings dialog box.

NOTE. If a recurring test failure needs to be examined in its true context, it is
advisable to make a triggered recording. With pretriggering set, it is then
possible to examine the events surrounding a test failure. See Triggered
Recording, page 2−126.
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The feature can be activated when a test flagged with a CaptureVu breakpoint
does not fall within the parameters set for the test. Breakpoints can be set at any
time. They will be activated during real-time analysis as soon as the flagged test
fails. To operate successfully in a deferred analysis stream, the stream may need
to be reanalyzed.

You can set a CaptureVu breakpoint as follows:

1. In either the Program or Tests view, locate and highlight the required test.

2. From the shortcut menu, select CaptureVu Breakpoint.

Note the addition of the breakpoint icon beside the test entry.

Setting Up the CaptureVu
Feature
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The CaptureVu breakpoint is now set. You can set as many breakpoints as you
require. The next time an error is detected on any breakpoint test, analysis
(real-time or deferred) will stop and the test will be identified.

The CaptureVu breakpoint will operate during real-time and during deferred
analysis. The CaptureVu Settings dialog box is displayed as soon as a breakpoint
is reached or the CaptureVu feature is activated from the toolbar.

The dialog box contains the following fields:

State: This panel displays the test and packet in which the test
has failed. Clicking either the test or the packet identity
will open the related view (Tests or Packets) and
highlight the test or packet (see Figure 2−60 and
Figure 2−61).

CaptureVu Analysis
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Figure 2−60: CaptureVu breakpoint - Test view
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Figure 2−61: CaptureVu breakpoint - Packet view

You can activate this dialog when the breakpoint triggers. When enabled, the
CaptureVu setting dialog box is opened automatically when a breakpoint occurs.

The CaptureVu Settings dialog box can also be viewed at any time by selecting
the CaptureVu Settings button on the toolbar.

With the CaptureVu feature activated, all of the TSCA tools are available for you
to analyze and inspect the saved information.

NOTE. In Packets view, only the packets contained in the last 200 MB are
available for analysis.
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You can resume deferred analysis by selecting the Resume Analysis button from
the dialog box or the toolbar.

NOTE. When you select the Resume Analysis button, analysis will continue from
the point at which analysis was paused.

Similarly, you can resume real-time analysis by selecting the Restart Analysis
button from the dialog box or the toolbar.

NOTE. While real-time analysis is paused, further analysis is stopped. When the
Restart Analysis button is pressed, analysis is restarted at the current time.

Resuming Analysis
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Triggered Recording

During real-time analysis, stream information can only be held for a finite time.
Eventually, the stream will be overwritten by more up-to-date information.

To examine events that occur in real-time mode more closely, recordings can be
made manually or automatically. Recordings are saved to hard disk and can be
subsequently analyzed and examined in more detail.

The Triggered Recording setup is accessed by the Record Setting button on the
toolbar or Record > Record Settings... on the menu bar; the Recording Settings
dialog box is displayed. The dialog fields are described below:

Figure 2−62: Record Settings dialog box

Source selection: Transport: Default selection.
PCAP: Only available when Enhanced performance IP
card is fitted.

Status bar: Indicates the trigger status (Ready, Armed, Recording,
or Complete) and the pretrigger/recording progress. The
status and progress are also displayed on the toolbar in
the main window.
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Target file

Path: Enter the file name and path for the recording or use the
browse button to find and select an existing file name. If
this file name already exists, you must approve the over-
writing of the old file when recording is initiated.

File Size: Enter the file size required in megabytes.
For example, for a stream at 30 Mbps, a file size of
600 MB would record approximately 160 seconds of
stream information.

Pretrigger: A proportion of a stream can be recorded before a trigger
event occurs. (See Pretrigger Recording, page 2−129.)
Enter the pretrigger size (as a percentage of file size) that
is to be recorded.

Trigger Type: The event that triggers the recording can be one of four
types, selected from the drop-down list. In each case, the
trigger is set and pretrigger recording starts when Arm is
selected. Pretrigger recording must be complete before
triggered recording will start.

Manual: Recording will start when the Start button is
pressed. IP analysis supports only manual recording.

External: Recording will start when a rising or falling
signal edge is detected at the external trigger input
connector. (Refer to the  MTS400 Series Technical
Reference, 071-1724-xx for specifications.)

Test Failure: Recording will start when an error occurs
on a flagged test.

Tests are flagged by highlighting a test in the Program or
Tests view and selecting Record from the shortcut menu.
The record icon is displayed next to the test.
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You can set the Record flag on as many tests as you re-
quire; recording will be triggered by the first flagged test
that is encountered.

Timed: Recording will start when the time and date set
in the Start recording at field is reached.

You can enter the date and time manually (in the format
displayed). The date can be selected from the drop-down
calendar.

For all trigger types, except manual, when recording is
complete, the starting packet is indicated in the Record
Settings dialog box. Click on the packet number to dis-
play it in the Packets view.

Arm button: Places the recording function into an armed state. If a
pretrigger value has been specified, the pretrigger re-
cording will start (as shown by the progress bar). Full
recording will start when any trigger requirements are
met.

Stop button: Only active during recording, this button either disarms
the previously armed trigger or stops recording immedi-
ately. Any recording made up to the point when the but-
ton is pressed will be lost.

Start button: For manual recording, this button becomes active after
arming and any pretrigger conditions have been met;
when pressed, recording will start immediately.

The Recording Settings dialog can be left open while waiting for a recording to
take place. If, after setting up the recording, the dialog is closed, the recording
can be controlled from the toolbar.
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Setting a pretrigger size allows the condition of the final recording to be
examined both before and after a trigger event. Pretriggering a recording allows a
section of a recording to be recorded before the trigger event. The pretriggered
portion of the file is filled and written over repeatedly until the trigger event
occurs.

Pretrigger recording starts when the trigger is armed by pressing Arm.

Figure 2−63: Record Settings dialog box - Armed state

CAUTION. Recording may fail if the hard disk is unable to match the data rate of
the stream. This can be caused by a fragmented hard disk. Regular defragmenta-
tion of the hard disk is recommended (refer to your Windows documentation or
on-line help).

NOTE. No timestamps are stored when performing a recording through an IP
interface

Pretrigger Recording
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Menu Bar and Options

The Menu Bar provides access to a selection of major system options using
drop-down menus.

The menus and their options are described in the following paragraphs.

Table 2−8: File menu options 

Command Function

Open Transport Stream… Opens the Open Transport Stream dialog box from which a
stream source (file or real-time) and the interpretation standard
can be selected.

Restart Analysis Restarts the current analysis.

Save Captured Stream… Saves the captured stream (200 MB maximum). Only available
in real-time mode.

Save TS Packets Saves the transport packets from a pcap file with the current IP
filtering. Only available in deferred mode.

Recent Files Lists the most recently analyzed files. Select a file name to
reanalyze the file.

Close Stop and close the current analysis, leaving the TSCA open.

Exit Exits the TSCA.

File Menu
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Table 2−9: Navigation menu options 

Command Function

Back Returns to previous view.

Forward Goes to next view.

Select Tree Allows selection of a navigation view (Programs, Tests, SI/PSI,
PIDs, Packets).

Go to next red LED in current
tree

Goes to and highlights the next leaf node with an error; parent
nodes are passed over since they only indicate lower level
errors.

Table 2−10: Settings menu options 

Command Function

Stream Interpretation... Opens the Stream Interpretation dialog box (see page 2−7); the
current settings can be changed; analysis will be restarted
when the new settings are accepted.

Preferences… Opens the Preferences dialog box which enables interface
management (see Preferences, page 2−133).

Navigation Menu

Settings Menu
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Table 2−10: Settings menu options (Cont.)

Command Function

Parameters… Opens the Parameters dialog box which allows all stream
parameters to be viewed and edited.

PCR filter settings... Opens the PCR Drift/Jitter Demarcation Filters dialog box
which allows PCR drift and PCR jitter to be differentiated.

Table 2−11: CaptureVu menu options 

Command Function

CaptureVu Status… Opens the CaptureVu status dialog box.

Capture Pauses the current analysis to allow detailed inspection.

Resume Resumes analysis (only available in deferred analysis mode.)

The Record menu is only available during real-time analysis.

Table 2−12: Record menu options 

Command Function

Record Settings Opens the Record Settings dialog box.

Arm Arms the record function.

Start Starts recording.

Stop Stops recording.

CaptureVu Menu

Record Menu
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Table 2−13: Help menu options 

Command Function

About… Displays application and system information.

Preferences

Three options are offered when the Preferences dialog box is opened (Settings >
Preferences...): General, Font, and Decode.

Figure 2−64: Preferences - General

The General preferences option allows you to specify a default folder for loading
and saving files. Either enter the path required or use the browse button to locate
the folder. Select OK to save the setting and close the dialog box.

Default File Folder: Specify the default folder for loading and saving files.

Maximum File History Size:
Specify the maximum number of file names to be shown
in the File > Recent Files list.

Help Menu

General
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Timezone for timestamp display:
This selection is not currently used. Ensure that it is set
to Local.

Packet Size used for TS bit rate:
Specify the packet size (188 or 204) to be used to calcu-
late the transport stream bit rate. This is displayed in the
status bar.

Color Scheme: Select the background color for all graphs. When De-
fault is selected, the graphs are based on a white back-
ground. When Instrument is selected, the graphs are
based on a black backgrounds.

Optimize for UI performance:
Under some circumstances when analyzing large files or
using low specification instruments, the user interface
may appear to freeze until the deferred analysis is com-
plete. Enabling this feature will cause the user interface
to refresh at more regular intervals, thus reassuring you
that the analysis is progressing.

Enable thumbnails: Thumbnail views of program content will be displayed
when this option is enabled.

The Font preferences option allows you to specify the display font and size for
log entries and stream content. Place the cursor in the field to be changed and
select the font name or font size required from the displayed drop-down list.

Figure 2−65: Preferences - Font

Font
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The decode preferences relate to the VLC Media Player that can be used to play
elementary stream video and audio content.

Figure 2−66: Preferences - Decode

VLC. Selecting the VLC setting indicates that a stream should be sent to the VLC
Media Player.

UDP. The UDP setting, which is only available for real time systems, is used to
designate the port over which streams should be sent to external players, for
example, the MPlayer. The UDP Destination can be set either automatically or
manually.

Script Files

In the TSCA, scripts provide a method of interpreting and displaying standards
during analysis. Scripts provide templates, which determine how the SI
information found during stream analysis will be displayed. The scripts must
cater for all the information that may be found in a stream, including the various
table types found in all of the identified standards. To this end, it has been found
that the best approach is to make the scripts modular; each script module deals
with different aspects of the SI and standards.

For example, when DVB is identified as the standard against which to analyze,
the scripting dialog box displays a list of Script modules. Additionally, when it is
known that tables or descriptors not commonly carried in the identified base
standard and region are likely to be included, extra scripts can be written and
added to the Script Files list to be used for the analysis.

Decode
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Figure 2−67: Stream Interpretation dialog box

Essential scripts are installed and enabled using the Stream Interpretation dialog
box. In the absence of any enabled scripts, only the PAT table will be analyzed,
and all other data will be presented as private data.

Scripts can be customized or new scripts can be written to analyze private data.
With the Custom Scripts checkbox enabled, if a suitably configured script is
selected and enabled before a stream is analyzed, custom data will also be
analyzed when the stream is opened.

Scripts can be selected and enabled when files are open; analysis will restart as
soon as any changes as accepted.

A script file will not be used for analysis until it is present in the Script Files
panel of the Open Transport Stream dialog box.
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Set the stream interpretation as follows:

1. From the Base Standard drop-down list, select the required base standard.

The selected standard will dictate the availability of options that are available
in the Regions drop-down list.

2. From the Region drop-down list, select the required region.

The regions list allows country-specific extensions to be added to the base
standard scripts. If No Extensions is selected, only the standard scripts are
listed in the script list. The remaining country-specific extensions add extra
scripts to the current listing. Scripts that will be used are listed in the main
pane.

Scripts listed by default are resident in the default installation directory
(program files\tektronix\mpeg\mts400\scripts). Other directory locations can
be specified in the custom script selection mode. All selections will be
retained between TSCA sessions.

3. Select OK to confirm changes.

Scripts are syntactically analyzed when the OK button is selected. A fault in the
syntax of a script will not necessarily prevent a stream from being analyzed, but
it may result in an incomplete analysis of the stream. Errors in the script syntax
will be noted in the stream log.

Setting Stream
Interpretation
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When the Custom Scripts checkbox is enabled, the buttons beside the script
listing become active and custom scripts can be selected in addition to the
standard scripts. Some script names in the listing are dimmed; these are
considered to be essential and cannot be removed.

The buttons operate as follows:

Resets the script list to the default list for the standard
and region.

Opens the script selection dialog box. You can highlight
the required script and select OK. Note that the script
name is added to the Script Files list.

Removes any script name highlighted in the Script Files
list.

Scripts are applied to streams in the order that they are
listed in the Script Files list. Use these buttons to move a
highlighted script up and down in the list.

Opens the highlighted script in ScriptPad (the Tektronix
script editor).

Verifies the syntax of the scripts listed in the Script Files
pane. A message window lists any errors found.

Custom Script Selection
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If the standard script list has been changed and you want to return to the default
list of scripts, highlight the Base Standard and Region required, and select the
default script button. The list will be overwritten with the default list.

(More information about ScriptPad can be found in the MTS400 MPEG Test
System User Manual.)

The Scripts Directory field indicates the root directory for scripts named in the
Script Files list when analysis starts. If scripts are not present in the scripts
directory, the interpretation and validation of the SI will be incomplete.

NOTE. If the script list is modified in any way, always use the � button to verify
the changes.

Scripts can be selected from any directory (using the + button). If the directory is
not the same as that identified in the Scripts Directory field, the path (either
relative or absolute) will be displayed with the script name in the Script Files
list.

NOTE. The Scripts Directory browse button allows you to specify a default
directory for script selection. The browse window does not display the scripts
available. If you need to see the scripts available, use the Windows Explorer.

If the standard script list has been customized and you want to return to the
default list of scripts, highlight the required Base Standard and Region and select
the default script button. The list will be overwritten with the default list.

NOTE. Each Base Standard and Region combination can be individually
customized.

Validating scripts checks the syntax of the listed scripts.

If the “Enable scripted section validations during analysis” check box is enabled,
the scripts are checked during analysis to ensure that the data as defined by the
scripts is as expected (for example, values are within specified ranges). A fault in
the syntax of a script will not necessarily prevent a stream from being analyzed,
but it may result in incomplete analysis of the stream. Errors in script validation
will be logged in the stream error log. Enabling this check box may have an
impact on real-time analysis.

Scripts Directory

Script Validation
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Task Examples

The examples in this section describe how to locate a fault or information using
the analyzer.

The examples assume a basic understanding of the analyzer user interface and
that you are familiar with the more important aspects of digital television
transport stream structure and interpretation standards.

The MPEG Test System is a tool which allows you to analyze a transport stream
and then examine it in detail. Errors in the content can be identified and
examined to byte level.

Because of the comprehensive nature of the analyzer, there are a number of ways
of achieving your objective. In these examples, one or more ways are described
to achieve the objective.

LED icons are used throughout the analyzer interface to represent the status of
the tests applied to associated items, for example, programs. Colors used are as
follows:

(Red) Error; test failed

(Yellow) Transient error (error not currently being detected but has
been seen since last reset)

(Green) No error; test passed

(Dark Blue) Warning (Interface tab only)

(Light Blue) Transient warning (warning not current, but has been
detected since last reset) (Interface tab only)

(Gray): Test disabled

(White) Test not applicable or unknown state

(Red) PID referenced but not found in the stream

(Green) PID referenced but not found in the stream; applicable test
disabled.

When an LED represents a parent node in a tree (for example, a program node is
the parent of elementary stream nodes) or a navigation tab, the color represents
the worst case of all of its tests and the worst case of all of the tests represented
by its child nodes.

Error Status
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Similarly, when an LED representing a parent node in a tree is disabled or
enabled, all subsidiary (or child) nodes are also disabled or enabled to reflect the
state of the parent node. When an LED representing a parent node is reset, all the
child nodes are also reset.

Which tests have failed in an analyzed stream?

In this example, the analyzer has just finished analyzing a stream. The Program
navigation view is initially displayed with the transport stream tree collapsed.
The transport stream error LED is red, indicating that one or more tests have
failed (see also page 2−27).

With the Program tab still selected, view the tests summary view (bottom right).

Figure 2−68: Failed tests - example

Identify the tests that have failed (red LED). As shown in Figure 2−68, in test
summary view (TR 101 290 tab), the following tests have failed:

� First Priority: 1.6 PID

Method
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� Third Priority: 3.1a NIT Actual; 3.2 SI Repetition; 3.5a SDT Actual;
3.6a EIT Actual

Remember that the tests may be distributed over more than one tab in the test
summary view; the color of the LED on the tab helps you locate the failed tests
(for example, the Other tab in Figure 2−68).

You can view a test (and see other PIDs that it has failed on) by highlighting a
test and selecting “View this Test in Tests Tree” from the shortcut menu:

You can also display the fault by expanding the tree in the Tests navigation view
until the fault is revealed.
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Expanding the test itself reveals the PIDs that have failed the test.
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How many PIDs are there in a stream?
How many PIDs are referenced?
How many are unreferenced?

For this task, the PID navigation view is used to view information about
individual PIDs in the transport stream. Under the All PIDs node, which displays
all of the PIDs in the summary view, there are four subgroup nodes: Reserved
PIDs, Referenced PIDs, Unreferenced PIDs, and User PIDs. The number (in
parenthesis) in each node gives the number of PIDs found during analysis.

1. Select the PID navigation view.

2. Expand the All PIDs node to display the subgroups (and their quantities).

Method
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What tests have been applied to a program PID?

1. Select the Program navigation view.

2. Expand the Transport Stream tree until the required PID can be highlighted.

In the Associated Tests view, note the tests that are enabled. Gray LEDs indicate
tests that have been disabled, and white LEDs indicate tests that are not
applicable to the selected PID.
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Establish the stream type of a PID

1. Select the Program navigation view.

2. Expand the Transport Stream tree until the required PID can be highlighted.

3. Keep the cursor over the PID. A tooltip will display the stream type.

The tooltip is available wherever the selected PID node is displayed (for
example, in the PID navigation view).

Method 1
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1. Select the Program navigation view.

2. Select the program node.

3. In the summary view, select the Summary tab.

Note the Stream Type column in the display. The stream type is given for
each PID in the selected program.

How many programs are there in the stream?

1. Select the Program navigation view.

2. Expand the Transport Stream tree and note the number of program nodes 
(see Figure 2−69).

3. The Summary view (bar chart or pie chart) also displays a program count.

Figure 2−69: Program count

Method 2
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What are the contents of the programs? 
And what PIDs are they on?

1. Select the Program navigation view.

2. Expand the Transport Stream tree and a program node (see Figure 2−70).

3. Note the number of program PIDs. Note also that each PID is accompanied
by an icon indicating the stream type. Hover the cursor over a PID node to
display more information.

4. The Summary and the PID Information views also display the program
PIDs.

Figure 2−70: PID count
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What is the bit rate of each PID in a program?

Bit rates are displayed in the Program and PID summary views. The bit rates
displayed depend on the node highlighted in the navigation view.

Table 2−14: Bit rate views 

Navigation View Node Bit rates displayed in Summary view

Program Transport Stream All programs

Program Program Program PIDs

PID All PIDs All PIDs

PID Secondary nodes 
(Reserved, Referenced,
Unreferenced, and User)

PIDs in secondary groups PIDs

Figure 2−71: Program PID bit rate -  bar chart
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The PID bit rate summaries can be displayed as either bar charts or pie charts by
selecting the appropriate icon at the top left of the Summary view.

Bar chart Pie chart

Figure 2−72: Program PID bit rate - pie chart

A selection of statistics for each program or PID is shown in the charts. Either
current or mean bit rates can be shown by selecting the Show Mean Values
option from the Summary view shortcut menu. For deferred analysis, the current
bit rate is the final bit rate.

You can also display a bit rate graph for the highlighted node by selecting the Bit
Rate Graphs tab.
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Figure 2−73: Bit rate graph
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What is the latest version number 
of the Program Association Table (PAT) in the SI?

Tables and their versions can be found in the Tables (SI/PSI) view. When a node
representing a table is selected in the navigation view, the table identity and the
version are displayed in summary view (top right) as shown in Figure 2−74.

Figure 2−74: Table Identity and Version (summary view)

The table identity and version can also be seen in the table header using the
Tables (SI/PSI) section view as shown in Figure 2−75.
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Table identity

Version number

Figure 2−75: Table Identity and Version (section view)

Examine a Transport Packet

A transport stream packet is a unit of data that contains a header and a payload.
The Packets view allows individual transport stream packets to be identified and
examined.

The navigation bar at the top of the Packet summary view is used to move
between packets. How the controls work depends on the selection in the Packets
navigation view. If All Packets is highlighted, the controls will operate on all
packets. If a PID has been identified, added to the PIDs node and highlighted,
the controls will operate only on packets carrying the selected PID.

Current packet position

The packet position bar shows the position of the selected packet in the stream.

The controls work as follows:

Selects the first available packet (in the stream or carrying the
selected PID).

Selects the previous available packet (in the stream or carrying
the selected PID).

Selects the next available packet (in the stream or carrying the
selected PID).

Navigating around the
packets
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Selects the last available packet (in the stream or carrying the
selected PID).

Opens the Go to packet... dialog box.

The packet position bar can also be used to navigate through the stream. You can
use the cursor to point to and click the next packet to be displayed. Similarly,
double-click the packet number in the bar and enter the required packet number
in the Go to packet... dialog box.

Having identified and selected a packet, the Packets summary view displays the
interpreted code and the raw data in hexadecimal and ASCII format.

Looking at the packet
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SI/PSI Nodes

The Tables view (SI/PSI tab) displays the service information in tree form. The
tree represents all of the service information tables found in the analyzed stream
that comply with the selected digital video standard (including MPEG program
specific information, DVB service information, and ATSC and ISDB program
and system information protocol). The tree contains nodes for each table found;
tables and nodes are grouped together functionally.

This section identifies the nodes that may be present for each standard.

Figure 2−76 shows an example of Table navigation view with DVB stream
interpretation selected.

Tables 2−15 to 2−19 show the nodes that may be displayed in the SI/PSI
navigation view depending on the selected interpretation standard and the
content of the stream.

Primary nodes

Figure 2−76: Primary SI/PSI nodes (DVB example)
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Table 2−15: MPEG SI/PSI 

Primary node Subsidiary node

TS info

TSDT

Programs

PAT

PMT PIDs

Conditional access

CAT

Other Tables

Table 2−16: DVB SI/PSI 

Primary node Subsidiary node 1 Subsidiary node 2 Subsidiary node 3

TS info

Partial TS

DIT

SIT

BIT

Programs

PAT

PMT PIDs

PMT PID +

SDT

Bouquets

BAT

Conditional access

CAT

Networks

NIT - This

NIT - Other

Time

TOT
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Table 2−16: DVB SI/PSI (Cont.)

Primary node Subsidiary node 3Subsidiary node 2Subsidiary node 1

TDT

EPG

This TS

SDT Actual

Service (number,
name)

Now/Next (EIT P/F)

Schedule (EIT
schedule)

Other TS

SDT Other

Service (number,
name)

Now/Next (EIT P/F)

RST

MHP apps

Other tables

Table 2−17: ATSC SI/PSI 

Primary node Subsidiary node 1 Subsidiary node 2 Subsidiary node 3 Subsidiary node 4

TS info

MGT

Programs

PAT

PMT PIDs

VCT C/T

ETT-V

Conditional access

CAT

Ratings

RRT+

Time
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Table 2−17: ATSC SI/PSI (Cont.)

Primary node Subsidiary node 4Subsidiary node 3Subsidiary node 2Subsidiary node 1

STT

EPG

Source/Services

EIT0 > EIT127

Directed channel
change

DCCT id +

DCCSCT

Other tables

Table 2−18: ISDB-S SI/PSI nodes 

Primary node Subsidiary node 1 Subsidiary node 2 Subsidiary node 3 Subsidiary node 4

TS info

Partial TS

DIT

SIT

BIT

Programs

PAT

PMT PIDs

SDT

Conditional access

CAT

Networks

NIT - This

NIT - Other

Time

TOT

EPG

This TS

SDT Actual

Service (number, name)
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Table 2−18: ISDB-S SI/PSI nodes (Cont.)

Primary node Subsidiary node 4Subsidiary node 3Subsidiary node 2Subsidiary node 1

Now/Next (EIT P/F)

Basic Schedule 
(EIT schedule)

Extended Schedule
(EIT schedule)

Other TS

SDT Other

Service (number, name)

Now/Next (EIT P/F)

Basic Schedule 
(EIT schedule)

Extended Schedule
(EIT schedule)

Maker id/model id +

Other tables

Table 2−19: ISDB-T SI/PSI nodes 

Primary node Subsidiary node 1 Subsidiary node 2 Subsidiary node 3 Subsidiary node 4

TS info

Partial TS

DIT

SIT

BIT

Programs

PAT

PMT PIDs

SDT

Conditional access

CAT

Networks

NIT - This

NIT - Other

Time
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Table 2−19: ISDB-T SI/PSI nodes (Cont.)

Primary node Subsidiary node 4Subsidiary node 3Subsidiary node 2Subsidiary node 1

TOT

EPG

This TS

SDT Actual

H

Service (number, name)

Now/Next (EIT P/F)

Basic Schedule 
(EIT schedule)

Extended Schedule
(EIT schedule)

M

Service (number, name)

Now/Next (EIT P/F)

Basic Schedule 
(EIT schedule)

Extended Schedule
(EIT schedule)

L

Service (number, name)

Now/Next (EIT P/F)

Basic Schedule 
(EIT schedule)

Extended Schedule
(EIT schedule)

SDTT

SDTT(H)

Maker id/model id +

SDTT(L)

Maker id/model id +

Other tables
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Getting Started

The Packetized Elementary Stream (PES) Analyzer performs a series of user
selectable conformance tests on a previously recorded file. Files can be
interpreted according to either the ATSC or DVB standards. Once the file is
analyzed analyzed users can view the results of the selected tests and browse
through the content of the PES packets.

Information can be viewed in graphical and textual formats. To analyze and view
the Transport Stream packets, use the companion program TS Analyzer, which
can be run at the same time as this PES Analyzer.

The functionality provided includes:

� Display of program structure showing the programs contained within the
transport multiplex and the PES streams which make up each program.

� Display an interpretation of PES packet for individual packets.

� Hexadecimal representation of PES packet.

� Extraction and display of Presentation Time Stamp (PTS) and Decoding
Time Stamp (DTS) information from the PES packet header.
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� Display of access unit information for video and audio access units.

NOTE. The examples shown in this chapter are taken from both ATSC and DVB
compliant transport streams. An example of each type is sometimes shown as a
reminder that both standards are supported or where a difference needs
explanation.

Starting the Program

Start the program by selecting the Tektronix PES Analyzer option from the
Start > Programs menu or by double clicking on the Tektronix PES Analyzer
shortcut on the desktop.

Once the program has started and is ready for use it will open a Main Window.
When the program first starts it looks as follows:

Initial Appearance
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The Toolbar (row of buttons above the dark gray area of the empty window) may
be hidden from view, moved to a separate window or moved to either side or the
bottom of the main window.

The Status Line at the very bottom of the window may be hidden from view.
Because no file is open, it is displaying a message that the TS packet number is
Not Valid.

Above the Status line is the Slider Bar. This has three groups of controls for
selecting streams and packets within a file. This may be moved to the top of the
window.

PES Analyzer presents different menus and options, depending on whether or not
a file is open for analysis. The menu options available when no file is open, are
as follows:

NOTE. A check mark next to an option indicates that the window or toolbar is
currently visible or enabled, no check mark means that it is hidden or disabled.

File Menu Options. The File menu contains the menu options listed in Table 3−1.

Table 3−1: File menu options 

Command Function

Open... Opens an MPEG file for analysis. The program opens the file
selection dialog allowing the user to choose the required file.

Print Setup ... Opens a dialog for selecting which printer and associated
options to use.

1 <filename>
2 <filename>
3 <filename>
4 <filename>

A list of the four most recently analyzed files. If the program
has recently been installed the list may be empty or hold less
than four files.

Selecting a filename opens that file for analysis.

Exit Finishes running the program.

Initial Menu Options
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View Menu Options. The View menu contains the menu options listed in
Table 3−2.

Table 3−2: View menu options 

Command Function

Toolbar Displays or hides the toolbar.

Status Bar Displays or hides the status bar.

Settings Menu Options. The Settings menu contains the menu options listed in
Table 3−3.

Table 3−3: Settings menu options 

Command Function

Test Options Opens a dialog for setting the Conformance Test Options for
analyzing and interpreting the PES information in stream files.

Options Menu Options. The Options menu contains the menu options listed in
Table 3−4.

Table 3−4: Options menu options 

Command Function

Limit Repeat Errors Lists the first 20 occurrences of each error type in the event
log.
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Options

The MPEG and ATSC Conformance Test Options for MPEG and ATSC may not
be modified when a file is open. To change them, all files must be closed, the
test options modified, and the file opened again.

Select Test Options from the Settings menu to open the Conformance Tests
dialog.

NOTE. The Settings Menu is only available when there is no file open. It is
hidden when a file is opened and redisplayed when the file is closed.
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The dialog box contains two tabbed pages containing tests relating to MPEG and
ATSC files, respectively. Note that the MPEG tests are sufficient for DVB
streams.

Test of PES Header Syntax (MPEG). The tests of PES header Syntax are based on
the conformance requirements laid down in the standards document ISO/IEC
13818-4 for Packetized Elementary Streams. Each check box uses the same
name for a particular test as the standard. For example, to test conformance to
the standard for the length of PES packets select the PES_packet_length option.

A check mark shows that a test is selected and an empty check box indicates that
the test will not be performed.

Conformance Tests
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Test of PES Header Syntax (ATSC). When the ATSC Stream box is checked,
selected streams are interpreted according to the ATSC standards, A/52 and
A/53.

A check mark shows that a test is selected and an empty check box indicates that
the test will not be performed.

For streams in a DVB standard stream, leave the ATSC Stream option un-
checked. The ATSC Stream option is disabled (grayed out) if the software
license is only for the DVB standard.
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Opening a File

Any file holding a recorded or synthesized sample of a stream can be opened for
PES Analysis by this program. To analyze the Transport Stream packets, open
the file in the TS Analyzer. A file can be opened by both the TS and PES
Analyzers at the same time.

To open a file select the Open... option from the file menu. If the required file is
in the list of recently analyzed files then it can be opened from the list to save
using the Open file dialog. Alternatively, use the Ctrl+O keyboard shortcut.

There is also a shortcut button available on the Toolbar for opening a file, which
has the standard file open symbol:

Once a file is open this button will be disabled, which is shown by being “grayed
out”.

Opening a File from the
Menus and Toolbar
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Program Structure and Event Log windows are opened as soon as the file is
opened. The layout of the windows will have been saved from the last time the
program was used. If the program has just been installed, the windows will be in
the application default Cascade arrangement, which looks like this:

Many users rearrange the windows so that the Program Structure and Event Log
windows do not overlap. The examples in this manual often use this arrange-
ment:

Window Layout
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NOTE. The above example is from a transport stream interpreted and labeled
according to the DVB standard. If the ATSC Stream option is set the elementary
streams will be interpreted and labeled according to the ATSC standard. For
example: audio streams would be labeled AC-3 Audio, instead of Audio or AAC
Audio.

The PES Analyzer program now starts to analyze the file for conformance to the
selected tests. Due to the very efficient algorithms used by the program, it will
analyze large files in a few minutes. Other algorithms have been seen to take
much longer. The rightmost pane in the Status Bar shows a progress indicator
during Analysis.

As the file is analyzed messages are written in the Event Log and the structure
diagram is drawn in the Program Structure window. When the processing is done
an “Analysis Complete” message is written in the Event Log.

PES Analysis
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Menus and Controls

When a file is open the program presents a different set of menus and options.
They change as soon as the Program Structure and Event Log windows appear.
For example, the Open file commands are replaced by Close file commands.

Toolbar

The Toolbar provides a set of convenient shortcuts for the more frequently used
menu options. The available commands are:

Closes the current file. This button becomes enabled the moment a file
is opened and analysis starts. If the wrong file is being opened, or the
wrong options are selected, clicking on the button will abandon the
analysis and close the file.

Open a file. This button is disabled when a file is open.

Print the contents of the current window.

Opens a dialog which displays the program version number.

Toggles the Event Log window. When the button is in this state the
window is not visible and clicking on the button will open the Event
Log.

Toggles the Packet Hex View window. When the button is in this state
the window is not visible and clicking on the button will open the Hex
View.

Toggles the PTS/DTS View window. When the button is in this state
the window is not visible and clicking on the button will open the PTS/
DTS View.

Toggles the Header Interpretation window. When the button is in this
state the window is not visible and clicking on the button will open the
Header Interpretation.
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Zoom In on data in the PTS/DTS View. This button is only enabled
when the PTS/DTS View is the current window.

Zoom Out from the data in the PTS/DTS View. This button is only en-
abled when the PTS/DTS View is the current window.

The Toolbar can be dragged off the edge of the main window into a floating
pallet. To do this click on the background inside the Toolbar, that is, not on one
of the buttons, and drag into the main window area. The result is a self-contained
window which looks like this:

To replace the Toolbar on the window border drag it over the border until the
outline changes shape. It can be placed on the top, bottom, left or right edges.
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Status Bar

The Status Bar may be hidden from view, but if visible is always at the bottom
of the main window. It displays the following information about the program and
keyboard states:
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Slider Bar

The Analyzer can display the contents of any PES packet in the currently loaded
file. Packets are numbered, within a PID, according to their position in the file;
the first PES packet of each PID being PES packet 0 (zero). The Slider Bar
displays the packet number and the PID for the current packet.

The slider bar controls are as follows:

Move to
next
packet

Move to
previous
packet

Slider
Scrolls through packets of
the selected type in the file.

End
of file

Start
of file

Goto Button
Selects packet shown
in Packet Number

Packet Number
Shows current packet number.
New values can be typed in.

then click
on the Goto

Button.

 click in the
Packet Number
Field and type in

the new value

To select
a packet by

number

Slider

Packet number
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Drop Down Arrow Button
”Drops down” the list of
Streams to choose from

Packet Type
Shows currently selected
Elementary Stream.

Like the Toolbar the Slider Bar can be dragged from the edge of the main
window into a floating pallet; to do this click on the background inside the Slider
Bar and drag it into the main window area. The result is a self contained window
which looks like this:

To replace the Slider Bar on the window border drag it over the border until the
outline changes shape. Unlike the Toolbar it can only be placed on either the top
or bottom edges.

Packet Type - Elementary
Stream
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The Slider and Packet Number can only select packets in the currently selected
program stream. The stream is indicated in the Packet Type drop-down list and

by the magnifying glass symbol, , in the Program Structure window. A new
stream may be selected from either the list box or the window.

Choose an
Elementary Stream

by selecting the Name in
the Program Structure or
from the List in the Slider

Bar ”List Box”.

Selecting Packet Type
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Menus and Options

NOTE. A check mark next to an option indicates that the window or toolbar is
currently visible or enabled, no check mark means that it is hidden or disabled.

The File menu contains the menu options listed in Table 3−5.

Table 3−5: File menu options 

Command Function

Close Closes the current file. This option is available as soon as analysis
starts. If the wrong file is being opened, or the wrong Conformance
Tests are being run, selecting this option will abandon the analysis
and close the file.

Print Prints contents of the current window.

Print Setup Selects printer and configuration.

Exit Closes any file that is open and terminates execution the program.

The Edit menu contains the menu options listed in Table 3−6.

Table 3−6: Edit menu options 

Command Function

Copy Copies the contents of the current window to the MS Windows™
Clipboard, from which it can be pasted into a document in another
application.

Copy TS Packet Allows the user to select an AU (access unit) within the PES
Analyzer, and then copy the TS packet number onto the Windows
clipboard. The Stream Analyzer may then be started and Paste TS
packet selected to go to the packet number retrieved from the
clipboard.

File Menu options

Edit Menu options
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The View menu contains the menu options listed in Table 3−7.

Table 3−7: View menu options 

Command Function

Toolbar Shows or hides the Toolbar, which provides a set of convenient
shortcuts for the more frequently used menu options.

Status Bar Shows or hides the Status Bar.

Event Log Shows or Hides the Event Log.

Hex Shows or Hides the Hex View.

Interpretation Shows or Hides the Packet Interpretation view.

PTS/DTS Timing Shows or Hides the PTS/DTS Timing Analysis window.

The Options menu contains the menu options listed in Table 3−8.

Table 3−8: Options menu options 

Command Function

Limit Repeat Errors Only lists the first 20 occurrences of each error type in the event
log.

The Window menu contains the menu options listed in Table 3−9.

Table 3−9: Window menu options 

Command Function

Cascade Arranges all the windows so that they are neatly stacked; only the
title bars show behind the active window.

Tile Reduces and moves windows so that they can all be seen at once.

Arrange Icons Aligns icons of any minimized windows at the bottom of the
program’s main window.

1 <window title>
2 <window title>
3 ... etc.

Makes the named window active, putting it on top of any windows
which had been hiding all or part of it.

View Menu options

Options Menu options

Window Menu options
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The Help menu contains the menu options listed in Table 3−10.

Table 3−10: Help menu options 

Command Function

About PES Analyzer… Opens a dialog that displays the program version number.

Help Menu options
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Packet Hex View

This is the lowest level view of the PES Packet data. It displays the contents of
every byte in hexadecimal. Each byte is represented as a pair of hexadecimal
digits. The window may be resized to display 16, 32, 48, … bytes of information
on each row.

The four digit numbers in the left most column are the addresses of the first (that
is, leftmost) byte in the row. The addresses are shown in hexadecimal.

Address Column

showing address

of byte immediately

to the right

Column of bytes addressed
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Packet Header

The Hex View displays the bytes holding PES Packet header information in
magenta color text. For example here is a packet containing a PTS field, from a
video stream:

bytes carrying header

information displayed in

magenta colour text

The most significant two bits of the eighth byte (that is, the byte at address
0x0007) contain the PTS_DTS_flags. The ninth byte (address 0x0008) contains
the PES_header_data_length, which specifies how many additional bytes are
present. In the above example:

PTS_DTS_flag = 2

PES_header_data_length = 5

These specify that there is a 5 byte Presentation Time Stamp (PTS) field in the
header. The contents of the PTS are 21 0A 17 64 B3 and they follow the
PES_header_data_length.
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The preceding packet, from the same stream, carried both a PTS and DTS field:

PTS_DTS_flag = 3

PES_header_data_length = 10 (shown as 0A in hexadecimal)

19 bytes of header

information including the

DTS and PTS fields

Instead of having to interpret header information from the Hex View, the PES
Analyzer provides the Header Interpretation window. This interprets the header
and displays the contents, in table form, according to the MPEG-2 standards.
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Event Log

The program always opens the Event Log window when it starts to analyze a
file. As the file is analyzed the program writes the results to the window as they
are produced. When processing finishes an “Analysis Complete” message is
appended to the report.

Packet Selection

If a warning or error message gives a packet number, that packet may be
inspected by selecting the message. For example, here is an extract from a file
with PTS errors on two of the Audio streams:

Clicking on the message for Prog. 3 Audio (PID 106), PES Packet 78 selects
both the program stream and the packet. This is reflected by the Slider Bar, in the
Program Structure, Hex View, Header interpretation and PTS/DTS Views.
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The Slider bar will look like this:

In the program structure view, the magnifying glass icon, , appears on the
selected stream:

If the Hex View and/or Header Interpretation windows are open they will be
updated to show the contents of the selected packet. If the PTS/DTS View
window is open the cursor is placed on the packet and the panel showing the
Data at Cursor is updated.
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Having selected the packet it can now be inspected with other tools. The
information in the Header Inspection and Hex View windows will look like this:

To look at the timing of all the PTS carrying packets, open the PTS/DTS View:

This shows all the PES packets for the selected PID. See the section on the
PTS/DTS View for more information on selecting a particular packet.
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Packet Header Interpretation

This window interprets and displays the header of the currently selected packet.
The above example shows a packet which carries a Presentation Time Stamp
(PTS).

The relationship between the top row of information displayed in the Header
Interpretation, for this packet, and the Hex View is:



PES Analyzer - Packet Header Interpretation

3−30 MTS400 Series MPEG Test System User Manual

The next row completes the compulsory header information. The mapping
between the Header Interpretation and Hex View is:

The last row is a reminder that after the header comes the packet data. Any other
rows represent additional fields, such as the Presentation Time Stamp (PTS)
carried in this example. The relationship of these rows to the Hex view is:
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The size of the header depends on the fields it carries. Here is the Header
Information view of the preceding packet which carries PTS and DTS fields:
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Program Structure

The Program Structure window displays a list of all available programs and the
elementary streams that they contain. It shows which stream is currently selected
for inspection and may be used to select a different stream.

The example below shows a program structure from a file conforming to the
ATSC standard.

The example below is a program structure from a file that is compliant to the
DVB standard.
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The Diagram

The Program Structure is displayed by the program as soon as a file is opened.
As the file is analyzed, the top levels of a structure diagram are drawn in the
window:

An Elementary Stream is selected by default. The Program Structure view shows
the selected stream and other streams in the same program. The first program is
expanded to show the streams in the next level.

Streams in the other programs are initially hidden from view.

The structure is represented by a tree diagram, with the “root node” or highest
level component at the top. Components which contain more information
beneath them in the structure are indicated by a square box.

Components that are connected to a branch of the tree without a square box are
leaf nodes. In this case the Video and Audio elementary streams are leaf nodes.
They display the lowest and finest level of detail.

Nodes can be expanded and contracted by clicking on the square box.
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Selecting a Packet Type

When a file is first opened and analyzed a stream will be selected by default. The

type is indicated by the magnifying glass symbol, , in the Program Structure.
It is also displayed in the Packet Type “list Box” on the Slider Bar. A new stream
may be selected from either the list box or the window.

Choose an
Elementary Stream

by selecting the Name in
the Program Structure or
from the List in the Slider

Bar ”List Box”
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PTS/DTS Timing Analysis

The PTS/DTS View shows timing analysis of the selected stream. The x-axis
shows the duration of the stream in seconds. The y-axis shows the differences
between the expected and actual DTS values. A vertical blue line is used to show
the difference between the PTS and DTS for each Access Unit (AU). Therefore,
a compliant stream will exhibit each DTS on the 0ms y-axis. Streams with errors
usually exhibit a “stepped” graphical effect.

Any AU in the stream may be selected to view additional information in the
panel on the right. If the panel is not tall enough to show all of the information a
scroll bar appears.
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When first opened the entire stream is shown. Even a small file may display data
points packed too closely together to be read; for example, here is just under 12
seconds of video:

A longer sample may appear as a solid band of blue.

To see the individual packets or access units click on the Zoom In button on the
Toolbar:
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In this example, clicking the on the Zoom In button four times gave a much
clearer view:

The blue  crosses of Presentation Time Stamps and the magenta  crosses of
Decoding Time Stamps can now be differentiated.

To Zoom back out click on the Zoom Out button as many times as required:
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Access Unit Selection

The triangular cursor above the graph indicates the selected access unit. Extra
information about that access unit is displayed in the Panel on the right of the
Graph.

Scrolling the View

The Slider at the bottom of the window indicates where the displayed packets /
access units are in relation to the rest of the file. It can be used to scroll the
display through the data in the same way as a standard window scroll bar.

 Earliest
Access unit

in View

 Latest
Access unit

in View

 Last
Access unit

in File

 First
Access unit

in File

Slider Control
Shows position of selected access unit
within the file.  Drag the control to move
the View Bar.  When released it returns
to show position of selected access unit

View Bar
Shows size and position
of visible area of the
graph within the file.

To scroll the stream through the view drag the Slider Control left or right with
the mouse. After dragging the Slider Control it returns to the previous position
showing the location of the selected access unit.
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Click the mouse pointer on the white space either side of the View Bar to center
the displayed graph about the currently selected access unit.

When an access unit is selected on the graph, the Slider Control is automatically
repositioned within the View Bar. The placement of the Slider Control reflects
the position of the selected packet in the field of view.

Selecting an Access Unit on the graph also changes the selection for all of the
other views to the packet containing that Access Unit.

Video Streams

The panel on the right shows information about the selected access unit. For
video streams these are always complete packets. Some of the information
shown in the panel is specific to video streams, that is, frame rate and frame
type.

The graph shows the frames of video in transmission order analysis and, when
“Zoomed In” close enough, the type of each packet plotted along the x-axis. The
graph scale is drawn in gray dashed lines. It is the equivalent of the scale or
graticule on an oscilloscope or logic analyzer.
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DTS

Line colour and
cursor show selected

access unit

B − Frame P − Frame I − Frame

PTS

Frame Type
Shown when there is space to
display the characters.

y−axis shows any 
differences between
the PTS / DTS times
and the calculated
arrival times of the
Access Unit.

It also indicates the
difference between
PTS and DTS times.

Frames plotted in
Transmission Order
along the x−axis

The x-axis shows the nominal time of an access unit. The first access unit
displayed is taken to have a nominal time of zero. Each access unit has a nominal
duration, calculated from parameters within the elementary stream. These
parameters include “low_delay” and “repeat_first_field”, which allow analysis of
effects such as 3:2 pulldown. These effects alter the access unit duration, which
is nominally equal to a video frame period.

The position on the y-axis of a PTS or DTS shows the relative timing of the
timestamps. The first timestamp (PTS, or DTS) is taken to have a y-value of
zero. Each Subsequent timestamp has a y-value given by the difference between
their timestamp and the first timestamp, less the difference in nominal time of
their access unit and the first access unit.

The solid blue vertical lines show the time difference between the PTS and DTS
from the same Access Unit.

X-Axis

Y-Axis
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Audio Streams

The panel on the right shows information about the selected access unit. For
video streams, these are always complete packets. The frame rate and frame type
shown in the panel are specific to video streams. The “Picture Size (H x V)”
information is taken from the display_horizontal_size and display_vertical_size
values in the sequence display extension. If that is not present, the horizon-
tal_size_value and vertical_size_values in the sequence header, as modified by
the sequence header extension values horizontal_size_extension and verti-
cal_size_extension in the sequence header extension are used.
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Some of the information shown in the panel is specific to audio streams. AC-3
Audio streams will differ from Audio streams.

The graph shows timing analysis of the PTS. There are no DTS in an audio
stream. Select an access unit by clicking on it with the mouse. Clicking between
two PTS will select an access unit that does not carry a PTS.

Solid line and
cursor show selected

access unit

PTS

Difference
between the
PTS and the
calculated
arrival time
of the
Access Unit.

The graph scale is drawn in gray dashed lines for each value on the axis. In this
example there are only two values on the y-axis, at 0 ms and 24 ms.



PES Analyzer - PTS/DTS Timing Analysis

MTS400 Series MPEG Test System User Manual 3−45

AC-3 Audio Streams

The Data at Cursor panel of the PTS/DTS View shows different information for
AC-3 Audio streams. Otherwise the window works in the same way as for Audio
streams.
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AAC Audio Streams

The Data at Cursor panel of the PTS/DTS View shows different information for
AAC Audio streams. Otherwise the window works in the same way as for Audio
streams.
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Getting Started

The T_STD Buffer Analyzer models the behavior of the buffers in the hypotheti-
cal Transport Stream System Target Decoder, as specified in ISO/IEC 13818-1. It
can process video, audio, and system control streams. The results of the analysis
are displayed as graphs of the buffer capacity over time and a log of exceptions
and noteworthy events.

Suitable Streams

Any valid MPEG file, recorded or synthesized, can be processed by this
application. A valid file is one that starts on a transport stream (TS) packet
boundary (the first byte of the file must contain the first byte of a TS packet).

The Buffer Analyzer will process video, audio, and system control streams that
are compliant with the 1996 standard ISO/IEC 13818 parts 1-3.

It will handle transport streams that contain PCR and/or PTS/DTS discontinui-
ties. The PTS/DTS and PCR in a stream must, however, use the same timebase.

Buffer Analyzer is unable to work on scrambled streams. If it fails to make sense
of a stream, use TS Analyzer to determine if the stream is scrambled.
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Table Handling

Buffer Analyzer forms a list of which elementary streams are present in the
transport stream. This is called the Stream List. It creates the Stream List by
reading the first occurrence of the Program Association Table (PAT) and Program
Map Table (PMT).

If more than one version of the PAT and/or PMT are present TS Cutter may be
used to isolate a particular section for analysis.

Only PIDs carrying MPEG-2 PSI tables are included in the System model. Any
DVB or ATSC tables that are present in the Transport Stream are ignored.

Starting the Program

The program may be started by selecting the Tektronix Buffer Analyzer option
from the Start > Programs menu or by double clicking on the Tektronix Buff-
er Analyzer Shortcut on the desktop.

Once the program has started and is ready for use, it will open a Main Window.
When the program starts, the main window looks like this:

Multiple PAT and PMT
Versions

MPEG-2, DVB and ATSC
Tables

Initial Appearance
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The Toolbar (row of buttons above the dark gray area of the empty window) may
be hidden from view, moved to a separate window, or moved to either side or the
bottom of the main window.

The Status line at the very bottom of the window may be hidden from view. It
displays information about the application and keyboard status.

The application presents different menus and options, depending on whether a
file is open for analysis. The menu options available when Buffer Analyzer has
just been started, or after a file is closed, are:

Initial Menu Options
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File Menu Options. Table 4−1 lists the File menu options.

Table 4−1: File menu options 

Command Function

New Opens a stream file for analysis and opens or creates a Buffer Model
Results (BMR) file in which to store the results.

The application opens a file selection dialog allowing the user to
choose the stream file. It then opens another file selector dialog to
specify the BMR file.

Open... Opens an existing BMR file to review results of a previous analysis.
The application opens the file selection dialog allowing the user to
choose the required file.

Print Setup... Opens a dialog for selecting which printer and associated options to
use.

1 <filename>
2 <filename>
3 <filename>
4 <filename>

A list of the four most recently used BMR files. If Buffer Analyzer has
recently been installed the list may hold less than four files.

Selecting a filename opens that BMR file for review.

Exit Finishes running the program.

View Menu Options. Table 4−2 lists the File menu options.

Table 4−2: View menu options 

Command Function

Toolbar Displays or hides the toolbar.

Status Bar Displays or hides the status bar.

Settings… Opens the Settings dialog for specifying Video Buffer Sizes and
Video Data Transfer method.

(a check mark next to an option shows that the toolbar is currently visible; no check mark means
that it is hidden.)

Settings

Various configuration parameters, including Packet Interpretation, Pre-Scan
Packets, PES Private Interpretation, Video Buffer Sizes, Video Data Transfer
method, and Audio Buffer sizes may be modified before and after opening an
MPEG file. When a file is open, one or more streams may be analyzed, the
settings may be changed, and then other streams may be analyzed with the new
settings. If the settings are changed, to reanalyze streams analyzed with previous
settings, the MPEG file must be closed and opened again.
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It is a good idea to check the settings before opening a file to verify the method
with which video streams will be analyzed.

Select Settings... from the View menu to open the Settings dialog.

This opens the Settings dialog, which has three tabs: System, Video and Audio.

These options can only be set before analyzing a file. They are disabled (grayed
out) while a file is open.

The MPEG2 / ATSC option is available on ATSC or ATSC/DVB dual standard
MPEG Test System products. It is disabled (grayed out) on single standard DVB
systems.

Packet Interpretation. Specifies which standards will be used for interpreting the
packets in the Transport Stream when a file is opened for analysis. The options
are:

MPEG2 Interprets the packets according to the standards for
DVB streams.

System Settings
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MPEG2 / ATSC Interprets the packets according to the ATSC standards.
This option is required to allow AC-3 audio stream con-
tent to be analyzed.

Pre-Scan Packets. During the initial processing of an MPEG file, a number of
packets are prescanned for information that will result in a more accurate
analysis of the initial parts of the transport stream. The greater the number of
prescanned packets, the greater the chance of locating all of the information
required for accurate analysis. The drawback is increased processing time. By
default, 10000 packets are prescanned, which should be sufficient for most
streams, excluding High Definition Video.

All Packets Select this check box to cause all packets to be pres-
canned. If this check box is selected, the packets field
will be disabled (grayed out).

Packets If the All Packets check box is not selected, enter the
number of packets to be prescanned in this field.

PES Private Interpretation. This setting specifies the model type to use for streams
signaled as PES Private (stream_type = 6).

The selections available include the following: AC-3 Audio, AAC Audio,
MPEG-2 Audio and Video and System. The default setting is AC-3 Audio.

Video Settings
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Buffer Sizes. Specifies the sizes that will be used for the Main and Elementary
Buffers, when interpreting the stream. The options are:

Automatic Automatically detect the buffer sizes from the Sequence
Headers and Extensions in the elementary stream being
processed. This is the default option when the applica-
tion is started.

Manual Enables the size of the Main or Multiplex buffer (MB)
and Elementary Buffer (EB) to be specified manually.
The MB and EB fields are available for editing when
this option is enabled.

Data Transfer. By default Buffer Analyzer inspects the stream to determine which
transfer method to use. This can be overridden if required. The options are:

Automatic Examines the stream to determine the transfer method.
This is the default option when the application is started.

Leak Method Initiates modeling of the stream using the Leak Method.
H.264 streams support only this method but the option
can be kept as Automatic.

VBV Delay Method Initiates modeling of the stream using the Video Buffer
Verifier (VBV) Delay Method. This option is specific to
MPEG-2.

Default Frame Rate. The frame rate is one of the parameters that is searched for
during the prescan phase of analysis. However if it is not found, then the default
value selected from the drop-down list in the Default Frame Rate field is used.

Audio Settings
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Buffer Size. Specifies the size that will be used for the audio buffer when
interpreting the stream. The options are as follows:

Automatic Automatically detect the buffer sizes from the Sequence
Headers and Extensions in the elementary stream being
processed. This is the default option when the applica-
tion is started.

Manual Enables the size of the buffer (B) to be specified manu-
ally. The B field is available for editing when this option
is enabled.

AAC. Select the number of AAC channels required from the drop-down list.

Within the ADTS (Audio Data Transfer Stream) fixed header, the channel
configuration field is used to indicate the number of channels required by AAC.
If the number in this field is zero, then the value in the AAC Default channels
field is used.

Note that the associated ADIF (Audio Data Interchange Format) is unsupported.

Refer to Information technology – 
Generic coding of moving pictures and associated information,
Part 7: Advanced Audio Coding (AAC) ISO/IEC 13818-7:1997

NOTE. Remember that if the settings are modified, the new settings are used for
all video streams that are subsequently processed. The settings are reset to the
default option when the application is started.

Opening an MPEG File

Any file holding a recorded or synthesized sample of a Transport Stream that
carries video, audio, and/or system control streams can be analyzed. These files
are referred to as MPEG files to distinguish them from Buffer Model Results
(BMR) files. The results of analysis are written to a BMR file.

To open a file for analysis, select the New option from the File menu. Alterna-
tively, use the Ctrl+N keyboard shortcut.

Opening a File from the
Menus and Toolbar
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NOTE. The list of previously used files shows BMR not MPEG files, as can be
seen by their .bmr extension.

There is a shortcut button, for the New command, on the Toolbar:

In response to the New command, the Buffer Analyzer opens a file selection
dialog to choose an MPEG file for processing. When the MPEG file has been
chosen, the MPEG file selector closes and another file selection dialog opens.
This is for choosing a Buffer Model Results File (BMR), which holds the results
of any analysis performed on the MPEG file.

Buffer Analyzer suggests an output file with the same name as the MPEG file
but a file extension of .bmr to hold the Buffer Model Results. Select OK to
accept the suggested filename. Otherwise select a different file or type in a
different name and then select OK.

NOTE. Choosing an existing BMR file will erase all results that had previously
been saved in that file.
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Opening a BMR File

An existing Buffer Model Results (BMR) file can be opened to review the results
saved in it from previous Buffer Model Analysis.

To open a BMR file select the Open... option from the File menu. Alternatively
use the Ctrl+O keyboard shortcut.

If the required file is in the list of recently analyzed BMR files, it can be opened
from the list to save using the open file dialog.

There is a shortcut button available on the Toolbar for opening a file, which has
the standard file open symbol:

Window Layout

The Stream List window is opened as soon as either an MPEG or BMR file is
opened. The application inspects the file to find what program streams are
present according to the Packet Interpretation setting. For example:

Opening a File from the
Menus and Toolbar
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Initial Processing of MPEG Files

If an MPEG file is opened, the program performs initial analysis to form the
Stream List and calculate the mean transport rate. All streams in the list are
marked as Unprocessed, because no analysis has been performed on them in this
session.

To build the Stream List the MPEG file is scanned for the PAT and PMT table
contents. It is assumed that the contents are constant, which is the general case.
If the program changes in a drastic way, such as streams disappearing between
PMTs, the model will give meaningless results.

Only the first occurrence of complete PAT and PMT are read when forming the
Stream List. Use TS Cutter to isolate a section when multiple versions of the
tables occur.

A number of packets in the file are scanned for the Sequence Header and
Extension start codes (containing profile and level) (see Settings, page 4−4). If
they are not found the Main Profile and Level setting are assumed together with
the maximum VBV buffer size.
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Initial Processing of BMR Files

If a BMR file is opened, the State column indicates which streams had been
processed. The file only holds results for those streams marked as Processed. To
obtain results for unprocessed streams, the original MPEG file will have to be
opened again and analyzed.
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Menus and Controls

When a file is open, the program presents a different set of menus and options.
They change as soon as the Stream List window appears. For example, the Open
file commands are replaced by Close file commands.

Toolbar

The Toolbar provides a set of convenient shortcuts for the more frequently used
menu options. The available commands are:

Opens dialogs to select an MPEG file for analysis and a BMR file for saving the
results. This button is disabled (grayed out) when a file is open.

Opens a dialog to select a BMR file to review the results of a previous analysis
session. This button is disabled (grayed out) when a file is open.

Closes the current file. This button becomes available the moment a file is opened. If
the wrong file is being opened, or the wrong options are selected, clicking on the
button will abandon the analysis and close the file.

Opens the Settings dialog.

Prints the contents of the current window.

Opens a dialog which displays the program version number.

Analyzes the stream(s) from the PID(s) which are currently selected in the
Stream List. This button is only enabled when one or more PIDs which are marked
as unprocessed are selected.

The next group of five buttons open Results Views for the selected streams.

Opens a graph of the Transport Buffer for the selected stream. This button is only
enabled when the PID of a Processed stream is selected in the Stream List window.

Opens a graph of the Multiplexing Buffer of a video stream; Main Buffer of an audio
stream or of a system information stream. The button is only enabled when the PID
of a Processed stream is selected in the Stream List.
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Opens a graph of the Elementary Stream Buffer for the selected video stream. This
option is only available when a PID carrying a Processed Video stream is selected in
the Stream List.

Opens the Event Log for the selected stream. The button is only enabled when the
PID of a Processed stream is selected in the Stream List window.

Opens all of the relevant graphs and the event log for the selected stream. This
option is only available when a PID carrying a Processed Video stream is selected in
the Stream List.

The remaining buttons control display options for Graphs of buffer analysis
results.

Toggles the graph displays between having all points drawn and sampling the points
for drawing.

Synchronize Graphs toggles the graphs between using the same position and zoom
settings or operating independently.

Auto Scale toggles the selected graph between fixed and auto scaling of the y axis.

Zoom In increases the magnification along the x-axis (time scale) of the currently
selected graph. All graphs are affected if Synchronize Graphs is enabled.

Zoom Out reduces the magnification along the x-axis (time scale) of the currently
selected graph. All graphs are affected if Synchronize Graphs is enabled.

Trace analyzes the message logs. You can view the message log that is produced by
the Buffer Analyzer.

The Toolbar can be dragged off the edge of the main window into a floating
pallet. To do this, place the mouse pointer on the background inside the Toolbar,
(not on one of the buttons), hold the left button down, and drag into the main
window area. The result is a self-contained window that looks like this:

To replace the Toolbar on the window border drag it over the border, until the
outline changes shape, and release it. It can be placed on the top, bottom, left or
right hand edges.
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Status Bar

The Status Bar may be hidden from view, but if is visible, it is always at the
bottom of the main window. It displays the following information about the
program and keyboard states:
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Menu Options

Table 4−3 to Table 4−10 list the available menu options.

Table 4−3: File menu options 

Command Function

Close Closes the current file. This option is available as soon as analysis
starts. If the wrong file is being opened, or the wrong options are
selected, selecting this option will abandon the analysis and close
the file.

Print Prints contents of the current window.

Print Preview Prints contents of the current window.

Print Setup Selects printer and configuration.

Trace Print
O ti

Font Selects the font to be used for printing text.
Options

Colors Not available with Buffer Analyzer.

Exit Closes any file that is open and terminates the program.

Table 4−4:  Edit menu options

Command Function

Cut Moves the currently selected records from the main window to the
clipboard.

Copy Copies the contents of the currently selected records to the
clipboard. They are not removed from the main window.

Delete Deletes the selected records from the main window.

Delete Except Deletes all records except those selected from the main window.

Delete All Deletes all records.

Select All Selects all records.

Table 4−5: View menu options 

Command Function

Toolbar Shows or hides the Toolbar.

Status Bar Shows or hides the Status Bar.

Settings… Opens the Settings dialog.

Global Event Log Shows or hides the Global Event Log window.

Transport Buffer Opens a graph of the Transport Buffer for the selected PID.
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Table 4−5: View menu options (Cont.)

Command Function

Main Buffer Opens a graph for the selected PID in the Stream List. The graph
shows results for the Main Buffer of audio and system streams or the
Multiplex Buffer for video streams.

Elementary Buffer Opens a graph of the Elementary Buffer for the selected PID.

PID Event Log Displays the Event Log for the selected PID.

All Buffers Opens all graphs and the log for the selected PID.

Trace Generates a detailed trace log.

Table 4−6: Options menu options 

Command Function

Draw All Points Toggles between drawing all points on the graphs, drawing every nth
point. ‘n’ is calculated from the total number of data points and the
screen space for the graph.

Synchronize Views Toggles the graphs between using the same position and zoom
settings and operating independently.

Auto Scale % Axis Toggles the selected graph between fixed and auto scaling of the y
axis.

Table 4−7: Process menu options 

Command Function

Process Streams Applies the stream(s) from the PID(s) selected in the Stream List to
the System Target Decoder Buffer Model.

This option is only enabled when one or more unprocessed PIDs are
selected in the Stream List.

Table 4−8: Trace menu options 

Command Function

View

Column Opens the column definition dialog box for selecting the columns of
information that has to be displayed.

Font Selects the font that is used for displaying the text of detail message
log records.
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Table 4−8: Trace menu options (Cont.)

Command Function

Colors.... Selects background and text colors that are used to display each
type of message.

Newest End Displays the newest record.

Show

Markers Shows markers permanently while using Trace with the Buffer
Analyzer.

General Text Shows or hides general messages. For example, messages
indicating start of processing for a particular PID.

Fixed Shows or hides information such as transport rates and buffer sizes.

PCR Timestamp Shows or hides messages about PCRs and associated instanta-
neous transport rates.

System... Selects which types of system messages to show.

Audio... Selects which types of audio messages to show.

Video... Selects which types of video messages to show.

Table 4−9: Window menu options 

Command Function

Cascade Cascades the windows.

Tile Tiles the windows.

Arrange Icons Arranges any minimized windows along the bottom of the main
window. Aligns icons of any minimized windows at the bottom of the
program’s main window.

1 <window file> Lists all of the available windows. A check mark indicates the active
window. Select an option to bring that window to the top.
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Table 4−10: Help menu options 

Command Function

About Buffer Analyzer… Opens a dialog that displays the program version number.
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Stream List

The Stream List is displayed in the form of a tree view. The tree view is grouped
and sorted by the program numbers with the label for the PIDs, stream types, and
the states displayed. The Stream List displays all the elementary streams in the
file. An unprocessed state is indicated by the black label and the processed state
is indicated by the green label.

The ‘+’ symbol displayed to the left of some icons indicates that the item
includes lower-level stream components that are not displayed. The symbol
changes to ‘–’ when the lower level components are displayed. To expand the
hierarchy click on the ‘+’ symbol. Similarly, to collapse the hierarchy click on
the ‘–’ of the selected upper-level icon.

The System, Audio, and Video PIDs of a specific program number are displayed
as leaf nodes of the same level.

Stream Type includes Video, Audio, AC-3 Audio, AAC Audio, System, or
Private. Private streams cannot be processed, but may show more information
about the type, for example ISO/IEC 13818 Auxiliary. The Packet Interpretation
from the System tab of the Settings dialog box sets the standard that is used for
identifying these types.

The preceding example is from a DVB compliant transport stream.
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An ATSC stream might look like this:

This tree view lists out processed (analyzed in the buffer model) and unprocessed
streams. A stream may be processed only once when the file is open. To process
a stream again, the file must be closed and then opened again.

When an MPEG file is first opened, the program streams are all marked as
Unprocessed. Unprocessed state indicates that no buffer analysis has been so far
performed in this session.

If a BMR file is opened, the streams state will be displayed as processed or
unprocessed. The file only holds results for those streams marked as Processed.
To obtain results for unprocessed streams the original MPEG file will have to be
reopened and analyzed.
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Selecting Streams

To analyze or open the results views for a stream, or streams, they must first be
selected in the Stream List. To select a stream, click on the PID number.

For example, click on PID 1 Stream Type text to select the Video stream carried
in PID 1.

By using the Shift and Control key, you can make multiple selections for all the
tree nodes.

You can select the highest level node to process all the descendent nodes. For
example, selecting the highest level transport stream node will process all the
PIDs or selecting a specific program level node will process all the PIDs of that
program.

To select a contiguous range of streams: click on the first streams PID, then hold
the Shift or � key down and click on the last stream’s PID number. If the
required streams are not adjacent, hold the Ctrl key down and click on the PID
number for each stream.

All streams can be deselected by clicking the mouse pointer outside the tree view
data. To deselect a particular stream while leaving the others selected, hold the
Ctrl key down and click the stream’s PID number.

Processing Streams

Having selected one or more streams from the Stream List they can be analyzed
in the buffer model.

To start analysis, select the Process Streams option from the Process menu.
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Alternatively, click on the Process button in the toolbar.

You can also process the highlighted streams by selecting Process Streams from
the shortcut menu.

When H.264 streams with SEI (HRD) parameters is processed a dialog box is
displayed prompting you to either continue or abort the processing of streams. If
you continue, STD leak method will be used for analysis. If you abort the
process, the state of that stream will be displayed as aborted.
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NOTE. For HRD model analysis use Tektronix ES Stream Analyzer (MTS4EA).

Buffer Analyzer supports 6 Profiles for MPEG-2 video: Simple, Main, SNR,
Spatial, High, and High4.2.2.

Buffer Analyzer supports 7 Profiles for H.264: Baseline, Main, Extended, High,
High10, High4.2.2, and High4.4.4.

It supports 4 Levels: High, High - 1440, Main, and Low.

Details of valid combinations of profile and level are given in standards
document ISO/IEC 13818 part 2 section 8.5.

The hypothetical T-STD specified in ISO/IEC 13818 part 1 section 2.4.2
assumes a processing steady state. To handle the start-up processing before
reaching the steady state Buffer Analyzer performs as follows:

� The fraction of the first video frame leading up to the first picture start code
is not passed through the Buffer Analyzer. This is because it is not possible
to determine whether the Leak or VBV Delay method is being used. During
this period, the PES header, Sequence Header, and Extension information are
extracted. This information is used to determine the initial DTS, size of the
MB and EB buffers.

� The Decoding Time Stamp (DTS) for the first frame is assumed to be
correct. It is used as a base for the timing of all subsequent frames. MB
underflow errors are suppressed during the first frame.

If the DTS of the first frame is not correct, use TS Cutter to remove the suspect
frame(s) from the file.

The application uses the following approximations to model the behavior of the
hypothetical T-STD:

Supported Profiles &
Levels

Start-Up

Approximations
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� Data is processed one packet (188 bytes) at a time. An underflow/overflow
condition that occurs and clears within the period of one packet will be
missed.

� Processing one packet at a time causes the buffers to be emptied in block
fashion, thus giving a stepped graphical output.

� Slight quantization effects occur because the model is processed at discrete
time intervals, corresponding to a single packet length. This may affect the
VBV Delay calculations. The timing intervals for transferring frames from
MB to EB are dynamically adjusted to compensate.
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Event and Message Logs

The T-STD Buffer Analyzer allows you to access the Global Event log and the
PID Event log. You can use the Trace to create a log containing a more detailed
analysis of the entire process.

The views can be synchronized by selecting the Synchronize Views option from
the Options menu. While Synchronize Views is enabled a change to any view is
immediately applied to all the other views.

Global Event Log

The Global Event Log displays: reports from the initial analysis, PID indepen-
dent information (Transport Stream errors) and high level details for each stream
processed.

For details of events detected during the processing of a stream, open the PID
Event Log for that stream.
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PID Event Log

An Event Log window may be opened for each PID that has been or is currently
being processed. Results are written to the log as they are produced. All time and
packet numbers are given relative to the start of the file.

Selecting an event row from the Event Log will place a cursor at that time in
each of the Buffer Results graphs. To select an event, click on the row of the
desired event.

To deselect an event, click the mouse pointer outside the data column.

Trace

The Trace is used for analyzing the message logs produced by the Buffer
Analyzer. The message logs may be useful for in-depth analysis of the internal
processing, particularly for the video stream type. Trace has filtering capabilities
that allow you to focus on message types of particular interest.

Trace record is displayed only for processed streams.

Event Selection



T-STD Buffer Analyzer - Event and Message Logs

MTS400 Series MPEG Test System User Manual 4−29

To start Trace, select the Trace option from the View menu.

Alternatively, click on the Trace button in the toolbar.

Trace displays the detailed message log in the main window. It has a Status bar
at the bottom of the window and a scroll bar on the right side.

The Status bar may be hidden from view, but when it is visible it is always at the
bottom of the main window.

These are displayed in the trace window as table. Each record is represented by a
single row of the table. The window displays buffer sizes, transfer rates, profiles,
levels, and frame rates that are used for the analysis. They also display the data
movements between buffers and their occupancies with respect to time and
packet numbers.

The example shows a log in which a PID (PID 17) carrying video was analyzed
and then another PID (PID 20) carrying audio was analyzed.

The types of messages that are displayed in the trace window is selected from the
Show menu.

To move forward and backward through the log use the scroll bar on the right of
the window, the Page Up, Page Down, Cursor Up Arrow, and Cursor Down
Arrow Keys.

User Interface

Detailed Message
Records
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NOTE. If more than one PID is processed concurrently by Buffer Analyzer, the
records will be interleaved in the Trace display. Unless this interleaving is
required, processing one PID at a time will make it easier to follow the messages
for each stream.

Records may be selected for printing, copying, deleting, and other Edit menu
operations. To do this, they must first be selected.

A single record can be selected by clicking on it. To select a contiguous range of
streams, click the first record to be selected and then hold the Shift down and
click the last required record. Alternatively, click the first record, hold the left
mouse button down and drag the pointer to the last record.

Selected records are repainted in the highlight color scheme. By default, this is
black text on a magenta background. For example:

The selected records can be edited and viewed by using the shortcut menu
option. You can edit (cut, copy, delete) records, define the Trace (column, font,
colors), and select messages (System, Audio, Video) to be displayed in the Trace.
You can also show/hide general text, fixed, and time stamp features.

Selecting Records
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To set the columns of information that are displayed in the Trace table, select the
Column option from the View menu.

A column is shown for each option that is enabled and is indicated by a check
mark. Clicking on an option toggles it between being shown or hidden.

Column Options
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The font of the messages displayed in the Trace table can be changed using the
Font dialog box.

You can select the font, font style, size, and script from this dialog box. A
sample of the selected font is displayed in the Sample display box. Click OK to
see the selected font in the Trace table.

Fonts
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The color scheme for each message type and for highlighting selections can be
changed using the Select Colors dialog box.

To modify the color schemes, select the Colors option from the View Menu. This
opens the Select Colors dialog box.

Select the message type to be changed from the list box on the left. The current
color scheme will be displayed in the Sample underneath the list box. Click on
the swatch (colored square) in the Text Color and Background panels for the
required text and background collars.

Repeat the procedure for each message type that is to be changed and click OK.

The Reset button restores the selected message type to the default color scheme.
The Reset All button restores all the color schemes to their defaults.

Color Schemes
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Results Graphs

The results of the analysis are plotted on a separate graph for each buffer. When a
graph is opened for a stream that is still being processed, each result is plotted as
soon as it is produced from the model.

All of the graphs have a similar format and controls.

Common Features

All of the graphs plot time from the start of file on the x-axis and current space
used in the buffer on the y-axis.

When the results graph is first opened, the entire graph is shown. Even a small
file may display data points packed too closely to see the features clearly. For
example, here is just under 20 seconds of a video stream that generated a lot of
events:

The Axes

Zoom
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Even this small sample holds some solid bands of blue lines and green event
markers, from which only general trends can be determined. To change the time
scale (x-axis) to resolve finer detail, click on the Zoom In button on the Toolbar:

Zoom in as many times as required to achieve the desired magnification. The
magnification is doubled each time the button is clicked.

In this example, clicking on the Zoom In button three times gave a much clearer
view:

To Zoom back out, click on the Zoom Out button as many times as required:

Each time the Zoom Out button is clicked, the magnification is halved, until the
full graph is again displayed.
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The slider at the bottom of the window indicates where the displayed area is in
relation to the rest of the file. It can be used to scroll the display through the
graph in a similar way to a window scroll bar.

View Bar
Shows size and position
of visible area of the
graph within the file.

Slider Control
Shows either: the center of the visible
area of the graph, or the position of the
cursor in both the file and visible area.

 Earliest
time in
View

 Latest
time in
View

End of fileStart of file

To scroll the stream through the view:

� Drag the Slider Control left or right with the mouse.

� Click the mouse pointer in the slider bar (either the clear sections or the view
bar) to the side of the Slider Control.

When a time or event is selected on the graph, the Slider Control is automatically
repositioned within the View Bar. The placement of the Slider Control reflects
the position of the selected packet in the field of view.

A graph may show one or more green triangular markers along the top. Each
marker indicates the time a particular event, listed in the PID Event Log,
occurred.

Only events that relate to the points plotted on the graph are displayed in that
graph. Hence an event relating to a Video Multiplex Buffer will only be marked

Scrolling the View

Event Markers
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on the Video Multiplex graph and not on the Elementary or Transport Buffer
graphs.

Double-clicking on a marker will display a pop-up window. This shows the time
and a brief description of the event that is marked.

For example: selecting an event relating to the Elementary Buffer from the Event
Log of a video stream will place a cursor at the time of the event in the buffer
results graphs. Looking at the graphs, a marker of the event has been placed on
the Elementary Buffer graph, but not the Multiplex Buffer graph.
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Graphs of results may be open for one or more streams. For each stream, one or
more graphs may be displayed. The graphs may have their zoom, cursor position
and visible section manipulated separately or all the graphs may be synchro-
nized. For example, in unsynchronized operation, the open graphs may look like
this:

This pair of graphs show different periods in the file at different magnifications.

To synchronize the views, select the Synchronize Views option from the Options
menu.

Synchronize Views
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Alternatively, click on the equivalent shortcut button.

This will apply the zoom, cursor, and visible section of the active window to all
of the other graphs. While Synchronize Views is enabled a change to any graph
is immediately applied to all the other graphs.

The Trace table can also be synchronized with the other graphs by enabling the
Synchronize Views icon. While Synchronize views is enabled, a change in the
selected event of the Trace table moves the cursor position of all other graphs
accordingly. Similarly, a change in any of the graphs moves the highlighted
event of the Trace table accordingly.
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To separate the control of the graphs, disable synchronize views by selecting the
menu option or by clicking the shortcut button again.

The cursor may be repositioned within a graph by clicking on the required point.
This is useful when Synchronize Views is selected as a way of marking the same
time in all the graphs for ease of comparison.

The scale on the y-axis of the graphs shows space used in the buffer as a
percentage. By default, all of the graphs have a vertical scale that goes from
-50% to 200%. For example:

Selection

Auto Scale
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Selecting the Auto Scale % Axis option from the Options menu changes the
y-axis for the currently active graph.

Alternatively, select the equivalent shortcut button.

The y-axis is now drawn so that the full scale contains the range of values in the
graph, to the nearest 25%. For example, if the range of values was from 30% to
64%, the y-axis would go from 25% to 75%. The earlier example will be
rescaled to look like the following:
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To revert to the default scale, select the menu option or click on the shortcut
button again.

The graphs will often contain more data points than can be resolved on the
screen. By default, to avoid drawing points on top of each other, the application
will plot every nth point. This also speeds up drawing process. How many points
to plot is determined from the available width of the graph on the screen and the
total number of points to plot.

Use the Draw All Points option to look for outlying points and to resolve the fine
detail when zoomed in on the data.

Selecting the Draw All Points option from the Option menu will cause the
application to plot every point.

Alternatively, select the equivalent shortcut button.

This may take much longer for larger files than the default option. The option
may be disabled by clicking on the shortcut button again or deselecting the
option from the menu. This can be done even while still redrawing the graphs.

Draw All Points
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Elementary Buffer Graph

An Elementary Buffer graph can only be opened for Video Streams, since these
are the only type that have an elementary buffer.

Elementary Buffers are not allowed to overflow, so the graph of the results never
goes above 100%. The graph uses the scale -50% to +250% to make comparison
easy.



T-STD Buffer Analyzer - Results Graphs

4−46 MTS400 Series MPEG Test System User Manual

Multiplex or Main Buffer Graph

For Video streams this graph shows the results for modeling a Multiplex Buffer.
For Audio and System Control streams the graph shows the results for the Main
buffer. The title bar shows the stream type.

Here is an example to show the title for a graph of a System Control stream.
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Transport Buffer Graph

The Transport Buffer graph shows results of modeling the Transport Buffer for
Video, Audio, or System Control streams. The type of stream is shown in the
title bar. In the above example, the results plotted are for a Video stream carried
in PID 305.

Here is an example of an audio stream.
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Elementary Stream Analyzer

Elementary Stream (ES) Analyzer is an MPEG (Motion Pictures Expert Group)
stream analyzer that allows all MPEG-1 and MPEG-2 streams to be quickly
analyzed. Developers of MPEG compliant encoder and decoder systems, or field
application engineers (FAEs) supporting MPEG-based products will find
ES Analyzer a powerful and easy-to-use tool and debugging aid.

ES Analyzer provides the following facilities:

� Analyze in detail and verify whether MPEG-1 system and MPEG-2, video,
and audio streams conform to MPEG standards. (A built-in stream demulti-
plexer makes it possible to analyze elementary streams embedded in a
transport stream. All streams are checked for both syntactic and semantic
conformance. Syntactic conformance means conformance with the MPEG
language, while semantic conformance relates to the field value and range
restrictions.)

� Quickly zoom from transport streams, through PES and video streams into
GOP, pictures, slices, and all the way down to the macroblock layer.

� Play out audio streams to MPEG-1, MPEG-2, Layers I and II, Japanese
AAC, and Dolby Digital (AC-3) standards.

� Audio play to soundcard.

� Analyze Layer I, Layer II audio data, AC-3 audio, and AAC audio.

� View video output with the incorporated video player and analyze picture
data for any frame.

� Produce picture quality analysis data including Quantizer Scale distribution,
motion vectors graph in a picture, and macroblock and picture size plots.

� View the coded block patterns that have been extracted.

� Display and analysis of DCT coefficients for each macroblock in a picture.

� View interpreted and hexadecimal view of headers for all streams.

� Display and analysis of DVB Teletext information.

� View and analyze DVB subtitle content.

� View and analyze ATSC closed caption to EIA608 and EIA708 standard.

� View PID spectrum analysis for transport streams.

� Analyze multiple streams in batch mode through the regression testing
mode.
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� Quickly navigate through stream hierarchy using the powerful and easy to
use graphical interface including the Stream Properties summary window.

� ‘Seekback’ at all levels, allowing users to go back in a stream at all levels,
thus allow more flexibility in navigation.

� Set a level to report errors, filter them, and also store errors in log files.

NOTE. It is assumed that you are familiar with MPEG compression standards
and terminology. If you are new to MPEG and want to know about MPEG
compression standards and terminology, refer to the documents: ISO/IEC 11172
(Vol. 1, 2, 3 and 4) for MPEG-1 and ISO/IEC 13818 (Vol. 1, 2 and 3) for
MPEG-2 basics.

Starting the ES Analyzer

The program can be started by selecting the Tektronix ES Analyzer option from
the Start > Programs menu or by double-clicking on the Tektronix ES Analyzer
shortcut on the desktop.

Initially an empty shell window is displayed. It is necessary to open a stream
before any screen details can be seen.
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Opening an MPEG Stream

1. To open a file, select the Open… option from the File Menu or select the
corresponding icon on the toolbar.

The following dialog box appears:

ES Analyzer displays a standard windows Open dialog box with two additional
fields: Hex Window and Open As.

2. Select the file you want to open.

The types of files that can be opened are as follows:

� Transport stream files

� PES stream files

� Elementary stream files

� MPEG-1 and MPEG-2 files

� Regression scripts

� Mask files
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NOTE. If you want ES Analyzer to automatically detect the type of MPEG stream
the file contains, let the default Auto remain in the Open as field.

If you want to open the file as a specific type of stream and do not want
ES Analyzer to detect it, select the stream type in the Open as field.

If you open an MPEG stream as an incorrect stream type, numerous errors may
be reported and ES Analyzer may also behave unexpectedly.

If you open an ATSC stream as auto and the stream contains no PSIP service

information, the AC-3 audio may appear as  and not decode. Close the file
and reopen with ATSC Stream selected from the Open as field; the AC-3 audio
will now decode correctly.

3. Enable or disable the hex window.

ES Analyzer parses and demultiplexes the opened MPEG stream, and
displays the packet header fields in two formats—interpreted and hexadeci-
mal.

� If you want ES Analyzer to display the packet header fields in both the
formats, interpreted and hexadecimal, check the check box next to Hex
Window. (The hexadecimal format is displayed in a separate window.)

� If you want ES Analyzer to display the packet header fields only in the
interpreted format, let the default remain. (By default, the check box next
to Hex Window is clear.)

NOTE. If you do not enable the Hex Window when you open a stream, you cannot
enable it later when ES Analyzer is parsing the stream.

4. Click Open when you are through with this dialog box.
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Understanding the Main Window and Icons

ES Analyzer allows you to view multiple programs and streams simultaneously.
The tree view area on the left side displays the stream hierarchy. For the
currently selected stream, the details of the header are shown on the right side.
Errors, if encountered, are logged in the error log window at the bottom. A
summary of the stream parameters is displayed in the Stream Property window.
The status bar at the bottom of the window displays the current status and stream
characteristics.
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The tool bar provides a means of accessing frequently used menu bar commands
quickly; each icon represents a menu bar item. Icons will display a tooltip
description when the cursor is rested over it. The tool bar illustration below does
not show all of the buttons.

The table below lists the function of each icon and also indicates when the icon
is available. Availability refers to an icon being enabled or disabled with respect
to selected nodes in the left tree view window; disabled icons are ‘grayed out’.

You can toggle the tool bar display by selecting/deselecting the Toolbar
command on the View menu.

Table 5−1: Tool Bar icons 

Icon Function
Availability
(Enabled/Disabled)

Menu Bar 
equivalent

Opens an MPEG stream, a saved regres-
sion file (.REG file by default), or dumped
reports

Always enabled File > Open…

Restarts analysis from the beginning of the
selected parent or child stream

Enabled for all nodes Node > Intialize

Extracts a PES, Audio, or Video stream
from a multiplexed stream

Enabled for all the embedded
stream nodes (PES, VES, AES)

Node > Dump
Stream

Allows navigation to the selected TPT
packets; used in conjunction with the Next
icon

Enabled for Transport and
Program

-

Enables navigation to the nth packet at
TPT node or the nth GOP at GOP node or
nth frame at AES node.
Used in conjunction with the adjacent
button

Always enabled; disabled only
for VES node

-

Allows navigation to the next/previous
packet of the selected node

Always enabled; disabled only
for VES node, or at end of file

Next/ Previous
Packet/ GOP

Toggles Start and Stop to run through Test
mode

Only enabled at GOP level Start
Stop

Toggles between hexadecimal and decimal
display of data in fields

Always enabled -

Shows or hides the error log window Always enabled -

Shows or hides the Hex Viewer, which
displays data in hexadecimal format

Enabled if Hex Window is
checked when opening a
stream, otherwise always
disabled

-

Tool Bar
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Table 5−1: Tool Bar icons (Cont.)

Icon
Menu Bar 
equivalent

Availability
(Enabled/Disabled)Function

Enables or disables packet view analysis
that displays the PID spectrum

Enabled only for PES -

Allows zooming into any part of data being
displayed; useful when viewing Motion
Vector Display in the Slice And MB tab

Always enabled -

(left icon) Shows Frame Size Statistics for different
frames within a GOP

Enabled only for GOP node
(Disabled if the Picture Player
tab is selected)

Frame Sizes

(right icon) Shows Slice Size Statistics, i.e., informa-
tion about the sizes of the slices within a
Picture in a GOP

Enabled only for a GOP node
from within the Slice And MB
tab

Slice Sizes

Allows viewing the version and copyright
information

Always enabled Help Topics

When using ES Analyzer, you can issue commands in one of three ways:

� By clicking commands on the menu bar; this also includes the keyboard
shortcuts, which are shown next to the menu bar entries

� By clicking icons on the toolbar

� By clicking the right mouse button and selecting a command on the quick
menu

After you have invoked ES Analyzer, you need to select the bit stream file you
want to be analyzed by clicking Open on the File menu or by clicking the
appropriate icon on the toolbar. If the bit stream file is a valid MPEG file,
ES Analyzer displays the first packet of the top level stream. Now you can use
commands, described below, to navigate randomly to any part of the stream. You
can also run through a selected embedded stream using the Go command.

Working with ES Analyzer
Commands
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Tree View and Navigation

The tree view window displays the stream hierarchy of the currently opened bit
stream file. Each node in the tree view represents a level of hierarchy and is
displayed with:

� An associated icon (the icon varies depending on the type of stream that the
node represents; these are displayed in the following table).

� A tip that describes the kind of stream represented by the node.

� The PID associated with the node, if applicable.

Table 5−2: Navigation icons 

Icon Stream type representation

Transport stream.

Program stream.

System stream.

Packetized elementary stream (PES); PES containing a video or
audio stream, respectively.

Audio stream; an MPEG-1 and/or MPEG-2 audio stream.

Teletext.

Dolby AC-3 audio stream.
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Table 5−2: Navigation icons (Cont.)

Icon Stream type representation

Video stream; an MPEG-1 and/or MPEG-2 video stream.

If Closed Caption data is detected during analysis, ‘CC’ is added to
the video icon.

User data stream.

Group of pictures (GOP).

DVB subtitle PES.

Suffix 1 and 2 in the Tree View icons (Video and Audio Elementary Streams)
refer to MPEG-1 or MPEG-2. Note that MPEG-2 streams can contain MPEG-1
audio information.

NOTE. If packets are scrambled or if stream analysis (AAC Audio) has been
excluded by dongle, ES Analyzer does not display them.

When an MPEG file is initially opened, ES Analyzer automatically determines
the kind of MPEG stream it is. For a valid MPEG bit stream, ES Analyzer opens
the tree view with a node for the top level stream contained in the file. By
default, the stream hierarchy is expanded to only one level. You can expand/col-
lapse a node by clicking it. You can select the stream to be viewed at any level
displayed in the tree view window by simply clicking the left mouse button on
the specific node. Automatically, the window on the right is refreshed to display
the header and related information for the selected node.

ES Analyzer gives you full flexibility in viewing streams at any level. You can
navigate through the stream independently at each level of the stream. For
example, you may be viewing the first PES packet of a PES Stream, but in the
embedded VES stream, you may be viewing the last GOP that is not contained
in the first PES packet.

Navigating through
Streams
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Using GoTo, Next and Previous Commands. These commands are applicable to all
types of streams and assume that you have opened a valid MPEG file. Each of
these commands can be executed for any node that is displayed in the stream
hierarchy tree where each node is either a GOP or a valid MPEG stream
(embedded or top level).

� Step forward/backward to the Next/Previous packet or GOP in a video
stream for the selected node.

� Position the file pointer to the nth packet or GOP in a video stream or frame
in an audio stream for the selected video/audio node.

� Position the file pointer to the nth packet of the selected PID; this is
applicable to MPEG-1 system streams and MPEG-2 transport and program
streams.

� Position the file pointer to the first packet of the selected node.

� Save the embedded stream corresponding to the selected node in a separate
file.

� Toggle between hexadecimal and decimal display.

� Use the Transport Stream PID drop-down list to select a PID and navigate to
the selected PID using the Next button.

Header, Extension and Hex Displays

The header display window shows the current header and related information for
the selected node in a read-only mode. The fields are interpreted and displayed.
The header is not displayed syntactically. Wherever field codes represent specific
values, the corresponding value is shown rather than the code itself. For
example, in a video sequence, although Chroma format is a two-bit code, it is
displayed with the interpreted value of 4:2:0 or 4:2:2 or 4:4:4.

You can view field values in decimal or hexadecimal format by clicking the
appropriate icon on the toolbar. One bit fields are displayed using one of three
icons:

Table 5−3: Header icons 

Icon Field value representation

One-bit field was set to 1

One-bit field was set to 0

One-bit field is not applicable here

Header Display Window
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Almost all MPEG headers allow stuffing bytes and have marker and unused bits
defined in their syntax. Although all these are parsed and checked for correct-
ness, they are not displayed since they do not provide any meaningful informa-
tion.

Wherever appropriate, ES Analyzer provides visual feedback, by the use of color,
to represent different states.

Besides this generic structure, individual headers may have special displays. For
example, the video sequence header has a lot of information to be displayed in a
small area. This is achieved by using tabbed folders for all the MPEG-2
extensions (see the following illustration). The tab corresponding to an extension
is disabled if the corresponding extension does not appear in the sequence
header.

When an extension appears in the video sequence, its presence is also communi-
cated by the changed color of text (in red) on the corresponding tab.

The hex display window shows a hexadecimal dump of header bytes contained
in the header being currently displayed in the header fields display window. This
is useful if you are used to viewing the headers in the hexadecimal format rather
than the interpreted format that is displayed in the header display window. Also
able to be displayed are sequence information at VES level and frame informa-
tion at GOP level (as shown below).

Go to field Find field

The data collection for the hex display window can sometimes be memory
intensive and can affect ES Analyzer’s performance. You can turn on the hex
display or turn it off according to your requirements by checking or clearing the

Extension Displays

Hex Display Window
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check box next to Hex Window in the Open dialog box. If you have not enabled
the Hex Window option when opening a stream, you will be unable to open it
when ES Analyzer is parsing the stream. However, you can dynamically turn off
the Hex Window, whenever you want, by clicking the Show/Hide Hex Viewer

icon  on the toolbar if you enabled it when you opened the stream (see details
in the Opening an MPEG Stream section).

The hex window displays a hyphen (-) after every eight bytes for display
purposes. The status bar in the hex window displays the current cursor position’s
byte offset from the start of the header. If you select a sequence of bytes in the
hex window, the size and the byte offset from the start of the selection appears in
the status bar when you release the mouse button.

To search for a specific byte pattern in the Hex Window. 

1. Type the pattern in the Find field, on the left of the Find button, on the status
bar.

2. Click the Find button.

The specific pattern will be searched from the current cursor position. If the
pattern is found, it is highlighted in the hex window. If the pattern is not
found, you will hear a beep. The search loops back to the beginning of the
file and subsequent occurrences of a pattern can be found by clicking the
Find button.

To position the cursor to a specific byte location from the start of the packet
header. 

1. Type the byte position in the Goto field, on the left of the Goto button, on
the status bar.

2. Click the Goto button.

You will be positioned to the corresponding byte location in the header in the
hex display window.
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Summary of Displayed Information (Header and Hex displays). Table 5−4 summa-
rizes the information displayed in the hex window that corresponds to the
information displayed in the header display window.

Table 5−4: Hex Headers Display 

Header display window information Hex dump in the hex display window

Transport packet header. Header data of the current packet.

PES Header. Header data of the current packet.

MPEG-2 Program stream - Pack Header. Header data of the current packet.

MPEG-1 System Stream - Pack Header. Header data of the current packet.

Video stream - Sequence header / sequence
extension.

All the video level information which is above
the GOP level.

Video stream - When viewing picture at
Picture or Slice level display (with video
analysis setting set to Macroblock level).

All the information for the currently selected
picture. When the first picture is selected in
the picture slider, data corresponding to the
GOP header (if available) along with first
picture data appears. For all pictures other
than the first picture in the GOP, only picture
data is shown. The subsequently read
sequence header and extension data is
updated in VES node.

Video stream - Hex data display when viewing
picture at Slice level display (with video
analysis setting set to Picture level).

Same as above.

Video stream - Hex data display when viewing
picture in Picture display form (with video
analysis setting set to Picture level).

Same as above, but with the following
exception.

Picture data includes only picture header and
extension data. No slice or macroblock level
data is shown. However, when you go down to
the slice level display by clicking the Slices
button, ES Analyzer appends slice and
macroblock data in the current picture data for
the hex viewer. When you return to the Picture
display dialog, ES Analyzer continues to show
the complete picture data. The pictures for
which you do not step down to the slice level,
you’ll still be shown picture data that includes
only the picture header and extension data.

Audio Stream Both frame header and audio data is shown.
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Error Testing Methods and Outputs

ES Analyzer can error check an entire stream in an automated manner (regres-
sion test). Part of a stream, triggered from a node for a specific program, can be
manually  checked (run though mode).

Regardless of the stream type, testing is only possible at the compression layer;
it is the task of Tektronix TS Analyzer and PES Analyzer to test at the systems
layer. However, you can still view the headers of the transport and PES packets,
but note that no tests are performed (either run-through or regression).

Both test modes will produce screen or file output error messages. Manual test is
also possible by examining the various block/slice/vector and picture display
menu screens.

Error filters can be applied to the tests, and fields selected to allow diagnostics
up to the error point to be dumped in a file for ‘pre error point’ analysis.
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Run Through Stream Test Mode

This is operated by highlighting the test node - usually the GOP filmstrip icon -
of the appropriate program, then clicking on the Start/Stop (green ball) in the top
toolbar.

The stream will be run though and errors reported in the error display window.

The error display window displays information, warning and error messages
generated by the run-through test mode for a specific program node.

For each message, the following are shown:

� An associated icon that indicates the kind of message (the icons E, I, and S
shown below indicate a syntactic error, information, and a semantic error,
respectively):

where:
E = protocol syntax (Rules) error.
S = semantic-parameter or data range error.
I = Information only; not an error.
Both E and S should be regarded as errors.

� A string that identifies the exact location in the bit stream where the error
was encountered; the format of the string is:

(STREAMTYPE) -> (STREAMTYPE, STREAMID) ->
(NODE) (packetNumber)

For example, the following string identifies an error in packet number 2 of
the MPEG 1 audio stream on PID 210:

TPT->PES(PID=210),  MPEG 1 Audio->AES0(2)

� The message string associated with the message.

Double-clicking a message in the error display window lets you view more
detailed information about the message.

Error Display Window
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Error Filtering

You can configure and filter the kinds of messages you want ES Analyzer to
report. You can turn on/off messages of any type (Information, Errors, Semantic
checks) to be reported for the entire stream, or any node in the stream hierarchy
displayed in the tree view. You can also store the displayed messages in a file or
clear the message window.

To configure messages:

1. Click the right mouse button anywhere in the error display window.

2. Select Filter Messages from the context menu that appears:

The Filter Message dialog is displayed. The dialog box contains two tabbed
pages: Global and Node.

Configuring and Filtering
Messages for Display
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Message Filtering - Global. The Global Message Filter tab provides settings that
can be used to select which messages are enabled and disabled and how many
times enabled messages are to be displayed. The rules created are global; that is,
they will be applied to all nodes in the active stream. Rules to be applied to a
single node (such as PSI, PES, VES) can be added from the Node tab.

The top half of the Global tab contains:

� A drop-down list from which the category of messages can be selected to
which rules are to be applied, and

� Three options for the display of messages.

As rules are created using these fields, they should be added to the Rules text
field below by selecting the Add Rule button.
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The three options are as follows:

� Disable all messages on the basis of severity, that is, Info (I), Semantic (S) or
Error (E). 
Enable the Disable Messages(s) of checkbox, select the type of message to
be disabled and press the Add Rule button. Note that the rule is added in the
Rules text field.

� Disable messages on the basis of message number. 
Each message is assigned a unique number based on the type of streams it is
related to; a tooltip will be displayed when the cursor is passed over the
message number. Enable the Disable message Number(s) checkbox, select
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the message numbers to be disabled and press the Add Rule button. The
Shift and Control keys can be used to make multiple selections. Note that the
rule is added in the Rules text field.

� Report repeated messages only a specified number of times. 
Enable the Report Message Number(s) checkbox and select the message
numbers to be disabled. The Shift and Control keys can be used to make
multiple selections. Select the maximum number of times that the message is
to be reported and press the Add Rule button. Note that the rule is added in
the Rules text field.
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Combinations of message rules can be created; they will need to be created and
added one at a time.

Rules can be removed individually (Remove Rule button) or globally (Remove
All button). Rules that are already set cannot be edited; they must be removed
and recreated.

Rule sets can be saved and reloaded as required using the Save Rules… and
Load Rules… buttons.

Message Filtering - Node. 

1. Select a stream in the left scroll window and then select the types of
messages you want to be filtered out. By default, all messages are displayed
for a stream.

� If you want your message filter(s) to be applicable to all streams opened
until now, select it for the entire World. This option will apply the
filter(s) to all nodes displayed in the tree view window.
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� If you want your message filter to be applicable to all streams, irrespec-
tive of whether they are opened or not, click the Set for all Streams
button.

2. Click OK to accept to changes; Cancel to close the dialog box without
applying the changes.

1. Click the right mouse button anywhere in the error display window.

2. Select Dump To File from the menu that appears.

3. The Dump Message dialog box is displayed. Enter the name of the file in
which you want to store the messages.

4. Click the Save button when done.

1. Click the right mouse button anywhere in the error display window.

2. Select Clear Log Window from the menu that appears.

To store the displayed
messages:

To clear the windows
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Status Bar

During regression and run-through mode, progress through the stream is
indicated by the status bar at the bottom of the main window. The status bar is
split into multiple fields and displays the following:

� A progress bar indicates the approximate byte position in the file for the
currently selected stream.

NOTE. Since you can view each embedded stream inside a multiplexed stream
independently, it is possible that in each embedded stream you may be viewing
packets which are far apart in the stream. In such cases, the file pointer will be
at different positions for each embedded stream and the file progress bar is
updated according to the stream being currently viewed. In addition, the byte
offset in the file for the currently displayed unit of data is also displayed in the
status bar. For example, when you are viewing a Packetized Elementary Stream
(PES), the byte offset of the first byte of the start-code of the currently viewed
packet in the opened file is displayed in the status bar. Similarly, when viewing a
GOP in a Video stream that is embedded in a Transport stream, the byte offset of
the start code of the corresponding GOP in the file is displayed in the status bar.
More details are given with the explanation of status bar with each individual
stream.

� Characteristics of the stream being currently viewed. These vary with the
stream and are described in detail for each stream in subsequent chapters in
this book.

� The state of the status bar display can be toggled by selecting/deselecting the
Status Bar command on the View menu; that is, View > Status Bar.
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Regression Testing and Error Log Files

With ES Analyzer, you can regression test MPEG streams (with errors being
saved to log files) and save data from selected fields to report files for viewing
later (see the section Reviewing a Report for details).

To perform a regression test, close the file, if it is open, using the File menu.
Select File > New Regression Script…. Note that disk drive icons are displayed
on the right side of the directory window; you may need to scroll right to
view/access them.

Double-click on the file you require and it should appear in the lower window
Streams Selected for Regression with an orange question mark to the left of the
file name.

When regression is done, this will turn to a red or green ball, depending on the
errors found. A default log file name is entered; it can be renamed by clicking on
the double-arrow button to the right of the name. After regression testing, the log
file can be viewed by double-clicking on the log file name.

Error messages written to the log file can be controlled via the Message Settings
screen.

Regression Test Window
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The button View Reports is only available to show dump/.dat files if they have
been set up beforehand (see Select Fields and Reviewing a Report sections).

You can select multiple streams for regression from the displayed list of files.
(To select multiple files, double-click a file or select it and then drag-and-drop it
in the lower window.) The streams selected for regression appear in the lower
window.

For each stream, the following are displayed:

� File name.

� Default log file where the messages for the stream will go. You can change
this by clicking the icon displayed next to the log file name. ES Analyzer
displays a default directory where all log files are created that store the
results of the regression. You can change the directory for storing log files by
clicking the Default Dir… button.

� The stream type. Initially this is not known and is set to Unknown. Once the
regression is complete, this is updated to reflect the type of stream that the
file contains.

� An icon indicating the state of the stream. Initially, when a file is selected,
the icon appears as a question mark indicating an unknown status. After the
stream is regression tested, the icon changes to red if the regression reported
errors, or changes to green if there were no errors.

Setting up the Regression
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For a regression test, you can also select embedded streams that correspond to
nodes in the tree view for a stream hierarchy. You can do this by clicking the
Streams Option button in the regression test window; see Reviewing a Report
below. This displays the settings for the current stream. By default, the tests are
enabled for all types of streams, which you can disable. Saving a regression
script also saves these settings.

Once you have set up a regression script, you can run it by clicking the Start
Regression button. A status window displays the continuous status of the
regression. If you want, you can cancel the regression anytime by clicking the
Cancel Regression button in the status window. When the regression is complete,
the state of the regression run on each stream is displayed in a dialog box
through the changed icon which is red (for failure) or green (for success), and the
updated file type. The icon remains a question mark if the file was not a valid
MPEG file.

You can view the error log file created for any stream after it has been regression
tested by double-clicking the specific bit stream file in the regression test dialog
box. You will need to associate files of the type *.log with a text editor of your
choice. You may do so through the Explorer. Click View > Options to display the
Options dialog, and then click the File Types tab. By default, ES Analyzer opens
the log files with the application with which they are currently associated.

You can save the regression script and the results in a regression script. To save
the file, choose Save As from the File menu. The file is saved as a binary file and
also saves the regression results. You can reload the regression file including the
results of the last regression whenever you want. Regression can also be run on a
previously saved regression script file.

Messages sent to the log file can be controlled through the Message Settings
dialog box. Rules to be applied to messages can be created as required. The
operation of this dialog box is similar to Message Filtering as described on
page 5−17.

Running the Regression

Viewing and Saving
Results

Message Settings
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Reports and Field Selection

You can save and review reports consisting of field value dumps of specific
fields when you regression test a stream. To review a report, it must first be
created by selecting the fields to be viewed, then setting up and running the
regression, and finally selecting the View Reports button (it is also possible to
select and open multiple reports).

A regression report is packet-by-packet details listed with information fields you
can choose. A report is not an error list, although errors detected may appear in
it. A report can be used to examine run-ups to problems (pre-trigger).

Before starting a regression test, select the Stream Options button in the
Regression test window. Ensure that the Dump Fields check-box is enabled and
select the adjacent Select… button. You can then add the fields to be listed in the
dump file columns (individual fields or all fields).

You can check the dump in file box and name your dat file or use the default
VES.dat or AES.dat.

Do this for video & audio elementary streams.

To select fields. 

1. Click the Stream Options button in the regression test window to display the
following screen.

2. Enable and disable the streams using the checkboxes in the Analyze column.

Creating a Report
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Deselect the streams you don’t want ES Analyzer to analyze. By default, all
the streams are selected.

3. If you want to analyze Video Elementary Streams, you may either select
Macroblock Level or Picture Level from the adjacent drop-down list.

4. Select the streams for which you want to dump data by enabling the
checkbox under the Dump Fields column.

5. Click the highlighted Select… button to display the Select Fields dialog box.

6. Finalize the list of names by adding/deleting the field names in the Fields
Included list box and click OK.

You may also double-click a field name displayed in the left list box to
include it in the right list box.

� If you have selected a video elementary stream, ES Analyzer also displays
options in the Select Fields dialog box.
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You may click the appropriate buttons to select fields specific to these options.
This is a quick way to add/delete specific fields into the Fields Included list box;
otherwise, you will need to manually find and add fields from the Fields
Excluded list box.

For example, if you have added all the fields from the Fields Excluded list box,
and now want to delete VES-related fields from the Fields Included list box, you
may click the Delete All button in the VES section. You can also click the Add
All button under Display Extension to add related fields to the Fields Included
list box.

7. Specify the file into which you want the fields to be dumped.

You may type the filename (*.dat) or select one by using the browse button
next to the default filename.

8. Specify the dump options.

If you select Part of Stream, the Maximum Size (MB) field is enabled and you’ll
need to specify the size of the stream from which the fields will be dumped.

Once you have specified the fields, return to the regression test window by
clicking the button next to the Stream Options button.
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A sample report looks like this:

Collecting Statistics for
“C:\mpegstreams\mls\bird4.mpg”
Date 04/02/98 Time: 16:38:42

Packet Fixed Audio
No. SCR Flag Bound
1 0 1 1
2 1083 1 1
3 2167 1 1
4 3250 1 1
5 4334 1 1
6 5417 1 1
7 6501 1 1
8 7585 1 1
9 8668 1 1
10 9752 1 1

(Note that these ‘dump’ files have the default extension of .dat.)

Demultiplexing Transport Streams to PES or Elementary Output Files

It is possible to select a given stream node in navigation view (such as PES
video/audio) or VES audio/video (but NOT gop). The diskette icon will
highlight on top toolbar at the left when the function is available. Select the icon,
name the dump file and select it’s type if required. ES Analyzer will then create a
PES or elementary stream.

This stream can be loaded back into the ES Analyzer to be checked, and then it
can be used as input to Tektronix Multiplexer application to create a transport
stream with SI/PSI to your specifications.

Reviewing a Report
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Working with Transport and PES Streams

Using Packet View

ES Analyzer displays transport packets in a specific way that is useful for
analyzing the Transport stream and also for quickly accessing a packet at
random.

The packet view window can be displayed by clicking the Show/Hide Packet

 View icon on the toolbar. A window appears that shows a spectrum of the
packets in the order in which they appear in the transport stream. Each PID is
assigned a color and each packet is represented using a single line of the
corresponding color. By double-clicking the spectral line for any packet, you are
positioned to the corresponding packet in the main window of ES Analyzer.

Packet View communicates with ES Analyzer’s main window through OLE. You
can selectively turn on/off the display of spectral lines for any PID in the Packet
View by clicking the corresponding color index in the Packet View dialog. The
color index is also a toggle for display. You can also view distance graph
between packets of the same PID by just viewing spectral lines of the corre-
sponding PID. To switch back to displaying all PIDs, double-click the All index
(represented by white color).
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NOTE. When you first open Packet View, it displays just the front page of the
stream, so that not all of the PID numbers present in the stream are displayed in
the button boxes below the main display. If you want to see them all, drag the
horizontal scroll bar pointer to the far right; all of the PID number buttons will
then be displayed (this could take a few seconds for large stream files).

Packet view does not operate when a program node is highlighted; it works in
all other nodes in navigation view.

Understanding PES

A Packetized Elementary Stream (PES) as the name suggests is composed of
contiguous packets of an elementary stream with packet headers, as shown in the
following illustration, prepended to the packet. A PES occurs only in MPEG-2
streams and its structure has been adapted from the packet structure of the
MPEG-1 System stream.

For more information on PES streams, refer to the ISO/IEC 13818-1 document.

An embedded stream is checked when you navigate through one; for details, see
the Navigating through Streams section in the Getting Started chapter.
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For PES streams, you can:

� Run through the stream; see details in the Navigating through Streams
section in the Getting Started section.

� View packet headers with their decoded fields.

� View an embedded elementary stream.

� View PES extension (if received).

The status bar, for PES streams, displays the following:

� Packet number, which is the number of the current packet in the PES stream.

� Byte offset in the file, which is the first byte of the Pack header being
currently viewed in both the hexadecimal and decimal formats.

Explaining the Status Bar
Display
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Working with Video Streams

ES Analyzer performs detailed checks on MPEG Video streams. Video streams
are complex with an embedded hierarchy. Structurally, a Video stream consists of
a video sequence that has a start code, end code, sequence header, and any
number of group of pictures (GOP). Each GOP consists of a GOP header and a
group of pictures. Pictures may be of different types (I, B, or P). Pictures can
also be frame pictures that correspond to progressive video or field pictures that
correspond to interlaced video. Pictures are broken down into a slice structure
and each slice consists of macroblocks.

For more details, you may want to refer to the documents ISO/IEC 11171-2 and
ISO/IEC 13818-2 that describe the MPEG-1 and MPEG-2 video standards.

Using ES Analyzer, you can:

� View the sequence header along with the extensions.

� Navigate through a stream; see details in the Navigating through Streams,
page 5−9.

� Run through a stream with the option of analyzing the stream at the picture
level or at the macroblock level.

When analyzing a group of picture, you can:

� Randomly access any picture within the group.

� View the picture type spectrum and picture size plots.

� Zoom into any picture and see its details at the slice or macroblock levels, or
view the encoded picture. You may also use the video or picture player to
play the entire video and pause at any picture when you notice a degradation
in quality; you can then review the details of this picture down to the
macroblock level. ES Analyzer provides an easy mechanism to switch
between the Picture display and the data analysis display windows.

� Select any macroblock and examine its detailed coding.

� Perform picture quality analysis with special displays of quantizer scale
distribution, slice size distribution, macroblock-size spectrum and motion
vector plots.

� Interpret any video descriptors received in the higher level streams and
validate them against the stream.
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When analysis with the DCT option is enabled, you can:

� View 8x8 coefficients for all macroblocks within a picture.

� View coefficient tables for y, cr, cb, luma and chroma pixel data.

Viewing the Sequence Header

The sequence header is interpreted and displayed as shown below.

NOTE. Placing the cursor over either Load Intro Quantizer Matrix or Load
Non-Intra Quantiser Matrix, displays the applicable quantizer matrix. The check
mark icon indicates that the matrix was received in this sequence header.

For MPEG-2 streams, an optional sequence extension and user data may also be
received. User data is displayed as a hex dump. If data is in the ASCII format,
the ASCII equivalent is displayed next to the hex dump.

The picture rate, chroma format, and the video type (NTSC/PAL/Unspecified,
etc.) appear in the status bar when the sequence headers are displayed.
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The information whether the stream is an MPEG-1 or an MPEG-2 stream is
displayed in the tree view window as a single numeral (1 or 2) on the node icons.

Within a sequence, you can view the GOPs by clicking on the GOP icon in the
left side hierarchy view of the stream. The GOP node appears below the
sequence header node. 

Viewing the GOP and Picture Header

When displaying a GOP, ES Analyzer shows you a window with three tabs, as
shown below.

Briefly, the contents of each tab are explained below. For details, see the specific
sections: Displaying the GOP Header, Displaying the Slice and Macroblock, and
Using the Video Viewer for Picture Analysis.

The GOP tab displays the following:

� GOP header data.

� A slider for the pictures in the GOP. The slider can be used to randomly
access any picture within the GOP; the slider moves in steps of two to
facilitate working with large GOPs. The slider lists the pictures in the
received (decoding) order.

GOP position transport controls lie to the left of the slider bar

Using these controls, any picture can be selected within the GOP. The controls
include Start and End GOP controls and Next and Previous I frame jump
controls. Note that the I frame controls only works in streams where multiple I
frames are present between GOP sequence headers.

� Picture header display for the picture selected in the slider.

� Picture extensions (applicable only to MPEG-2).
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The Slice and MB tab:

� Takes you inside a specific picture and provides detailed information down
to the macroblock level.

� Allows you to generate picture quality plots.

� Allows you to view a picture frame by frame and view macroblock level data
for a selected macroblock in the picture.

The Picture Player tab allows you to play and view the video output on your
screen.

NOTE. ES Analyzer synchronizes the picture being currently displayed by the
video viewer with the picture/data that is displayed on the other tabs: GOP And
Picture and Slice And MB. For example, if you select a macroblock and switch
from the picture display to the other picture-quality analysis tabs, the same
macroblock remains selected for easy identification.

As an aid to locating a stream, you can click on any open GOP icon in the tree
view to switch picture displays in the stream multiplex.

The GOP header is an optional header and it is displayed, as shown below, when
received.

Displaying the GOP
Header
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The lower part of the display also shows the picture extensions that have been
received.

Video Analysis Settings. Analysis of GOPs can be carried out at picture level or
macroblock level. This will affect the speed at which the ‘next GOP’ is analyzed.
The setting is selected from the Video Analysis Settings dialog.

Select Menu Bar > Settings > Video Analysis. The following dialog is displayed:

Picture level analysis provides faster analysis but error reporting at the macro-
block level is suspended. Macroblock level analysis provides error reporting but
at the cost of analysis speed.
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Status Bar (in GOP mode). When ES Analyzer displays the GOP and picture
headers, the status bar, as shown below, displays the:

� Picture rate

� Chroma format

� Video Type (NTSC/PAL/Unspecified etc.)

� GOP number of the current GOP

� Picture number of the currently selected picture, relative to the current GOP
(the first picture is given the offset 0.)

� Picture display number, which gives the picture number in display order,
relative to the first GOP received. This represents the actual picture Display
number. It is calculated by adding the temporal reference of the current
picture to the cumulative picture display number prior to the GOP.

The GOP header tab has a slider for selecting the picture whose details you want
to display. The header for the selected picture is displayed below the GOP header
in the same dialog box as shown in the earlier illustration.

For MPEG-2, several picture extensions may be received. The picture coding
extension is always displayed, while the other picture extensions are displayed
on tabbed folders, as shown below. The tabs for each of these extensions are
enabled and the text on the tab appears in red, only if the corresponding
extension is received in the stream.

All tabs with red text represent extensions that have been received for the current
picture. The next section describes each extension and its interpretation.

Displaying the Picture
Header

Displaying the Picture
Extension



ES Analyzer - Working with Video Streams

MTS400 Series MPEG Test System User Manual 5−41

Explaining the Picture Extensions. 

QME
(Quantizer Matrix Extension)

This allows the quantizer matrices to be down-
loaded for any picture.

At most four matrices can be downloaded,
namely, intra-quantizer matrix; non-intra-quan-
tizer matrix, chroma intra-quantizer matrix, and
chroma non-intra-quantizer matrix.

The QME tab displays through a check mark
the matrices that were downloaded. A down-
loaded matrix is displayed when you move the
mouse over the name of the specific matrix.

CE
(Copyright Extension)

This indicates any copyrights on the video. The
copyright field is interpreted and displayed.

PDE
(Picture Display Extension)

This extension gives display extensions for
MPEG-2 video.

PSSE
(Picture Spatial Scaleable
Extension)

This is received when the spatial scalability of
MPEG-2 video is used in the video stream.

PTSE
(Picture Temporal Scaleable
Extension)

This extension is received when the temporal
scalability of MPEG-2 video is used in the vid-
eo stream.

UD
(User Data)

This displays any user data associated with the
picture in hexadecimal format. If the data repre-
sents ASCII text, the ASCII text is also inter-
preted and displayed.

CPE
(Camera Picture Extension)

NOTE. These tabs will only operate if the appropriate extensions are present
within the stream under test.

All four matrices will only display if they are downloaded with certain stream
types for example, HDTV streams.

 - indicates that only the default matrix will be displayed.
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Displaying the Slice and Macroblock

ES Analyzer allows you to take a microscopic view of a picture by letting you
view the picture’s slice and macroblock structure.

1. Select the picture by using the picture slider on the GOP And Picture tab.

2. Click the Slice and MB tab.

The macroblocks for the selected picture are displayed as shown below:

The Slice dialog box graphically displays the slices and macroblocks in the
picture and also displays the:

� Slice header for the selected slice.

� Macroblock details for the selected macroblock.

� Picture Quality data, which overlaps the slice display area.

� Decoded field/frame for the selected picture.

To view slice details of
any picture:
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When displaying the slices, the current picture is represented by its constituent
slices; see the above illustration. You can move the mouse to any slice and select
it using the left mouse-button. The slice header display shows the header for the
currently selected slice. MPEG-1 slices can span multiple rows and the display
shows the same.

Slice display is color coded. Intra-slices are shown in green color, while slices
that do not have this flag set are displayed in gray color.

Within a slice, the macroblocks are also shown. You can select a macroblock in
the slice using the left mouse-button. The header and information of the currently
selected macroblock is displayed below the macroblock display. Skipped
macroblocks in a slice are shown using a different color and cannot be selected.

When viewing the slice display, you can move forward to the next picture or
backward to the previous picture. You do this by clicking the picture navigation
buttons on the top right corner of the dialog box. You can also return to the GOP
display and select a specific picture. When moving backwards, you cannot cross
the GOP boundary; however, when moving forward, you can cross a GOP
boundary.

When displaying macroblocks, the status bar looks like this:

While in the slice and macroblock level display, you can view the coded block
pattern for any macroblock (except for the skipped macroblocks). This is
displayed in the last field (CBP) as shown below.

Depending on the chroma format, the coded block pattern is displayed as a
sequence of 6, 8, or 12 bits. From left to right, the bit pattern represents the
blocks in the macroblock as they are numbered in the standard MPEG specifica-
tions. For more details, see the ISO/IEC 11172-3 and ISO/IEC 11318-3
documents. 

Explaining the Slice and
Macroblock Display

Viewing Coded Block
Patterns for a Macroblock 
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Analyzing Picture Quality

The Macroblock Size Display provides a color-mapped two-dimensional
graphical plot of the macroblock size and type distribution in a picture; it is
plotted as an overlay on the slice display area. This plot can be viewed by
clicking on the MB Size Display button in the Slice and MB tab. The types of all
macroblocks in the picture are color-mapped; a key is shown at the right side of
the display and described below (see Macroblock Colors). Skipped macroblocks
are displayed in dark green. The macroblock size for the selected macroblock is
displayed in the macroblock field display area below it.

Macroblock Colors. The color-coded macroblock type represents the prediction
type employed.

Field Based Predictions are made independently for each field by using
data from one or more previously decoded fields.

Frame Based Predictions are made for the frame using the data from one or
more previously decoded frames.

Viewing the Macroblock
Size Spectrum
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16 x 8 MC (16 x 8 motion compensation) In which two motion vectors are
used for each macroblock. The first motion vector is used for
the upper 16x8 region, the second for the lower 16x8 region. In
the case of a bi-directionally predicted macroblock a total of
four motion vectors will be used since there will be two for
forward prediction and two for the backward prediction. 16x8
MC is only used with field pictures.

Dual Prima Only one motion vector is encoded (in its full format) in the bit
stream together with a small differential motion vector. In the
case of field pictures, two motion vectors are then derived
from this information. These are used to form prediction from
two reference fields (one top, one bottom) which are averaged
to form the final prediction. In the case of frame pictures, this
process is repeated for the two fields so that a total of four field
predictions are made. This mode is only used in P-pictures
where there are no B-pictures between the predicted and
reference fields or frames.

NA Not Applicable - Refers to the instances where there is no
prediction in the macroblock.

(For more detailed information, refer to ISO/IEC 13818-2 : 1996, Information
Technology - Generic coding of moving pictures and associated audio informa-
tion, Part 2 Video.)

Quantizer scale distribution for the macroblocks in a picture is plotted where the
picture slice is displayed. This gives you a graphical view of the scale code
distribution and lets you visually check any obvious scale code problems. This
plot can be viewed by clicking on the Q-Scale Code Display button in the Slices
dialog box. The scale codes of 1 through 31 are mapped to shades of green with
1 being mapped to the lightest shade and 31 to the darkest (black). Skipped
macroblocks use the same scheme but are mapped in shades of gray. The value
of the scale code for the selected macroblock is displayed in the macroblock field
display area below it.

Viewing the Quantizer
Scale Distribution



ES Analyzer - Working with Video Streams

5−46 MTS400 Series MPEG Test System User Manual

ES Analyzer gives a detailed graphical display of motion vector for the selected
B or P picture. Both MPEG-1 and MPEG-2 type vectors are interpreted and
displayed.

To view motion vectors (applicable to only B or P pictures). 

1. Position the cursor to the picture for which you want to see the slice size
plot.

2. Move into the slice display.

3. Click the Motion Vector Display button in the slice display dialog box.

For each macroblock, the motion vectors corresponding to it are plotted to scale
as a directed arrow. The direction of the arrow represents motion coding for the
macroblock from the reference frame to the current frame. Different types of
vectors are plotted in different colors. You can also selectively choose to display
different motion vectors by using the buttons on the right.

Viewing the Motion Vector
Plots
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FF Forward Frame BF Backward Frame

FTF Forward Top Field BTF Backward Top Field

FBF Forward Bottom Field BBF Backward Bottom Field

DTF DMV Top Field DBF DMV Bottom Field

If a button is grayed out, the associated vector is not currently available.

The motion vectors are plotted for the luminance blocks. They are to scale (in the
resolution of full pel or half pel) according to the pel resolution fields received.
For each macroblock, multiple vectors may be received. All or some of them
may be displayed simultaneously.

When Tooltips are enabled, a summary of parameters is displayed in a popup
window.

For MPEG-1 that has only frame pictures, two kinds of motion vectors are
applicable -forward frame (for P and B pictures) and backward frame (for B
pictures).

For MPEG-2 video, additional vectors may also be coded, which are: forward
frame (for P and B pictures), backward frame (for B pictures), forward top field,
backward top field, forward bottom field, backward bottom field, dual prime top
field, dual prime bottom field.

ES Analyzer interprets all the above vectors and lets you view them graphically.
When motion vectors cross the picture boundary, an error condition occurs and
the same is reported in the error log window. In this case, the vector is drawn
until the edge of the picture display.
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ES Analyzer decodes and displays the selected picture when you click the Picture
Display button. You can view I, B, or P frames or fields (only for MPEG-2).

ES Analyzer also allows you to view the previous and the next decoded picture
(whether frame or field) by clicking the appropriate buttons. The actual size of
the picture is displayed and if the picture is larger than the picture display area,
scroll bars will appear. For the current picture being viewed, you can select a
macroblock by clicking the left mouse button anywhere in the picture display
area. When you do so, the slice and macroblock area below the picture displays
the slice and MB data for the currently selected macroblock. If Tooltips are
selected, a summary of the macroblock information is displayed in a popup box.
When you switch from the picture display to the other picture-quality analysis
tabs (e.g., MB Size Display, Q-Scale Code Display or Slice Display), the same
macroblock remains selected for easy identification.

You can also enable a macroblock grid on the displayed picture by using the
Show Grid button to easily identify and select macroblocks.

Reviewing the Decoded
Picture
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The picture display has the following limitations:

� When you navigate to a specific GOP using the toolbar icon, the picture
display may be unable to display some B pictures correctly. These pictures
are those that use a frame from the previous GOP for reference. This happens
only when you navigate to a GOP that is not a closed GOP.

� For MPEG-2 scaleable streams, you will be able to display pictures only
from the base layer. Other extension layer data cannot be displayed using
ES Analyzer.

� ES Analyzer currently displays and decodes video streams within the
following MPEG-2 profiles:

� Main Profile @ High Level (MP@HL)

� Main Profile @ Main Level (MP@ML)

� 4:2:2 Profile @ Main Level (4:2:2P@ML)
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Viewing the Decoded Picture with Motion Vector Plots. The decoded picture can be
further enhanced with an overlay of motion vector plots. The interpretation of the
display corresponds with the description in the previous section - Viewing the
Motion Vector Plots.

To view the vector plots for the currently displayed picture:

� Select the Show MV button on the right side of the picture.

� The vectors displayed will depend upon the selections made from the
remaining buttons on the right side of the screen.

The picture display has the following limitations:

� When navigating to a specific GOP using the toolbar icon, the picture
display may be unable to display some B pictures correctly. These pictures
are those that use a frame from the previous GOP for reference. This happens
only when you navigate to a GOP that is not a closed GOP.

� For MPEG2 scaleable streams, you will be able to display pictures only from
the base layer. Other extension layer data cannot be displayed using ES
Analyzer.
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� For MPEG2 streams, ES Analyzer currently displays and decodes only
decodes MP@HL, MP@ML, and 4:2:2 video streams.

NOTE. Make sure that your monitor’s Display Properties is set to either 24 or
32-bit true color; otherwise, you may find a distortion in the colors in the picture
being displayed.

Displaying DCT Coefficients. The Discrete Cosine Transformation matrix of each
block in a selected macroblock can be seen by selecting Settings > DCT Display
from the Menu Bar. The DCT Display option is available only when viewing the
details of GOP in Video Stream Analysis. Enabling the DCT Display option will
enable Show DCT button next to the displayed picture in Slice & Macroblock
Tab, Picture View Mode.
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The Show DCT button is used to toggle the DCT Coefficients display. To view
the DCT values of the a macroblock, select the macroblock; a window contain-
ing details of coded and decoded DCT values will be displayed.

Note that the luma (y) control has four selections (0, 1, 2 and 3) which corre-
spond to an 8x8 pixel corner of the 16x16 pixel selected macroblock. Chroma
sub-sampling (Cb and Cr) will display matrices for the color differences between
frames.

The picture display has the following limitations:

� When navigating to a specific GOP using the toolbar icon, the picture
display may be unable to display some B pictures correctly. These pictures
are those that use a frame from the previous GOP for reference. This happens
only when you navigate to a GOP that is not a closed GOP.

� For MPEG2 scaleable streams, you will be able to display pictures only from
the base layer. Other extension layer data cannot be displayed using ES
Analyzer.

� For MPEG2 streams, ES Analyzer currently displays and decodes only
decodes MP@HL, MP@ML, and 4:2:2 video streams.
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DCT Value Display - Version Changes. The diagram below shows the monitoring
points in the analysis process for the DCT values. The diagram also indicates the
changes that occurred between ES Analyzer, Version 1.5 (MPEG Test System,
Versions 6.4 and 6.4.2) and ES Analyzer, Version 1.6 (MPEG Test System,
Version 6.5). The “windows” referred to are those in the DCT Values window.

The video analysis or picture analysis default settings can be set as required.

NOTE. The selected Video Analysis settings will not affect analysis on either the
Slice and Macroblock or the Picture Player pages. On the Slice and Macroblock
page, analysis is always at the macroblock level. On the Picture Player page,
analysis is always at the picture level.

Configuring Video
Analysis Settings
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Video Analysis Settings. Select Settings > Video Analysis… from the Menu Bar.
The following dialog box is displayed:

Select Picture level analysis to view frames quickly.

Select Macroblock level analysis if pictures/frames are to be analyzed at the
macroblock level.

When Macroblock level analysis is enabled, select the shading scheme required.

Picture Display Settings. A number of display and vector parameters are set from
the Picture Display Settings dialog.

Select Settings > Picture Display… from the Menu Bar. The following dialog is
displayed:
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Display Order of Pictures Select Presentation Order or Decoding order

Motion Vector Overlay Colour Section White: All vectors will be displayed in white.

Black: All vectors will be displayed in black.

Vector Dependent: Colors will correspond to the
vector selection button colors.

Background Dependent: Colors are combined with
picture background to provide a contrast.

For any picture, you can also view the slice size distribution.

To view the plot. 

1. Position the cursor to the picture for which you want to see the slice size plot
on the GOP And Picture tab.

2. Move into the slices display by clicking the Slice and MB tab.

3. Click the Show Slice Size Statistics icon  on the toolbar.

NOTE. The Show Slice Size Statistics icon  is grayed out on all tabs except
the Slice and MB tab.

The plot appears in another window.

Viewing the Slice Size
Distribution
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You can view the picture spectrum for a GOP and the frame size plots.

To view the plot.. 

1. Display the GOP for which you want to see the Frame Size Spectrum plot.

2. Click the Show Frame Size Statistics icon  on the toolbar.

The following plot is displayed. Each bar represents the frame size in kilobytes:

Selecting the Show Data Distribution button will further enhance the plot by
showing the content of each frame.

Content is color-coded as shown by the key in the bottom left corner. Details of
the content of each frame are displayed when the cursor is moved over a frame.

Viewing the Frame Size
Spectrum
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Using the Video Viewer for Picture Analysis

The video viewer (or Picture Player) allows you to play a video stream and
display the decoded picture on the screen. The picture player playback speed
may vary from real time according to the ES Analyzer processor speed. You may
also notice certain pauses in the display at regular intervals. These pauses occur
at GOP boundaries. The Remote Control (described below) allows you to pause
and resume the display at any frame. You can also restart the display from the
beginning of the current GOP, or from the start of the video sequence.

The number of the current picture and the number of the last decoded picture are
displayed, as shown in the following illustration. Here is a typical sequence of
steps in which you may use the video viewer:

1. Open the video stream you want to analyze.

2. Start the video viewer.

3. Monitor the displayed picture for quality problems.

4. Pause the player whenever you notice a problem in a picture, such as a
degradation in quality. The player is intentionally made to play at a speed
slower than the regular play speed to allow you to stop at specific frames.
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5. Switch to the analysis tabs to view details of the currently displayed picture
down to the macroblock level.

6. Step forward or backward in decode order in the Slice And MB tab, or
switch back to the video viewer and resume play.

ES Analyzer synchronizes the picture being currently displayed by the video
viewer with the picture/data that is displayed on the other tabs: GOP And Picture
and Slice And MB. This means that:

� The GOP And Picture and Slice And MB tabs always display data for the
same picture.

� When you switch from the video viewer to either the GOP And Picture or
the Slice And MB tab, you are presented the data for the picture being
displayed on the Picture Player tab.

� When you switch from the GOP And Picture or the Slice And MB tab to the
Picture Player tab, the video viewer presents the picture for the data being
displayed on the GOP And Picture or the Slice And MB tab.

� If you select a macroblock and switch to the picture-quality analysis tabs
(such as MB Size Display, Q-Scale Code Display or Slice Display), you will
find that the same macroblock remains selected for easy identification.

The video viewer, however, has the following limitations:

� When you navigate to a specific GOP using the toolbar icon, the picture
display may be unable to display some B pictures correctly. These pictures
are those that use a frame from the previous GOP for reference. This happens
only when you navigate to a GOP that is not a closed GOP.

� For MPEG-2 scaleable streams, you will be able to display pictures only
from the base layer. Other extension layer data cannot be displayed using
ES Analyzer.

� ES Analyzer currently displays and decodes video streams within the
following MPEG-2 profiles:

� Main Profile @ High Level (MP@HL)

� Main Profile @ Main Level (MP@ML)

� 4:2:2 Profile @ Main Level (4:2:2P@ML)
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The Remote Control is displayed whenever the Picture Player tab is selected.

Play Video Plays the video stream from where it
last stopped.

Stop Stops the video stream and allows the
other analysis tabs to be selected.

Next Picture Steps forward one frame.

Play from GOP Start Plays the pictures from the start of the
current GOP.

Zoom/Restore Display Enlarges and restores the area in
which the picture appears.

Fit Best in Display Area/
Display Picture at True Size

Fits picture in display area or displays
picture at original size.

Left/Right Scroll Scrolls the displayed picture left and
right.

Up/Down Scroll Scrolls the displayed picture up and
down.

Show/Hide information Shows or hides the information panel
for the displayed picture. The follow-
ing information is displayed:

GOP Number - in which the frame is
present.
Coded Number - refers to the picture
number within the GOP.
Display Time - in hh:mm:ss:cc;
where cc is the display number in the
whole file.
Display Number - refers to the dis-
play number of a picture within the
GOP.

Picture Player Remote
Control
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Working with Audio Streams

ES Analyzer analyzes both MPEG (-1 and -2) Audio streams and Dolby Digital
(AC-3) Audio streams.

Understanding MPEG Audio Streams

An MPEG audio stream consists of a sequence of audio frames. Audio data may
be received for multiple channels. Each channel is divided into sub-bands for
which data is transmitted.

ES Analyzer verifies audio streams according to the MPEG audio recommenda-
tions. Support for both MPEG Layer I and Layer II audio is available. MPEG-2
extensions for Layer I and II (surround and center channels, and low frequency
channels) are also interpreted and analyzed. Multi-lingual extensions in MPEG-2
are currently not analyzed. ES Analyzer is also unable to analyze the MPEG-2
Audio stream if the extension bit stream is present.

For a detailed discussion on the MPEG audio syntax, refer to ISO 11172-3 and
ISO 13818-3.

With ES Analyzer, you can:

� Navigate to any audio frame; see details in the Navigating through Streams
section in the Getting Started chapter.

� View frame details, including frame header, and plots of the frame data, as
shown in the following illustration.

� Interpret and display audio descriptors received in higher level streams and
validate them against the stream.

� Play an audio stream.

For each audio frame, data may be received for at most two channels, as shown
in the next illustration; additional channels may also be received in the MPEG-2
extension.
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Audio Player

The Audio Player is available on MPEG-1, MPEG-2 and Dolby AC-3 streams
(and AAC as an option). With a suitable sound card installed in the host PC,
audio streams can be played.

NOTE. The speed and quality of playout, isnot high fidelity, but is sufficient to
allow an audio stream to be monitored for analysis.

WARNING. While an audio stream is playing, you cannot access any other
analyzer functions. In particular, do not close the Audio Player while an audio
stream is playing (especially in loop mode), because you will be unable to
reopen the player (and control the stream) until it has finished playing.

If more than one audio device is installed, a selection can be made from the
Device drop-down list.

The channels to be played can be selected from the Play Channels drop-down
list.

  To open the Audio Player, select the player start button, which is
available on the audio stream header pages.

The Audio Player control panel is displayed:

The player controls follow the same convention as the Video Player controls:

Play

Stop

Fast forward

Fast rewind
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(To use Fast Forward and Fast Rewind, press the required button and then stop
the action with the Stop button.)

The Audio Player display shows the following:

� Play time

� Stream Name and Audio PID number

� Player status (Stop/Play)

The following controls are available in addition to those described in the
preceding list.

Toggles continuous (or looped) playout.

Toggles a real-time waveform display.

NOTE. Currently two channels are output to the sound card. These can be
assigned as required (as mono or stereo) from any of up to five channels in a
stream.
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ES Analyzer displays data for each channel separately.

For the selected audio frame, ES Analyzer displays the following:

� The frame header.

� A plot of bits per code word against the sub-bands for each channel.

� SCFSI (Scale Factor Selection Information) plotted against sub-band for
each channel.

� Grouping information plotted against sub-bands for each channel.

� The scale factor plotted against the sub-band.

� Channel selection and playout controls.

Explaining MPEG-1 Audio
Streams
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For MPEG-2 Audio streams, ES Analyzer analyzes the following channels if the
data is present: Left, Right, Left Surround, Right Surround, Center and LFE.
Currently, ES Analyzer analyzes 5.1 Audio streams. When ES Analyzer detects
an MPEG-2 Audio stream, the information displayed is similar to what is shown
in the following illustration.

ES Analyzer displays information on the following tabs:  MPEG-1 Header, MC
Header (Multi-channel header), and MC Composite Status (Multi-channel
composite status).

MPEG-2 Audio streams are backward compatible with MPEG-1 streams.
Therefore, the MPEG-1 header for each frame is the same as that for an MPEG-2
Audio stream.

Explaining MPEG-2 Audio
Streams



ES Analyzer - Working with Audio Streams

5−66 MTS400 Series MPEG Test System User Manual

The MC Header tab displays information about the additional data present for
the multi-channel extensions, over the two stereo channels. It gives you the
number of channels that are present, the presence of the LFE channel, additional
CRCs, and other relevant fields in the MC Header, as shown.

The MC Composite Status tab provides the sub-band information of the
channels; and their relationship with the transmission channels, as shown.
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The lower part of the dialog box displays information specific to the channels.
You can select the channel for which you want to see the details by clicking the
appropriate graphic at right. The channel-specific data for the selected channel is
displayed at left as for MPEG-1.

The status bar for Audio streams displays the following:

� Frame number, which is the number of the current frame in the stream.

� Layer number, which is the number of the audio stream.

� Byte offset in the file, which is the first byte of the Frame header being
currently viewed in both the hexadecimal and decimal formats.

Explaining the Status Bar
Display
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Understanding Dolby Digital (AC-3) Audio Streams

ES Analyzer also analyzes Dolby Digital’s audio streams, which could be an
independent, stand-alone audio stream, or a multiplexed stream that is embedded
inside an MPEG-2 System stream (ATSC transport or program stream). The
Dolby Digital stream is analyzed by ES Analyzer for syntactic compliance with
Dolby Digital specifications.

For a detailed discussion on the Dolby Digital audio syntax, refer to the
document A/52 from Advance Television Systems Committee (ATSC).

ES Analyzer analyzes Dolby Digital stream frame by frame and also performs
CRC checks for each audio frame. When analyzing a Dolby Digital stream, you
may navigate to any frame and also view data specific to an audio block within
it.

Automatically detecting the data format used in the Dolby Digital stream, ES
Analyzer analyzes both the little endian and the big endian formats. For ease of
debugging, ES Analyzer displays information for all the fields of any block for
any audio frame.

When errors are encountered in a stream, ES Analyzer reports the errors and
synchronizes to the next audio frame to continue the analysis.

ES Analyzer displays the header and audio block information on specific tabs, as
shown. The Header And BSI tab displays the Dolby Digital synchronization and
bit stream information.

The audio controls are only available on the Header and BSI tab.
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Depending on the selection, the Audio Block tab displays information for the
corresponding audio block within the frame.

The lower part of the previous illustration displays the channel-specific
information for the selected audio block, as shown in the following illustration.
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The Coupling information tab distinguishes between the stand-alone and coupled
data for the selected channel. The green band denotes the stand-alone informa-
tion, and the blue region denotes the coupled information. The blue region may
be further divided into bands; these appear as solid lines as opposed to the dotted
lines that denote sub-bands.

The status bar for Dolby Digital Audio streams displays the following:

� Frame number, which is the number of the current frame in the stream.

� Bit rate of the Dolby Digital audio stream.

� Sampling rate.

� Frame size information.

� Byte offset in the file, which is the first byte of the Frame header being
currently viewed in both the hexadecimal and decimal formats.

Explaining the Status Bar
Display
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Working with Program Streams

Program streams are quite similar to MPEG1 System streams in structure. A
Program stream consists of a sequence of packs. Each pack has a header, an
optional system header, and any number of packets. If a system header is not
received in a pack, then the last received header is applicable for the pack. The
system header is sent periodically in the stream to facilitate random access. Each
pack contains any number of packets. Each packet belongs to a particular stream
and has a PID associated with it. If packets of a given PID are concatenated, you
get the embedded PES stream with this PID. The PES stream in turn has an
elementary stream embedded in it.

For more details on Program streams, refer to the ISO/IEC 13818-1 document.

ES Analyzer performs conformance and semantic checks at the program stream
packet level as per the ISO/IEC 13818-1 recommendations. An embedded stream
is checked when you navigate through one; for details, see the Navigating
through Streams section in the Getting Started chapter.
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For Program streams, you can:

� View pack and system headers, as shown in the previous illustration.

� View the program stream map; see the Viewing Program Map section for
details.

� View an embedded stream at the PES or the elementary stream level; see the
Understanding Packetized Elementary Streams section for details.

� Perform buffer analysis of the embedded audio/video stream using the STD
model; see the Analyzing Streams chapter for details.

� Perform PCR/PTS frequency analysis model; see the Analyzing Streams
chapter for details.

Viewing Pack and System Headers

When navigating through a stream, the current pack is displayed in the header
display area, as shown in the preceding illustration. The pack and system header
fields are displayed for the current packet of the Program stream. The currently
applicable system header is displayed for the packet. The receipt of a system
header in the current pack is indicated by a check mark in the system header
group box. A cross mark indicates that the system header was received earlier.

The list of streams declared in the header is displayed in the elementary stream
list box. It is possible that the stream may contain some PES streams that are not
declared in the System Header. Such streams are added in the tree view when a
packet of the same is encountered.
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Viewing the Program Stream Map

  The program stream map can be viewed by clicking the stream map icon
(PSMAP) in the tree view window. This pops up the stream map showing the
descriptors for the Program stream and the contained elementary streams. The
descriptors associated with each elementary stream in a program can be viewed
in one of two ways:

� By double-clicking the corresponding icon for the stream in the display

�  By clicking the more details icon shown for the corresponding stream in
the elementary stream listbox

The form is extended (if not already extended) to add the descriptors display, as
shown in the following illustrations. All descriptors that are received for the
corresponding stream are displayed on tabbed folders. If a descriptor is not
received, its tab will not appear in the descriptor display. The illustrations below
show descriptors for the respective video and audio tabs.
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The status bar for Program streams displays the following:

� Pack number, which is the number of the displayed packet.

� Packet number, which is the number of the current packet in the entire
stream.

� Packet number of SID, which is the number of the current packet taking into
account only packets of the same stream ID (SID).

� At GOP level, the location of GOP header/start at PES level and Pack level
is displayed by PES packet number & Pack number respectively.

� At AES & AC3 level, the location of frame header/start at PES level and
Pack level is displayed by PES packet number and Pack number respective-
ly.

� Byte offset in the file, which is the first byte of the Pack header being
currently viewed in both the hexadecimal and decimal formats.

Explaining the Status Bar
Display
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Working with Teletext

Teletext can be incorporated into DVB streams. ES Analyzer allows the
associated data to be analyzed and viewed.

  To view the teletext data, navigate to the teletext icon in the Tree View

window.

Initially, the Page Header data will be displayed:
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Using the Next button, details of the page can be viewed in the Data Packet tab.

Other tab pages (Color Map Table, Decoded Display, Decoding Parameters)
provide detailed teletext encoding data. These tabs will only appear as progress
is made through the stream using the Next button and the analyzer detects them.

VBI (Enhanced Teletext Support)

Enhanced teletext support is available (reference: ETSI EN 301-775). The
supported extensions include the following:

� VPS (Video Program System)

� WSS (Wide Screen Signaling)

� Monochrome Data

Note that the associated information screens will only be available for display
where data of the specific type is available in the stream.
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Examples of the screens are shown in the following illustrations.

VPS (Video Program
System)
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WSS (Wide Screen
Signaling)

Monochrome Data
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Advanced Audio Compression

Elementary Stream Analyzer (ES Analyzer) performs off-line stored stream
analysis for MPEG1 Audio, MPEG2 Audio, and Dolby Digital Audio streams,
as well as MPEG1 and MPEG2 video streams. The streams can embedded inside
DVB, ATSC or MPEG1 System streams.

Advanced Audio Compression (AAC) is one of the audio compression formats
defined by the MPEG-2 standard. AAC used to be called NBC (Non-Backward-
Compatible), because it is not compatible with the MPEG-1 audio formats. AAC
offers a better compression ratio than MP3 (MPEG-1 Layer 3) and is the
state-of-the-art in audio compression technology. It can include up to 48 audio
channels, 15 low frequency enhancement channels, 15 embedded data streams
and has multi-language capability. MPEG formal listening tests have demon-
strated that it can provide slightly better audio quality at 96 kb/s than layer-3 at
128 kb/s or layer-2 at 192 kb/s.

Due to its high coding efficiency, AAC is a prime candidate for any digital
broadcasting system. The Japanese authorities were the first to decide to use
AAC within practically all-digital audio broadcasting schemes. Because their
first services will start in the year 2000, this decision has already triggered the
development of dedicated AAC decoder chips at a number of manufacturers. Due
to its superior performance, AAC will also play a major role for the delivery of
high-quality music via the Internet. Furthermore, AAC (with some modifica-
tions) is the only high-quality audio-coding scheme used within the MPEG-4
standard.

The AAC bit stream is encoded in either of two formats:

� Audio Data Interchange Format (ADIF)

� Audio Data Transport Stream Frame (ADTS)
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The corresponding forms are displayed according to the format of the input bit
stream  These forms display the information contained in the fields of the Header
and the Raw Data.

Summary window

Hierarchy window

Analysis window

Error log window
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ADIF Stream Forms

The analyzed information regarding the input ADIF stream is displayed by
means of a property sheet containing three tabs.

The ‘ADIF Header’ tab (Figure 5-1) displays the fields of the header.

Figure 5−1: ADIF header Information

The ‘Raw Data’ tab (Figure 5−2) displays the fields in each raw data block. A
slider control helps to navigate through the various raw data blocks. The
information regarding each raw data block is displayed by means of another
child property sheet containing seven tabs (the fields in each tab are shown in
Figure 5−3 to Figure 5−9).
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Figure 5−2: ADIF raw data Information

The Element Type (below the slider bar) is color-coded; the key is given on the
right side of the display in the Element Types box. The number displayed in the
Element Type color spot indicates the EIT (element instance tag) of that syntactic
element.

The text in the Raw Data tabs is color-coded as follows:

Light Blue indicates the syntactic element is present and activated in the
raw data.

Dark Blue indicates that the syntactic element is present, but currently
inactive in the raw data.

Dark Gray indicates that the syntactic element is not present in the raw data.

Element Color Coding in
the Raw Data Tab

Color Coding of Raw Data
Tabs
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Figure 5−3: Single channel element Information

Figure 5−4: Coupling pair element information
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Figure 5−5: Coupling channel element information

Figure 5−6: Low frequency element channel information
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Figure 5−7: Data stream element information

Figure 5−8: Program configuration element information
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Figure 5−9: Fill element information
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The ‘Channels’ tab (Figure 5−10) displays the configuration of the coded
channels. The physical location of the speakers corresponding to the channels
coded in the stream for standard and non-standard configurations can be
displayed.

Figure 5−10: ADIF channels (non-standard) information
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The syntactic element type corresponding to each speaker in the Speaker-Chan-
nel Mapping is denoted by a color-code scheme, the legend for which is given in
the Ch.Element Types box. The number appearing in the color spots denotes the
EIT (element instance tag) of that syntactic element.

Figure 5−11: ADIF channels (standard) information
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ADTS Stream Forms

The analyzed information regarding the input ADTS stream is displayed by
means of a property sheet containing three tabs.

The ‘ADTS Header’ tab (Figure 5−12) displays the fields of the header, while the
‘Raw Data’ tab displays the fields in each raw data block and the ‘Channels’ tab
displays the configuration of the coded channels. The content of the ‘Raw Data’
and ‘Channels’ tabs are identical to that in the ADIF stream.

Figure 5−12: ADTS header information
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Closed Caption Analysis

Closed captions are captions that are hidden in the video signal, invisible without
a special decoder. The place they are hidden is called line 21 of the vertical
blanking interval (VBI).

ES Analyzer allows closed caption data to be analyzed and inspected.

The two options are:

� CCA Standalone (Player + CC-EIA608 + CC-EI708 analysis)

� Full Elementary Stream Analyzer + CC-EIA608 + CC-EI708 analysis

NOTE. No special installation process is required. The options are dongle
protected/enabled.

The Stand-Alone option has full Closed Caption functionality, but other
ES Analyzer functions are disabled.

XDS analysis is currently disabled. Extended Data Services is a supplementary
data stream existing in Line 21, Field 2. It is used to provide additional data
(primarily content advisory information) on the program being aired 
(Reference: EIA-744).

Enabling Closed Caption Analysis

1. Open a stream containing Closed Captions.

2. Expand the navigation tree and open either a VES or a GOP node.

3. Enable Closed Caption Analysis in the Settings menu. A check mark next to
the option indicates that Closed Caption Analysis is enabled.

NOTE. By default, Closed Caption Analysis is enabled. It is recommended that it
be only enabled when required; disabling it will improve the speed of picture
analysis processing.

However, disabling and enabling the Closed Caption Analysis feature should
only be done when a stream is first opened, not during analysis. Opening the
feature during analysis may result in improper analysis.

When Closed Caption Analysis is enabled, the Closed Caption Display tab
will be visible in the Slice and MB GOP tab.
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4. Ensure that the Picture Display Settings (Settings > Picture Display…) are as
shown in the following screenshot:

� Display Order of Pictures > Presentation Order

� Motion Vector Overlay Colour Selection > White

Selecting Closed Caption Analysis Standard

Two primary forms of Closed Caption Analysis are offered: CC-EIA608 and
CC-EIA708. CC-EIA746 support is also supported in the EIA608 mode.

The selection of CC-EIA608 or CC-EIA708 is made from the Closed Caption
Display tab available in the Slice and MB GOP tab.

NOTE. Whichever standard is selected, no closed caption content will be
displayed until the file has been at least partially analyzed. To start analyzing
the stream, select the GOP And Picture tab and press the Go button.

A sign that closed caption content has been detected during analysis is that the
Video icon in the navigation tree changes to include a CC symbol:

>
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CC-EIA608 Support

The following dialog box is displayed below the picture display (in the Closed
Caption Display tab) when CC-EIA608 Closed Caption Analysis is enabled:

At the top of the display, the LED icons indicate that closed caption data has
been received in the Field and Services sections; green indicates that data has
been received.

If data has been received for the current GOP it should be displayed in the
Display Memory tab and on the picture display:

The remaining tabs (Roll Up, Pop On and Paint On) display various parameters
defining the manner in which the captions will be displayed.
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Associated with CC-EIA608 is CC-EIA746 which supports the transmission of
URLs (Uniform Resource Locators) within the closed caption data.

The URLs transmitted in the T2 closed caption service are parsed, decoded and
displayed in the EIA-746 Data view.

� The attributes shown apply to the URL selected from the drop-down list.

� The selected URL is fetched and displayed on the default Web browser
installed on the system.

CC-EIA708 Support

The following dialog box is displayed below the picture display (in the Closed
Caption Display tab) when CC-EIA708 Closed Caption Analysis is enabled:

Details of the fields in the Closed Caption Analysis window are as follows:

CC–EIA746 Support
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The service whose details are to be displayed can be selected from the drop-
down list.

Sequence No. The sequence number of the packet from which the current
service block has been extracted (for example, Service 1,
Service 2, etc).

Packet Size The packet size that has been coded in the packet header.

Bytes Left The number of bytes still to be received.

Block size The size of the service block.

Bytes Left The number of bytes still to be received.

Active Window The Window ID which is currently the active window.

W# The buttons in red in the W# column indicated the defined
windows in the received service. The parameters to the right of
this column depend on the selection made here.

The text shown in the current window.

Caption Service

Packet Info

Block Info

Window Identity

Window Text
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By placing the cursor over the more… field all the parameters related to the
window definition can be viewed.

Window Definition
Parameters
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By placing the cursor over the more… field all the parameters related to the
window styles can be viewed.

By placing the cursor over the more… field all the parameters related to the pen
styles can be viewed.

Window Style Parameters

Pen Style Parameters
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Dumping Closed Caption Statistics

Closed Caption Analysis statistics can be written to file for each standard
(EIA608 and EIA708).

NOTE. Regardless of which standard is selected, no closed caption statistics can
be dumped until the file has been at least partially analyzed. To start analyzing
the stream, select the GOP And Picture tab and press the Go button.

A sign that closed caption content has been detected during analysis is that the
Video icon in the navigation tree changes to include a CC symbol:

>

The sequence of actions required for a dump of statistics to be successful is as
follows:

1. The Dump CC Statistics option in the Settings menu will only become
available when analysis (or partial analysis) has established that Closed
Caption data is carried in the stream.

2. A standard must be selected from the Dump CC Statistics option sub-menu,
for example, EIA608.

3. A destination file must be specified for the statistics dump.

4. Further analysis must be carried out to provide data for the statistics dump.

The following paragraphs describe the setup required for each standard; however,
the previous steps must be adhered to for the dump to be successful.
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1. Select the EIA608 option from the Dump CC Statistics sub-menu.

2. Enable Dump Statistics.

3. Identify a destination file in the Statistics File: field.

4. Enable the parameters to be dumped.

5. Select OK.

Existing reports (reports that you set up) can be viewed by selecting View
Report.

EIA608 Closed Caption
Statistics Dump
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1. Select the EIA708 option from the Dump CC Statistics submenu.

2. Enable Dump Statistics.

3. Identify a destination file in the Statistics File: field.

4. Enable the parameters to be dumped.

5. Select OK.

Existing reports (that is, reports previously set up) can be viewed by selecting
View Report.

EIA708 Closed Caption
Statistics Dump
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DVB Subtitle Stream Analysis

DVB Subtitling provides a means of conveying region-based bit-mapped
graphics as MPEG-2 packetized elementary streams (PES). The bit-mapped pixel
images are run-length encoded and transmitted with color look-up tables (CLUT)
to a decoder where the stream is decoded and the subtitle image rendered with
the on-screen display.

When a DVB Subtitle node is revealed and highlighted, the screen shown below
is displayed:

NOTE. Some streams may show subtitle nodes from which the Page View
(described below) cannot display any subtitles.

This is not an error, it is because the stream is too short to carry the requisite
data. If possible, record a longer section of the stream and retry the analysis.
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The working area contains two tabs: DVB Subtitle Data and Page View.
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DVB Subtitle Data Tab

The DVB Subtitle Data tab displays the fields associated with the current
display. Access to two areas of detail is provided by pressing the Default CLUT
Table… and the Show Object… buttons.
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The Object View displays a decoded bitmap of the selected object rendered on a
blank screen (that is, with no underlying picture). The fields at the top of the
dialog box, provide the user with the options of changing the decoder type (2-bit,
4-bit or 8-bit), the background color, and the CLUT identity. As described in the
standard, the CLUT is attached to the region, not the object; therefore, the user
can see the bitmap using all of the available CLUTs.

The Object view is displayed by selecting the Show Object… button on the DVB
Subtitle Data tab.

Object View
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The Object view is displayed by selecting the Default CLUT table… button on
the DVB Subtitle Data tab.

NOTE. Subtitles in the UK are colored in a limited set, (red, cyan, green, yellow,
white), one for each of four speakers/actors and white for additional speakers/
actors.

CLUT View
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Page View Tab

On the Page view tab, the regions listed in the Page Composition Segment area
of the DVB Subtitle Data tab are rendered on a blank screen (size 720(H) x
576(W) pixels). The regions and objects are rendered at their actual locations on
the blank screen. The user can select the Decoder Type and Background Color
from the drop-down lists.

NOTE. Background color is not carried in the broadcast. The user can select a
suitable color.
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General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

Use Proper Power Cord. Use only the power cord specified for this product and
certified for the country of use.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

Power Disconnect. The power cord disconnects the product from the power
source. Do not block the power cord; it must remain accessible to the user at all
times.

Do Not Operate Without Covers. Do not operate this product with covers or panels
removed.

Do Not Operate With Suspected Failures. If you suspect there is damage to this
product, have it inspected by qualified service personnel.

Avoid Exposed Circuitry. Do not touch exposed connections and components
when power is present.

Use Proper Fuse. Use only the fuse type and rating specified for this product.

Do Not Operate in Wet/Damp Conditions.

Do Not Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.

Provide Proper Ventilation. Refer to the manual’s installation instructions for
details on installing the product so it has proper ventilation.

To Avoid Fire or
 Personal Injury
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These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result
in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in
damage to this product or other property.

These terms may appear on the product:

� DANGER indicates an injury hazard immediately accessible as you read the
marking.

� WARNING indicates an injury hazard not immediately accessible as you
read the marking.

� CAUTION indicates a hazard to property including the product.

The following symbols may appear on the product:

CAUTION
Refer to Manual

Protective Ground
(Earth) Terminal

Terms in this Manual

Symbols and Terms
 on the Product
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Preface

This manual describes the functions and use of the Tektronix MTS400 Series
MPEG Test System. After the introduction, each section of the manual describes
one of the software applications or tools that make up the MTS400 Series system

Other documents are available on the Tektronix Web site (www.tektronix.com):

� MTS400 Series MPEG Test System Getting Started Manual (071-1505-xx)

� MTS400 Series MPEG Test System Programmer Manual (071-1725-xx)
This manual specifies the remote control and status monitoring interfaces
available to a management application.

Related Material

Additional documentation, such as Read Me files, may be included on the
installation disks.

The following URLs access the web sites for the standards organizations listed
(the URLs listed were valid at the time of writing):

� MPEG-2 standards (International Organization for Standards)
http://www.iso.ch/

� DVB standards (European Technical Standards Institute)
http://www.etsi.org/

� ATSC standards (Advanced Television Systems Committee)
http://www.atsc.org/

� ISDB/ARIB standards (Association of Radio Industries and Businesses)
http://www.arib.or.jp/english/

� SCTE Society of Cable Television Engineers
http://www.scte.org/
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Manual Conventions

Naming conventions for the interface elements are based on standard Microsoft
Windows naming conventions. Naming conventions for MPEG−2, ATSC, and
DVB structures follow the conventions derived from the standards listed above.
In addition, the following formatting conventions apply to this manual:

� Bold text refers to specific interface elements that you are instructed to
select, click, or clear.
Example: Select Settings from the Configuration menu.

� Mono−spaced text can indicate the following:

� Text you enter from a keyboard
Example: Enter the network identity (http://TSMonitor01)

� Characters you press on your keyboard
Example: Press CTRL+C to copy the selected text.

� Paths to components on your hard drive
Example: The program files are installed at the following location:
C:\Program Files\Tektronix\
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Carousel Analyzer - Getting Started

The Digital Storage Media Command and Control (DSM-CC) protocol was
originally developed to provide a VCR-like control mechanism for program
material delivered in an MPEG2 transport stream. Since then, the standard has
evolved to encompass a wide variety of applications including data broadcasting
and interactive television. DSM-CC forms a core part of a variety of both closed
and open standards such as the DVB MHP (Multimedia Home Platform)
standard for European Interactive Television.

The following DTV standards are supported:
(See page 6−97 for details of all references in this section.)

� ISO/IEC 13818-6 Information technology - Generic coding of moving
pictures and associated audio information - Part 6: Extension for Digital
Storage Media Command and Control [MPEG] (Reference [2])

� EN 301 192 Specification for data broadcasting [DVB] (Reference [4])

� ARIB STD - B24 Data Coding and Transmission Specification for Digital
Broadcasting (Reference [11])

� Multimedia Home Platform [DVB] (Reference [12])

A bibliography of DTV standards documentation is given in the Reference
section.

The Tektronix Carousel Analyzer has been developed to meet the specific need
to analyze and display the content and structure of data broadcasts. The tool
provides a variety of ways of looking at a transport stream and its contents
including displaying the bit rate, repetition rates, structure, syntax, and semantics
of data items.
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The program view shows the various services in the transport stream and their
associated PIDs and data streams. Object or data (one or two layer) carousels and
U-U or U-N messages such as DSM-CC Download can also be displayed with
options to view associated, sections, carrier modules, or transport packets for
each version as required.

An object carousel in the stream can be viewed by contents as a directory
structure containing the underlying objects such as Java classes, picture, or text
files. If an object is associated with an installed application then a double-click
will launch that program, providing, for example, an easy and quick way to view
the contents of a picture file or read a text file.

The structure of the U-N download messages can be viewed showing the
relationship between DII, modules and blocks. The associated DSI and DII
messages contained in the U-N-Download tables can also be viewed in inter-
preted or hex fashion; these indicate where to find and view the BIOPs that
contain a required object in the stream.

The timing relationships between the various components can also be easily
shown because the bit rates or the repetition rates of blocks, modules, objects,
U-N messages or SI tables can be shown together in a single graphical display.
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Data Broadcasting Overview

Data Broadcasting allows data to be transmitted in asimilar way to the way in
which video and audio services are delivered to end users. Object and Data
Carousels are intended for the periodic transmission of information in a transport
stream. DVB Data Carousels contain modules of data of unspecified content.
ARIB Data Carousels and Object Carousels contain identifiable data objects, for
example, JPEG files, text files, and application software. Multimedia Home
Platform (MHP) is also supported because the Application Information Table
(AIT) and Object Carousels (as specified in the MHP standard) can be viewed.

The diagram below shows how information carried by data and object carousels
is subdivided and ultimately carried by the transport stream.

Object Carousel:
BIOP Messages

Download Data
Carousel:
Modules and
Blocks

DSM−CC Sections

Block 1 Block 2 Block 3 Block 4 Block 5

Module 1

Section 1 Section 2 Section 3 Section 4 Section 5

Headers are
shown shaded.

ÎÎ
ÎÎ
ÎÎÎ
ÎÎÎ
ÎÎÎÎÎ
ÎÎÎÎÎ

BIOP 1 BIOP 2 BIOP 3 BIOP 4

Ï
Ï

Ï
Ï

Ï
Ï

Transport Packets

BIOP messages contain a message header, a message sub-header and the
message body which contains data. The message body may contain complete
data objects.

BIOP messages are broadcast in Modules. A Module is formed from one or more
concatenated, complete BIOP messages.

Each Module is fragmented into one or more Download Data Blocks which are
in turn transmitted in corresponding DSM-CC Sections.

Sections are transmitted in packets in the Transport Stream.

The Carousel Analyzer enables each layer of the protocol stack to be analyzed
and inspected. The following sections provide an overview of how the Carousel
Analyzer can be used to locate messages and packets of interest.
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Starting the Program

The program can be started by selecting the Tektronix Carousel Analyzer
option from the Start > Programs > Tektronix Data Applications V2.0 menu
or by double clicking on the Tektronix Carousel Analyzer shortcut on the
desktop.

When the program has started and is ready for use, it will open the Main
window, as shown in Figure 6−1:

Menu bar

Toolbars

Workspace

DTV standard

Transport

packet bar

Status bar

Figure 6−1: Main Window - Intial Appearance

Initial Appearance
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Elements of the main window can be hidden during a session, but will be
restored at start-up.

The Menu Bar contains all options available to the application; disabled options
are visible but grayed out. The Toolbars provide shortcuts to the more important
menu options; similarly, disabled buttons are visible but grayed out. The
Transport Packet Bar provides controls to locate and jump to transport packets.
The Status Bar shows stream information and the cursor message field.

The Carousel Analyzer presents different menus and options depending upon
whether or not a stream is open for analysis. The menu options available when
no stream is open are as follows:

File Menu Options. Table 6−1 lists the options in the initial File menu.

Table 6−1: File menu options 

Option Function

Open... Opens an MPEG transport stream for analysis. The program
opens the file selection dialogue allowing the user to choose
the required file.

Print Setup... Opens a dialog for selecting which printer and associated
options to use.

1 <<filename>>
2 <<filename>>
3 <<filename>>
4 <<filename>>

A list of the four most recently analyzed files. If the program
has recently been installed, the list may be empty or hold less
than four files.

Selecting a filename opens that file for analysis.

Exit Finishes running the program.

View Menu Options. Table 6−2 lists the options in the initial View menu.

Table 6−2: View menu options 

Option Function

Toolbars > Submenu shows or hides the toolbar.

Transport Packet Bar Shows or hides the Transport Packet Bar.

Status Bar Shows or hides the status bar.

Initial Menu Options
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Analysis Menu Options. Table 6−3 lists the options in the initial Analysis menu.

Table 6−3: Analysis menu options 

Option Function

Set Interpretation > Select the Digital TV standard to be used for stream analysis.

Settings... Displays a dialog for selecting scripts to be used during
analysis.

The DTV standard to be used for analysis must be selected before any streams
are opened.

Select the required standard from the submenu.

Scripts are available to the Carousel Analyzer to enable structures to be analyzed
successfully.

If any script is not selected or enabled, the stream will not fail to be analyzed,
but any data normally interpreted by that script would be ignored.

Scripts can only be selected and enabled when no files are open. The option is
not available when a file is open.

Handling Script Files. To open the Analysis Settings dialog box, select Settings...
from the Analysis menu.

Stream Interpretation

Script Selection And
Manipulation
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The dialog box shown below is displayed:

In the Analysis Settings dialog, the left window shows a tree structure of the test
protocols available. The right window shows the scripts currently allocated to the
test protocol; in the example, the listed scripts are associated with the DVB -
Section protocol. The right window also contains the controls needed to
manipulate the scripts.

Note that across the standards, the scripts are not hierarchical; that is, each DTV
standard must be self-contained in terms of the scripts that it uses.

The currently available script files are listed in the Reference section
(page 6−97).

The following paragraphs describe the available script manipulation activities.
The activities are applied to the currently selected test protocol.
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Adding a Script file. 

1. With the required test protocol highlighted, select the Add New Script button
(Shortcut key: Insert).

2. If the script path/name is known, enter it into the blank field.

If the script name is unknown, use the browse button at the right side of the
blank field to display a standard Windows file Open dialog box.

3. The new script file name will be added at the bottom of the script list. Note
that script files are parsed in the order that they are listed, because the file
may require moving up in the list – see Moving Script files in the list below.

Removing a Script File. 

1. Highlight the file to be deleted and select the Delete Script button (Shortcut
key: Delete).
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Moving Script Files in the List Script files are parsed in the order that they are
listed; the file may require moving up in the list

1. Highlight the file to be moved and select either the Move Up or Move Down
button (Shortcut keys: Alt-� and Alt-� respectively). The file will move up
or down one place for each press of the button.

A number of options are available from the Analysis Settings dialog that allow
strict syntax checking to be enabled and disabled.

If any option is not enabled, the relevant syntax will not fail to be checked, but
will be interpreted more loosely.

Syntax Checking Options can only be selected and enabled when no files are
open. The option is not available when a file is open.

Currently, three syntax checking options are available:

Strict private data length/Message length checking. Object: U-U Object Carousel 
Disabling this option allows the privateDataLength field where it exists in the
DSI to be set to zero. The application will calculate it when required, using the
total message length and the position of the private data in the message. 
(See reference [2], sections 2 and 7.3.6.)

Strict association tag checking. Object: U-U Object Carousel 
The association tag field in the stream_identifier_descriptor is an 8-bit value,
while the same field in an object carousel is a 16-bit value. When comparing
these two values, the MSB of the 16-bit value should be zero. Disabling this
option allows it to take other values.
 (See reference [4], 9.3 paragraph 3 and [6], paragraph 4.7.7.3.)

Syntax Checking Options
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Strict CRC/Checksum checking. Object: DSM-CC Section
section_syntax_indicator and private_indicator fields should be the complement
of each other to determine whether a CRC or checksum is in use. Disabling this
option allows them to be the same and allows the application to work out which
method should be applied.
(See reference [2], section 9.2.2 paragraphs 3 and 4.)

Enabling a Syntax Checking Option. To open the Analysis Settings dialog box
select Settings... from the Analysis menu.

Select the Options tab. The dialog shown below is displayed:

In the Analysis Settings dialog box, the left window shows a tree structure of the
test protocols available. The right window shows the options currently allocated
to the test protocol; note that currently, options are only applicable to DSM-CC
Sections and U-U Object Carousels. Available options are applicable to all
standards, for example, an option set in the DVB DSM-CC Section will be
applied in the MPEG and ARIB protocols.
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Any Transport Stream file can be opened for browsing by the Carousel Analyzer.
However, only those streams containing Data and/or Carousel Objects will
provide meaningful results. Tektronix’s Transport Stream Analyzer should be
used for normal stream analysis. Only one file can be opened at a time.

To open a file, select File > Open.... If the required file is in the list of recently
analyzed files, then it can be opened from the list to save using the open file
dialog box.

Alternatively, use the Ctrl+O keyboard shortcut.

There is a shortcut button available on the Toolbar for opening a file, which uses
the standard file open symbol:

As the file opens, a progress bar is displayed; analysis may require more than
one pass through the transport stream file. The current pass number is shown in
the title line. After the first pass, a second progress bar (new resolved links)
shows the number of unresolved links at each pass.

Opening a Stream File
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Analysis can be halted at any time by selecting the Stop button in the dialog
box; the stream is still opened, but only the elements that have been analyzed so
far will be displayed.

By default, the Services window and the Log window open as soon as a stream
file opens. Further windows can be opened by using the View Menu or the
Toolbar. Note that although the options on the View menu remain the same, they
are enabled or disabled according to which protocol element is highlighted at the
time.
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Menus and Controls

The following pages contain descriptions of the menu options, toolbar controls,
status bars, and methods for managing the workspace.

Menu Options

The following pages describe all of the menu options. Since many of the options
are context sensitive, they will be available only when their function is appropri-
ate for the selected window or display element. When a menu option is not
available, the option is grayed out.

File Menu Options. Table 6−4 shows the options available in the File menu.

Table 6−4: File menu options 

Command Function

Open... Open an MPEG transport stream for analysis. The program
opens the file selection dialogue box allowing the user to
choose the required file.

Close Closes the current file.

Save As... Saves the file to a new file name.

Print Opens the Print dialog.

Print Preview Opens the Print Preview dialog.

Print Setup... Opens the Print Setup dialog.

Exit Closes any file that is open and terminates execution of the
program.

Edit Menu Options. Table 6−5 shows the options available in the Edit menu.

Table 6−5: Edit menu options 

Command Function

Applications Opens the Application Management dialog.

Go To Next Jumps to next occurrence of the structure being viewed. The
Packet field in the Transport Packet bar will reflect the change
of packet.
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View Menu Options. Table 6−6 shows the options available in the View menu.

NOTE. An active (depressed) button next to an option indicates that the window
or toolbar is currently visible; an inactive button means that it is hidden.

Table 6−6: View menu options 

Command Function

Toolbars > Submenu shows or hides the toolbar.

Transport Packet Bar Shows or hides the Transport Packet Bar.

Status Bar Shows or hides the Status Bar.

The remaining options in this menu open and close the associated window. The
options and windows are described elsewhere in this section.

� Program/Services, U-N Download, Object Carousels, Data Carousels, PIDs
and Log.

� BIOP Message, U-N Message, Section, Transport Packet, Transport Packet
List, Hex Dump, Timing, Carrier and Resources.

� Repitition and Bitrate.
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Graph Menu Options. Table 6−7 shows the options available in the Graph menu.

Table 6−7: Graph menu options 

Command Function

Zoom Applies to Bitrate and Repetition views only.

Zoom In: Maximizes the central 50% (x-axis) of the current
graph.

Zoom Out: Takes one step back in the Zoom sequence.

Show All: Resets the graph to show all points.

Save Saves the graph in the selected format.

Copy Copies the graph to the clipboard in the selected format.
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Window Menu Options. Table 6−8 shows the options available in the Window
menu.

Table 6−8: Window menu options 

Command Function

Cascade Rearranges the windows like this:

Tile Tiles the windows. For example, four windows would be tiled
like this:

Arrange Icons Aligns icons of any minimized windows at the bottom of the
program’s main window.

1 <<window title>>
2 <<window title>>
3...etc

Makes the named window active, putting it on top of any
windows that had been hiding all or part of it.
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Help Menu Options. Table 6−9 shows the options available in the Help menu.

Table 6−9: Help menu options 

Command Function

Quick Help Opens the Quick Help browser window.

About Carousel Analyzer Opens a message box that displays the program version
number and license number. This information will be required if
Tektronix Technical Support is contacted.

Toolbars

Quick access buttons are divided between several toolbars: File, Edit, View and
Help.

A number of the toolbar functions are context-sensitive; which window is open
and which element is highlighted will dictate which buttons are enabled and
disabled.

Open a file. This button is disabled when a file is open.

Save As… - BIOP file messages can be saved to separate files.
Structures can also be saved to a separate file.

Print – only available for bit rate and repetition views.

Jumps to next occurrence of the structure being viewed.

File Toolbar

Edit Toolbar
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The buttons in this toolbar open and close the associated windows. The windows
are described elsewhere in this manual.

View Programs/Services View Section

View PIDs View Transport Packet

View Object Carousels View Bitrate

View Data Carousels View Repetition Rate

View U-N Download Mes-
sages

View Lifetime

View Log Zoom In

View BIOP Message Zoom Out

View U-N Message Show All

Edit Application Timing View Carousel Cycle Time

View Entity Cycle Time View Carousel Cycle Time
Graph

View Entity Cycle Time
Graph

About Carousel Analyzer: Opens a dialog box which displays the
program version number and license number. This information will be
required if a Tektronix Technical Support is contacted.

View Toolbar

Timing Toolbar

Help Toolbar
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Transport Packet Bar

The Transport Packet bar provides a quick method of locating and navigating to
transport packets PIDs.

Packet: To locate a particular Transport Packet, enter the Trans-
port Packet number and select Goto.

PID Filter enable: The PID navigation feature can be enabled by selecting
the checkbox (as shown).

To navigate to a specific packet: with the PID Filter disabled, enter the packet
number and select either the Previous or Next Packet button. If a PID structure
view is now requested from a View, the search for the PID will commence with
the transport packet number displayed.

Similarly, with the PID Filter enabled, each press of either the Previous/Next
button will display the previous/next transport packet containing the PID number
displayed in the PID Number field. If a PID structure view is now requested
from a View, the search for the PID will commence with the transport packet
number displayed.

NOTE. When a Transport Packet is viewed, the number in the Packet field will
increment by one.

The Transport Packet bar can be hidden from view by using the View menu
Toolbars option.
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Status Bar

The Status bar provides information about the stream that is currently being
displayed. A message field gives a description of the button, menu or option that
the cursor is resting on; other non-critical messages may also be shown.

Message field

DTV analysis
standard

Transport packet
total

Stream bit
rate

Stream
length
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Workspace

In addition to the generic Cascade and Tile options available from the window
menu, management of individual windows is provided through a submenu
available by right-clicking the title bar of the individual window.

Right-click window title bar:

Each window within the workspace can be designated as Docked, Floating, or as
an MDI Child.

Docked. When docked, a window will be automatically placed against one of the
four sides of the workspace.

For example, selecting Docked > Top will dock the selected window at the top
of the workspace.

Window Management
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Floating. Designating a window as floating allows it to be moved around on the
monitor desktop independently of the Carousel Analyzer interface.

For example, selecting Floating will allow the window to be moved anywhere on
the desktop:

MDI Child. Designating a window as an MDI Child allows it to be moved
anywhere within the workspace.

The MDI Child submenu allows the window to be designated as Restored,
Minimized or Maximized.

NOTE. When a window is “docked” it can be dragged (and dropped) around the
workspace; when it is at an edge it will adopt a docked position. MDI Children
do not attempt to dock with the edges of the workspace.
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Most of the views described later use a split-pane arrangement to display the
view data and related version, file size and PID information. The information is
displayed in the right pane. However, the default arrangement when opening the
view is that the right pane is closed. To open the pane, pass the cursor over the
right edge of the view until it changes to the split pane cursor, then move the
dividing bar to the desired position.

The principles employed in displaying the information in each workspace
window are applicable to all windows, although the content will vary from
window to window.

Tree Structure. Structures are represented by tree diagrams, with the “root node”
or highest level component at the top. Components that contain more informa-
tion underneath them in the structure are indicated by a + box. Clicking on the +
box will display the structure underneath the node. Similarly, if a - box is
adjacent to the node, the level of detail immediately below it is already dis-
played; this detail can be hidden by clicking on the - box. Components that are
connected to a branch of the tree without a square box are leaf nodes; they
display the lowest and finest level of detail.

Right-clicking on a tree node may open a context sensitive menu.

Component Selection. Components can be selected (or highlighted) either singly
or in groups. When selected, the views available from the View menu (or a
right-click menu) will be those that can be applied to all of the selected
components.

Version/Size Pane Display

Content Management
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Single component selection
Selected by clicking on a component.

Range selection
Selected by highlighting the first
component in the required selection
and, while holding the Shift key on
the keyboard, clicking on the last
component. The selected range will be
highlighted.

Multiple component selection
Selected by holding the Control key
(CTRL) on the keyboard and clicking
the required components.

Node selection
Selected by holding the Alt key on the
keyboard and clicking the required
node; all subcomponents will be
selected.
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Saving Components. Selected (or highlighted) components can be saved through
the right-click menu. However, the manner in which the components were
selected (see previous paragraphs) will affect the file structure of the saved
components.

If a Node Selection has been made, the directory structure is recreated at the
specified location and the subcomponents are saved to their equivalent directo-
ries.

If a Range or Multiple selection has been made, all files will be duplicated in the
root directory at the specified location in addition to recreating the directory
structure and saving the sub-components to their equivalent directories.

Hex Displays. Hex displays follow a common format.

The eight-digit number in the left column is the address of the first (that is, left)
byte in the row. The addresses themselves are shown in hexadecimal format.

The center column displays the contents of the structure in hex format.

The right column displays the contents of the structure in ASCII format.
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Views

The Carousel Analyzer provides three types of view as a means of inspecting and
analyzing information carried in a transport stream.

Static Views:
(Programs/Services, Object Carousel, U-N Download, Data Carousel, PID, Log)
Static views display information derived from the transport stream when it is
opened.

Structure Views:
(Transport Packet, U-N Messages, Module, Section, BIOP Messages)
Structure views use Tektronix scripting technology to analyze structures that
appear in the transport stream, for example, tp, and BIOP messages. For repeated
structures, this view allows all occurrences to be visited.

Chart Views:
(Bitrate, Repetition Rate)
Chart views present timing information in graphical form about one or more
structure in the stream.

View Page View Page

Programs/Services View 6−30 Structure Views 6−52

Object Carousel View 6−34 Bitrate View 6−55

U-N-Download View 6−41 Repetition View 6−58

Data Carousel (DVB) View 6−45 PID View 6−61

Data Carousel (ARIB) View 6−46 Log View 6−64

Resource View 6−50 Cycle Times View 6−67

In the following sections, each view is described together with the information
accessible from that view.
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The nodes displayed in the views relate to the protocol layers as shown in the
diagram below:

Table 6−10: Key to Tree Nodes 

Service/Program Active PIDs/PIDs

Download Block BIOP Object Directory / ARIB
Directory

U-N Message BIOP Object / ARIB Resource

Download Module Table

Compressed Download Module Transport Packet

Data Carousel Audio Stream

Object Carousel Video Stream

Stream Object Data/Other Stream

Stream Event Object MHP Applications

Java Application HTML Application
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Key to Node Overlays. Overlays are used to signify additional information about
nodes; the overlays may be used individually or in combination.

Absent Objects: 
Objects referenced but not found, for example, directory object not found.
The path in which the absent object is recognized is also marked.

Unresolved Objects: 
When an object is found during analysis, but its key is not referred to in the
Service Gateway, it is displayed under an Unresolved Objects node.

Boot Class Objects: 
Boot class items are identified. The path in which the boot class resides is
also indicated.

Manual Signaling: 
Indicates that a PID has been subjected to the manual signaling process;
used in the carousel and PID views only.
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Programs/Services View

Menu Bar: View > Program/Services Toolbar: 

The Programs/Services view gives a static, DVB/ARIB service (or MPEG
program) centric view of the transporst stream contents. Each program is listed
together with the service name (for DVB/ARIB). Expanding a program item will
reveal its elemental PIDs and any object (or data) carousels associated with it.

Figure 6−2: DVB Programs/Services view (typical)
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Figure 6−3: ARIB Programs/Services view (typical)

The diagram below indicates the primary nodes that are accessible from the
Program/Services view.

Service/Program node

Elementary
PID node

Table node

See
Object/Data
Carousel View
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  This node represents a specific program or service (DVB or ARIB) in a
transport stream. If a name for the program is available in the SDT (Service
Description Table), it is displayed. Each Elementary PID listed in the PMT
(Program Map Table) will have a corresponding node displayed as a child node
of the Services/Program node. Similarly, any Object or Data Carousels associat-
ed with the Services/Program node are listed as child nodes.

Right-Click Menu Options. 

View PMT Opens the Section Table view for the PMT.

View Bitrate Activates or creates a bit rate view of the sum of the ele-
mentary streams that are listed in the PMT for this pro-
gram.

    This node represents a PID referenced by a program. If the PID
carries Sections, these are represented as Table nodes.

Right-Click Menu Options. 

View Transport Packet
Displays a structure view of the next transport packet
encountered on this PID from the current stream posi-
tion (as indicated by the Transport Packet number that is
displayed in the Transport Packet Bar).

View Cycle Time  � Allows either cycle time statistics or graphical view to
be selected.

View Repetition Activates or creates a view of the repetition rate of this
PID in the transport stream.

View Bitrate Activates or creates a bit rate view of this PID.

Service/Program Node

Elementary PID Node
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  This node represents the stream of sections present on a specific PID with a
specific table identity.

Right-Click Menu Options. 

View Section  Displays a structure view of the next section with this
PID and table identity that can be formed from the cur-
rent stream position onwards (as indicated by the Trans-
port Packet number displayed in the Transport Packet
Bar).

View Cycle Time  � Allows either cycle time statistics or graphical view to
be selected.

View Repetition Activates or creates a view of the repetition rate of this
PID with this PID and table identity.

View Bitrate Activates or creates a bit rate view of sections with this
PID and table identity.

Table Node
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Object Carousel View

Menu Bar: View > Object Carousels Toolbar: 

The Object Carousel view shows a static view of every object carousel in the
transport stream.

The view is in the style of Windows Explorer. The left pane shows the directory
structure of the object carousels, and the right pane lists the versions of the BIOP
message currently selected in the left pane.

Double-clicking a file BIOP message can bring up an appropriate viewer
application if the operating system can find one (file associations can be set
through the Windows Explorer Options). File BIOP messages can also be saved
to disk by selecting File > Save As....

NOTE. The version number of the BIOP messages represents the version number
of the module that carries the BIOP message.
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The following diagram indicates the nodes accessible from the Object Carousels
view:

BIOP Message node

Object Carousel node

  This node indicates that an object carousel has been signaled in the PSI/SI.

Right-Click Menu Options. 

View Application Timing
Opens the Application Management dialog.

View DSI Carrying Carousel IOR 
Displays a structure view showing the U-N DSI message
that carries the service gateway IOR for this carousel.

   This node represents a specific BIOP Message. If the node represents a
BIOP directory, the directory entries appear as child nodes.

Right-Click Menu Options. 

Open View the message in its native format. This only works
for file messages that have an associated viewer applica-
tion on the PC.

Save As… Save the BIOP message to a separate file.

View BIOP Message Displays a structure view of the next appearance of this
BIOP message that can be formed from the current
stream position onwards (as indicated by the Transport
Packet number displayed in the Transport Packet Bar).

Object Carousel node

BIOP Message node
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View Carrier Module Activates or creates the U-N download view and high-
lights the module that carries this BIOP message.

View Cycle Time  � Allows either cycle time statistics or graphical view of
the carousel to be selected.

View Repetition Activates or creates a view of the repetition of this BIOP
message.

View Bitrate > This BIOP message: Activates or creates a view of
the bit rate of this BIOP message.

> Including nested messages: View the sum of the bit
rates for this BIOP message and all descendant messages
(that is, all children and their children). These options
are only available for BIOP directory messages.

NOTE. If a Service Gateway is viewed in the Bitrate, Repetition, or Structure
view, its name in these views reflects the DSI transaction ID and PID in which it
was carried.
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(See MHP Support, page 6−91.)

When an object is found during analysis, but its key is not referred to in the
Service Gateway, it is displayed under an Unresolved Objects node.

However, when a directory object is found, the keys of its child nodes can be
resolved and its tree structure built correctly, even though the directory object
itself may still be unresolved.

MHP Applications

Unresolved Objects
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Objects referenced but not found are identified, for example,  - directory
object not found. The path in which the absent object is recognized is also
marked ( ).

Absent Objects
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If a carousel is present in a stream, but has not been found during analysis, it can
be identified with Manual Signaling from the related PID node.

The Signal Carousel command can be found on the right-click menu associated
with each PID node. When this command is selected, the stream will be
reprocessed. During processing, only the DSM-CC tables on the selected PID
will be analyzed.

The user interface is updated when the stream has been processed. Any carousels
that have been identified are added to the Carousel view. The signal icon, used
inly in the carousel and PID views, indicates that the PID has been subjected to
the manual signaling process.

The PID view will display a list of the table types that were detected during
processing.

NOTE. Carousels that span multiple PIDs will be only partially analyzed. 
The PID must contain a Service Gateway for any Object Carousel view to be
displayed.

The Log view is refreshed by describing the most recent action, for example,
Added Manually Signalled PID150….

Manual Signaling
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Any feedback from the Manual Signaling will be displayed in the Summary log.
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U-N-Download View

Menu Bar: View > U-N-Download Toolbar: 

This static view shows all the U-N-download (DSM-CC data carousel scenario)
messages in the transport stream.

The view is in the style of Windows Explorer. The left pane contains a hierarchi-
cal pane on the left and a version pane on the right. The version pane will list the
versions of the U-N download message selected in the left pane.

DII items contain module items that the DII message references. All modules are
also listed under the “Modules” item.

Modules may be in compressed form; the version of the compressed icon is
displayed in the Version column of the right pane. 

Modules are listed independently of DII messages in case the DII does not
reference the module correctly; for a compliant stream, each module is listed as a
child of the DII node and within the Modules node.
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The following illustration indicates the nodes that are accessible from the U-N
Download view.

U−N Message
(DSI) node

U−N Message (DII)
node

Download Module
node

Download Block
node

  This node represents a Download Server Initiate message.

Right-Click Menu Options. 

View U-N Message Displays a structure view of the next appearance of this
DSI message that can be formed from the current stream
position onwards (as indicated by the Transport Packet
number displayed in the Transport Packet Bar).

View Carrier Section Displays a structure view of the next appearance of the
section that carries this DSI message.

View Cycle Time  > Allows either cycle time statistics or graphical view of
the object to be selected.

View Repetition Activates or creates a repetition view of the DSI mes-
sage.

View Bitrate Activates or creates a bit rate view of the DSI message.

U-N Message (DSI) node



Carousel Analyzer - Views

MTS400 Series MPEG Test Systems User Manual 6−43

  This node represents a Download Information Indication message. A DII
message may reference modules. If the module reference can be resolved, the DII
tree node will contain child Module nodes.

Right-Click Menu Options. 

View U-N Message Displays a structure view of the next appearance of this
DII message that can be formed from the current stream
position onwards (as indicated by the Transport Packet
number displayed in the Transport Packet Bar).

View Carrier Section Displays a structure view of the next appearance of the
section that carries this DII message.

View Cycle Time  > Allows either cycle time statistics or graphical view of
the object to be selected.

View Repetition Activates or creates a repetition view of the DII mes-
sage.

View Bitrate Activates or creates a bit rate view of the DII message.

   This node represents a U-N Download Module. The download blocks
that constitute the module are listed as child nodes.

Right-Click Menu Options. 

View Hex Dump Displays a data view of the next appearance of this mod-
ule that can be formed from the current stream position
onwards (as indicated by the Transport Packet number
displayed in the Transport Packet Bar).

View Cycle Time > Allows either cycle time statistics or graphical view of
the object to be selected.

View Repetition Activates or creates a repetition view of the module.

View Bitrate Activates or creates a bit rate view of the module.

U-N Message (DII) node

Download Module node
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  This node represents a U-N Download Data Block (DDB).

Right-Click Menu Options. 

View U-N Message Displays a structure view of the next appearance of this
DDB message that can be formed from the current
stream position onwards (as indicated by the Transport
Packet number displayed in the Transport Packet Bar).

View Carrier Section Displays a structure view of the next appearance of the
section that carries this DDB message.

View Cycle Time  > Allows either cycle time statistics or graphical view of
the object to be selected.

View Repetition Activates or creates a repetition view of the DDB mes-
sage.

View Bitrate Activates or creates a bit rate view of the DDB message.

Block node
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Data Carousel (DVB) View

Menu Bar: View > Data Carousel Toolbar: 

This static view shows all the data carousels in the DVB transport stream. The
view is in the explorer style with a hierarchical view in the left pane and a
version view in the right.
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Data Carousel (ARIB) View

Menu Bar: View > Data Carousel Toolbar: 

This static view shows all the data carousels in the ARIB transport stream. The
view is in the explorer style with a hierarchical view in the left pane and a
version view in the right.

The diagram below indicates the nodes that are accessible from the Data
Carousel (ARIB) view.

Carousel node

Download Module
node

Resource node
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  This node represents a single Data Carousel in the ARIB data carousel
structure.

Right-Click Menu Options. 

View U-N Message Displays a structure view of the next appearance of this
DII message that can be formed from the current stream
position onwards (as indicated by the Transport Packet
number displayed in the Transport Packet Bar).

View Carrier Section Displays a structure view of the next appearance of the
section that carries this DII message.

View Cycle Time  > Allows either cycle time statistics or graphical view of
the object to be selected.

View Repetition Activates or creates a repetition view of the DII mes-
sage.

View Bitrate Activates or creates a bit rate view of the DII message.

  This node contains all of the resources available to a module.

Right-Click Menu Options. 

View Resources Displays the Resource view of the selected module.

Save Resources Saves the resource files to a selected location. The head-
er information is not saved.

View Cycle Time  > Allows either cycle time statistics or graphical view of
the object to be selected.

View Repetition Activates or creates a repetition view of the module.

View Bitrate Activates or creates a bit rate view of the module.

(See also ARIB Module Versions, page 6−49.)

Carousel node

Download Module node



Carousel Analyzer - Views

6−48 MTS400 Series MPEG Test Systems User Manual

  Each Resource node is a leaf node containing one resource file.

Right-Click Menu Options. 

Open Opens the resource in an associated application to allow
it to be viewed. If no association has been made with the
file type on the host computer, a message is displayed.

Save Saves the resource file to a selected location. The header
information is not saved.

View Displays the Resource view. The selected resource is
highlighted in the Resource view.

Resource node
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Note that there may be multiple versions of a single ARIB module. Each version
of the same module can potentially contain different resources. For example,
Version 1 may contain resources A, B, and C and Version 2 may contain
resources C, D, and E.

When viewing the resources in Data Carousel and Service/Program views, the
resources listed under the Module node will be all resources across all versions,
for example, A, B, C, D and E. When opening or saving any of these resources
from Data Carousel or Service/Program views, the operation will work on the
first version encountered in the stream (A, B, and C will come from Version 1
and D and E will come from Version 2). Basically, these two views contain a
summary of all the resources encountered in that module regardless of version.

The ARIB Resource view will show only the resources contained in an
individual module version - to view resources from different module versions,
the user must use the Go To Next command or open a different version in ARIB
Resource view.

ARIB Module Versions



Carousel Analyzer - Views

6−50 MTS400 Series MPEG Test Systems User Manual

Resource View

Menu Bar: View > Resources

The ARIB Resources view displays a hierarchical and raw data interpretation of
the resource structure in Data Carousels. The raw data is presented in hexadeci-
mal and ASCII form in the adjacent pane.

Resources
node

Resource
node

Data

  This Resources node displays a header and the resources associated with
one Module.

Right-Click Menu Options. 

  Go To Next Displays the next occurrence of the Resource node in the
transport stream (note the change of Packet number in
the Status bar).

Save Saves the resource files to a selected location. The head-
er information is not saved.

Resources node
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  Each Resource node displays header information and a resource.

Right-Click Menu Options. 

Open Opens the resource in an associated application to allow
it to be viewed. If no association has been made with the
file type on the host computer, a message is displayed.

Save Saves the resource file to a selected location. The header
information is not saved.

Represents the currently selected tree node.

Right-Click Menu Options. 

 Save As… Saves the Module Resource data to a selected location.

 Go To Next Displays the next occurrence of the Resource node in the
transport stream (Note the change of Packet number in
the Status bar).

View Transport Packet List
Displays the Transport Packet Contributions view
which lists the transport packets that have contributed to
the resources in the module (See Structure Views,
page 6−52).

Resource node

Data
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Structure Views

Structure views display a hierarchical and raw data interpretation of a structure
(BIOP Message, U-N Message, Module, Section, or Transport Packet). The
hierarchical view is based on a script from the script files that are loaded (see
Script Selection and Manipulation, page 6−6). Raw data is presented in
hexadecimal and ASCII format in the lower pane.

Highlighting an element in the table window will automatically highlight the
section of the hexadecimal code that contains the selected information.

The view will bring up the first appearance of a particular message in the
transport stream reading from the current packet position. To view the next
appearance, select Edit > Go to Next. This will display the next repetition of the
message in the open structure view window; if necessary, it will wrap to the first
occurrence.

For example, in the screenshot below, the PAT first appears in transport packet 0.
Selecting Go to Next and viewing the section again will show the next repetition
of the PAT on transport packet 532 and so on.
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Since the structure view is based on a script, the script can be edited and the
presentation of the packet or message changed.

Right-clicking on the any item in the structure view will open this menu:

Using the Save As… option, the structure can be saved to a separate file.

The Go To Next option moves the structure view to the next repetition of the
same item. If the current view is the last in the stream, the option will loop back
to the first repetition in the stream.



Carousel Analyzer - Views

6−54 MTS400 Series MPEG Test Systems User Manual

The information displayed by the structure view may be carried in one or more
transport packets. By right-clicking the item and selecting View Transport
Packet List, a list of the transport packets carrying the information will be
displayed. Highlighting a Packet Number and selecting View will display the
selected transport packet structure. Several structure views can be opened in this
way but the views are not enabled until the Transport Packet Contributions
dialog is closed.

The Low and High Index entries in the Transport Packet Contributions dialog
box indicate the first and last byte respectively of the packet that contributes to
the structure.

The screenshots below illustrate an example of this sequence of actions:
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Bitrate View

Menu Bar: View > Bitrate Toolbar: 

This structure view charts the bit rate of a set of transport entities (for example,
BIOP message, PID, module). The bit rate calculation is a rolling average. For
any transport entity the sum of the transport packets that contribute to that entity
in each 100 ms time-slice are summed. The average is calculated every 100 ms
using the last 10 time-slices (that is, the bit rate is the average over the last
second).

In some cases a choice is offered between displaying the bit rate of the selected
element or a composite bit rate of the selected element and its subsidiary (nested)
elements.

NOTE. In calculating bit rates, Carousel Analyzer returns to the stream file. For
large files, the calculation may take an appreciable amount of time.



Carousel Analyzer - Views

6−56 MTS400 Series MPEG Test Systems User Manual

The y-axis is automatically scaled to accommodate the maximum bit rate. The
name of the element from which the bit rate is derived and the related graph are
linked by color; a line (of the same color) is displayed to the right of the element
name.

If the bit rate for a second element is requested, it is displayed on the same
graph, as shown in the following illustration:

Any number of element bit rates can be displayed; each will be a separate color.
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It is possible to zoom in on an area of the graph in order to inspect the bit rate in
detail.

To zoom in on the central 50% of the displayed graph, use the  Graph > Zoom

> Zoom In menu option (or the Toolbar button: ; or tab key). This action can
be repeated.

To zoom in on any area of the bit rate graph, drag the mouse while holding the
left-button, to highlight the area required. When the mouse button is released, the
highlighted area will be enlarged to fill the graph area.

The menu option Graph > Zoom > Zoom Out (Toolbar: ; or shift-tab key)
will zoom out one step at a time; a step being the previous zoom in actions.

The menu option Graph > Zoom > Show All (Toolbar: ) will redisplay the
graph with no zoom factor applied.

The graph can be saved or copied in text format or as a picture file (JPEG or
bitmap).

Menu Option Description

Graph > Save Save the graph to a user defined location.

> Bitmap Size the graph window before saving.

> JPEG Size the graph window before saving.

> Table Tab delimited format.

Graph > Copy Copy to clipboard, from where it can be pasted into a suitable
application:

> Image

> Table Tab delimited format.

Inspecting Bitrates

Saving/Copying
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Repetition View

Menu Bar: View > Repetition Toolbar: 

This structure view charts the repetition of a set of data broadcast entities. This
Gantt style graph displays a row for each transport entity (for example, BIOP
message, U-N message etc) selected. A colored block on the row indicates the
presence of the message at that point in the transport stream.

NOTE. In calculating repetition rates, Carousel Analyzer returns to the stream
file. For large files, the calculation may take an appreciable amount of time.

It is possible to zoom in on an area of the graph in order to inspect the repetition
rate in detail.

To zoom in on the central 50% of the displayed graph, use the View > Zoom >
Zoom In menu option (or the Toolbar button). This action can be repeated.

To zoom in on any area of the repetition rate graph, drag the mouse while
holding the left-button, to highlight the area required. When the mouse button is
released, the highlighted area will be enlarged to fill the graph area.

Inspecting Repetition
Rates



Carousel Analyzer - Views

MTS400 Series MPEG Test Systems User Manual 6−59



Carousel Analyzer - Views

6−60 MTS400 Series MPEG Test Systems User Manual

The View > Zoom > Zoom Out menu option (Toolbar:  or shift-tab key)
will zoom out one step at a time; a step being the previous zoom in actions.

The View > Zoom > Show All menu option (Toolbar: ) will redisplay the
graph with no zoom factor applied.

Tooltips: When the cursor is placed over a block, a tooltip provides the PID,
time, and packet number.

The graph can be saved or copied in text format or as a picture file (JPEG or
bitmap).

Menu Option Description

Graph > Save Save the graph to a user defined location.

> Bitmap Size the graph window before saving.

> JPEG Size the graph window before saving.

> Table Tab delimited format.

Graph > Copy Copy to clipboard, from where it can be pasted into a suitable
application.

> Image Copy image.

> Table Tab delimited format.

Saving/Copying
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PID View

Menu Bar: View > PIDs Toolbar: 

This static view displays all the active PIDs within the transport stream. A PID
carrying sections will have nested items, which detail the table types on that PID.
The structure, bit rate, and repetition of transport packets and sections are
available from this view.

The following diagram indicates the nodes accessible from the PIDs view.

Active PIDs node

PID node

Table node
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  This node represents all the PIDs found in the current transport stream; the
PIDs are listed as child items.

Right-Click Menu Options.  

View Transport Packet
Displays a structure view of the packet at the current
stream position (as indicated by the Transport Packet
number displayed in the Transport Packet Bar).

  Represents all the transport packets with a particular PID. If the PID carries
sections then the PID tree node will have child table tree nodes.

Right-Click Menu Options.  

View Transport Packet
Displays a structure view of the next transport packet
encountered on this PID from the current stream posi-
tion (as indicated by the Transport Packet number dis-
played in the Transport Packet Bar).

View Cycle Time > Allows either cycle time statistics or graphical view to
be selected.

View Repetition Activates or creates a view of the repetition of this PID
in the transport stream.

View Bitrate Activates or creates a view of the bit rate of this PID.

Active PIDs node

PID node
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  This node represents the stream of sections present on a specific PID with a
specific table identity.

Right-Click Menu Options.  

View Section  Displays a structure view of the next section with this
PID and table identity that can be formed from the cur-
rent stream position onwards (as indicated by the Trans-
port Packet number displayed in the Transport Packet
Bar).

View Cycle Time > Allows either cycle time statistics or graphical view to
be selected.

View Repetition Activates or creates a view of the repetition rate of this
PID with this PID and table identity.

View Bitrate Activates or creates a bit rate view of sections with this
PID and table identity.

Signal Carousel (See Manual Signaling, page 6−39.)

Table node
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Log View

Menu Bar: View > Log Toolbar: 

The log view is a tabbed window with each tab representing information about a
particular MPEG-2 layer. Each tab contains any miscellaneous information about
the transport stream that has been analyzed. For example, packets that have the
transport_error_bit set will have an entry in the transport log tab.

The diagram below indicates the information that is accessible from the Log
view.

This view provides a summary of the transport stream analysis.Summary
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  This view displays the errors that have been logged in transport packets
during analysis of the stream.

Right-Click Menu Options.  

View Transport Packet Displays a structure view of the highlighted
transport packet.

Transport Packet Log view
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  This view displays the errors that have been logged in sections during
analysis of the stream.

Right-Click Menu Options.  

View Section Displays a view of the highlighted section.

This view displays the errors that have been logged in DSM-CC sections during
analysis of the stream.

Right-Click Menu Options.  

View Section Displays a view of the highlighted DSM-CC section.

This view displays the warnings that have been logged in U-U Object sections
during analysis of the stream.

Section Log view

DSM-CC Section Log view

U-U Object Carousel
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Cycle Times View

Cycle times can be calculated for either a carousel (given a starting point) or an
entity in the transport stream.

In the following diagram, a carousel is shown carrying objects A, B and C.

In this example, object B is identified as the starting point for both carousel and
entity cycle timing. The cycle time of a carousel is the time taken to receive all
of the objects within the carousel given a specified starting point in the carousel.
The cycle time of any given entity in the transport stream (including Section,
BIOP Object, PID and U-N Message) is the time taken from the start of an
instance to the start of the next instance.

The cycle times calculated give the maximum, minimum and mean times for the
occurrences of an object in a transport stream in seconds; standard deviation and
number of cycles found will also be displayed. The statistics can also displayed
in graphical format.
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The cycle time of an object carousel is the time taken for all components of the
carousel to be received starting with a selected component of the carousel.

Selecting one or more BIOP objects from a carousel and View Carousel Cycle
Time from the right-click menu generates the Carousel Cycle Times statistics
window. The information can also be displayed in graphical form by selecting
View Carousel Cycle Time Graph.

In the Carousel Cycle Times window, the BIOP Object column identifies the
PID, Carousel ID and Object that the user identified as a starting point for the
test.

The information can also be displayed in graphical form.

Carousel Cycle Times
Statistics
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Similarly, the cycle time of any entity (object) in the transport stream is the time
between the start of an instance of the entity and the start of the next instance.

Selecting one or more entities in any view and View Entity Cycle Time from
the right-click menu generates the Entity Cycle Times statistics window. The
information can also be displayed in graphical form by selecting View Entity
Cycle Time Graph.

The Entity column identifies the PID, Carousel ID and Object that the user
identified as a starting point for the test.

In both Carousel and Entity statistics windows, further cycle time statistics will
be added to the bottom of the list while the window remains active.

Similarly, with one or more entries in a Cycle Times window selected, the
right-click menu allows the user to display a graph of the cycle times or export
cycle time statistics to a text file.

Entity Cycle Times
Statistics
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Application Support

Carousel Analyzer provides a means of testing the effects of associating
applications with Object Carousels. An application consists of a “boot class” and
“assets”. Typically, a boot class will comprise a Java or HTML class; assets may
be images or text required by the boot class.

A comprehensive range of tests and measurements is provided in addition to
application management tools.

A single Object Carousel may be timed with several applications in the Carousel
Analyzer.

Application Management

The Application management dialog shows the applications currently defined
and allows the user to manage them. The user can also create new applications.

When defining an application, it may be done by adding application tree nodes
manually using context menus, or by moving parts of currently available object
carousels over to the application. It is also possible to move over sub-trees from
the hard disk to the application definition.

If an asset is specified as a wildcard, the timing will wait for that asset and all
child assets that are found in the transport stream. This means that a directory
can be specified as a wildcard asset and any content found underneath it in the
transport stream will be treated as an asset, for example, specify \bin\star-
tup.class as the boot class, and \images\ as a wildcard directory asset. Any
content in the \images\ directory in the carousel will be treated as an asset.
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To open the Applications management dialog, select Edit > Applications... .
The following dialog box is displayed:

In the Applications management dialog, the main list displays those applications
that have already been created. Application data is stored locally in the file
C:\Program Files\Tektronix\DataTestSystem\applications.dat; this is the
installation directory but it may have been modified by the user. This data file
can be copied to other Carousel Analyzer installations if required.

A summary of the highlighted application is displayed below the list; the user
should enter this summary when the application is created.

The dialog button functions are described as follows:

New Allows a new application to be defined in the New Ap-
plication Definition dialog box.
Keyboard shortcut: Insert.

Copy Creates a copy of the highlighted application. The new
application is allocated a modified name (Copy of …).

Edit… Allows the highlighted application to be edited in the
Edit Application Definition dialog box.
Shortcut: Double-click application name.

Rename… Allows the highlighted application to be renamed. 
Keyboard shortcut: F2.

Delete Deletes the highlighted application after receiving con-
firmation from the user. 
Keyboard shortcut: Delete.
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Auto Create Creates an application definition for each MHP applica-
tion that is found in the stream. The boot class for each
application is also set up.

Select OK to close the dialog box. All of the buttons, except New, are disabled
unless an application is highlighted; New is always enabled.

Application Definition

Applications are defined using the New Application Definition dialog as shown
in the following illustration:

(Initially the Application panes will be empty except for the root nodes (Boot
Class and Assets)).
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The elements of the New Application Definition dialog box are as follows:

Object Carousels tab:  This displays all of the object carousels in the current
transport stream. Note that if the current transport stream
carries no object carousels, then none will be displayed
here.

The example screenshot below shows the Object Carou-
sels displayed in the New Application Definition dialog
box overlaid onto the standard Object Carousel views.

Name Enter the name of the application.

Description An optional field that allows a brief description of the
application to be entered.

The boot class and the assets are displayed as parts of a tree structure in the
lower pane. The boot class is the object that must be loaded first in an applica-
tion (an executable image). Assets are data objects to be used by the Boot Class
in the same carousel (for example, picture files, and text files).
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Selecting the OK button closes the dialog box and stores the new application
data. The action will be refused if a boot class object has not been specified. If a
duplicate application name has been entered, it must be renamed.

The boot class must be in the associated carousel; if it is not, the timing test
cannot be performed. An asset is a BIOP object in the carousel that is used by
the boot class. If the asset is not in the associated carousel, the user will be
warned that the assets could not be found and the tests will be performed as if
those assets had not been defined.

Selecting the Cancel button closes the dialog and discards the new application
data.
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The Test button at the bottom of the application dialog box allows items in the
application to be tested against the currently selected carousel. This can be used
to ensure that the correct carousel has been selected for the application and that
all of the objects are present. The results of the test are displayed in the
Application Test dialog.

Objects are moved from the Object Carousel pane to the Boot Class or Asset
panes using the Add Asset button. T do this, highlight the object in the Object
Carousel pane, select Add Asset, and note that the object is added to the adjacent
application structure.

� Making a node that has children an asset will automatically include all the
children as assets. To include every object in a carousel, add the carousel
root node to the application.

� The boot class can only contain one object; it may be at any depth in the
directory structure.

� Adding an object to the Boot Class will displace any existing object.

� Moving assets from the Object Carousel will automatically recreate the
directory structure from the object carousel.

� Moving assets from the hard disk directory tree will only recreate the
structure below the source tree node. When moving assets from the directory
tree, highlight a node in the asset tree as a target.

� A right-click context menu is available at all nodes in the application
structure; available options will depend on the node type.

Testing an Application

Adding Objects to the
Application
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The context menu options operate on the currently highlighted node in the
application structure as follows:

Add Child Adds a child node. It can be subsequently renamed to
indicate an object.

Rename Allows a node to be renamed.

Delete Deletes the node.

Toggle Wildcard Asset directory nodes can be identified as wildcard en-
tries. A wildcard directory indicates that the directory
and all of its children at the time of analysis are defined
as assets.

Application editing is similar to creating a new application.Editing an Application
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Application Timing

The Application Timing feature allows the user to observe the effect in terms of
download time of one or more applications being timed with an object carousel.

In practice, an object carousel is identified and one or more applications are
selected from the current application list to be timed with it. As each application
is selected, the software will check the availability of the Boot Class and Assets.
If the Boot Class cannot be found, the timing operation will fail. If Assets cannot
be found, the timing tests can still be performed, but they will not represent the
true effect of the application on a particular carousel.

Progress bars are displayed while the tests are being performed.

The results of the application timing tests are presented in tabular form.
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Data displayed in tabular form can be displayed in graphical form or exported to
a tab separated file.
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This section gives a graphical explanation of each of the application timing tests.

The calculations assume that control information (DSI/DII; that is, SI/PSI
information, for example, PAT, PMT) has been cached.

The boot class must be received before any of the assets can be received. This
simulates the STB not knowing which carousel objects the boot class depends on
until it has completely received and processed it.

Best Transmission Time.  From the start of a boot class to the end of the last asset.

The true application load time is the transmission time plus the time taken by the
set-top box (STB) to load the application. The time taken by the STB to load the
application is not included in these tests.

Explanation of Timing
Tests
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Worst Transmission Time.  From the end of a boot class, through the next boot
class, to the end of the last asset.

The true application load time is the transmission time plus the time taken by the
set-top box (STB) to load the application. The time taken by the STB to load the
application is not included in these tests.
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Cycle Time.  From the start of a boot class, through the last asset, to the start of
the next boot class.

Best Boot Time.  From the start of a service gateway, through the next boot class,
to the end of the last asset.
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Worst Boot Time.  From the end of a service gateway, through the next service
gateway, through the next boot class, to the end of the last asset.
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Cold Boot Time.  Whereas the other timing methods assume that control
information (PAT, PMT, DSM-CC section, etc.) has been cached, this method
does not.

The user defines a sampling frequency, which is timed to start the download and
observe how long it takes to signal the carousel and download the service
gateway, the boot class and all of the assets. For example, in a 60-second stream,
a Start Point (on the Cold Boot Time Settings dialog) of five seconds will
sample the download time twelve times. The result is added to the Application
Timing results table and graph.

The boot class must be received before any of the assets can be received. This
simulates the STB, not knowing which carousel objects the boot class depends
on until it has completely received and processed it.

Directories must be received before any child objects can be received in this
case. This is because this timing method assumes no signaling caching.

The end of each cycle will be the end of the module containing the last asset.
This is an important distinction because an asset may not be the only one in that
module.
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It is assumed that applications have been created as described in the previous
section.

1. With the Object Carousel view active, select View > Timing > Application
Timing.

Alternatively, highlight an object carousel and select View Application
Timing from the right-click menu (not shown).

Setting up a Timing Test
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2. The Timing Application dialog is displayed:

The dialog displays the selected object carousel identity and the applications
that are already defined.

Applications to be associated with the object carousel are selected by
enabling the adjacent checkbox.

Highlighting an application name will display its description and a brief
report on the availability of the boot class and assets. If the boot class is
reported as being not present, the timing operation will be aborted after the
first test pass.

Select Applications… to open the Applications management dialog 
(see page 6−71).

On first opening this dialog, a simple test is performed to detect the presence
of the required boot classes. Applications for which the boot class is found
will be enabled.

Subsequently, user selections will be recalled.
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Treat Intermediate Directories as Assets: 
If this checkbox is enabled, all directories that form part
of the asset path are also treated as assets. They must be
downloaded as part of the timing test. This will not usu-
ally have any significant impact on the results because
directories are generally much smaller and transmitted at
a higher frequency than files.

Calculate Cold Boot Time: 
If this checkbox is enabled, the Cold Boot timing test
will be applied (see page 6−84); this may take some
time.

NOTE. In MHP mode, if the Cold Boot time is to include the AIT acquisition
time, the Application Timing selection must be made from an MHP application
node (Java or HTML). By selecting an MHP application, the application’s AIT
will be automatically included in the Cold Boot timing.

3. Select Go to start the timing tests.

If the Calculate cold boot time checkbox was enabled, the Cold Boot Time
Settings dialog is displayed. Enter the starting point repetition rate required.

Select OK to continue with the tests.

Progress bars will be displayed while the test is being carried out.
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4. On completion of the test, the Application Timing results table is displayed.

The column headings are largely self-explanatory. Number of Cycles shows
the number of times that the test could be calculated for the stream.

5. To display the results in graphical form, highlight a test name and select
Graph… from the right-click menu.

If another test is selected, the results are overlaid. Color coding is used to
identify each result.
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The screenshot below illustrates a graph showing all five test results (Cold
Boot not shown).

Zoom in and zoom out buttons are provided on the toolbar (or use the tab
and shift-tab keys on the keyboard).
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Alternatively a precise area can be selected by dragging the mouse over the
required range (hold the left-button, move the mouse, release the button).

When the mouse button is released, the zoomed area of the graph will be
displayed immediately (as shown below).
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MHP Support

Although described separately here, MHP Object Carousel support is fully
integrated into Carousel Analyzer. MHP applications are displayed in the
Services and Object Carousel views. The features described here can be accessed
from menu options and right-click context menus.

The MHP application ( ) is identified by its name in the AIT. If the boot class
is found in the Service Gateway, it is attached as a child of the MHP application.
As a visual aid, boot class items are identified in the Service Gateway by green
triangles overlaying the primary icon. The path in which the boot class resides is
also indicated by green triangles.

Applications are designated as Java ( ) or HTML ( ). The color of the icon
represents the running status of the application when the carousel was recorded;
green indicates running, yellow indicates ready and red indicates not running.
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Right-clicking on an MHP application node will display the following menus:

View Application Timing
(See Application Timing, page 6−71)

View AIT
Opens the AIT structure view (see also Structure Views, page 6−52)

View Application Lifetime
(See Application Lifetimes, page 6−71)

Right-Click Menu Options
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Application Lifetimes

This Gantt style graph displays an analysis of the lifetime of an MHP applica-
tion. Multiple applications can be displayed; each application is subdivided and
color-coded to indicate the changing state of the application.

The Applications Lifetimes view can be opened by highlighting an MHP
application node and selecting either the toolbar icon or View Application
Lifetime from the right-click menu.

A key to the color codes is displayed at the bottom of the view. Each application
is labeled. Placing the cursor over a color block displays details of the block,
including the block start time.
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Reference

Script Files

The following scripts (Table 6−11) are shared between the Carousel Analyzer
and other Tektronix products. They exist in the Tektronix\Scripts directory.

Table 6−11: Script Files - General 

Script file name Purpose

MPEG.scp Scripts for MPEG sections and descriptors.

DVB.scp Scripts for DVB sections and descriptors.

ISDB-T.scp Script for ISDB-T sections and descriptors.

ISDB-S.scp Script for ISDB-S sections and descriptors.

MHP.scp Script for AIT table.

MPE.scp Scripts for DVB datagrams.

DSMCCv2.scp General purpose DSMCC structures.

DSMCC.scp Scripts for (DVB) DSM-CC sections.

ISDB_DSMCC.scp ISDB version of the DSM-CC script.
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The following scripts (Table 6−12) are used only by the Carousel Analyzer. They
exist in the Tektronix\DataTestSystem\Scripts directory.

Table 6−12: Script Files - Carousel Analyzer 

Script file name Purpose

Transport.scp Script for transport packets.

Pat_Cat.scp Script for PAT and CAT sections.

Biop.scp Scripts for BIOP messages.

DSMCC_DataCarouselObject.scp Script for DSM-CC objects, which relate a Data
Carousel.

DSMCC_DataCarouselSection.scp Script for DSM-CC sections, which relate a Data
Carousel.

DSMCC_ObjectCarouselObject.scp Script for DSM-CC objects, which relate an Object
Carousel.

DSMCC_ObjectCarouselSection.scp Script for DSM-CC sections, which relate an Object
Carousel.

DSMCC_Object Script for DSM-CC objects, whose content is not
assumed to be either data or objects.

Error Checking

DSM-CC sections have two bit fields called section_syntax_indicator and
private_indicator (Ref 13818-6 section 9.2.2). If the section_syntax_indicator
field is 1, there is a CRC32 at the end of the section; if set to 0, there is a
checksum at the end of the section. The private_data field should always be the
complement of the section_syntax_indicator field.

If both these fields are set to the same value, the application cannot be absolutely
sure whether a CRC or a checksum is being used. It therefore attempts to use the
CRC method first and then the checksum. If neither method works, the section is
rejected.

Currently nothing will be reported in the error logs if these bits are set incorrect-
ly. This issue will be addressed in a future release of Carousel Analyzer.
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Carousel Generator - Getting Started

The Carousel Generator is aimed principally at the content provider user who
simply wants to create a carousel to deliver content to a set-top box quickly and
efficiently. The product also aims to support the more experienced MPEG user
who wants to modify a carousel to test the effects on equipment along the
broadcast chain. Similarly, the more experienced MPEG user can incorporate a
carousel into a transport stream alongside video and audio content.

The assembled transport stream can be saved to an MPEG file.

Data Broadcasting Overview

Data Broadcasting allows data to be transmitted in a similar way to the way in
which video and audio services are delivered to end users. Object and Data
Carousels are intended for the periodic transmission of information in a transport
stream. Data Carousels contain modules of data of unspecified content, whereas
Object Carousels contain identifiable data objects, such as JPEG files, text files
and, application software. Multimedia Home Platform (MHP) builds on object
carousels by defining parameters such as the boot class and application life cycle
in the Application Information Table (AIT).

The diagram below shows how information carried by data and object carousels
is subdivided and ultimately carried by the transport stream.

Object Carousel:
BIOP Messages

Download Data
Carousel:
Modules and
Blocks

DSM−CC Sections

Block 1 Block 2 Block 3 Block 4 Block 5

Module 1

Section 1 Section 2 Section 3 Section 4 Section 5

Headers are
shown shaded.

ÎÎÎ
ÎÎÎ

ÎÎÎ
ÎÎÎ
ÎÎÎÎÎ
ÎÎÎÎÎ

BIOP 1 BIOP 2 BIOP 3 BIOP 4

ÏÏ
ÏÏ

Ï
Ï

Ï
Ï

Transport Packets

BIOP messages contain a message header, a message sub-header and the
message body, which contains data. The message body may contain complete
data objects.
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BIOP messages are broadcast in modules. A module is formed from one or more
concatenated, complete BIOP messages.

Each Module is fragmented into one or more Download Data Blocks that are in
turn transmitted in corresponding DSM-CC Sections.

Sections are transmitted in packets in the Transport Stream.

Carousel Generator Overview

Activity in the Carousel Generator is referred to as a “session”. During a session,
data objects are assembled into one or more carousels. Video and audio content
can also be added. Mandatory SI tables are added automatically. The structure of
the carousel can be saved in XML format; this definition file can be subsequently
reopened in a new session for further edits.

The end result of a session is the creation of a transport stream, which can be
saved to a file.

One of the main advantages of Carousel Generator is that many of the more
complex concepts in the various Object Carousel standards are hidden from the
user for the sake of clarity and user friendliness.

Three views of the assembled stream are offered: Carousels, Collections and
Programs. Each view displays aspects of the stream from a single perspective.
The three following screenshots show the same stream in each of the views.
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The Carousels view lists the carousels and the associated objects that are
included in the session.

Carousel Types. The supported carousel types are as follows:

Object Carousels: DSMCC, DVB, DTT, MHP

Object carousels Reference specification

DSM-CC Digital Storage Media - Command and Control
(MPEG only)

DVB Digital Video Broadcast

DTT Digital Terrestrial Television

MHP Multimedia Home Platform

The type of carousel being edited dictates the available options and user interface
elements.

Carousels View
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Objects associated with a carousel can be grouped together in collections. The
properties of each collection can be adjusted to give the most efficient delivery in
the transport stream.

The way that individual objects in a carousel are to be transmitted often varies.
Each object in the carousel has properties including its minimum repetition rate
(maximum cycle time) and whether it is compressed. Files that need to be
transmitted with similar properties or which are logically related can be grouped
into a module. As the DSMCC module is a limited size, the process of adding an
object to a module would require calculating whether the object would fit into
the module’s available space (possibly after compression) and if no space is
available, generating a new module and feeding this back to the user. This would
slow this aspect of the user interface down appreciably.

Consequently, the concept of a collection is used to replace the size-limited
DSMCC module, with a “module of unlimited size”. Any number of objects can
be added to a collection; during stream generation, this may translate to many
modules with the same properties.

Collections View
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In the Program view, the root is the Carousel Session (as in the other views).
Immediately below this are nodes giving access to the supported (mandatory)
SI/PSI tables and a listing of PCR PIDs. There is also an Elementary Streams
node, which lists all of the imported elementary streams included in the stream
and the Program nodes, which show the allocation of carousels and elementary
streams to programs.

The current state of the Carousel Generator session can be saved to disk at any
time during the creation process, using the carousel definition file. The format of
the saved file is standard XML and can be viewed in any XML compatible
viewer (for example, Internet Explorer 5 and up); editing the XML file directly is
not recommended.

Programs View

Carousel Definition File
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Starting the Application

The application can be started by selecting the Tektronix Carousel Generator
option from the Start > Programs menu or by double-clicking the Tektronix
Carousel Generator shortcut on the desktop.

In addition, files with an XML extension have an additional option in the
right-click menu (Open with Carousel Generator). When this option is
selected, Carousel Generator opens and attempts to use the file as a Carousel
Definition file (see page 7−5).
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Menu bar

Toolbar

Session window

Properties window

Log window

Status bar

The full range of options available to the Carousel Generator can be accessed by
using the Menu Bar. However, the selection of options varies during the stages of
carousel creation; unavailable options are normally grayed out. The Toolbar
provides shortcuts to the more common options.

The working area of the Carousel Generator screen contains three windows: the
Session window, the Properties window and the Log window. The Session
window and the Log window can each be either floated (moved to anywhere on
the desktop) or docked to one of the four sides of the application window. The
content of the Properties window is context-sensitive; it will provide a summary
of the properties of the node highlighted in the Session window.

A full description of the Carousel Generator screen components can be found in
the Menus and Controls, page 7−40.

Initial Appearance
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Session Window. The Session window is the workspace in which carousels and
collections are built and manipulated. The window has three tabs: Carousels,
Collections and Programs. Each window displays different aspects of the current
session in the form of a tree structure.

Carousel Tab The Carousels Session window displays all of the carou-
sels in the current session and the directories and files
associated with each carousel. It is in this window that
carousels are built and manipulated.

Collections Tab The Collections Session window displays the collections
associated with each carousel and the allocation of files
and directories within them.

Programs Tab The Program session window displays the contents of
the stream from the program or service point of view.

Properties Window. The Properties window provides an immediate view of the
parameters and values associated with each node in the Carousels and Collec-
tions Session windows. The values displayed are those of the currently selected
node.

Log Window. The Log window displays errors and warnings as the carousel
building and stream generation progresses.

A full description of the Carousel Generator screen components can be found in
the Menus and Controls, page 7−23.
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Carousel Wizard

The Carousel Wizard makes the process of creating a single carousel easier. The
carousel is added to the current session. The final step of the wizard allows a
transport stream to be created using the information in the current session.

Default parameters are provided at all stages of the wizard, but the user can
change them either in the wizard screens or subsequently in the various property
dialog boxes.

The description in this section provides an overview of the wizard and carousel
creation. Individual properties and activities are described in more detail in the
Reference section. Extensive tooltips are provided with the wizard screens. Place
the cursor over any element of a screen to reveal the tooltip.

If a carousel session is in progress, the user must decide whether a new session is
required or a new carousel is to be added to an existing session.

To start a new carousel session, select File > New Carousel Session.

Any open carousel session will be closed with an option to save.
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The following screen is displayed:

For a new session or adding a carousel to an existing session, the wizard can now
be invoked.
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Step 1: Select Carousel

1. In the work area select Carousel Wizard… or select Session > Carousel
Wizard.

Step 1: Select Carousel of the Carousel Wizard is displayed.

2. Highlight the required Carousel type.

Note that depending on the type selected, some of the subsequent wizard
screens will vary in content. The content is dictated by the carousel type
selected.

3. Select Next to display Step 2: Carousel Properties.
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Step 2: Carousel Properties

In Step 2, the Carousel Properties are selected. Defaults are supplied but all
properties can be edited. Properties can also be edited after the carousel has
been created from the main window.

4. Make any required adjustments to the Carousel properties.

5. Select how many times the carousel should appear in the output stream.

NOTE. When using the wizard, only a single carousel is being assembled.
However, more than one carousel may be created within a session.

The number of repetitions can be specified for each carousel. The length of the
transport stream will be dictated by the carousel that requires the longest time by
virtue of its size or the number of requested repetitions . Carousels in the same
session requiring less time to fulfill their size/repetition criteria will be repeated.

6. Select Next to display Step 3: Carousel Contents.
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Step 3: Carousel Contents

Files and directories containing applications and resources are added to the
carousel during this step.

The buttons on the right side of the window allow individual files or
complete directory structures to be added to highlighted nodes of the
carousel. Files and directories can also be dragged and dropped from
Windows Explorer.

Add files: Add directories: 

Files and directories can be dragged and dropped within the wizard window,
to allow final adjustments to be made.

Highlighted files and directories can be also be deleted .

7. Build the carousel structure as required.
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Highlighting an object and selecting Properties from the right-click menu
allows access to the object properties.

8. Select Next to display Step 4: Collection Contents.
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Step 4: Collection Contents

The files added in the previous step are automatically placed in a single
default Collection (as shown above). Collections allow objects to share
transmission properties including minimum repetition rate (maximum cycle
time) and compression. This step allows the user to change the properties of
the default Collection, create new Collections, and move files between the
various collections.

9. Select  to create a new collection header.
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10. Highlight a collection node and select to modify the collection’s
properties.

NOTE. If the previous wizard step is reselected (Back) and more files added or
removed, the Collection assignment is maintained for existing files and new files
are placed in the parent directory’s collection by default.
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To modify the collection properties, highlight the required Collection node
and select Properties from the right-click menu.

11. Select Next to display Step 5: Imported Elementary Streams.
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Step 5: Imported Elementary Streams

In addition to the carousel objects, elementary streams from a transport stream
can be included in the session.

12. Use the Source File:  button to identify and select the transport stream.

The contents of the source file are displayed.

13. Select one or more elements from this tree to import into the current session,
or select a program node to import every element contained by the program.
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Note that only elements from the same source program can be selected. All
elements included in the session will be included in the output stream,
whether they are referenced by a program or not.

Where possible, elementary streams will be carried on the same PID used in
the source stream; where a conflict within the session occurs, a new PID will
be automatically allocated or can be allocated manually.

14. Having identified the source stream and the individual elementary streams to
be included in the session, select Next to display Step 6: Program Entry.
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Step 6: Program Entry

At this step, a new entry will be created in the PMT referencing this carousel.
Also, the elementary streams identified in the previous steps can be associated
with a new program.

15. Select the elementary streams to be included in the new program.

16. Select Next to display Step 7: Output Stream Properties.
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Step 7: Output Stream Properties

Use this screen to specify the name and properties of the transport stream
that is to be created.

17. Enter the TS Bitrate.

18. Enter minimum duration for the output transport stream if required.

19. Enter or select ( ) an Output File name.

20. Select Next to display Step 8: Congratulations.
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Step 8: Congratulations

The carousel is now prepared. If the option to create the transport stream is
enabled, then all carousels in the current session will be included. The
carousel created with the wizard will be added to the session screen.

21. Select Finish to exit the wizard.
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Menus and Controls

The following pages contain descriptions of different menu options, toolbar
controls, status bar, log window, and properties window.

Menus Options

The following pages describe all of the menu options. Since many of the options
are context sensitive, they will be available only when their function is appropri-
ate for the selected window or display element. When a menu option is not
available, the option is grayed out.

Table 7−1: File menu options 

Option Function

New Carousel Session Opens a new carousel session. An opportunity to save the
current session is offered, if relevant.

Open Carousel Session… Opens an existing carousel session using a saved carousel
definition file.

Save Carousel Session Saves the current carousel session in the form of a carousel
definition file.
If the file has not been saved, an opportunity is offered to name
it.

Save Carousel Session As… Allows the current carousel session to be named and saved in
the form of a carousel definition file.

Most Recently Used List Lists the most recently used carousel session files. Click on a
file name to reopen it.
The number of files displayed is set in the Carousel Generator
Options dialog box (Tools > Options).

Exit Closes the application. An opportunity is offered to save the
session if it has not been saved.

File Menu Options
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Table 7−2: Edit menu options 

Option Function

Cut Cuts the currently highlighted item. The item is stored on the
Windows clipboard.

Copy Copies the currently highlighted item. The item is stored on the
Windows clipboard.

Paste Paste the item currently on the Windows clipboard.

Empty Carousel (Carousel contents node highlighted.) Deletes the carousel
contents.

Delete Collections (Collection node highlighted.) Deletes the selected collection
(The Collection must be empty; the contents must be moved to
another collection first).

Delete Program (Program node highlighted.) Deletes the selected program and
the carousel(s) it contains.

Table 7−3: View menu options 

Option Function

MHP Applications List MHP applications where they are included in a session.

Carousels; Log; Generator
Toolbar; Player Toolbar; Sta-
tus Bar

Allows the screen elements listed to be shown or hidden.

Edit Menu Options

View Menu Options
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Table 7−4: Session menu options 

Option Function

New Program… (Program view.) Adds a new program node.

Import Elementary
Stream(s)…

(Program view.) Allows elementary streams to be added to the
Elementary Streams node.

New Carousel (Carousel view or Program node.) Allows a new carousel type
to be created.

Carousel Wizard Opens the Carousel Wizard which takes the user through
carousel and stream generation step-by-step.

Carousel Properties… Opens the Carousel Properties dialog box.

Contents Facilitates the file activities listed below (the menu content is
context sensitive):

Empty Carousel
Empty currently highlighted carousel.

  Delete Object 
Deletes currently highlighted object (and dependant objects).

Add File(s)… Adds one or more files to the selected carousel.

Add Directory… Adds a directory to the selected carousel.

New Directory…
Creates a new directory at the selected node.

Move to Collection
Moves the selected objects to another collection.

HTML Application commands
Makes, Removes, and Edits HTML applications.

Java Application commands
Makes, Removes, and Edits Java applications.

These HTML and Java Application commands are only
applicable to file objects (when a file is selected).

Synchronize Synchronizes the carousel contents with the source files.

Delete Carousel Deletes the selected carousel.

Delete All Carousels Deletes all carousels in the current session.

Session Menu Options
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Table 7−5: Player menu options 

Option Function

Stream Generation 
Properties…

Opens the Stream Generation Properties dialog box.

Start Playout Initiates output stream generation using information in the
current session.

Stop Playout Stops output generation.

View Packets/Time Switches between packet count and time display during
playout.

Table 7−6: Tools menu options 

Option Function

Launch Multiplexer Opens the Multiplexer application.

Launch Carousel Analyzer Opens the Carousel Analyzer application.

Launch TS Analyzer Opens the Transport Stream Analyzer application.

Options… Opens the Carousel Generator options dialog box. This is used
to set the basic Carousel Generator and session defaults.

Table 7−7: Help menu options 

Option Function

Quick Help Opens an HTML help page containing summarized help
information.

User Guide Opens the Carousel Generator User Guide in Adobe Acrobat�
(PDF) format.

About Carousel Generator… Displays information about Carousel Generator, including
Software Version and Serial Number. This information will be
required if Tektronix support is required.

Player Menu Options

Tools Menu Options

Help Menu Options



Carousel Generator - Menus and Controls

MTS400 Series MPEG Test Systems User Manual 7−27

Toolbars

Two toolbars can be displayed: Generator and Player. The toolbars can be shown
or hidden using the View menu or by right-clicking in the toolbar area.

Toolbars provide a set of convenient shortcuts for the more frequently used menu
options. The buttons are context-sensitive and are enabled or disabled dependent
upon the currently highlighted view or the action being performed.

Table 7−8: Generator toolbar icons 

Icon Function Equivalent Menu Bar Command

Carousel wizard Session > Carousel Wizard (Ctrl+W)

New carousel session File > New Carousel Session (Ctrl+N)

Open carousel session File > Open Carousel Session (Ctrl+O)

Save carousel session File > Save Carousel Session (Ctrl+S)

Toggle workspace view View > Carousels

Add directory Session > Contents > Add Directory…

Add files Session > Contents > Add Files…

New collection (Right-click on Collection node) > 
New Collection

Insert program Session > New Program…

Synchronize carousel Session > Synchronise…

Launch Carousel Analyzer Tools > Launch Carousel Analyzer

Launch Multiplexer Tools > Launch Multiplexer

Launch Transport Stream Analyzer Tools > Launch TS Analyzer

Generator Toolbar
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Table 7−9: Player toolbar icons 

Icon Function Equivalent Menu Bar Command

Playout Carousel Player > Start Playout

Stop playout Player > Stop Playout

Player > View Packets/Time

Toggle Packet/Time display

Toolbars can be dragged off the edge of the main window into a floating pallet.
To do this, place the mouse pointer on the background inside the Toolbar, (not on
one of the buttons), hold the left button down, and drag the toolbar into the main
window area. The result is a self-contained window that looks like this:

To replace the Toolbar on the window border, drag it over the border until the
outline changes shape. It can be placed on the top, bottom, left or right edge.

The Toolbar may be hidden from view - View > Toolbar.

Player Toolbar
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Icons. The icons in Session windows are used to provide the user with a
graphical indication of status.

Icons incorporating an arrow indicate a shortcut function; for example, elementa-
ry streams displayed in a Program node in the Programs view indicate a shortcut
to the elementary stream in the Elementary Streams node.

Table 7−10: Session icons 

Icon Function

Collections node

Collection node containing the Service Gateway.

At least one collection must exist during any session. The collection containing the
Service Gateway cannot be deleted.

Ordinary collection node.

Not containing Service Gateway.

Compressed collection.

Directory object
Included in Carousel; Included in Synchronization.

Directory object
Included in Carousel; Not included in Synchronization.

Directory object
Not included in Carousel; Included in Synchronization.

Directory object
shared.

File object
Included in Carousel.

File object
Not included in Carousel.

PCR node

DVB SI / MPEG PSI

Table node

Transport Stream node

Program node

Carousel object

Elementary Stream - Audio
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Table 7−10: Session icons (Cont.)

Icon Function

Elementary Stream - Video

Elementary Stream - Private data

Log Window

The Log Window contains three tabbed views:

� The Summary log records information on the general activities in the
Carousel Generator.

� The Definition File Syntax log records information on activities concerning
the definition file.

� The TS Generation log records information during stream generation
activities.

During file loading and saving and the generation of transport streams, error
messages are routed to the appropriate Log window tab. More information about
each error can be accessed by clicking on the error entry or selecting the
Details… option from the right-click menu.
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The following icons are used to indicate the severity of the error:

 (Blue) Event Indicates normal processing activity.

 (Gray) Warning Indicates that information was not available or
was invalid. The operation will often be com-
pleted.

 (Yellow) Error Indicates that a sub-operation could not be
completed; the overall task may still be com-
pleted.

 (Red) Fatal Indicates that a fatal error has occurred; an
activity has failed to reach completion.

A right-click menu allows the user to clear the displayed log or all logs.

Status Bar

The Status Bar displays tool-tips when the mouse pointer is over active elements
of the window, for example, toolbar buttons and menu options.

Properties Window (List Control)

In properties windows that display lists (for example, contents lists), one column
can be selected to sort the list into ascending or descending order.

To sort a list, click the key column header. If the same column needs to be sorted
in reverse order, click the header again; note that the arrow icon in the header bar
indications the sort direction.
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Carousel Generation

This section describes the processes required to create a transport stream
containing one or more carousels. In broad terms it echoes the steps outlined in
the Wizard, but more background information is provided.

Setting Overall Carousel Generator Properties

Although not essential during every session, the general properties of the
Carousel Generator can be set using the Carousel Generator Options dialog box.
Note that settings such as the Output Filename can be overridden in the current
session; however, the settings made here will be used as the defaults in any new
session.

Select Tools > Options… to open the Carousel Generator Options dialog box.

The following screens are available in this dialog box: General, New Session
Defaults and Event/Error messages. To view a screen, click the name in the left
panel.

Carousel Generator
Options
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Number of items… A list of the most recently used carousel definition files
is displayed in the File menu. Use this parameter to se-
lect how many file names should be displayed.
Range: 0 to 15

Relative Paths The paths of source components associated with a carou-
sel file can be stored in relative or absolute format.

Update base path… When a carousel definition is saved to a different (new)
location, components stored with paths relative to the
original carousel definition may no longer be found at
the same (relative) location. If Yes is selected from the
drop-down list, the base path will be modified so that
the components can still be found. Select Ask to allow
the user to make a decision when the carousel definition
is saved. If No is selected, no modification will be made
to the base path; carousel components may no longer be
accessible to the definition file.

Fix relative paths… When the base path for components referenced by a car-
ousel definition file is changed, the existing relative
paths may not refer to the correct locations. If Yes is se-
lected from the drop-down list, the relative paths will be
adjusted so that they are referenced correctly to the new
base path.

General screen
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Regenerate… When enabled, launching Carousel Analyzer, Transport
Analyzer or Multiplexer causes the output stream to be
regenerated using the current session properties. This
ensures that the properties that have been entered in the
Carousel Generator are the same as those shown in the
Carousel Analyzer, Transport Analyzer or Multiplexer.

Show message… When enabled, a message will be displayed during
stream generation if an error occurs which causes the
stream generation to terminate. The error will always be
reported in the TS Generation tab of the Log window.

This screen provides default values to be used for all new sessions and conse-
quently in the carousel definition files and generated transport streams. The
default values can originate from a template or be set individually. The values
can be overridden in individual carousel sessions.

Startup Template Select this option and identify a file to be used as a start-
up template.

Any carousel session file (XML format) can be used as a
template. It can be used primarily to retain settings
which are required from session to session, for example,
network settings.

New Session Defaults
screen
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Startup Settings. Select the Use the following settings… option to set the session
defaults locally.

TS Bitrate: The bit rate of the output transport stream.
Range: 0.25 Mbit/s to 90 Mbit/s

Duration: The duration value (in seconds) available when this fea-
ture is enabled will dictate the minimum length of the
transport stream.

PSI/SI Type: This selection will dictate the tables that are automati-
cally created at startup.

If MPEG PSI is selected, only the PAT and PMT will
be generated. If DVB SI is selected, the mandatory DVB
tables (NIT actual, TDT, SDT actual and EIT P/F actual)
will also be generated.

Select the Warn before… checkbox to display a mes-
sage when a change to the Stream Generation PSI/SI
Type property is attempted (see page 7−40).

Output Settings. 

Output File: Enter the filename to be used in generating an output
transport stream or browse to find an existing filename.

Automatically set the default values…

If at the start of a session (with no carousels defined), changes are made to the
Stream Generation Properties (see page 7−40), whether or not the changes are
saved as Carousel Generator defaults is dictated by this setting.
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The options operate as follows:

Ask: The dialog box shown below will allow the user to choose between using
the revised settings as future defaults or to only use them for this session.

If the Always use… checkbox in the dialog box is enabled, the Automatically
set… option in this screen will be reset to concur.

No: The revised settings will not be used as future defaults.

Yes: The revised settings will be used as future defaults.

The Log view, which can be displayed as part of the main application, displays a
series of status and error messages, which advise the user of the progress of
carousel and stream generation.

Event/Error Messages
screen
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This screen allows the user to indicate which messages should be displayed. The
Log view contains three tabbed screens: Summary, Definition File Syntax and
TS Generation. These correspond to the message categories Summary messages,
Definition File errors and TS Generation errors in this screen.

Each message category contains four levels of severity: Events, Warnings, Errors
and Fatal Errors. Individual messages that can be displayed in the Log view are
listed at each level.

Message Selection. The checkmarks associated with each message icon indicate
the reporting status of the message.

Enabled (permanent): this message type will always be reported in
the log view.

  Enabled / disabled (toggle): this message type is enabled/disabled by
the user. It will only be reported in the log view when enabled.

If one or more of the subsidiary message types in a category (Events,
Warnings Errors) is disabled, this icon is displayed.

All messages in the Summary category and Fatal Error messages in all categories
are all permanently enabled; they cannot be disabled. The remaining messages in
the Carousel Definition File and Stream Generation categories can be enabled
and disabled as required by clicking on the message icon.

A brief description of a message can be displayed by clicking on the message
name.

(See also Log Window, page 7−30.)
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Creating a Session

A session in Carousel Generator is the activity during which objects are
assembled in one or more carousels with a transport stream being the end result.

The initial activity when starting a session is to note the defaults that are already
displayed in the Stream Generation Properties screen; these are derived from the
Carousel Generator Options. If required, the values can be modified for the
current session.

The values may be changed at any time in the session; it may be useful to review
these settings at the end of a session, before the transport stream is created.

Select Player > Stream Generation Properties... to open the Stream Generation
Properties dialog box or select Edit... in the properties window or double-click
in the properties window.



Carousel Generator - Carousel Generation

7−40 MTS400 Series MPEG Test Systems User Manual

This screen provides stream generation values to be used in the current session.

TS Bitrate: The bit rate of the output transport stream.
Range: 0.25 Mbit/s to 90 Mbit/s.

PSI/SI Type: This selection will dictate the tables that are created in
the generated stream. If MPEG PSI is selected, only the
PAT and PMT will be present. If DVB SI is selected, the
mandatory DVB tables (NIT actual, TDT, SDT actual,
and EIT p/f actual) will also be generated.

A warning may be issued noting that SI settings may be
lost (see New Session Defaults Screen, page 7−35).

Output File: Enter the name and path of the output file. Select to
specify a location on local or network drives.

Relative Paths in Session…
The paths of source components associated with a carou-
sel file can be stored in relative or absolute format.

Stream Generation
Properties
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Allow relative paths based on
When enabled, Carousel Generator will interpret all in-
complete paths as being relative to the base path speci-
fied in the adjacent text box.

The specified base path can be an absolute path (such as
c:\data) or it can be relative to the current location of the
carousel definition file. Note that if ‘.’ is entered in the
box, all relative paths are referenced to the current loca-
tion of the carousel definition file.

Any automatically created paths will also be made rela-
tive to the base path, if possible.

If the checkbox is cleared (disabled), only absolute paths
will be used.

Update all existing… When enabled, Carousel Generator will attempt to con-
vert all paths used in the session to be relative to the
specified base path (where possible).

If the checkbox is cleared (disabled), existing absolute
paths will be left unchanged.

Selecting the Carousel Type

There are a number of carousel types available from the various standards
authorities. Carousel Generator makes available the types listed in the following
table:

Carousel Type Guiding Standard

DSMCC Object ISO/IEC 13818-6: 1998 (MPEG)

DVB Object DVB EN301 192 V1.2.1

DTT Object DTG DTT Requirements for Interoperability V3.1

MHP Object ETSI TS101 812 V1.1.2 & V1.1.1

Select Session > New Carousel and click on the required carousel type. A new
(empty) carousel of the required type will be added to the session. The carousel
will be assigned an identity number (ID) and allocated to a PID automatically.

Additional carousels can be added; successive IDs and PIDs will be allocated.
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Modifying the Carousel Properties

The properties of individual carousel can be modified as required. A summary of
the carousel properties is displayed in the Properties window.

The contents of the carousel are displayed when the Carousel Contents node is
highlighted.

To edit individual carousel properties, in the Carousels tab of the Sessions
window and with the carousel node highlighted, select Session > Carousel
Properties... or select Edit... in the Properties window. The Carousel Properties
dialog box is displayed.

The number of screens available in the Carousel Properties dialog box is
dependent on the carousel type selected. In the following notes, screens
dedicated to only a single carousel type are identified; all other screens are
common to all types.

The Carousel Properties dialog box can display up to four screens: General PID
settings, DSI/DII settings, DTT Applications (DTT only), and MHP (MHP
only).
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Carousel ID: Unique carousel identity. The Carousel ID is normal-
ly generated automatically but can be changed by the
user.
Range: 0 to 4294967295

Maximum module size: The maximum size of the modules used to carry the
carousel objects. During output stream generation, if
a module has one or more objects and does not have
enough space for the next object, a new module will
be created. If a module is empty and the object added
will exceed the maximum size, the object is still add-
ed, but no more objects will be placed in that mod-
ule.
Range: 0 to 4294967295   Default: 65536

Carousel PID (DSI PID): Select the required Association Tag from the drop-
down list.
During carousel creation, a default Association is
generated to carry the Carousel/DSI PID. This cannot
be removed.

Include in Output… This flag allows the carousel to be included in or ex-
cluded from the output stream. If the checkbox is
disabled, no reference to this carousel or its contents
will appear in the generated output stream.

General screen
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Minimum number… Enter the minimum number of times that the carousel
is to appear in the output stream; this can be repeated
for each carousel in the session. The resulting output
stream will be long enough to accommodate at least
the minimum number of repetitions requested for
each carousel.

The tree structure in the PID Settings screen shows the PID usage for the
selected carousel’s program. The DSI and DII messages carried in the carousel
use an Association tag, which allows the BIOP messages in the carousel to be
linked to a PID in the stream (see “BS ISO/IEC 13818-6:1998 Information
Technology - Generic coding of moving pictures and associated audio informa-
tion - Part 6: Extensions for DSM-CC).

To place the DII and DSI messages on different Association Tags, use the
DSI/DII settings screen (see page 7−46).

During stream generation, each Association Tag specified will result in the
following:

� An elementary stream (ES) with a stream type of 11 (DSMCC U-N
messages) and the entered PID being added to the PMT ES loop.

� The Association Tag value will be inserted into an association_tag_descrip-
tor inside this ES’s descriptor loop.

Highlighting any of the association nodes will display the PID associations in the
Selected PID association panel.

PID settings screen
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Select New Assoc... to create a new association node in the tree. The PID and
Association Tag will be automatically allocated, but they can be changed in the
Selected PID association panel.

PID: This is the PID of the elementary stream (ES) carrying
the DII and/or DSI messages.
Range: 0 to 8191 (see PID Values, page 7−45).

Association Tag: This is the 16 bit value carried in the associa-
tion_tag_descriptor which is inserted in the ES descrip-
tor loop of the PMT signaling this carousel.
Range: 0 to 65535

Maximum bitrate… This is the maximum bit rate allocated in the stream for
this PID. If there is not enough bandwidth to support
this rate, the actual bit rate will be less.
Range: 0.25 Mbit/s to 90 Mbit/s

PID Values. As stated, the valid range for PIDs is 0 to 8191. However, there are a
number of restrictions on the actual values that can be used, since some are
reserved or may be used in other carousels. The following table shows the
elements that can and cannot share PID values. Unless otherwise noted, “No”
indicates the entities in the row and column headers may not share a PID value
in any carousel in a single session. ’Yes’ indicates that the PID value may be
shared with other entities in the same session; unless otherwise indicated in the
Notes below.

Reserved PCR PMT AIT DSI DII

DII No No No No Yes (Same
as Carousel)

Yes (Same
as Carousel)

DSI No No No No No -

AIT No No No No - -

PMT No No Yes - - -

PCR No No - - - -

Reserved No The Reserved PIDs are PIDs 0 to 31 (0x00 to 0x1F) and the Null
PID 8191 (0x1FFF)

Selected PID association
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NOTE. PIDs 0 to 15 (0x0000 to 0x000F) are reserved by MPEG; PIDs 16 to 31
(0x0010-0x001F) are additionally reserved by DVB.

PMTs cannot share PIDs with anything but other PMTs. Multiple PMT sections
can be on the same PID, so, if required, every carousel could have its PMT entry
on the same PID (usually not done that way, but it can be).

The DIIs belonging to a single carousel can be on the same PID as its DSI or its
other DIIs, but not on the same PID as DSIs or DIIs belonging to other
carousels.

For example, the yes/no indicators in the PMT row/column indicate that the
value of the PID carrying a PMT may not be shared with any other entities in the
session. However, in the case of the PMT, see the above note.

The tree structure in the DSI/DII Settings screen shows the DSI and DIIs that
will be generated in the stream for the selected carousel. Each DSI/DII has an
Association Tag and a cycle time, and DIIs have a user definable name.

Highlighting any of the DII nodes will display the PID associations in the
Selected DII panel.

Select New DII to create a new DII using default values. The default Association
Tag to use is decided by first checking if an existing DII uses the DSI tag. If so,
this tag is used, otherwise the tag of the first DII in the list is used.

DSI/DII settings screen
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Name: This is a user allocated name for this DII. The name
does not appear anywhere in the generated stream, only
within the Carousel Generator.

Assoc. tag: This is the list of all the currently defined Association
tags listed for this carousel. Assigning a different Asso-
ciation Tag to the DII effectively changes the PID that
the DII messages will be carried on.
(Association tags can be added from the PID Settings
screen.)

Cycle time (ms): This option sets the time taken for this DII to be re-
peated. For example, DIIs referencing boot classes may
be given shorter cycle times to speed up the boot pro-
cess.
Range: 1 ms to 3600 s.

To associate a collection with a DII, first create the DII, giving it a meaningful
name, set the Association tag and Cycle time of the DII and close this dialog
box. On the Collections tab of the Session window, edit the collection’s
properties to set the field Using DII to the new DII.

Selected DII
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AIT PID This is the PID that carries the Application Information
Table (AIT).
Range: 0 to 8191 (see PID Values, page 7−45).

AIT cycle time: Set the time to be taken for the selected Carousel’s AIT
to be repeated. Default: 100 ms.

Use… Select this option to allow the AIT cycle time to
be set manually. Range: 1 ms to 3600 s.

Use old-style… If this box is checked, the DVB-HTML application des-
criptor format as defined by MHP v1.0.0 (see MHP;
ETSI 101812, Version 1.1.2 and 1.1.1) will be used.

If this box is not checked, the new format as defined in
MHP v1.1.2 (see MHP; ETSI 101812, Version 1.1.2 and
1.1.1) will be used. This will cause the DVB-HTML
Application Descriptor to be properly formed and in-
clude an empty set of application IDs. To add applica-
tion IDs to this descriptor, use the HTML Properties
page on the MHP File Properties dialog box.

MHP
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Application Codes. The entries in this list will be added to the data_broad-
cast_id_descriptor in the elementary stream descriptor loop of the PMT. This
descriptor lists the application types that can be booted from the elementary
stream with which it is associated. The Boot Priority Hint is an indication of the
application that should be booted in the case of more than one in the list being
supported. The application with the highest Boot Priority Hint, in the range 0 to
255, will be booted first.

 Add Displays the Add Application Code dialog box.

 Remove Removes the highlighted Application Code.

DTT Applications
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Initial Objects. The Initial Object list allows different languages to have different
boot objects. On stream generation, entries here will appear in the ServiceCon-
textList part of the Service Gateway object.

 Add Displays the Add Initial Object dialog box.

The Application Code should correspond to a code that
is already listed in the Application Codes panel. A
Language Code can be selected from the drop-down
list. The object can be given a name in the Carousel
Object field. If objects have already been associated
with the carousel, the adjacent button will display the
contents of the carousel, from which an object can be
selected.

 Remove Removes the highlighted Initial Object.
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Carousel Contents

Each carousel initially contains two subnodes: Carousel Contents and Service
Gateway. The carousel will eventually contain all of the objects associated with a
particular function or feature. These objects can be arranged in a hierarchy of
directories and files all displayed beneath the Service Gateway node.

Files and directories can be manipulated in a variety of ways:

� All commands are accessible via the Menu Bar or context sensitive
right-click menus.

� Files and directories can be dragged and dropped within Carousel Generator.

� Files and directories can be dragged from Windows Explorer.

The properties of files and directories can be edited after they have been
incorporated into a carousel.



Carousel Generator - Carousel Generation

7−52 MTS400 Series MPEG Test Systems User Manual

Individual files or complete directory structures can be added to a carousel. New
directories can be created.

The location that an object is to be added to should be highlighted.

Adding Directories. 

1. Highlight the node in the carousel where the directory is to be added.

2. Select Carousel > Contents > Add Directory…

Adding an Object
(File/Directory)
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The Add Directory dialog box is displayed.

The Add Directory allows the user to select any available directory. The
directory path is shown in the top field; the most recently accessed directo-
ries are available in the drop-down list. The adjacent checkboxes have the
following functions:

Add Contained Files:  All files contained in the selected directory (and any
subdirectories if Add Subdirectories is enabled) will be added to the
carousel.

Add Subdirectories:  All subdirectories of the selected directory will be
added to the carousel.

Include Topmost Directory:  The selected directory will be added to the
carousel (not just the files and/or subdirectories).

Include in Synchronization:  The selected directory will by synchronized
with its source directory (see page 7−65).

3. Select the required directory and enable the required checkbox options.
Select OK to add the directory to the carousel.
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4. The new directory is added below the highlighted node.

NOTE. When directories are dragged and dropped from Windows Explorer, all
subdirectories and files will be included. If the Shift key is held down during this
action, the topmost directory name is not included.
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Adding Files. 

1. Highlight the directory node in the carousel where the file is to be added.

2. Select Carousel > Contents > Add file(s)…

The Select File(s) to Add dialog box is displayed.

3. Select the file(s) to be added.
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4. Select OK to add the files to the carousel.

5. The new file(s) are added to the selected directory node.
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Creating a New Directory. 

1. Highlight the node in the carousel where the directory is to be created. (In
this screenshot, the new directory is the first object to be created.)

2. Select Carousel > Contents > New Directory…

3. Enter the name of the new directory and select OK to create the directory.
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4. The new directory is created below the highlighted node.

Files and directories are moved within a carousel using standard Windows
commands and techniques, such as Copy, Cut and Paste and Drag, and Drop.

Files and directories are removed from a carousel using standard Windows
commands and techniques.

When a file is highlighted, the properties of that file are summarized in the
Properties window. The properties can be viewed in detail and edited by
selecting Edit… and displaying the File Properties dialog box.

The File Properties dialog boxes for files contained in all types of carousel are
similar. However, for the MHP carousel type, if a file is designated as an
application (Java or HTML), there are additional properties; these are described
in the following sections.

Moving an Object

Removing an Object

File Properties
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Include in Carousel: If this box is checked, the file object will be included in
the generated carousel. If not checked, the file object
will not be included in the generated carousel.

Name in Carousel: This is the name of the object as it will appear in the
BIOP message in the output stream. 
Range: 254 characters maximum (specified by the
DSMCC specification. Additional characters will be
truncated.) 
ASCII character set excluding: \ : / * ? ” < > |.

Source File: This field is set when the object is added to the carousel
and can be edited to point to another object if required.
This field does not appear in the output stream and is
limited to 260 characters.

Member of Collection: This is a list of all the collections currently included in
this carousel. Selecting a different collection effectively
put this object into a different module possibly with dif-
ferent cycle times and compression characteristics. In
the case of a directory object, all child objects below it
are also moved to the selected collection.

 New   Create a new collection (see page 7−66).

Collection Properties: Displays a summary of the properties of the collection
that the object is a member of. The properties can be
edited by using the Edit… button to open the collection
Properties dialog box (see page 7−68).
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When a directory is highlighted, the properties of that directory are summarized
in the Properties window. The properties can be viewed in detail and edited by
selecting Edit… and displaying the Directory Properties dialog box.

Include in Carousel: If this box is checked, the directory object will be in-
cluded in the generated carousel. If not checked, the di-
rectory object will not be included in the generated
carousel.

Include in Synchronization
If this box is checked, the source directory will be in-
cluded in the Synchronization process which aims to
match the source directory structure with the carousel
structure, removing and adding file and directory objects
as necessary.
If this box is cleared, this directory will not be compared
to the source directory and neither will any subdirecto-
ries, regardless of their individual settings.

Name in Carousel: This is the name of the object as it will appear in the
BIOP message in the output stream. 
Range: 254 characters maximum (specified by the
DSMCC specification. Additional characters will be
truncated);
ASCII character set excluding: \ : / * ? ” < > |.

Directory Properties



Carousel Generator - Carousel Generation

MTS400 Series MPEG Test Systems User Manual 7−61

Source Directory: This field is set when the directory is added to the carou-
sel and can be edited to point to another directory if re-
quired. Newly created directories may not initially have
a correct source directory, but this can be edited if de-
sired. This field does not appear in the output stream and
is limited to 260 characters.

The Source Directory will be used when the carousel is
synchronized only if the Include in Synchronization
box is checked (see also page 7−65).

Member of Collection: This is a list of all the collections currently included in
this carousel. Selecting a different collection effectively
put this object into a different module with possibly dif-
ferent cycle times and compression characteristics. In
the case of a directory object, all child objects below it
are also moved to the selected collection.

 New   Create a new collection (see page 7−66).

Collection Properties: This panel displays a summary of the properties of the
collection of which the object is a member. The proper-
ties can be edited by using the Edit… button to open the
Collection Properties dialog box (see page 7−68).

In MHP, applications are transmitted in object carousels. Applications can be
written in Java or HTML. All files that make up the application should be added
to the carousel. However, the receiver must be made aware of the entry point into
the application and certain other information about the characteristics of the
application. This information is sent in the Application Information Table (AIT),
which the receiver must process before it can start any application.

To define an application entry point and other application information, highlight
a file and select Carousel > Contents > Make Java Application or Make
HTML Application. The Application Properties dialog box will be displayed.
The components of the Application Properties screens are described in the
following paragraphs. Note that when the file properties of an application are
viewed, the File Properties General screen is also displayed.

Applications
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Application Descriptor screen. The Application Descriptor screen is common to
both Java and HTML applications.

All the properties on this screen are described in the Application Signaling
section of the MHP specification; TS 101 812 v1.1.1, Section 10, Application
Signaling.

Application Descriptor Name TS 101 812 identity

Application Name: Application Name Descriptor

Language Code: Application Name Descriptor

Application ID: Application Identifier

Control Code: application_control_code

Origination ID: Application Identifier

Service Bound: Application Descriptor

Visibility: Application Descriptor

Priority: Application Descriptor

Application Profiles: Application Descriptor
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Java Properties screen. All the properties on this screen are described in the
DVB-HTML Specific descriptors of the MHP specification; TS 101 812 v1.1.1,
Section 10, Application Signaling.

Application Descriptor Name TS 101 812 identity

Initial Class: DVB-J Application Location Descriptor

Base Directory: DVB-J Application Location Descriptor

Class Path Extension: DVB-J Application Location Descriptor

Parameters DVB-J Application Descriptor
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HTML Properties screen. All the properties on this page are described in the
DVB-Java Specific descriptors of the MHP specification: TS 101 812 v1.1.1,
Section 10, Application Signaling.

Application Descriptor Name TS 101 812 identity

Initial Path: DVB-HTML Application Location Descriptor

Physical Root Drive: DVB-HTML Application Location Descriptor

Parameter String: DVB-HTML Application Descriptor
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Directory objects included in carousels are simply references to directories that
exist elsewhere; for example, a PC hard drive.

If the Include in Synchronization checkbox is enabled for a directory, the
directory will be included in the Synchronization process. When Session >
Synchronise… is selected, the source directory structure is matched with the
carousel directory structure. Any objects missing from either the source directory
structure or the carousel directory structure are listed in the Synchronizing MHP
Object Carousel dialog box (as shown in the following screenshot).

Files or directories available at source but not currently included in the carousel
can be automatically added to the carousel by enabling the checkbox (Select this
option if you wish to add any missing files or directories to the carousel).
Individual files and directories listed in the panel can be included or excluded
from the activity by enabling or disabling the adjacent checkbox.

Files or directories listed in the carousel but not available at the source can be
automatically removed from the carousel by enabling the checkbox (Select this
option if you wish to delete invalid links from the carousel). Individual files
and directories listed in the panel can be included or excluded from the activity
by enabling or disabling the adjacent checkbox.

Select Synchronise to synchronizes the carousel with the source files in
accordance with the checkbox selections.

Synchronicity
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NOTE. If the Include in Synchronization checkbox is disabled for a directory, this
directory will not be compared to the source directory and neither will any
subdirectories, regardless of their individual settings.

Collections

(See Carousel Generator Overview, page 7−2)

Collections provide a means by which objects can be grouped and transmitted in
a single carousel with differing properties, such as repetition rate and compres-
sion. Each collection can have different properties; all objects in a collection are
transmitted with the same properties.
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Collections can be viewed by selecting the Collections tab in the Session
window.

A summary of a collection’s properties is displayed in the Properties window.
With a collection node highlighted, the contents of the collection can be viewed.

Three icons are used at the Collection node:

  (orange) Collection containing the Service Gateway.
At least one collection must exist during any session.
The collection containing the Service Gateway cannot be
deleted

  (red) Ordinary collection.

Compressed collection.

To open the Collection properties dialog box, select Edit… in the Collection
Properties bar.
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Name: Enter the required name.

Using DII: This is the list of all the DIIs in the carousel. The
Collections in the carousel (and therefore the generated
DSMCC modules) can be distributed among several
DIIs or all be referenced by a single DII.
This enables, for example, a minimal collection contain-
ing just the objects needed for booting to be referenced
in a DII with a short cycle time.

Weighting: This is the relative priority of the collections in a single
carousel. For example, the objects in a collection with a
weighting of 1.5 will be repeated half as often as those
in a collection with a weighting of three.

This enables, for example, boot classes in a collection to
be given a higher weighting than the other files in a car-
ousel. The weighting is a floating point value so virtual-
ly any ratio can be achieved.
Range: 0 to 10000
A value of 0 signifies the objects will not appear in the
stream.

Compression:  The modules can be optionally compressed to de-
crease module size. There are 10 levels of compression
ranging from 0 (no compression) to 9 (maximum com-
pression). Compression is applied to the complete
collection, although compression can be applied via any
of the property dialog boxes. The collection node icon in
the Collections view will indicate that compression is to
be applied.

Collection Properties
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To add a new collection, right-click on the collections node in the Collections
Session window and select New Collection. The properties of the new collection
can be modified as required.

To delete a collection, highlight the collection node and select Edit > Delete
Collection. However, note that a collection cannot be deleted while it contains
objects or while it contains the Service Gateway. These objects must be deleted
or moved to another collection.

Objects can be dragged and dropped or cut and pasted between collections in the
same carousel.

When dragging and dropping directories, pressing the Shift key down while the
object is moved will move only the directory, not the contained items. If the
Shift key is not used, the directory and its contents are moved.

When items (file or directory) that are part of a tree structure are moved between
collections, the complete path, from the Service Gateway is shown. The icons
above the moved object are grayed out to indicate that they are carried in another
collection (in the screenshot, they are the directory icons without a check mark or
a cross within them).

Adding a New Collection

Removing a Collection

Moving Objects between
Collections
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The node description indicates the owning collection.

NOTE. When an object is not included in the synchronization process, the icon

changes from  to  (see also Synchronicity, page 7−65).

Objects can also be moved between collections in the same carousel by
right-clicking on the object to be moved and selecting the collection from the
Move to Collection list. All current collections will be included in the list.

Programs

(See Carousel Generator Overview, page 7−2)

Programs allow audio and video content to be added to the carousel-carrying
stream. An example of the Program view is shown below:
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Note that the Carousel Session is still the ‘root’ of the view, but in this view, the
program content is also shown; this includes tables and streams.

PCR PID references are displayed under the Clock Reference node.

Mandatory PSI/SI information is created by default and included in the generated
stream. Changes made to the stream content are reflected in the PSI/SI informa-
tion. Individual settings are accessible in the various Programs properties dialog
boxes.

The PSI/SI node displays either MPEG or DVB service information that cannot
be easily included elsewhere.

� For MPEG PSI, only the Transport Stream ID, which is carried in the PAT, is
displayed.

� For DVB SI, the Transport Stream ID is augmented by mandatory DVB SI
(NIT, SDT (actual), EIT (actual present/following) and TDT.) The TDT
(Time/Date Table) and the NIT (Network) are the only entries under the
PSI/SI node. Parameters for the other tables are available in other dialog
boxes.

Under each Program node is a list of all the program components - Carousels
and video and audio elementary streams.

The Elementary Streams node lists the elementary streams that are included in
the stream. These can be associated with one or more programs. Note that the
elementary streams will be included in the generated stream even if they are not
associated with a program.
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This node indicates which PIDs are carrying PCRs.

Adding a PCR. 

1. Highlight the Clock Reference node in the Programs view.

2. From the right-click menu select New PCR….

3. In the PCR PID Properties dialog box, make the changes required and
select OK.

Note that the new PCR is added to the Clock Reference node.

Also available on the Clock Reference right-click menu are Cut, Copy, and
Paste. These operations follow normal Windows conventions. Messages will be
displayed where conflicts arise between existing PCRs and proposed new or
pasted PCRs.

Clock Reference
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PCR Edit. The PCR PID Properties dialog box of an existing PCR PID can be
opened by highlighting the PCR PID and selecting Properties… from the
right-click menu.

The content of the SI node will depend on the SI Type selected: MPEG or DVB.

SI Type. SI Type is normally set in the Stream Generation properties
(see page 7−40). However, a change can be made at any time before generation
of the stream.

Switching SI types may involve some loss of data or some creation of default
values. When switching from MPEG PSI to DVB SI, default values are applied
to the TDT and Network information; the Transport Stream ID will be copied.
Switching from DVB SI to MPEG PSI requires only the Transport Stream ID to
be copied. In this phase, any user changes to the default values in the DVB SI
properties will be lost and will need to be reentered if the SI type is changed
back to DVB, or a new session is created.

The EIT and SDT information is maintained between switching SI type as it is
stored in the Program Properties. The tables will simply not be generated if the
type is MPEG.

To switch between SI types during a session, highlight the SI node in the
Programs view and select the required SI Type from the right-click menu.

PSI/SI
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Figure 7−1: MPEG PSI

Figure 7−2: DVB SI
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Time/Date Table (DVB Only). The Time/Date Table carries a UTC time in the
stream, which is set to a starting value when the stream is generated. It is then
continually updated throughout the stream to reflect the passing of time. The
default setting of the initial value will be the time the generation is started, but
this can be changed to any user defined value.

To edit the Time/Date Table parameters, highlight the Time/Date Table node
and select Properties… form the right-click menu. The Time/Date Table
Properties dialog box is displayed.

Cycle Time gives the frequency at which the time and date information should
be repeated in the generated stream.
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Audio and video elementary can be imported and incorporated into the generated
stream. Subsequently, the imported streams can be associated with one or more
programs.

Importing Elementary Streams. 

1. In the Programs view, highlight the Elementary Streams node and select
Import Elementary Stream(s)… from the right-click menu.

The Add New Elementary Stream dialog box is displayed:

Elementary Streams and
Programs
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2. Use the browse button to select the source file (mpg) from which the
elementary streams are to be imported:

All programs in the source file are displayed, but only one program, or the
elementary streams from one program, can be imported into a session.

3. Highlight the program or elementary stream(s) to be imported.

Select OK to import the program/stream(s).
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Note that selected elementary streams are displayed under the Elementary
Streams node in the Programs view.

Elementary Stream Properties. Imported elementary streams are allocated to the
same PID used in the source program. If there is any conflict with existing PIDs
in the session, a warning is displayed and an opportunity offered to make
changes.

The elementary stream properties dialog box allows the PID to be changed. A
warning will be displayed if a conflict with an existing PID occurs. Continuous
looping of the stream during generation can also be enabled.

To select the Elementary Stream Properties dialog box, highlight the elementary
stream and select Elementary Stream Properties from the right-click menu.

Linking Elementary Streams to Programs. When a carousel is created, a Program
node is automatically created. If the Carousel Wizard is used, elementary streams
can be added during the process. Streams can also be added from a selected
program as required.

Streams are added to the Program node(s) by dragging and dropping them from
the Elementary Stream node. Note that in this case, they are simply linked to the
Elementary Stream entry; if they are deleted from the program, they will
continue to be listed under the Elementary Stream node. However, if an
elementary stream is deleted from the Elementary Streams node, it will also be
deleted from the programs in which it is used.

Note also that the Elementary Streams Properties dialog box (when accessed via
the Program entry) allows descriptors to be added to the elementary stream
information loop in the PMT.
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Output Stream Generation

To start generating the output stream, select Player > Start Playout. The
parameters used are part of the Stream Generation properties (page 7−40).

Errors occurring during stream generation are reported in the TS Generation tab
of the Log view.

Carousel Definition File

The current state of the carousel generator session can be saved to disk at any
time during the creation process using the File > Save Carousel Session or File
> Save Carousel Session As… options. This can then be reloaded at any time
using the File > Open Carousel Session… option. The format of the saved file
is standard XML and can be viewed in any XML compatible viewer (for
example, Internet Explorer 5 and up); editing the XML file is not recommended.
Errors in the syntax of the XML file will be reported in the Definition File
Syntax tab of the Log view; errors are summarized on the Summary tab of the
Log view.
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PSI and SI in the Carousel Generator Output Stream

The Carousel Generator creates various PSI and SI tables while generating its
output stream. The exact contents of the PSI and SI depends on many user
settings; this section describes most of the auto-generated content and which
options or properties affect that content. Note that all PSI/SI related properties
can be accessed through nodes in the program tab.

PSI/SI Mode Settings

There is one field that has a huge effect on the PSI and SI tables that Carousel
Generator produces – the Session’s ‘PSI/SI type’ field. This can be accessed
from the Stream Generation Properties dialog box (Player > Stream Generation
Properties), or by right-clicking on the SI node in the program tab, selecting the
SI Type sub-menu, and selecting one of the two options.

MPEG PSI PAT, PMT, and AIT (for MHP carousels) will be gener-
ated.

DVB SI In addition to the standard MPEG tables, Carousel Gen-
erator will output NIT actual, SDT actual, EIT present/
following actual and TDT sections.
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MPEG PSI tables

Table 7−11: Program Association Table (PAT) 

Table Syntax CG Value Comment

program_association_section() {

table_id 0x00

section_syntax_indicator 1

‘0’ 0

reserved 0x3

section_length auto

transport_stream_id user SI node > Properties… >  (MPEG SI page) ‘Transport
Stream ID’ field.

reserved 0x3

version_number 0 CG does not support table versioning.

current_next_indicator 1

section_number auto depends on the number of programs.

last_section_number auto depends on the number of programs.

for (i=0; i<n; i++) {

program_number user Program node > Properties… >  (PMT entry page)
‘Program Number’ field.

reserved 0x7

if (program_number == 0) { CG does not specify the network PID.

network_PID n/a 13818-1 describes it as ‘optional’.

}

else {

program_map_PID user Program node > Properties… >  (PMT entry page) ‘PMT
PID’ field.

}

}

CRC_32 auto

}

(ISO/IEC 13818-1 (Systems) section 2.4.4.3)
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Table 7−12: Program Map Table (PMT) 

Table Syntax CG Value Comment

TS_program_map_section() {

table_id 0x02

section_syntax_indicator 1

‘0’ 0

reserved 0x3

section_length auto

program_number user Program node > Properties… >  (PMT entry page)
‘Program Number’ field.

reserved 0x3

version_number 0 CG does not support table versioning.

current_next_indicator 1

section_number 0

last_section_number 0

reserved 0x7

PCR_PID user Program node > Properties… >  (PMT entry page) ‘PCR
PID’ dropdown menu.

reserved 0xF

program_info_length auto

for (i=0; i<program_info_length; i++) {

descriptor() auto + user Auto generation depends on carousel type. See ‘carousel
descriptors’ note below.

User can add additional descriptors via Program
node > Properties… >  (Program Descriptors page)

}

for (i=0; i<N1; i++) { Carousel Generator will add elementary streams as
required. Streams include carousel data, AITs, and
imported PIDs.

stream_type auto Stream type 11 for carousel data, stream type 5 for AIT
data, and the source stream type of any imported PIDs.

reserved 0x7

elementary_PID user User editable – edit method depends on the type of
stream.

reserved 0xF

ES_info_length auto

for (i=0;i<N2;i++) {

descriptor() auto + user Auto generation depends on stream type and carousel
type.
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Table 7−12: Program Map Table (PMT) (Cont.)

Table Syntax CommentCG Value

}

}

CRC_32 auto

}

(ISO/IEC 13818-1 section 2.4.4.8)

The various standards supported by the Carousel Generator have differing
signaling requirements, so the type and content of descriptors added to the PMT
depend on the carousel types contained in a program.

DSM-CC Object Carousels (ISO/IEC 13818-6 defined). The basic 13818-6 standard
only supports a single carousel per program, and requires that a carousel_identi-
fier_descriptor be inserted in the program_info loop (first descriptor loop) of the
PMT section for a program carrying a DSM-CC carousel.

Table 7−13: DSM-CC object carousels - Carousel identifier descriptor 

Descriptor Syntax CG Value Comment

carousel_identifier_descriptor {

descriptor_tag 0x13

descriptor_length auto

carousel_identifier user Carousel node > Properties… >  (General) Carousel ID

for (n=0; n<N; n++) {

private_data_byte n/a These bytes are not used when signaling

} a basic DSM-CC Object Carousel

}

(ISO/IEC 13818-6 (Extensions for DSM-CC) section 11.4.1)

DSM-CC Object Carousels are carried on one or more PIDs referenced by the
PMT with stream type 11. The ES_info loop for each of these streams contains
an association_tag_descriptor which maps the association_tag used by DSM-CC
messages to a particular PID.

Carousel Descriptors in
the PMT
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Table 7−14: DSM-CC object carousels - Association tag descriptor 

Descriptor Syntax4 CG Value Comment

association_tag_descriptor {

descriptor_tag 0x14

descriptor_length auto

association_tag user Carousel node > Properties… > (PID Settings)
Association tag

use auto 0 if the PID is used for a DSI, 1 otherwise

selector_byte_length auto

for (n=0; n<N1; n++) {

selector_byte auto not used if ‘use’ is 1, otherwise follows the use_0_selec-
tor_bytes format

}

for (n=0; n<N2; n++) {

private_data_byte n/a not used

}

}

use_0_selector_bytes {

transaction_id auto Matches the transaction id of the DSI

timeout 0xFFFFFFFF timeout unknown

}

(ISO/IEC 13818-6 section 11.4.2)

DVB Object Carousels (ETSI EN 301 192 defined). Although not mentioned in the
DVB data standard (ETSI EN 301 192: Specification for the transmission of data
services in DVB bitstreams), the DVB implementation guidelines for data
broadcasting allow support for multiple Object Carousels per program, by
allowing the carousel_identifier_descriptor to be transmitted in the second
descriptor loop of the PMT.

“DVB Guideline: The carousel_identifier_descriptor() shall be inserted in the
second descriptor loop of the PMT (ES_info) corresponding to the elementary
stream carrying the DSI of the object carousel. This allows more than one object
carousel per MPEG-program and implicitly identifies the PID on which each
carousel should be booted from.”
(TR 101 202 (Implementation Guidelines for Data Broadcasting) section 4.7.7.1)

Carousel Generator therefore transmits a carousel_identifier_descriptor for every
DVB Object Carousel in a program, as specified by this implementation
guideline.
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DVB also extends the carousel_identifier_descriptor slightly, by defining the
contents of the private_data_byte section further with what it calls a FormatSpe-
cifier. However, CarouselGenerator only uses the required parts of this extension
- it sets the FormatId to zero, which indicates that no format specifier is
provided.

Table 7−15: DVB object carousels - Private_data_byte syntax 

Private_data_byte syntax CG Value Comment

carousel_identifier::private_data_bytes {

FormatId 0 0 indicates no FormatSpecifier present

FormatSpecifier() {

FormatSpecifier_byte n/a Not used by Carousel Generator

}

for (n=0; n<N1; n++) {

private_data_byte n/a Not used by Carousel Generator

}

}

TR 101 202 (Implementation Guidelines for Data Broadcasting) section 4.7.7.1

An association_tag_descriptor is added to the ES_info loop in exactly the same
way as for DSM-CC object carousels.

Two more descriptors are also added to the ES_info loop for streams carrying
DVB object carousels – the data_broadcast_id_descriptor and the stream_identi-
fier_descriptor. Both are defined in EN300 468 (Specification for Service
Information in DVB systems).

Table 7−16: DVB object carousels - Descriptors 

Descriptor Syntax CG Value Comment

stream_identifier_descriptor {

descriptor_tag 0x52

descriptor_length 1

component_tag user LSB of the association_tag for this stream

}

data_broadcast_id_descriptor {

descriptor_tag 0x66

descriptor_length 2
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Table 7−16: DVB object carousels - Descriptors (Cont.)

Descriptor Syntax CommentCG Value

data_broadcast_id 7 DVB Object Carousel code

for (i=0; i<N; i++) {

id_selector_byte n/a DVB Object Carousels do not use these

} selector bytes

}

DTT Object Carousels (DTG D-Book (DTT Requirements for Interoperability)). Most
of the PMT signaling for DTT Object Carousels is the same as for DVB Object
Carousels. However, the D-Book does specify the contents of the id_selec-
tor_byte section of the data_broadcast_id_descriptor, and also requires that the
data_broadcast_id value in that descriptor is 262 (0x106).

Table 7−17: DTT object carousels 

DTT id_selector_bytes Syntax CG Value Comment

for (i=0; i<descriptor_length-2; i++) {

application_type_code user DTT Object Carousel node > Properties…  > (DTT
Applications page). Application codes list contains the
app codes used.

boot_priority_hint user Boot priorities accessed as above.

app_specific_data_length (N2) 0

for (j=0; j<N2; j++) {

app_specific_data_byte n/a Not used.

}

}

(UK DTG D-Book (Digital Terrestrial Television Requirements for Interoperability) section 18.5.2.1)

MHP Object Carousels (ETSI TS 101 812). MHP uses an additional table, the AIT,
for most of its signaling requirements. The location of the AIT table for a
program is identified through an elementary stream PID entry in the PMT with
stream type 5. The ES_info loop for the AIT PID also carries an applica-
tion_signaling descriptor (AIT information is given in the DVB SI Tables section
of this appendix):
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Table 7−18: MHP object carousels - Application signaling 

Descriptor Syntax CG Value Comment

application_signaling_descriptor {

descriptor_tag 0x6F

descriptor_length auto

for (i=0; i<descriptor_length; i++) {

application_type auto An entry for application_type 1 will be present if any Java
apps are defined in the carousel, and an entry for type 2
will be present if any HTML apps are defined in the
carousel.

reserved_future_use 0x7

AIT_version_number 0 CG does not support table versioning – all tables have
version number 0.

}

}

(ETSI TS 101 812 (Multimedia Home Platform (MHP) specification) section 10.7.1)

The PMT signaling for MHP carousel carrying streams is very similar to that for
DVB Object Carousels. The only difference is that, like DTT, MHP defines
additional content for the data_broadcast_id_descriptor’s data_broadcast_id
value and id_selector bytes. The MHP data_broadcast_id value is 240 (0xF0),
and the id_selector bytes are as defined below:

Table 7−19: MHP object carousels - ID selector

MHP id_selector_bytes Syntax CG Value Comment

for (i=0; i<descriptor_length-2; i++) {

application_type auto An entry for application_type 1 will be present if any Java
apps are defined in the carousel, and an entry for type 2
will be present if any HTML apps are defined in the
carousel.

(ETSI TS 101 812 section 10.7.2.2)
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DVB SI Tables

The following SI is only generated when the session’s SI type is set to DVB SI.
All user-editable properties of these tables can be accessed through nodes in the
Programs tab.

The Carousel Generator only generates NIT actual sections, and the contents of
the NIT can be accessed by editing the properties of the Network node and its
children.

Table 7−20: Network information table 

Table Syntax CG Value Comment

network_information_section() {

table_id 0x40 NIT actual – CG does not generate NIT other sections.

section_syntax_indicator 1

reserved_future_use 1

reserved 0x3

section_length auto

network_id user Network node > Properties… >  ‘Network ID’ field

reserved 0x3

version_number 0 CG does not support table versioning

current_next_indicator 1

section_number auto

last_section_number auto

reserved_future_use 0xF

network_descriptors_length auto

for (i=0;i<N;i++) { A network_name_descriptor will always be added, with
the name

descriptor() auto + user Specified in the Network Properties >  ‘Name’ field.

} The user can add custom descriptors to this loop by
editing the descriptor list in the Network Properties dialog
box.

reserved_future_use 0xF

transport_stream_loop_length auto

for (i=0; i<N; i++) { CG will always add at least one transport stream to this
loop (the ‘actual’ transport stream’ but the user can add
additional transport streams (by right-clicking on the
network node).

transport_stream_id user Transport Stream node > Properties…  > (Transport
Stream page) Transport Stream ID field

Network Information Table
(NIT)
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Table 7−20: Network information table (Cont.)

Table Syntax CommentCG Value

original_network_id user As above  >  Original Network ID field

reserved_future_use 0xF

transport_descriptors_length auto

for (j=0; j<N; j++) { One of the three delivery system descriptors will always
be present (see ‘Delivery System Descriptors’ below)

descriptor() auto + user The user can also add custom descriptors via Transport
Stream node  > Properties… > (Transport Stream page)
Descriptors list

}

}

CRC_32 auto

}

(ETSI EN 300 468 (Specification for Service Information in DVB systems) section 5.2.1)

Every transport stream listed in the NIT will contain at least one descriptor – one
of either the cable delivery system descriptor (ETSI EN 300 468 sec-
tion 6.2.12.1), the satellite delivery system descriptor (ETSI EN 300 468
section 6.2.12.2) or the terrestrial delivery system descriptor (ETSI EN 300 468
section 6.2.12.3). The type of descriptor used, and the contents of all its fields,
are edited through the Transport Stream node > Properties… > Delivery System
page.

All of the delivery system descriptor fields defined in EN 300 468 can be
modified.

Delivery System
Descriptors
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Table 7−21: Service Description Table (SDT) 

Table Syntax CG Value Comment

service_description_section() {

table_id 0x42 SDT actual – CG does not generate SDT other sections.

section_syntax_indicator 1

reserved_future_use 1

reserved 0x3

section_length auto

transport_stream_id user Matches the transport_stream_id of the actual transport
stream

reserved 0x3

version_number 0 CG does not support table versioning

current_next_indicator 1

section_number auto

last_section_number auto

original_network_id user Matches the original_network_id of the actual transport
stream

reserved_future_use 0xFF

for (i=0; i<N; i++) { CG auto-generates an entry for every program in the
session.

service_id auto Matches the program number

reserved_future_use 0x3F

EIT_schedule_flag 0 EIT schedule tables not supported.

EIT_present_following_flag user Transmission of an EIT_pf is user-controllable per
service. See the EIT section below.

running_status 0x4 Always set to 4 – Running

free_ca_mode 0 Always set to 0 – No scrambling

descriptors_loop_length auto

for (j=0; j<N; j++) {

descriptor() auto A service_descriptor is always added, and depending on
the carousel content of the program, data_broadcast_
descriptor(s) may be added.

}

}

CRC_32 auto

}

(ETSI EN 300 468 section 5.2.3)

Service Description Table (SDT)
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Table 7−22: Service descriptor 

Descriptor Syntax CG Value Comment

service_descriptor() { All of the properties in this descriptor are accessed via
the Program node that is associated with the service.
Program node  >  Properties… > Additional SI page

descriptor_tag 0x48

descriptor_length auto

service_type user  >  Service Type dropdown

service_provider_name_length auto

for (i=0; i<N; i++) {

char user  >  Service Provider field

}

service_name_length auto

for (i=0; i<N; i++) {

char user  >  Service Name field

}

}

(ETSI EN 300 468 section 6.2.30)

The data_broadcast_descriptor is a DVB defined descriptor that can be used in
either the SDT or EIT to indicate that a carousel is associated with a service or
event. Carousel Generator only supports associating a carousel with a service, so
will only add the data_broadcast_descriptor to the SDT.

Table 7−23: Data broadcast descriptor 

Descriptor Syntax CG Value Comment

data_broadcast_descriptor() {

descriptor_tag 0x64

descriptor_length auto

data_broadcast_id auto depends on the type of carousel

component_tag user LSB of the assoc_tag of the PID carrying the carousel’s
DSI

selector_length auto

for (i=0; i<selector_length; i++) {

selector_byte auto depends on the type of carousel

Service_descriptor

Data_broadcast_
descriptor
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Table 7−23: Data broadcast descriptor (Cont.)

Descriptor Syntax CommentCG Value

}

ISO_639-2[3]_language_code �und" CG does not use the text field, so the language code is
set to �und"efined

text_length 0

for (i=0; i<text_length; i++) {

text_char n/a Not used

}

}

(ETSI EN 300 468 section 6.2.10)

The use of the data_broadcast_descriptor, and the contents of the data_broad-
cast_id and selector_bytes fields depend on the type of carousel(s) in the
program.

DSM-CC Object Carousel. The DSM-CC standard does not define the data_broad-
cast_descriptor, and so a data_broadcast_descriptor is not added to the service
entry for a program containing a DSM-CC object carousel.

MHP Object Carousels. MHP uses the AIT for all its signaling requirements, and
so does not require the use of the data_broadcast_descriptor.

DVB Object Carousels. A data_broadcast_descriptor is added for every DVB
Object Carousel contained in a program. The data_broadcast_id is set to 7, and
the selector_byte format is as follows:

Table 7−24: DVB object carousel 

DVB selector_bytes Syntax CG Value Comment

Carousel_type_id 0x2

Reserved 0x3F

Transaction_id auto Matches the carousel DSI transaction ID

time_out_value_DSI 0xFFFFFFFF not used

time_out_value_DII 0xFFFFFFFF not used

Reserved 0x3

leak_rate 0

for (i=0; i<N; i++) {
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Table 7−24: DVB object carousel (Cont.)

DVB selector_bytes Syntax CommentCG Value

ISO_639_language_code n/a The object names loop is not used by the Carousel
Generator.

object_name_length n/a

for (j=0; j<object_name_length; j++) {

object_name_char n/a

}

}

(ETSI EN 300 468 section 6.2.10)

DTT Object Carousels. The DTG D-Book requires that there only be a single
data_broadcast_descriptor per service, to identify the application type carried in
that service. The Carousel Generator uses the first Carousel it encounters in a
program that has at least one application id set as the carousel referenced by the
data_broadcast_descriptor. Generally, only one of the DTT Object Carousels in a
program should have any application IDs set.

Because only a single data_broadcast_descriptor is allowed per service, the
component_tag value of the descriptor is set to zero – the descriptor does not
identify any particular stream as carrying a carousel.

The data_broadcast_id for the descriptor is set to 262 (0x106), and the selec-
tor_bytes format is as follows:

Table 7−25: DTT object carousel 

DTT selector_bytes Syntax CG Value Comment

for (i=o; i<selector_byte_length;i++) {

application_type_code user The first application id defined in a DTT carousel
contained in the service.

number_languages 0

for (j=0; j<number_languages;j++) {

ISO_639_language_code n/a Not used

}

application_specific_data_length 0

for (j=0; j<a_s_d_length; j++) {

application_specific_data_byte n/a Not used

}
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Table 7−25: DTT object carousel (Cont.)

DTT selector_bytes Syntax CommentCG Value

}

(UK DTG D-Book section)

The Carousel Generator only supports the creation of EIT present following
information, for the actual transport stream. The presence of EIT p/f sections for
a particular service is user controllable, but where transmitted, information will
only be included for the present (now) event. The following (next) event section
will always be empty. If an EIT p/f is present for a particular service, the relevant
EIT_present_following_flag in the SDT will be set.

Table 7−26: Event Information Table (EIT) 

Table Syntax CG Value Comment

service_description_section() {

table_id 0x4E EIT actual present/following – CG does not generate any
other form of EIT.

section_syntax_indicator 1

reserved_future_use 1

reserved 0x3

section_length auto

service_id auto

reserved 0x3

version_number 0 CG does not support table versioning

current_next_indicator 1

section_number auto section 0 is present event, 1 is following event

last_section_number 1

transport_stream_id user Matches the transport_stream_id of the actual transport
stream

original_network_id user Matches the original_network_id of the actual transport
stream

segment_last_section_number 1 p/f table is not segmented

last_table_id 0x4E Only table id 0x4E is used

for (i=0; i<N; i++) { The present event section (section 0) will always contain
a single event, while the following event section (section
1) will not contain any events. The following fields are
therefore only used in section 0 of the EIT.

event_id 0 Event ID is always set to zero

Event Information Table
(EIT)
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Table 7−26: Event Information Table (EIT) (Cont.)

Table Syntax CommentCG Value

start_time user The start time will match the start time of the TDT.

duration 99:59:59

running_status 0x4 Always set to 4 – Running

free_CA_mode 0 Always set to 0 – No scrambling

descriptors_loop_length auto CG always adds a single descriptor

for (i=0; i<N; i++) { to the event descriptors loop, the

descriptor() auto short_event_descriptor.

}

}

CRC_32 auto

}

(ETSI EN 300 468 section 5.2.4)

The fields of the short_event_descriptor for the present event are all accessed
through Program Node > Properties… > Additional SI page. This page also
contains the checkbox (Include EIT present/following section for this service)
that controls whether an EIT will be transmitted for a particular service.

Table 7−27: Short event descriptor 

Descriptor Syntax CG Value Comment

short_event_descriptor() {

descriptor_tag 0x4D

descriptor_length auto

ISO_639-2[3]_language_code user  > Language Code dropdown

event_name_length auto

for (i=0; i<event_name_length;i++) {

event_name_char user Set to match the service name field

}

text_length auto

for (i=0; i<text_length; i++) {

text_char user  > Description field

}

}

(ETSI EN 300 468 section 6.2.33)

Short_event_descriptor
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The TDT is accessed through the Time/Date Table node under the DVB SI node
in the program tab. It carries current time information, and the user can specify
whether that information will be filled with the current system time, or start at a
time specified by the user and increment in real time.

Table 7−28: Time and date table 

Table Syntax CG Value Comment

time_date_section() {

table_id 0x70

section_syntax_indicator 0

reserved_future_use 1

reserved 0x3

section_length 5

UTC_time auto/user This value starts at the time specified by the user
(Time/Date Table node  >  Properties… > Start Time)
and increments appropriately during stream output.

}

(ETSI EN 300 468 section 5.2.4)

The AIT (ETSI TS 101 812 section 10.4) is the main signaling component of the
MHP standard, and the Carousel Generator will generate an AIT for every
program that carries one or more MHP carousels containing applications. Note
that if the MHP carousel(s) in a program do not have any applications defined an
AIT will not be generated for that program.

The AIT is split into subtables based on the application_type value. The current
MHP spec defines two application types, Java and HTML, and Carousel
Generator supports both. If only Java applications are present in the carousels in
a program, only the Java subtable will be generated, and the same is true for
HTML applications. If both application types are present in the carousel(s) in a
program, both subtables of the AIT will exist for that program.

Time and Date Table (TDT)

Application Information
Table (AIT)
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Table 7−29: Application information table 

Table Syntax CG Value Comment

application_information_section() {

table_id 0x74

section_syntax_indicator 1

reserved_future_use 1

reserved 0x3

section_length auto

application_type auto

reserved 0x3

version_number 0 CG does not support table versioning

current_next_indicator 1

section_number auto

last_section_number auto

reserved_future_use 0xF

common_descriptors_length 0

for (i=0; i<c_d_length; i++) {

descriptor() n/a

}

DVB_reserved_future_use 0xF

application_loop_length auto

for (i=0; i<app_loop_length; i++) { Carousel Generator will add applications as defined in
the carousel. To create an application, right-click on the
file and select Make HTML Application or Make Java
Application.

application_identifier() {

organisation_id user File node > Properties… >  (Application Descriptor page)
Organisation ID field
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Table 7−29: Application information table (Cont.)

Table Syntax CommentCG Value

application_id user File node > Properties… >  (Application Descriptor page)
Application ID field

}

application_control_code user File node  >  Properties…  >  (Application Descriptor
page) Control Code dropdown

app_descriptors_loop_length auto

for (j=0; j<a_d_l_length; j++) {

descriptor() auto/user Carousel Generator creates the appropriate descriptors
for each application type automatically. However, fields in
the properties pages allow the contents of these
descriptors to be edited. See ‘application descriptors’
note below.

}

}

CRC_32 auto

}

Every application listed in the AIT will have five descriptors in the app_descrip-
tors_loop, but two of these depend upon the type of application (Java or HTML).
The three common descriptors are the application_descriptor, applica-
tion_name_descriptor and transport_protocol_descriptor, and the two app
specific descriptors will either be dvb_j_application_descriptor and dvb_j_ap-
plication_location_descriptor (for Java apps) or dvb_html_application_descriptor
and dvb_html_application_location_descriptor (for HTML apps).

Common Application Descriptors. 

Table 7−30: Application descriptor 

Descriptor Syntax CG Value Comment

application_ descriptor { Note. All of the user editable fields are accessed through
File  >  Properties…  >  Application Descriptor page

descriptor_tag 0x00

descriptor_length auto

application_profiles_length

for (i=0; i<N; i++) {  > Application profiles list

application_profile user

version.major user

Application Descriptors in
the AIT
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Table 7−30: Application descriptor (Cont.)

Descriptor Syntax CommentCG Value

version.minor user

version.micro user

}

service_bound_flag user  > Service Bound checkbox

visibility user  > Visibility dropdown

reserved_future_use 0x1F

application_priority user  > Priority

for (i=0; i<N; i++) {

transport_protocol_label auto Matches the transport_protocol_label value in the
transport_protocol_descriptor.

}

}

(ETSI TS 101 812 section 10.7.3)

Table 7−31: Application name descriptor 

Descriptor Syntax CG Value Comment

application_name_descriptor { Accessed through the same page as described.

descriptor_tag 0x01

descriptor_length auto

for (i=0; i<descriptor_length; i++) {

ISO_639_language_code user  > Language Code dropdown

app_name_length auto

for (i=0; i<a_n_length;i++){

app_name_char user  > Application Name field

}

}

}

(ETSI TS 101 812 section 10.7.4)
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Table 7−32: Transport protocol descriptor 

Descriptor Syntax CG Value Comment

transport_protocol_descriptor {

descriptor_tag 0x02

descriptor_length auto

protocol_id 0x0001 Transport via OC

transport_protocol_label auto Set to match the component tag value

remote_connection 0 CG does not support remote carousels

component_tag auto Matches the component tag in the stream_identifier_des-
criptor for the DSI of the MHP Object Carousel that
contains this application.

}

(ETSI TS 101 812 section 10.8.1)

Java Application Descriptors. 

Table 7−33: Java application descriptor 

Descriptor Syntax CG Value Comment

dvb_j_application_descriptor { This descriptor specifies the Java application parameters, and is
accessed on the Java app file  >  Properties…  >  Java
Properties page.

The parameter list is edited by using the Parameters list box and
buttons.

descriptor_tag 0x03

descriptor_length auto

for (i=0; i<N; i++) {

parameter_length auto

for (j=0; j<parameter_length; j++) {

parameter_byte user

}

}

}

(ETSI TS 101 812 section 10.9.1)
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Table 7−34: Java application location descriptor 

Descriptor Syntax CG Value Comment

dvb_j_application_location_descriptor { This descriptor specifies the Java application path, and is
accessed via Java app file  >  Properties…  >  Java
Properties page.

descriptor_tag 0x04

descriptor_length auto

base_directory_length auto

for (i=0; i<base_directory_length; i++) {

base_directory_byte user > Base Directory field

}

classpath_extension_length auto

for (i=0; i<classpath_ext_length; i++) {

classpath_extension_byte user  >  Classpath extension field

}

for (i=0; i<N; i++) {

initial_class_byte user  >  Initial class field

}

(ETSI TS 101 812 section 10.9.2)

HTML Application Descriptors. 

Table 7−35: HTML application descriptor 

Descriptor Syntax CG Value Comment

dvb_html_application_descriptor { This descriptor specifies the HTML application
parameters, and is accessed via HTML app file  > 
Properties…  >  HTML Properties page.

Descriptor_tag 0x03

descriptor_length auto

appid_set_length auto

for (i=0; i<appid_set_length; i++) {

application_id user  >  Application IDs list box

}

for (j=0; j<N; j++) {

parameter_bytes auto  >  Parameter String edit box

}
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Table 7−35: HTML application descriptor (Cont.)

Descriptor Syntax CommentCG Value

}

(ETSI TS 101 812 section 10.10.1)

NOTE. The dvb_html_application_descriptor format shown above is that defined
in TS 101 812 v1.1.2 (MHP v1.0.1) – previous versions of the standard did not
have the application_id loop. Carousel Generator can be made to revert to the
older version of the descriptor (v1.0.0) for a particular carousel by checking the
MHP Object Carousel node > Properties� > (MHP page) Use old style (MHP
v1.0.0) HTML application descriptor checkbox.

Table 7−36: HTML application location descriptor 

Descriptor Syntax CG Value Comment

dvb_html_application_location_descriptor { This descriptor specifies the HTML application path, and is
accessed on the HTML app file  >  Properties…  >  HTML
Properties page.

descriptor_tag 0x04

descriptor_length auto

physical_root_length auto

for (i=0; i<physical_root_length; i++) {

physical_root_bytes user  >  Physical Root Directory field

}

for (i=0; i<N; i++) {

initial_path_bytes user  >  Initial Path field

}

(ETSI TS 101 812 section 10.10.2)

Summary

Carousel Generator v2.0 is designed to generate enough SI to create a fully DVB
conformant stream, which should be enough to drive most set-top boxes. If any
additional SI is required, another suitable tool (the Tektronix Multiplexer) should
be used to insert the extra information into the generated stream.
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Multiplexer - Getting Started

The Tektronix Multiplexer provides off-line multiplexing of ATSC, MPEG-2,
DVB, and ISDB transport streams.

Transport streams (TS), elementary streams (ES), packetized elementary streams
(PES), Packet Identifiers (PID) - can all be selected, manipulated and recom-
bined to form customized, synthesized transport streams. Program Specific
Information (PSI), Service Information (SI), and Program and System Informa-
tion Protocol (PSIP) are often referred to as simply SI in this section.

The functionality provided includes:

� Wizards that facilitate the completion of common tasks, such as populating
streams with Program Specific Information/ Service Information/ Program
and System Information Protocol (PSI/SI/PSIP) and programs.

� Table contents are displayed in and edited from structure diagrams (tree
diagrams).
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� Transport Streams that either conform strictly to the standards selected for
interpretation or have precisely engineered, known, nonconformances.

� Two or more instances of Multiplexer can run concurrently. This allows table
information to be copied from one file to another.

� The source data for nonconformant streams can be saved in a raw format,
which can be quickly reloaded as the basis for generating more stream data.

� Conformance of edits to the standards is checked interactively and enforced
by default. Checking and enforcement may be turned off when specifying
nonconformances to be introduced into the new transport stream.

On opening, streams are analyzed and displayed according to the selected
standard: MPEG, DVB, ATSC, or ISDB. Scripts are used by the analysis
process; this allows private PSI/SI tables and descriptors to be defined.

NOTE. Most examples given in this section of the User Manual are based on
DVB SI. You should remember that Multiplexer is equally at home with all major
DTV standards, MPEG-2, DVB, ATSC, and ISDB as well as the major exten-
sions to those standards.

The Transport Stream Analyzer program should always be used for reliable
analysis of transport streams containing DSM-CC or MPE addressable sections.

In the absence of TS Analyzer, it is acceptable to use Multiplexer for analysis,
provided that the DSM-CC or MPE scripts are first applied using Expert mode
in the Stream Interpretation dialog box (see Scripts, page 8-6 ).

However, when multiplexing streams containing DSM-CC or MPE addressable
sections, the related scripts must not be active.
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H.264 ES Input Characteristics

The H.264 elementary streams used by the Multiplexer should comply with
ISO/IEC-14496-10/2005 Rec. H.264. The transport stream generated by the
Multiplexer should comply with ISO/IEC-13818-1/2000/AMD_3/2004.

� SEI (Supplemental enhancement information) stream support

The multiplexer detects a H.264 stream as an SEI stream if the following
conditions are met:

� VUI (video usability information) packet contains the coded bit rate.

� HRD (hypothetical reference decoder) parameters are specified in the
SEI packets.

� Non-SEI stream support

Those streams that are not detected as SEI streams are assumed to be
non-SEI streams.

Table 8−1 lists the stream properties of H.264/AVC and generated transport
stream characteristics.

Table 8−1: PTS/DTS Timestamp Updations 

        H.264/AVC stream properties              Comments                        Generated TS characteristics

SEI VUI
BM(Valid Buff-
ering Mes-
sages)

Bit rate Comments

− − −

Stream without any
buffering messages

Prompted or auto de-
tected

TS will have PTS and DTS calcu-
lated at a constant frame rate from
the VUI parameters of the stream
unless you change the parameters.
If the stream does not have VUI
parameters 25 fps is taken as the
default.

� − −

SEI NAL units poten-
tially carrying private
data

Prompted or auto de-
tected

TS will have PTS and DTS calcu-
lated at a constant frame rate from
the VUI parameters of the stream
unless you change the parameters.
If the stream does not have VUI
parameters 25 fps is taken as the
default.

PTS/DTS Timestamp
Generation
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Table 8−1: PTS/DTS Timestamp Updations (Cont.)

        H.264/AVC stream properties                        Generated TS characteristics             Comments

� � −

SEI stream without full
HRD data

Prompted or auto de-
tected

TS will have PTS and DTS calcu-
lated at a constant frame rate from
the VUI parameters of the stream
unless you change the parameters.
If the stream does not have VUI
parameters 25 fps is taken as the
default.

� � �

SEI stream with both
buffering period and
picture timing present
(HRD Compliant)

Coded bit rate will be
auto-detected

TS will carry PTS and DTS as
coded by the SEI timing infor-
maion.

The stream bit rate is calculated as follows.

Bitrate � File�Size
�Number�of�Frames��Frame�Rate)

Starting the Program

The program can be started by selecting the Tektronix Multiplexer option from
the Start > Programs menu or by double-clicking on the Tektronix Multiplexer
shortcut on the desktop.

Once the program has started and is ready for use, it will open a Main Window
that looks as follows.

Auto detection

Initial Appearance
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Use the View menu to select a standard that will be used to interpret transport
streams, and then open a transport stream file or import a multiplex configura-
tion file.

When the application is opened, you are presented with options relevant only to
opening new or existing multiplex files. Options that are not relevant at this time
are inactive (grayed out).

File Menu Options. Table 8−2 lists the options available in the initial File menu.

Table 8−2: File menu options 

Command Function

New Opens new multiplex configuration file.

Open Opens an MPEG file for use. The program opens the file
selection dialog box allowing you to choose the required file.

Examine TS Opens the Examine TS window, which allows a brief summary
of the stream to be viewed before it is subjected to full
analysis.

Close (Currently disabled - see page 8−17.)

Import... Opens a previously saved multiplex configuration file.

Initial Menu Options
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Table 8−2: File menu options (Cont.)

Command Function

Export (Currently disabled − see page 8−17.)

Export As (Currently disabled − see page 8−17.)

1 <filename>

2 <filename>

3 <filename>

4 <filename>

A list of the four most recently used files. If the program has
recently been installed the list may be empty or hold less than
four files.

Selecting a file name opens that file for use.

Exit Finishes running the program.

View Menu Options. Table 8−3 lists the options available in the initial View menu.

Table 8−3: View menu options 

Command Function

Interpretation Opens the Stream Interpretation dialog box. This allows the
scripts to be used in stream analysis to be selected.

Event Log Opens the Event Log window.

Toolbar Displays or hides the Toolbar.

Status Bar Shows or hides the Status Bar.

A check mark next to an option indicates that the object is currently visible.

Scripts

SI scripts are necessary to enable SI table and descriptor data to be analyzed
successfully. Scripts are used to enable analysis of SI data dictated by the various
international standards, for example, MPEG-2, DVB, ATSC, and ISDB.

Essential scripts are installed and enabled using the Stream Interpretation dialog
box. In the absence of any enabled scripts, only the PAT table will be analyzed;
all other data will be presented as private data.

If a suitably configured script is selected and enabled before a stream is opened,
custom data will be analyzed when the stream is opened. If the script is not
selected or enabled, the stream will be analyzed, but any custom data will be
reported as either an error in the stream configuration or as an elementary stream
PID.
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Scripts can be selected and enabled only when no files are open. The Stream
Interpretation dialog box is available when a file is open, but all activity is
disabled.

Note that a script file will not be used for analysis until:

� It is present in the Scripts text box in the current analysis mode.

� It is successfully enabled by closing the Stream Interpretation dialog box
using the OK button.

To open the Stream Interpretation dialog box, with all files closed, select 
View > Interpretation.

Handling Scripts
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The Stream Interpretation dialog box is displayed as shown.

Current

Script
Selection

Expert mode controls

The top half of the dialog box is concerned with selecting scripts. The text box
(Scripts) lists the scripts currently selected. The area adjacent to the text box is
dedicated to Expert mode controls.

The selection area of the Stream Interpretation dialog box is best viewed and
used from left to right.

The Base Standard section allows the MPEG-2, DVB, ATSC, or ISDB standard
to be selected for analysis.

MPEG-2 only Interprets and analyzes the packets in conformance to
the MPEG-2 standards.

DVB Interprets and analyzes the Transport Stream Packets
according to the specifications of the DVB and MPEG-2
standards.

Selecting Scripts
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ATSC Interprets and analyzes the Transport Stream Packets
according to the specifications of the ATSC and
MPEG-2 standards.

ISDB Interprets and analyzes the Transport Stream Packets
according to the specifications of the ISDB and
MPEG-2 standards.

The selected standard will dictate the availability of the remaining options in the
Extensions and Data Standards sections.

The Extensions section allows country-specific extensions to be added to the
basic standard scripts. If None is selected, only the standard scripts are listed in
the Scripts text box. The remaining country-specific extensions add extra scripts
to the current listing. As with the Base Standard, the choice of Extensions option
will dictate the availability of the options in the Data Standards section. The
Custom selection in the Extensions section allows users to include their own
selection of scripts using Expert Mode controls.

The Data Standards section offers a choice of data-specific scripts.

Note that the scripts listed by default are those resident in the default installation
directory (tektronix\scripts). Other directory locations can be specified in Expert
Mode. All selections will be retained between sessions.

Scripts are syntactically analyzed when the OK button is selected. They are also
checked when the application is opened. A fault in the syntax of a script will not
necessarily prevent a stream from being analyzed, but it may result in incomplete
analysis of the stream.

Scripts listed in the Scripts text box will not be used for stream analysis until
they have been successfully checked (the application has been opened or the
Stream Interpretation dialog box has been closed with no script-related error
messages issued).

An intermediate check of scripts listed in the Scripts text box can be made by
selecting the Reload Scripts button. This performs the same action as the OK
button but leaves the dialog box open.

Syntax errors will be indicated and reported in the Event Log (see page 8−63).

Checking Syntax
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 Expert Mode allows you to select and customize the scripts to be used in
stream analysis and multiplexing. Note that when the expert mode is selected,
the Custom extension option is automatically selected and the management
buttons are enabled. In Expert mode, all scripts become available to be added to
the script list. The scripts will be checked and loaded, ready to be used for
analysis, when the OK button is selected.

Script Management

The script management buttons act on the scripts currently listed in the Scripts
text box.

Table 8−4: Script Management 

Buttons Function

Script files are parsed in the order that they are listed; in some circum-
stances this may be important. To move a file in a list, highlight the file
name and select the Up or Down arrow button as required. Each press of
the button will move the file up or down one place in the list until it reaches
the top or the bottom.

Add a script to the list: A standard Windows file selection dialog box is
opened. The default file extension is .scp. Select the required file. The
selected script will be added to the bottom of the list. If necessary, move it
using the Up and Down buttons.

Scripts can be loaded from any directory.

Delete the highlighted script.

Export Mode
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Table 8−4: Script Management (Cont.)

Buttons Function

Change scripts default directory: by default, all scripts are found in a default
directory created during installation (tektronix\scripts). This button can be
used to set a different default directory.

Note that all scripts supplied by Tektronix in the default installation are
installed in a single directory; as long as this directory is designated as the
default directory, they will work satisfactorily.

View highlighted script with the associated application; by default, script files
are associated with the ScriptPad utility.

For a script file to be viewed successfully, the file extension (.scp) must be
associated with a text editor in the Microsoft Windows environment. The MPEG
Test System installation program by default associates a script editing utility
called ScriptPad; you can use another text editor, for example, Microsoft
Notepad, if preferred. ScriptPad is a simple script editor that can be installed
with the MPEG Test System. Scripts can be viewed and edited as required
(depending upon the file permissions).

Opening a Stream

Two options are available when opening a stream for multiplexing: to open an
existing stream or to open a previously prepared multiplex configuration file.

Three options are available when preparing a stream to be multiplexed:

� Create a new null stream (using File > New)

� Open an existing stream

� Import a multiplexer configuration file

Any file holding a recorded or synthesized sample of a stream that conforms to
the relevant standards can be opened and used as a basis for a new multiplex.
Note that the Examine TS option (see page 8−64) can be used to preview stream.

Some nonconformant streams can be opened, although, only the conformant
parts can be edited usefully. Any tables that are carried in a conformant PID and
have the correct syntax will appear in the output transport stream, as will any
elementary streams (whether referenced by a table or not) which are in the input
transport stream.

To open a file holding a transport stream, select the File > Open. If the required
file is in the list of recent files, it can be opened from the list using the Open File
dialog box.

Opening an MPEG Stream
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Alternatively use the Ctrl+O keyboard shortcut or drag the file from Windows
Explorer and drop it into the Multiplexer window. A shortcut button is available
on the Toolbar for opening a file.

Any file holding a recorded or synthesized sample of a stream, which conforms
to the relevant standards, can be opened. Many nonconformant streams can be
opened provided that the PAT, PMT, and MGT tables correctly specify all the
other tables and their PIDs.

Multiplexer is used for generating both conformant and nonconformant streams.
Having generated a nonconformant stream, it may not be possible to successfully
open it again in Multiplexer.

The specification for a new transport stream may be saved to a multiplex
configuration file. This also saves time for opening large MPEG files, since the
specification contains the results of the analysis from opening the original
MPEG file.

NOTE. The multiplex configuration file does not contain a copy of the transport
stream; instead it refers to the original MPEG file by the full path name.
Deleting or moving the MPEG file will result in a dialog box prompting for the
new location of the file.

Double-clicking on a *.muxml or *.mux file in Windows Explorer will open the
file in a new instance of Multiplexer.

Importing a File. Importing opens a multiplex configuration file and the MPEG
file on which it is based.

To open a previously exported multiplex configuration file, select the 
File > Import. If the required file is in the list of recent files, it can be opened

Opening Multiplex
Configuration Files
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from the list to save using the Import file dialog box.

Alternatively use the Ctrl+I keyboard shortcut or drag the file from Windows
Explorer and drop it into the Multiplexer window.

NOTE. Multiplexer reads the name and location of the MPEG file from the
multiplex configuration file and then opens it automatically. The previously
stored changes in the configuration file are applied to the display.

Note that the import dialog box offers a choice of file types: *.muxml, *.mux
and *.*.

The Navigator Tables view window is opened as soon as a file is opened or
imported. The program now starts to analyze the file with the loaded scripts to
determine what tables are present.

As the file is analyzed, the Top Levels of the Transport Structure diagram are
drawn in the Navigator window. The rightmost pane in the Status Bar at the
bottom of the program window shows the progress of analysis.

Initial Stream Analysis
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Files that are imported require less processing because they were analyzed in the
session from which they were exported.

The file can now be manipulated to form a specification with which to synthesize
a new transport stream. Tables, elementary streams, and PIDs are viewed and
selected using the Navigator views. The components of any table selected in the
Navigator views are viewed and selected using the Section View window.

Tables, Programs and PIDs can be added and modified using the wizards
provided or manually. A selection of menu options is provided to facilitate
manipulation of the data.

The Multiplex menu has options to inhibit and reenable forced conformance to
the selected standards.

Having manipulated the file, a transport stream can be synthesized to the new
specification by the multiplex engine. The engine is started from the Multiplex
menu or using a toolbar button. The source file is used as reference data by
Multiplexer and the output written to a different file.

The illustration on page 8−15 gives an overview of the Multiplex process.

What to Do Next
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Open/Import

Any file holding a recorded or synthesized sample of a
stream that conforms to the relevant standards can be
opened. See Opening an MPEG file.

Importing opens a multiplex configuration file and the
MPEG file on which it is based. 

See Importing a File, page 8−12.

Transport Structure Modifications

The file can now be manipulated to act as the specification
to synthesize a new transport stream. The tables and
elementary streams are viewed and selected either with the
aid of Wizards or in the Navigator windows.

Output/Export

The Multiplex Engine synthesizes a new transport stream
and writes it to an MPEG file.

To ensure that the specification for any synthesized stream
can be reused, it can be saved to a multiplex configuration
file.

See Multiplexing Transport Streams, page  8−119.

Transport Structure Demultiplex

As the file is analyzed, the Top Levels of the Transport
Structure diagram are drawn in the Transport Navigator.

See Initial Stream Analysis, page 8−13.
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Closing Files

To close the files, select File > Close. This will close both the MPEG file and
any multiplex configuration file that is open.

A shortcut button is also available on the Toolbar for closing a file, which has a
standard file close symbol.

If a multiplex configuration file has been edited, and the changes not exported,
the program will ask if the file should be saved.

Select Yes to export the file, No to close the file without saving, or Cancel to
undo the close command and keep the file open.
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Menus and Controls

This section describes the various menu options, toolbar controls, status bar,
icons, and user interface.

Menu Options

The following pages describe all of the menu options. Since many of the options
are context sensitive, they will be available only when their function is appropri-
ate for the selected display or window element. When a menu option is not
available, the option is grayed out.

Table 8−5 lists the options available in the File menu.

Table 8−5: File menu options 

Command Function

Close Closes the current file. This option is available as soon as
analysis starts. If the wrong file is being opened, or the wrong
options are selected, selecting this option will abandon the
analysis and close the file.

Examine TS Opens the Examine TS window, which allows a brief summary
of the stream to be viewed before it is subjected to full
analysis.

Export... Exports the current multiplex specification in a form that can be
imported even if it no longer generates a conformant transport
stream. This option is disabled when no file is open.

Export As... Exports the current file, as above, and allows a different file
name to be specified. This options is disabled when no file is
open.

Exit Closes any file that is open and terminates the program.

File menu options
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Table 8−6 lists the options available in the Edit menu.

Table 8−6: Edit menu options 

Command Function

Add Adds a table/section/loop to the currently selected item in the
Navigator or Section View.

Modify Edits the information in the currently selected field or item.

Delete Deletes the item currently selected.

Cut Cuts the current selection from the Window.

Copy Copies the contents of the current selection to the clipboard.

Paste Pastes data from the clipboard to the part of the transport
structure that holds that type of data.

Export Payload Extracts and exports the payload of the source transport
stream PID in the form of a simple data file.

Export Elementary Stream Removes the transport stream PID and PES headers and
exports the remaining information as a simple data file.

Export Section Data Extracts and exports section data. The created file can be
imported as ES using Multiplexer’s Add function or as SI using
the Import Section Data option (see next option).

Import Section Data Imports SI data from a file and analyzes it. The section is
added to the Navigator view.

Table 8−7 lists the options available in the View menu.

Table 8−7: View menu options 

Command Function

Interpretation Displays a read−only dialog box for viewing scripts that have
been selected for analysis (see also Initial Menu Options,
page 8−5).

Section View Opens the window and displays the table section currently
selected in the Navigator view.

Event Log Displays the list of events that are recorded in the Event Log.

Component Bit rate Displays a graphical comparison of the stream bit rates.

Component Duration Displays a graphical comparison of the stream component
durations.

Available Bit rate Displays a graphical view of the bit rate in the stream.

Properties Opens a properties dialog box for editing the currently selected
item in the Transport Navigator window.

Edit menu options

View menu options
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Table 8−7: View menu options (Cont.)

Command Function

Zoom In Zooms in the Available Bit rate and Component Duration
views.

Zoom Out Zooms out from the Available Bit rate and Component Duration
views.

Synchronize Synchronizes zoom levels of the Available Bit rate and
Component Duration views (toggle).

Show Cursor Shows or hides the cursor in the Available Bit rate and
Component Duration views.

Toolbar Shows or hides the Toolbar.

Status Bar Shows or hides the Status Bar.

Table 8−8 lists the options available in the Options menu.

Table 8−8: Options menu options 

Command Function

Display Filter Opens the SI Filter dialog box.

Single Section View Selects single or multiple section view. When disabled, multiple
section views can be opened.

Program Wizard Invokes the Program wizard.

Transport Wizard Invokes the Transport wizard.

Scan Settings Opens the Scan Settings dialog box.

Options menu options
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Table 8−9 lists the options available in the Multiplex menu.

Table 8−9:  Multiplex menu options 

Command Function

Start Starts the Multiplex Engine, to synthesize a new transport
stream file.

Stop Aborts multiplexing. The output file is closed and contains all of
the data synthesized up to the point where the multiplex engine
stopped. This option is available only while the Multiplex
Engine is running.

Standard Mode Enforces conformance to the selected standards when editing
some fields that can be generated automatically.

Expert Mode Inhibits the above conformance checking so that nonconfor-
mant files may be created.

Report Provides the option of printing all or part of the transport
structure to either a file or a printer.

Seamless When enabled, the program specified in Seamless Settings is
processed and made seamless.

Seamless Settings Opens a dialog box in which the Make seamless parameters
are specified.

Table 8−10 lists the options available in the Window menu.

Table 8−10: Window menu options 

Command Function

Cascade Cascades the open windows when Options > Single Section
View is disabled.

Tile Tiles the windows horizontally when Options > Single Section
View is disabled.

Arrange Icons Aligns icons of any minimized windows at the bottom of the
program’s main window.

1 <window title>
2 <window title>
3 ... etc.

Makes the named window active, putting it on top of any
windows that had been hiding all or part of it.

Multiplex menu options

Window menu options
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Table 8−11 lists the options available in the Help menu.

Table 8−11: Help menu options 

Command Function

About Multiplexer Opens a dialog box that displays the program version number
and license number.

Toolbar

Toolbars provide a set of convenient shortcuts for the more frequently used menu
options. The buttons are context sensitive and are enabled or disabled depending
upon the currently highlighted view or the action being performed.

The Toolbar can be hidden from view by selecting View > Toolbar.

Help menu options
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Status Bar

The Status Bar may be hidden from view, but when displayed it is always at the
bottom of the main window. For example:

Message Filter

Standard
interpretation

TS Rate TS Duration Progress

ProcessingUser mode

The following information is displayed from left to right on the Status Bar:

Message Field Provides a description of any button or menu option
over which the cursor pointer is placed. Other noncriti-
cal messages may also be shown.

Filter Status Indicates the status (On/Off) of the SI Filter.

Standard Interpretation Indicates the selected standard with which the file is pro-
cessed: MPEG-2, ATSC, DVB, or ISDB.

TS Rate & Duration Shows the transport stream rate and the duration at that
rate. A default rate is displayed during initial analysis.

User Mode Shows User mode selected: Expert or Standard. The
Standard mode prevents changes to certain fields. The
Expert mode enables editing.

Processing Status Indicates the progress (%) during initial analysis and
multiplexing.

Processing Progress Indicates the progress during initial analysis and multi-
plexing.

The Status bar can be hidden from view by selecting View > Status Bar.

NOTE. The status bar (Standard interpretation) displays ISDB−T SS whenever
the ISDB interpretation with Single segment extension is selected.
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User Interface

Title bar

Menu
bar

Toolbar

Status

Navigator area

Section area

Right−click menu

Log View

NOTE. The Menu Bar contains the complete selection of options available in the
Multiplexer. Shortcuts to options are available through the toolbar and
context-sensitive shortcut menus.
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Icons are used throughout the Multiplexer user interface to assist you to identify
components and make visual links with toolbar shortcuts and menu options.

The following table lists all the icons used.

Table 8−12: Icons 

Icon Description Icon Description

About Multiplexer Program

Add Program Group

Audio stream Program Wizard

Bit field Properties

Close Report

Container/Loop Seamless

Copy Seamless Settings

Current selection Section

Cut Section timing

Delete Section View

Display Filter dialog box Single window

Examine Transport Stream Standard mode

Exit Start

Expert mode Stop

Export Table

Icons
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Table 8−12: Icons (Cont.)

Icon DescriptionIconDescription

Export As Transport Stream icon

Export Elementary Stream Transport Wizard

Export Payload Unknown

Export Section Data Video stream

Import Section Data View Event Log

Modify View Component Duration

New View Component Bit rate

Open View Available Bit Rate

Paste
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Table types, sections, and PIDs can be cut, copied, and pasted using the
Windows clipboard. Only one selection can be held on the clipboard at a time.
Alternatively, a selection can be dragged and dropped using the mouse.

Cutting a Selection to the Clipboard. A selection (table type, section or PID) can
be deleted and automatically placed on the Windows clipboard. It can then be
pasted to a different file or back into the current file. Highlight the selection in
the Navigator Tables or PIDs view and select Edit > Cut or use the Ctrl+X
keyboard shortcut.

Copying a Selection to the Clipboard. A selection (table type, section or PID) can
be copied to the Windows clipboard. From the clipboard, it can be pasted to a
different file or back into the current file.

Highlight the required selection in the Navigator Tables or PIDs view and then
select Edit > Copy or use the Ctrl+C keyboard shortcut.

Pasting a Selection from the Clipboard. More than one instance of Multiplexer can
run concurrently on a machine. A selection (table type, section, or PID) can be
pasted from the clipboard into any open transport stream file. The contents of the
clipboard are not affected by the paste operation, so the section can be pasted to
many files and more than once to the same file.

Activate the Navigator Tables or PIDs view of the required transport stream file
(that is, in an instance of Multiplexer). Then select Edit > Paste or use the
Ctrl+V keyboard shortcut.

The section/version is always appended to the end of the list under the appropri-
ate table. Program/version numbers are automatically created. If the table is not
present in the multiplex configuration, it will be created automatically.

Cutting and Pasting
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A concept familiar to Windows users is “drag and drop” in which files can be
highlighted by clicking on them with the mouse and then dragged and dropped to
a new location, either in the same application or across applications.

In Multiplexer, the main uses of the drag and drop feature are to modify
multiplexes and to build new ones.

Elements can be dragged within Multiplexer, or from the Multiplexer Browser,
Windows Explorer or other instances of Multiplexer.

Program references and numbering will be automatically added and/or updated
when a new program is dropped onto the Navigator Programs view.

NOTE. Only the MPEG aspects of the transport structure are updated. Tables
specific to DVB and ATSC are not updated.

Manipulation in Program view. The following manipulations are available in the
Program view:

� When using Navigator Program view, a program can be copied or dragged.
The program can be dropped only on the transport stream node of the
Program view.

� Only the standard MPEG elements are copied, namely the PAT entry, the
PMT section and the elementary streams. Standard dependent information is
not copied, for example, DVB SDT.

� Where a conflict occurs with the target, new values will be allocated for the
Program and PID numbers.

� Elementary streams can also be dragged and dropped between Program
Views. They can be dropped only onto the elementary stream root node.

� An elementary stream may have a stream type, a component tag and
descriptors associated with it; this information is retained during a drag and
drop in the program view. The program view displays this information when
the properties dialog box is activated.

Dragging and Dropping
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Wizards

In the Navigator Programs view, wizards provide you with a step-by-step
approach to building streams to be multiplexed by offering defaults for PSI/SI
and the opportunity to include user-selected programs. The standard previously
selected in the Interpretation dialog box will dictate which PSI/SI components
are offered.

There are two major wizards: the Transport Wizard and the Program Wizard.
Other minor wizards may be opened by these major wizards or they may be
opened in a new window to facilitate specific tasks, such as adding EIT
information. When configuring a new multiplex, the Transport Wizard is opened,
followed by the Program Wizard; although, on completion of the Transport
phase, an opportunity to exit the wizard process is offered before the Program
Wizard opens. For some detailed operations, only the appropriate wizard can be
opened.

At their most basic level, wizards open, in a logical order, the property dialog
boxes that are available when building a stream manually.

The following paragraphs provide a step-by-step description of the wizards.

The following control buttons are provided on the wizard dialog boxes where
relevant:

Next Retain changes made using this dialog box and
move to next dialog box.

Back Discard changes made using this dialog and return
to the previous dialog box.

Cancel Exit the wizard and discard all changes.

Finish Exit the wizard and implement all changes.

Transport Wizard

Toolbar icon: 

The Transport wizard allows you to easily create a basic stream populated with
the PSI/SI necessary to hold program information. It may also be opened when
PSI/SI is to be added to an existing stream.

Wizard Controls
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The following steps show the screens used in the creation of a DVB stream.

NOTE. When the Transport Wizard is used to populate a new stream, if the
defaults in the various dialogs are retained, then the resulting stream will
conform to the selected standard.

1. Open a new file; File > New.

2. Select the Program tab in the Navigator view.

3. Select and highlight the Transport Structure element; at this stage in the
creation of a new stream, this will be the only element visible in the Program
Navigator view.

4. Select Add from the shortcut menu.

Creating a New Transport
Stream
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The Transport Stream Settings dialog box allows you to set up the transport
stream identity (part of the PAT section) and version. Adjustments can also
be made to the PAT timing, if required, by selecting the PAT button.

PAT timing - see Editing PSI/SI Table Properties, page 8−92.

NOTE. You cannot add a PAT with the ISDB interpretation and Single segment
extension selected. When you click Add, Add a Program wizard is displayed
instead of the Transport Stream Settings.

5. Select Next to move to the Optional Tables dialog box.

6. This dialog box allows you to include, and if required, configure basic
PSI/SI information.
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As the check box next to each table is enabled, the table name is added to the
graphical representation on the left. The associated buttons are also enabled
to allow timing or other aspects of the table to be modified.

NIT, TOT, and TDT Timing - see Editing PSI/SI Table Properties, page 8−92
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To set up the Network Information Table (NIT), enter or select the required
values and select the OK button. Note that if a Delivery System other than
Undefined is selected, an additional settings dialog box becomes available,
specific to the Delivery System chosen.

NIT Settings
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7. Select Next to move to the Transport Wizard Complete dialog box.

This dialog box allows you to review the changes made by the wizard before
confirming the process.

The process can be cancelled, thereby losing all changes, by selecting the
Cancel button.

At this stage in the creation of a new multiplex, if you want to add programs,
leave the Add Program Wizard check box enabled and select Next. If you want
to add them by some other means, clear the Add a Program Wizard check box.
The Next button label will change to Finish, which allows you to exit the wizard
and implement all changes.

When the Transport Wizard has closed, note that the Navigator views are
updated with the new PSI/SI.
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Program Wizard

Toolbar Icon: 

The Program Wizard allows you to add programs as required to a stream that is
already populated with basic PSI/SI. Each use of the Program Wizard allows the
addition of one program. Adding more programs requires the wizard to be
opened each time.

If a new stream is being created, the Transport Wizard offers an opportunity to
open the Program Wizard. Alternatively, in the Navigator Programs view,
highlight the Programs node and select Add from the shortcut menu.

To add a program to the transport stream, follow these steps:

NOTE. If, when the Program Wizard is used to add programs to a stream, the
defaults in the various dialogs are retained, the resulting stream will conform to
the DVB standard.

1. When you open the Program Wizard, either as a continuation of creating a
new stream or as an attempt to add a new program, a dialog box similar to
that shown below is displayed:

Adding a Program to a
Transport Stream
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The values placed automatically in the three displayed fields will be the next
in the sequence of programs. (In the example screen, the stream contains no
prior programs, hence this is program number 1. PID 32 is used because that
is the first free PID after the reserved PSI/SI PIDs.)

PMT Timing - see Editing PSI/SI Table Properties, page 8−92.

2. Select Next to move to the Add Service Description dialog box.

NOTE. If ISDB interpretation with Single Segment extension is selected the
program number starts from 8 (default). However,  you can enter numbers from 1
to 7.

The Service Description dialog box allows you to identify the Service Provider
to be associated with a program.

3. By default, the Add Service Description check box is clear. When it is
enabled, a Service Provider Name and a Service Name must be entered and a
Service Type selected from the drop-down list. If no details are provided, the
section will still be created but the relevant descriptors will be empty.

Service Description Dialog
Box
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Enabling the Use Single Section check box will cause the SDT descriptors to
be added to the existing SDT section. If the stream contains no SDT section,
the check box is disabled.

SDT timing - see Editing PSI/SI Table Properties, page 8−92.

4. Select Next to move to the Program Content dialog box.

This dialog box allows you to compile a list of elementary streams to be
associated with the program in the final multiplex.

5. Select Add to display the Add Program Stream dialog box.

Program Content Dialog
Box
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This dialog allows you to identify elementary streams to be included in the
new multiplex. You must specify the PID and Stream Type of the new
stream. A Component Tag can also be allocated.

If the Component Tag is enabled, it can be referenced by other tables, for
example, the Event Information Table.

The dialog box consists of three tabbed pages that specify the source of the
stream, its timing within the multiplex, and whether it should be carrying a
PCR PID.

6. Select a Stream Type from the drop-down list.

This will be the Stream Type allocated to the stream in the new multiplex.
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NOTE. The Stream Type drop−down list displays the previously selected stream
as the default type.

7. Allocate a PID Number in which the elementary stream is to be carried.

8. Enable the Component Tag check box, if required. Enter a Component Tag
number (0−255) in the enabled field.

Source Tab. The Source tab of the Add Program dialog box is used to select and
specify elementary streams to be included in the new multiplex.

9. Enter an elementary stream File Name. You can enter it directly or use the
Browse button to open a standard Windows file selection dialog box.

10. Select the File type of the selected stream from the drop-down list.

� If you select MPEG-2 video, the bit rate is detected automatically and
displayed in the Bit rate field.

� If you select H.264 video with SEI messages, the bit rate is detected
automatically and displayed in the Bit rate field.

� If you select H.264 video without SEI messages, the bit rate is not
detected automatically.
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When the selected file type does not match with the selected file name,
an error message is displayed and you will have to reselect the correct
file type.

The remaining fields on this tab will be enabled or disabled depending on the
Stream Type selected. Complete the enabled fields as necessary.

11. If you select H.264 video with SEI stream, a Suppress PTS/DTS insertion
check box is displayed.  The PTS/DTS insertion can be suppressed by
selecting this check box.

Enter Bit rate for H.264 non-SEI streams. You can assign the bit rate in the
following ways:

� If you know the actual bit rate of the ES, enter the value in the Bit rate
field. Select the frame rate from Frame rate box and click Accept. The
entered bit rate will be displayed in the Bit rate field of the Source tab.
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� If you want the Multiplexer to auto detect the possible bit rate, select the
Frame rate and click Detect Bit rate. A progress bar is displayed giving
the percentage of the scan completed and the bit rate is automatically
filled in the Bit rate field of the Source tab.
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You can detect the bit rate by setting the scan value in the Scan settings
dialog box. Select the options accordingly to scan the entire source file,
bytes of the source file, or percentage of the source file.
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Timing Tab. The Timing tab of the Add Program dialog box is used to specify the
portion of the new multiplex that the selected stream will use. The default start
time is set to 0.002 s.

12. Complete the fields as required. The default settings assume that the stream
is to be carried throughout the new multiplex, looping if necessary.

PCR Tab. The PCR tab of the Add Program dialog box is used to specify whether
PCR information should be carried with the selected elementary stream or in a
separate associated PID.

13. If the PCR is to be held in an associated PID, disable the Carry PCR check
box and enter a PCR PID number.

14. If the PCR is to be carried with the stream, enable the Carry PCR check box
and complete the remaining fields as required.

Set Defaults returns the settings to their initial values.
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15. Select the OK button to complete adding an elementary stream to the listing
in the Program Wizard.

16. More streams can be added using the Add button. Listed streams can be
deleted using the Delete button. Details of listed streams can be modified
using the Update button.

This completes the addition of one or more program streams.

17. Select Next to move to the Event Information dialog box.

For more details about the fields on these tabs, refer to Adding an Unreferenced
Elementary Stream, page 8−99.
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The Event Information dialog box allows you to add Present and Following
event information.

18. If the Event Information Table (EIT) is to be included in the multiplex,
enable the Event Information Table check box.

19. Enable the Present and Following check boxes as required.

 Present/Following timing - 

For more information on Present/Following timing see Editing PSI/SI Table
Properties, page 8−92.

Event Information Dialog
Box
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20. Use the Settings buttons to open the Present/Following Events dialog box
and add and specify events as required.

21. Select Next to move to the Program Complete dialog box.
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The Program Complete dialog box provides you with a summary of the created
Transport Structure.

22. To confirm and implement the Transport Structure, select the Finish button.

Note that the proposed structure is created in the Navigator views.

This completes the procedure of adding a program to a transport stream using the
Program Wizard.

Program Complete Dialog
Box
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Views

Multiplexer contains a number of views, which are displayed in the working area
of the user interface. All of the views can be manipulated using conventional
Windows techniques. The Navigator and Error Log views can be docked against
the edges of the UI or floated independently of the Multiplexer window. The
Section view can be manipulated within the Multiplexer window, including tiling
and cascading where multiple Section views are displayed.

Each available view displays a different aspect or level of detail of stream
analysis and manipulation.
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Navigator Views

The Navigator view contains three subviews or tabs: Programs, Tables, and
PIDs.

The Navigator Programs view extracts and displays system information that is
relevant to programs. Information that is not directly related to programs (for
example, NIT), or that has not been incorporated into a program (for example,
elementary streams not listed in a PMT) will be omitted from the Program view.
The system information is still available for viewing in the Navigator Tables and
PIDs views.

It is recommended that manipulation of programs and elementary streams should
take place from the Program view.

Program Views
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The Tables view displays high-level structure of the Program and System
Information Protocol (PSIP), Service Information (SI), and Program Specific
Information (PSI) tables. More detailed payload information can be examined
and edited, for a selected section of a table, using the Section View.

Any PSI/SI information that the program cannot confidently analyze, will be
shown in the PIDs view.

Tables View
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The PIDs view displays the PIDs contained in the stream. The PIDs are
displayed in ascending numerical order.

PSI/SI table types are identified in the section nodes of System Information
nodes.

Elementary stream PIDs are identified by source and type where possible.

PIDs View
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Section View

The Section View displays the contents of the currently selected section in any of
the Navigator views.

The Section view is dynamic in that it will be instantly refreshed if a new section
is highlighted in the Navigator view. If no section is selected, the Section view
will be blank.

The lock icon - - adjacent to certain elements of the table in the Section view

indicates that those items have restricted access due to the mode of user
operation: Expert or Standard.
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The following diagram shows a section from a Master Guide Table (MGT).

The syntax specified for an MGT in the ATSC standard A65 is:

master_guide_table_section () {
table_id
section_syntax_indicator
private_indicator
zero
section_length
table_id_extension
reserved
version_number
current_next_indicator
section_number
last_section_number
protocol_version
tables_defined
for (i=0;i<tables_defined;i++) {

Syntax of a Section
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table_type
reserved
table_type_PID
reserved
table_type_version_number
number_bytes
reserved
table_type_descriptors_length
for (k=0;k<N;k++)

descriptor()
}
reserved
descriptor tag
descriptors_length
for (I = 0;I< N;I++) 

descriptor()
CRC_32

}

The terms used in this manual to describe the components, represented by nodes,
in the structure diagram are:

Container A term used to describe a node in the structure diagram
which may contain zero, one or more loops. It is analo-
gous to the for (i=0;i<loops_defined;i++) statement used
to describe the syntax of a table in the ATSC standards.
The container is always preceded by a field which speci-
fies the number of loops it contains.

Loop Describes a data structure composed of a specified set of
fields and subordinate loops. The structure diagram
shows each loop as a node with the fields and subordi-
nate loops as children. Each loop node in the section
view represents one iteration of the loop body (the con-
tents of the curly braces { }) in the syntax specified by
the ATSC standards.

Field Fields are referred to in the standards documents as both
data items and fields. They are the smallest pieces of
information that make up a table.
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For example, taking an MGT that defines three tables, the Section View
represents the syntax and contents of the Tables container like this:

Container for a
set of zero or
more

Contents
of the first
loop

Number of loops

Container

 First loop

Second loop

Last loop

The loop for the first table, EIT-0 has been expanded to show the fields and
subordinate loops that it contains.



Multiplexer − Views

MTS400 Series MPEG Test Systems User Manual 8−57

The ATSC standard A65 defines a data structure called the Multiple String
Structure. An instance of this structure may contain zero or more strings and
each string may contain zero or more segments. The syntax specified for a
Multiple String Structure in A65 is:

multiple_string_structure () {
number_strings
for (i= 0;i< number_strings;i++) {

ISO_639_language_code
number_segments

for (j=0;j<number_segments;j++) {
compression_type

mode
number_bytes
for (k= 0;k<number_bytes;k++)

compressed_string_byte [k]
}

}
}

Using the notation of container, loop, and field nodes, Section View represents
the Multiple String Structure in the same way as any other data structure. For
example: an Extended Text Table (ETT) carries its extended_text_message in a
Multiple String Structure. The default view of a section of an ETT in the Section
View looks like this:

Section view displays a node for the extended_text_message with as much as
possible of the first segment from the first string.

Syntax of a Multiple String
Structure
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Expanding the node reveals a number_strings field which specifies the number
of strings and a container which holds them (strings):

The number_strings field shows that there are two strings in this example.
Expanding the strings container shows the loop for each string. From this it can
be seen that both strings are in English.

Expanding each of the strings reveals the number of segments (number_seg-
ments) that make up each string and a segments container. Similarly, expanding
the segments container reveals segments.
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The contents of each segment loop define what compression and character set are
used, followed by the actual text. The text is held in the compressed_string field.
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The Multiplexer has two modes of operation for conformance checking when
editing table contents. These are selected from the Multiplex menu. The checks
that affect the Navigator are:

Standard Mode Prevents changing the PID of a table whose PID number
is specified in the standard, for example, PID 0x0 carries
the PAT.

Expert Mode A warning is displayed and confirmation requested be-
fore changing the PID of a table whose PID number is
specified in the standard.

An adjacent check mark indicates the mode selected. The mode is also indicated
on the Status Bar.

Expert and Standard
Modes
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In the Section View a padlock symbol is displayed adjacent to all of the

fields that cannot be edited in the current mode. For example, the screens below
show the same tables in Standard and Expert mode.

Standard Mode Expert Mode

NOTE. The current_next_indicator in both Standard and Expert mode cannot be
edited. This is because the field is affected solely by the Section Properties
concerned with Version Timing (see Version Timing, page 8−94).

The selected mode is also reflected in the Wizards that are used to facilitate
creation of multiplexes. Elements that are restricted in the tables in Standard
mode will also be restricted in the relevant wizard. Similarly, elements that are
enabled in Expert mode will be enabled in the associated Wizard.

NOTE. The section view may need to be closed and reopened in order to update
the padlock icons.
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Structure Diagram Manipulation

A tree diagram, with the “root node” or highest level component at the top
represents the Transport Structure. A square box indicates components that
contain more information beneath them in the structure.

Click on the box
to show or hide
the details
under the node.

Clicking on the box does not select that node. It only shows or hides the next
level of detail under that node.

If the node has a minus sign in the box the level of detail below it is currently
displayed. The lower level(s) may be hidden by clicking the mouse pointer on
the box.

If the box contains a plus sign, there is another level in the node that is currently
hidden. Click the mouse pointer on the box to display the next level of informa-
tion under the node.

Components that are connected to a branch of the tree without a square box are
leaf nodes; the accompanying icon indicates the node type. They display the
lowest and finest level of detail available in this diagram. These are either a
Section of a Table or a PID.
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Fields in the Section view that cannot be edited directly are indicated by a

padlock symbol, . This protection can be switched off by selecting Expert

Mode from the Multiplex menu. It can be reenabled by selecting Standard Mode.

Event Log

Messages about significant events are written to the Event Log from the time a
file is first opened. The Event Log can be opened for viewing at any time during
or after the initial analysis. When the initial analysis is done, the mean transport
rate, bit rate for each PEES PID, and a Demultiplex complete message are
written in the Event Log.

The start and end times for generating a new transport stream are shown by the
Multiplexer started and Multiplexer completed messages.

Note that when demultiplexing and multiplexing streams, the bit rate at which
the demultiplex or the multiplex is performed is given in the Event Log. This is
in addition to the stream bit rate derived from the stream itself.

When synthesizing a new transport stream any errors or warnings about the new
stream are written to the Event Log between the start and completed messages.

The Category column indicates the type of event. The subject or time of the
event is shown in the Reference column and the details are given in the
Comment column.

The complete text can be copied onto the Windows clipboard, using the Copy
option from the shortcut menu. The text can also be cleared with the Clear
command. Both commands are also available from the Edit menu.
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Examine Transport Stream Window

The Examine Transport Stream (Examine TS) window (File > Examine TS)
performs two main functions within the Multiplexer:

� It allows you to take an overview of a transport stream before subjecting it to
full analysis.

� It allows tables and programs to be dragged and dropped from the examined
stream to the file that is currently open in Multiplexer.

Menu
Bar

File
Summary

Navigator
Views
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The Examine TS window menu bar contains only two items: File and Edit.

File Menu. Table 8−13 lists the items in the File menu.

Table 8−13: Examine TS - File menu options 

Command Function

Open... Analyzes and opens the selected file in the Examine TS
window. Closes the current file.

Close Closes the Examine TS window.

Edit Menu. Table 8−14 lists the items in the Edit menu.

Table 8−14: Examine TS - Edit menu options 

Command Function

Copy Copies the currently highlighted section to the clipboard.

These fields provide a brief summary of the analyzed file.

Filename  The filename of the examined stream.

Interpretation The interpretation applied to the stream. This is the same
as that selected in the Multiplexer application through
the View menu: MPEG-2, DVB, ATSC, or ISDB.

TS Rate The transport stream bit rate derived from the stream.

Duration The duration of the transport stream.

Status The status of the stream analysis.

The Examine TS Navigator views correspond to the Navigator views in the main
application. Programs, Tables, and PIDs are shown as they would be after a full
analysis. The PSI/SI tables are expanded and collapsed in the same manner. The
Section view is not available in the Examine TS window.

Menu Bar

File Summary

Navigator Views
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While examining transport streams, it is possible to copy sections to the main
multiplex using the standard Windows techniques: copy and paste or by dragging
and dropping them with the aid of the mouse.

For example, to import a section that is visible in the Examine TS window into
the new multiplex configuration:

1. Select the Navigator Tables view.

2. Highlight the section to be copied in the Examine TS window and do one of
the following:

� Select Edit > Copy. With the Navigator Tables view active, select Edit >
Paste.

� Using the mouse, place the cursor over the highlighted section, press and
hold the left button on the mouse and drag the section onto the Navigator
Tables view. Release the mouse button.

3. Note that the copied section is placed in the PSI/SI structure at the correct
location. If any conflict arises concerning similar PID numbers, a new
version is created.

Examine TS Section Copy



Multiplexer − Views

MTS400 Series MPEG Test Systems User Manual 8−67

SI Filtering

Table elements can be excluded from the Navigator Tables view using the
Display Filter available through Options > Display Filter.

The following dialog box is displayed:
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Example: Before filtering, the stream tree may be as shown below:

In the Filter SI Display dialog box, table identities are listed in the Table Id
drop-down menu.

All sections of a table can be excluded by enabling the Exclude all table sections
check box.

To preview the result of filtering, select the Apply button.

Selecting a Table for
Filtering
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Note that all reference to the PMT tables is removed as shown below:

To exclude a range of sections, enable the section by selecting from the Table ID
drop-down list and entering the required range.

Note that section names shown in the dialog box change according to which
table is selected.

To preview the result of filtering, select the Apply button.

For example, the following settings will result in the display shown overleaf:

NOTE. Minimum and maximum values may be entered in either decimal (12345)
or hexadecimal (0xA12B) format.
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The parameters for each table must be set individually. Overall settings can be
applied individually by selecting the Apply button when a setting is made or as a
whole by making all of the settings and selecting the OK button.

To preview the result of filtering, select the Apply button. All settings can be
cleared by selecting the Clear All button.

Note that filter settings remain in force for as long as the current multiplex is
active. The settings are lost when the Multiplexer is closed unless they have been
previously saved.

The filter settings made in the Display Filter dialog box can be saved and
subsequently reapplied to the same stream or other streams.

To save the current filter settings, select the Save button and enter a name (and
location) in the Save As dialog box. To retrieve or load filter settings, select the
Load button and identify the filter file in the Open dialog box. The file extension
*.fil is used.

Saving/Loading SI Filter
Settings
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Component Views

The Component views provide a graphical view of the bit rate and duration of
the components of a stream. The management of the views has a number of
common features; these are described in the Common Features, page 8−77.

The Component Bit rate view provides a graphical comparison of the stream
components.

Open the Component Bit rate view either by selecting View > Component Bit
rate from the Menu Bar or the toolbar button.

Each component includes the following information: Program name, PID,
Description and the Bit rate in numerical and graphical form. Where appropriate,
the Service ID and the Service Name is displayed (extracted from the SDT).

The Component Duration view provides a graphical view of the timing and
duration of each program/component within the current stream. Adjustments can
be made to the duration of each component.

Component Bit rate

Component Duration
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Open the Component Duration view by selecting either View > Component
Duration from the Menu Bar or the toolbar button.

The following data is displayed for each component of the stream: Program,
Description, PID, Start and Stop time (in numerical and graphical form), Length
and Bit rate. The timing and bit rate elements of this information are also
available in the Program Stream Properties dialog box. (See Program Content
Dialog Box, page 8−37.)
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Scaling Bar. The Scaling bar, which is displayed at the top of the Component
Duration view, allows you to select the portion of the transport stream that is to
be displayed.

(After
adjustment)

(On opening)

Stream limits

Display limits

Display Limits Pointer position

Pointer

The Stream limits bar represents the full extent of the stream. The Display limits
bar (dark portion) indicates the portion of the stream that is currently displayed
in the body of the view.

The Display limits fields indicate the extents of the Display limits bar and the
current Pointer position.

The Pointer can be dragged to a new position on the Stream limits bar. The
Display limits bar will center on the Pointer.
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Duration Control. The duration of each element in the stream is given by the Start
and Stop values and shown graphically by the associated bar. The components
are color coded according to which program group they belong to.

The Start, Stop and Length values can be changed by clicking on the appropriate
field and entering the required value. The associated bar will reflect the change.

The Start, Stop and Length values can also be changed graphically by manipulat-
ing the bar. The cursor shape indicates the action that can be taken.

The changes are reflected in the associated field values.

Components can be changed individually. In addition, whole Program groups
can be changed by manipulating the Program duration bar, but only when the
view is sorted by Program.

Program duration

A vertical dotted line indicates the upper limit of the multiplexed stream.



Multiplexer − Views

MTS400 Series MPEG Test Systems User Manual 8−75

In the Transport Stream Properties dialog box (View > Properties with the
Transport Stream node highlighted in the Navigator Programs view), you can
determine how and if the stream duration is updated. The available options will
be:

� Select Fixed to ensure that the stream duration can only be updated in the
Stream Properties dialog box.

� Select Set to the greatest component stop time to ensure that the stream
duration is set to the greatest stop time recorded in the SI/PSI/PSIP tables.

Component start and stop times changed in the Component Duration view are
automatically updated in the SI/PSI tables.
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The Available Bit rate view displays in graphical form the available bit rate for
the duration of the multiplex.

The bit rate is calculated using the MGB2 measure (Ref: ETSI TR 101 290).
Open the Available Bit rate view by selecting View > Available Bit rate from the
Menu Bar or by using the toolbar button.

If the bit rate falls below zero, the points will be highlighted in red. When
editing a multiplex, you can add components which cause the bit rate to fall
below zero and no warnings will be displayed. However, if a transport stream is
then generated, errors will be logged and displayed in the Log view.

Use Refresh to redraw the graph. Clicking anywhere within the graph will place
a vertical cursor at that point; the position and bit rate are displayed in the Time
and Available Bit rate fields.

The zoom level and cursor placement of the Available Bit rate and the Compo-
nent Duration views can be synchronized by selecting View > Synchronize.

Available Bit rate
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Columns in the Component views can be sorted and rearranged to suit your
preferences. Column management in the two Component views is similar.

Field Selection. You can select the fields to be displayed in each Component
view. The Header bar indicates which fields are currently displayed.

When you right-click on the Header bar, a menu is displayed. You can select
which fields are to be displayed. A check mark next to a field name indicates that
the field display is currently enabled.

The version number of the PAT and PMT can be displayed in the Description
column by enabling the Show program version option in the shortcut menu from
the Description column header.

Similarly, the PID numbers can be displayed in hexadecimal, by selecting
Display in hexadecimal from the PID column shortcut menu.

Common Features
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Column Repositioning. Columns can be repositioned as required. Click and drag
the column to the required position.

Column Width. Columns can be resized as required. Place the cursor over the
dividing line between two columns; it will change to the resizing cursor. Click
and drag the column to the required width. The change will be made to the
column to the left of the cursor.

Double-clicking the column divider will automatically resize the column to the
left to the optimum size required to view the content.
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Column Sort. Columns can be sorted in ascending or descending order. Click the
cursor on the heading to sort the column. Clicking again will sort the column in
reverse order.

Similarly, the columns can be grouped in Program order, by clicking the
Program header.
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Common Menu Options

The specifications for components of the various views can be manipulated by
options from the Edit menu, View Menu, and Toolbar.

There is also a shortcut menu that provides the Add, Modify, Delete, Import,
Export and Properties options. Place the mouse pointer over the component to
change and click the right mouse button to open the menu.

A typical shortcut menu is shown here:

The menu options are context-sensitive and will be enabled or disabled
according to the current selection in the view.

The following options are available from the various shortcut menus:

Add Adds a component to the currently selected item.

Modify Opens the properties dialog box.

Delete Deletes the currently selected component.

Properties Opens a properties dialog box for editing the
currently selected item.

Export Payload Extracts and exports the payload of the source
transport stream in the form of a simple data file.

Export Elementary
Stream

Removes the transport stream and PES headers and
exports the remaining information in the form of a
simple data file.

Export Section Data Extracts and exports section data. The created file
can be imported as ES using Multiplexer’s Add
function or as SI using the Import Section Data...
option.

Import Section Data Imports SI data form a file and analyzes it. The
section is added to the Navigator view.
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Editing in the Navigator Views

Multiplexer provides a variety of ways of building and modifying transport
streams for multiplexing. In addition to the Menu Bar options and Toolbar
shortcuts built into the Multiplexer, many of the operations can be carried out
using familiar drag and drop Windows techniques.

In the following descriptions, the alternative methods for carrying out a task are
given at the head of the section, but only one method is described for each
action. Other methods for the same action often invoke the same dialog boxes
and sequence of follow-on actions.

Dragging and Dropping

To drag a file, click on its name and hold down the left button of the mouse
while dragging the file to the required location. The cursor will change according
to the background that it is dragged over:

(With Ctrl key held) when dropped, the file will
be copied.

When dropped, the file will be moved (cut and
pasted).

When dropped, no action will be taken.

Note that as the file is dragged over elements in the Navigator, receptive
elements (elements where the file can be meaningfully dropped) will be
highlighted.
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Transport Stream

For information on Opening a Stream, refer to page 8−11.

For information on Opening a Stream, refer to page 8−11.

To specify a new bit rate or duration for the transport stream, select and highlight
the Transport Structure component in the Navigator view.

From the shortcut menu, select Properties. The dialog box shown below will be
displayed.

Edit the Bit rate and the Duration as required, then click on the OK button.

Opening an MPEG File

Opening a Multiplexer File

Changing Transport
Stream Bit rate and

Duration
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Programs

The introduction of the Navigator Programs view has provided a more program-
centered means of manipulating SI/PSI. Whole programs can be added to the
multiplex and the application will update the associated tables, including the PAT
and PMT.

Note that the nodes of the tree structure in the Navigator Programs view are
context sensitive. When dragging and dropping files from either the Examine TS
window or from another instance of Multiplexer, a node will only be highlighted
as the cursor passes over it when the operation proposed is legal. Note that there
may be a short delay before the node is highlighted while the legality of the
operation is checked.

With the Transport Stream ID field highlighted in the Navigator Programs view,
selecting the Add option either from the shortcut menu (PAT highlighted in
Navigator Programs view) or the Menu Bar (Edit > Add) will open the Program
Wizard (see page 8−35).

In the Navigator Programs view, the PAT is represented by the Transport Stream
ID field.

Adding a New Program
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Methods available:

� Drag and drop (copy only) from the Examine TS window (Programs view)
to the Navigator Programs view.

� Drag and drop (copy/move) from another instance of Multiplexer to the
Navigator Programs view.

In the Navigator Programs view, programs can only be dropped onto the PAT
node.

Copying/Moving a
Program
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Tables

Methods available:

� Highlight the PSI/SI Tables level in the Navigator Tables view and select
Add from the shortcut menu.

� Drag and drop (copy only) from the Examine TS window (Tables view) to
the Navigator Tables view.

� Drag and drop (copy/move) from another instance of Multiplexer to the
Navigator Tables view.

Any Table that is defined in the selected standards, and not already present, can
be added the transport stream. To add a table to the transport stream, click on
PSI/SI Tables in the Navigator Tables view:

1. Highlight the PSI/SI Tables level and select Add from the shortcut menu.

Adding a New PSI/SI Table
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This will open the Select dialog box. The dialog box displays a list of the
table types that are not already present in the stream.

NOTE. A PAT table cannot be added when ISDB interpretation with Single
segment extension is selected.

2. Highlight the required table type and then select the OK button.

Pressing Cancel will abandon the operation without adding a new table.

Only the table types that are not currently specified for the stream are listed.
If the required table type is not listed, press the Cancel button to close the
dialog box without affecting the specification for the stream.

The Select PID & Table ID dialog box is displayed only if a PID and/or
Table ID need to be identified. Otherwise, the selected Table type is
automatically created.
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A single section is automatically added to the newly created table type.
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Methods available:

� Drag and drop (copy only) from the Examine TS window (Tables view) to
the Navigator Tables view.

� Drag and drop (copy/move) from another instance of Multiplexer to the
Navigator Tables view.

Tables can be copied (or moved) from existing multiplexes, using either of the
available methods.

If a similar table type is already present in the multiplex, the contents of the
copied table will be integrated with it.

A table is automatically removed when the last section is deleted 
(see page 8−96).

For more information on Exporting a Section, refer to page 8−97.

For more information on Importing a Section, refer to page 8−98.

Copying a PSI/SI Table

Deleting a PSI/SI Table

Exporting a Table

Importing a Table
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Sections

Methods available:

� Highlight the parent table level in the Navigator Tables view and select Add
from the shortcut menu.

� Drag and drop (copy only) from the Examine TS window (Tables view) to
the Navigator Tables view.

� Drag and drop (copy/move) from another instance of Multiplexer to the
Navigator Tables view.

To add a section to a table, select the parent table in the Navigator Tables view.
For example, to add a section to the SDT, select SDT Tables:

Then select Add from the shortcut menu.

The Select PID & Table ID dialog box is displayed only if a PID and/or Table ID
need to be identified. Otherwise the selected section is automatically created.

Adding a New Section to a
PSI/SI Table
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Select the required PID and Table ID (where enabled) and press OK.

Pressing Cancel will abandon the Add operation without adding a new section.

The version/section of a table is created with a new version or section number.
The rules used by Multiplexer for numbering are:

� For tables that the selected standard dictates should always have a section
number of 0, the version number is increased by one. The new version
number is based on the version currently in the table with the most recent
number. The version_number is a 5-bit field, so if the new version would be
32, it is reset to 0.

version_numberNEW = (version_numberRECENT + 1) modulo 32

� For any table type that allows a section_syntax_indicator, the Add multiple
sections check box in the Generate subtable part of the dialog box is enabled.
Additionally, the One section per segment check box will only be enabled
for the EIT schedule table type.
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� Up to 256 sections can be added.

� Additions to existing subtables using the same Table Id Extensions and
Versions will be rejected.

� When multiple EIT Schedule sections are being added, the One section per
segment check box is enabled. When it is checked, only the first section in
each segment will be created, rather than all sections numbered between First
section and Last section.

When dragging and dropping a section, the Multiplexer will resolve any
numbering conflicts by creating new versions of duplicated tables.
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Table and Section Properties are edited by selecting and highlighting one of the
versions/sections within the transport structure and selecting the Properties
option from the shortcut menu.

This opens a dialog box with four tabs, one for each property. Depending on the
type of table, properties can be applied to a specific version or section of the
table. Multiplexer allows only operations that make sense in the context of the
selected table type.

Editing PSI/SI Table
Properties
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The properties that can be edited from the Navigator Tables view are:

PID Number. The PID tab is displayed by default when the Section Properties
dialog box is opened.

Edit the value and select OK to change the PID number.

Edit the value and select Apply to make the changes and update the other
properties (tabs) without having to close this dialog box.

Multiplexer checks the new PID number against the selected standards and warns
of any nonconformance issues. If a conflict is found, a warning message is
displayed, with the option to continue. Multiplexer also checks for conflicts with
other PIDs. If the new PID number conflicts with an existing PID, an error
message is displayed and the change is rejected; in this case, either choose a
different PID number for the table or edit the number of the PID that is currently
the owner.

If no conflict is found, another dialog box is opened to define the scope of the
changes:
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Select the required scope and click OK. Selecting Cancel will abandon the
change.

Version Timing.  The Version timing tab shows the time when the version will
become current, and the start and end times. New values may be specified for
any of these times.

Start Time Specifies the time at which sections of this version
will start to appear in the transport stream.

Signalled As Current
Time

Controls the time when the sections with this
version will have the current_next_field set to 1.

By default when these sections start to appear in the
transport stream, the current_next_field of the
section set to 0. To specify a version that is always
current set the Start Time and Signaled As Current
Time fields to the same value.

Transmit until end of
transport stream

Enables the section to be repeated until the end of
the transport stream. If the check box is disabled,
the Stop Time becomes active.

Stop Time Specifies the time after which no sections of this
version will appear in the transport stream.

All of the times are in seconds, taken from the start of the transport stream file.
The default start time for PAT is 0.00 s and for PMT is 0.001 s.

Edit the values and select OK to change the timings. Edit the values and select
Apply to make the changes and update the other properties (tabs) without having
to close this dialog box.
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Subtable Timing. Service information is usually constrained to appear at regular
intervals in the transport stream. This is usually implemented as a maximum
time between appearances of all the sections of a subtable (where a table is
defined by the table_id, table_id_extension and version_number on the same
PID).

Use the Subtable Timing tab to specify the desired and the maximum acceptable
period between instances of the subtable. When an MPEG file has been opened,
this shows the mean time between instances of the subtable in the transport
stream.

Cycle Time Displays the mean time between instances of the subt-
able specified for synthesizing a new MPEG file. The
value can be edited to specify a different cycle time.

Beneath the Cycle Time, the dialog box displays subtable specific information
from the currently selected standard.

Edit the values and select OK to change the Cycle Times. Select Apply to make
the changes and update the other properties (tabs) without having to close this
dialog box.

When synthesizing a new transport stream, the multiplex engine tries to insert
the subtable at the frequency specified by the Cycle Time. An error message is
written to the event log whenever a subtable cannot be multiplexed into the
stream within the period specified by the maximum cycle time.
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Section Timing. Where a table can contain only a single section (for example,
TOT and TDT), a section timing tab is displayed in the Properties dialog box.

Start Time Specifies the time at which the first appearance of this
section will occur.

Stop Time When enabled, specifies the time at which the last ap-
pearance of this section will occur.

Transmit until end... When enabled, specifies that the section should be trans-
mitted until the end of the stream.

Cycle Time Specifies the interval at which the section should be
transmitted.

Max cycle time... Gives the cycle time recommended by the current stan-
dard.

Edit the values and select OK to change the timings. Select Apply to make the
changes and update the other properties (tabs) without having to close this dialog
box.

An error message is written to the event log when a table cannot be multiplexed
in accordance with the timings set.

A section can be deleted from a table by highlighting it in the Navigator Tables
view and selecting Delete from the shortcut menu. To delete more than one
section, select and delete each one in turn. When the last section is deleted from
a table, the table is automatically deleted from the structure.

Deleting a Section
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Section data can be exported in the form of a binary file. In the Navigator Tables
view, highlighting a Table node (for example, PMT Tables), allows all sections
of the table to be exported. Similarly, highlighting a single section entry (for
example, Program 123) allows only that section to be exported.

Highlight the required section or Table node in the Navigator Tables view. From
the shortcut menu, select Export Section Data. Name the file to be created and
choose a location. Select Save to confirm the action.

Individual sections can also be exported using the Navigator Programs view.
Highlight the required section to be exported. From the shortcut menu, select
Export Section Data. Name the file to be created and choose a location. Select
Save to confirm the action. Note that not all tables are shown in the Navigator
Programs view, for example, TOT.

Exporting a Section
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In the Navigator Tables view, highlight the PSI/SI Table node. From the shortcut
menu, select Import Section Data. In the PID tab of the Import Section Data
dialog box, identify the PID that is to carry the information. Similarly, in the
Source tab, identify the file that holds the section data to be imported. Select OK
to confirm the selection. During the import action, the content of the file is
examined to determine where the section(s) should be placed.

ES PIDs

ES PIDs that carry additional Elementary Streams can be multiplexed into the
synthesized transport stream. The following actions are required when defining
an elementary stream to be added:

� Allocate a PID number

� Define the source of the elementary stream to be added

� Define the timing to be applied to the new stream

� Define the PCR placement

Importing a Section
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Methods available:

� Highlight the ES PIDs in the Navigator Tables view and select Add from the
shortcut menu.

� Drag and drop (copy only) from the Examine TS window (Tables view) to
the Navigator Tables view.

� Drag and drop (copy/move) from another instance of Multiplexer to the
Navigator Tables view.

To add a new stream, highlight ES PIDs in the Navigator Tables view and select
Add from the shortcut menu.

This opens the Add Stream dialog box; the Source tab is displayed by default.

Adding an Unreferenced
Elementary Stream
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Defining the PID Source. In the Add Stream dialog box, select the Source tab; this
allows the PID source to be selected and defined.

File name Enter the file name of the stream to be multiplexed.
If the file name is unknown, select Browse to open
a standard file browser dialog and locate the file
required.

The names of files being copied to the multiplex
will be automatically filled in.

File type Select the type of file to be multiplexed from the
drop-down list box.

The following file types are available:

MPEG-1 video ES or PES
MPEG-2 video ES or PES
MPEG-2 audio ES or PES (MPEG-1 or MPEG-2)
MPEG-2 AAC audio ES or PES (ADTS format
only)
AC-3 audio ES or PES
(ES - Elementary Stream;
PES - Packetized Elementary Stream)
H.264 video ES or PES

Transport Packets: A single PID stream. The Bit rate
value will require setting. The Original TS PID will
require setting.
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Section: The content of the file will be Sections.
The sections will be in binary form. The file will
consist of one, or many sections appended one after
the other.

When multiplexed, the sections will be encoded on
the given PID as SI. If the resulting multiplex is
subsequently opened in the Multiplexer, the sections
will be interpreted as SI and displayed under the SI
Tables node in the tree.

A file generated using the Edit > Export Section
Data menu option can be used here. The Bit rate
value will require setting.

Other: Any binary or ASCII file that is to be
packetized into the transport stream at the specified
bit rate. The Bit rate value will require setting.

The remaining fields are interactive and will only be enabled when a value is
required.

Bitrate When first defining a source, the bit rate is
unknown and 0 Kbps is displayed. If a Transport
Packet Stream or an “Other” File Type is selected,
the field is enabled and a value (in Kbps) can be
entered. If MPEG-2 video or H.264 video with SEI
messages is selected, the bit rate value is detected
automatically and displayed. If H.264 video without
SEI messages is selected, the bit rate is not detected
automatically.

Original TS PID For streams other than transport streams, this field
will be blank and disabled.

Extra DTS offset When multiplexing ES or PES streams, the
Multiplexer will derive an offset between the PCR
and the decoded timestamp (DTS) of the first access
unit (video picture / audio frame).

You can override this offset and make it larger
(positive number) or smaller (negative number).
Changing this value may cause the resultant stream
to be nonconformant with respect to the T-STD of
the MPEG-2 standard. Enter the DTS offset in
seconds required.
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Stream_id Only enabled for elementary stream types. This
number specifies the value of the stream_id field in
the PES packet header.

Only needs to be set for DVB stream. Stream
identity in the PES header.

Start each field in a new
PES packet

Only enabled when File Type: MPEG-2 Video is
selected.

When disabled, both field pictures making up a
coded frame are put in a single PES packet.
Otherwise, each field picture is put into a separate
PES packet. This setting has no effect upon frame
pictures.

Start each section in a
new packet

Only enabled when File Type: Section is selected.

When disabled, SI data is placed in the packet
payloads in the most efficient manner. The start of a
section will immediately follow the end of the
previous section; no stuffing bytes will be used.

When enabled, each section will begin in a new
packet and stuffing bytes will be used to pad any
payloads that are not full.
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Defining the Stream Timing. In the Add Stream dialog box, select the Timing tab.
This tab will allow timing parameters for the selected source stream to be
defined.

NOTE. To achieve compatibility between MUX and MTS4EA, the start time is set
to the following default values: PAT is 0.000, PMT is 0.001, and ES is 0.002.

Start/Stop Time Enter the times that the selected source stream is to start
and stop within the host transport stream. Note that the
overall duration of the host transport stream is defined
through the Transport Stream Properties dialog box.

Loop Select this check box to loop the selected source stream
for the duration of the synthesis. A Loop Interval can be
set that introduces a delay between each repeat of the
source stream; if zero is entered, the source stream will
loop continuously. The Loop check box will always be
disabled for transport stream types. The Multiplexer can-
not loop transport streams.

Select OK to accept all changes and close the dialog box.



Multiplexer − Editing in the Navigator Views

8−104 MTS400 Series MPEG Test Systems User Manual

Defining the PCR Placement. In the Add Stream dialog box select the PCR tab;
this will allow PCR placement to be defined.

PCR for Elementary Streams. (Includes File Type: Transport Packets.)
PCRs are placed in the packets at the specified interval, starting with the
specified initial value.

PCR for Remultiplexed PIDs. (Includes File Type: Transport Stream)

� If the Carry PCR check box is not enabled, any PCRs in the packets will be
removed.

� If the Carry PCR check box is enabled, PCRs will be sent as follows: If
Preserve PCR Inaccuracy is set, the PCRs from the original transport stream
will be used, otherwise the initial PCR value can be specified.

� If the Preserve PCR Intervals check box is enabled, PCRs will be sent in
those packets that originally contained them, otherwise PCRs are inserted
into packets at the specified intervals.
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Enter the PID number. A new value can be entered using either decimal or
hexadecimal notation. Values are assumed to be decimal unless preceded with
0x. The dialog box is not case sensitive and values may include zeros after the
prefix and before any significant digits.

When all details (in all tabs) are satisfactory, select OK to accept all changes and
close the dialog box.

Methods available:

� Highlight an Elementary Stream node in the Navigator Programs view and
select Add from the shortcut menu.

� Drag and drop (copy only) from the Examine TS window (Programs view)
to the Navigator Programs view.

� Drag and drop (copy/move) from another instance of Multiplexer to the
Navigator Programs view.

Specifying the PID
Number

Adding Elementary
Streams to the Program

Structure
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Elementary stream data can be added using the Navigator Programs view.

1. In the Navigator Programs view, highlight an Elementary Streams node to
which the elementary stream is to be added.

2. From the shortcut menu, select Add. The Add Program Stream dialog box is
displayed.

The dialog box tabs allows the input elementary stream to be selected and
specified. The main dialog box fields Stream Type and Pid Number dictate the
PID that will carry the stream and the stream type entry that will be made in the
PMT.

3. The functionality of the tabbed dialog boxes is described in the following
pages:

Source See Defining the PID Source, page 8−100,
Timing See Defining the Stream Timing, page 8−103,
PCR See Defining the PCR Placement, page 8−104.

4. Enable the Component Tag check box, if required. Enter a Component Tag
number (0 - 255) in the enabled field. If the Component Tag is enabled, it
can be referenced by other tables, for example, Event Information Table.
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The Export Elementary Stream option allows the nonpacketized elementary
stream data to be extracted from an elementary stream and saved to a binary file.
Note that this data will not include the transport packet or the PES packet
headers.

In the Navigator Programs view, highlight the elementary stream whose payload
is to be exported. Select the Export Elementary Stream... option from the shortcut
menu. Name the file to be created and choose a location. Select Save to confirm
the action.

The Export Payload option allows the PES packets to be extracted from an
elementary stream and saved to a binary file. Note that this data will not include
the transport packet headers.

In the Navigator Programs view, highlight the elementary stream whose payload
is to be exported. Select the Export Payload option from the shortcut menu.
Name the file to be created and choose a location. Select Save to confirm the
action.

To modify any of the ES PID parameters, highlight the required PID in the
Navigator Tables view and select Properties from the shortcut menu. The Stream
Properties dialog box and its tabs are identical to the Add Stream dialog box.
Refer to Adding an Unreferenced Elementary Stream, page 8−99. Locate the
parameter to be changed, and click OK when changed.

ES PID parameters can also be modified in the Navigator Programs view.
Highlight an Elementary Stream in the Programs view and select Properties from
the shortcut menu. The dialog box thus displayed (Program Stream Properties) is
similar to the Add Program Stream dialog box shown on page 8−105.

An elementary stream can be removed from the multiplex by deleting the PID.
To delete a PID, highlight the required PID and select Delete from the shortcut
menu. Then select the Delete option from the Edit or pop-up menus. Alternative-
ly, click the delete button from the toolbar.

Multiplexer asks for confirmation before removing the PID from the multiplex.
Select Yes to delete the stream or No to abandon the operation and leave the
stream unchanged.

Exporting Elementary
Streams

Exporting PES Packets

Modifying PES PID Details

Deleting a PES PID
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DSM-CC

Methods available:

� Highlight the ES PIDs node in the Navigator Tables view and select Add
from the shortcut menu.

� Drag and drop (copy only) from the Examine TS window (Tables view) to
the Navigator Tables view.

� Drag and drop (copy/move) from another instance of Multiplexer to the
Navigator Tables view.

Adding an unreferenced DSM-CC section is similar to adding an unreferenced
elementary stream (see page 8−99), with the following modifications:

In the Source tab of the Add Stream dialog box, select Transport Packets /
Sections as the File type and set the bit rate.

Adding an Unreferenced
DSM-CC Section
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Methods available:

� Highlight an Elementary Stream in the Navigator Programs view and select
Add from the shortcut menu.

� Drag and drop (copy only) from the Examine TS window (Programs view)
to the Navigator Programs view.

� Drag and drop (copy/move) from another instance of Multiplexer to the
Navigator Programs view.

Adding a DSM-CC section to the program structure is similar to adding an
elementary stream to the program structure (see page 8−99), with the following
modifications:

� The main dialog box fields Stream Type and Pid Number dictate the PID that
will carry the stream and the stream type entry that will be made in the PMT.
The Stream Type should be set to one of the DSM-CC entries.

� In the Source tab of the Add Program Stream dialog box, identify the File
name to be added. Select Transport Packets / Sections as the Stream type and
set the bit rate.

The DSM-CC section will be added.

A DSM-CC section can be deleted from a table by highlighting it in the
Navigator view and selecting Delete from the shortcut menu. To delete more
than one section, select and delete each one in turn.

Adding DSM-CC Sections
to the Program Structure

Delete a DSM-CC Section
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DSM-CC data can be exported in the form of a binary file.

Highlight the required DSM-CC section in the Navigator Tables view. From the
shortcut menu, select Export Section Data. Name the file to be created and
choose a location. Select Save to confirm the action.

Individual DSM-CC sections can also be exported using the Navigator Programs
view. Under any Elementary Streams node, highlight the DSM-CC section to be
exported. From the shortcut menu, select Export Section Data.... Name the file to
be created and choose a location. Select Save to confirm the action.

Export a DSM-CC Section
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Editing in Section View

Use the Section View window to modify the contents of a version/section. This
includes version, section, and table-specific data that the Navigator Tables view
displays. If the Section View window it is not already open, select View >
Section View.

If a section/version is selected in the Navigator Tables view, the contents are
automatically displayed in the Section View; otherwise the Section View
window is blank.

To open a table version/section in Section View, select the component in the
Navigator Tables view. The Section View is updated immediately to show the
selected section/version.



Multiplexer − Editing in Section View

8−112 MTS400 Series MPEG Test Systems User Manual

Editing Fields

To add, change, or delete a field, element or loop in a section/version, the parent
table must be selected in the Navigator Tables view. Highlight the appropriate
line in the Section view and select the required option from the shortcut menu.

To select a field or container, place the mouse pointer over it and click the left
button.

The magnifying glass icon indicates the selected component.

If Standard Mode is selected, the magnifying glass selection cannot be placed on
a field that is locked. To select and edit locked fields, first select the Expert
Mode option from the Multiplex menu.

Selecting a Field
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To add an element to a loop, select the parent loop that will contain it, and then
select Add from the shortcut menu. For example, to add a program to a PAT,
highlight the Programs container and select Add from the shortcut menu.

In this example, a dialog box is displayed in which the Program Number and
Program Map PID can be accepted or respecified. Other table loops may not
display any dialog box, but immediately create a new element with default
contents. An entry is displayed for the new element, with its details collapsed, at
the end of the list of elements in the loop. In addition, the section length field is
automatically recalculated and amended. For the above example the new entry is
program_number = 6 (0x6).

Adding an Element to
Loop
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NOTE. The example above was taken with Standard mode selected. In Standard
mode, all recalculation is done automatically. In Expert mode, a program
element will be added, but the program number and PID must be manually
adjusted. Similarly, the section length will need to be calculated and amended
manually (see also Expert and Standard Modes, page 8−60).

To delete a loop element, in the Section view, highlight the element and select
Delete from the shortcut menu.

The element is deleted and the Section View window updated to reflect the
changes.

To edit the contents of a field, highlight the field and select Modify from the
shortcut menu. This will open an appropriate dialog box for modifying the type
of data held by the field.

The following paragraphs describe the different types of data that may be
modified.

Enumerated Value. The Modify value dialog box displays the name of the field
and the current value. The value is shown as a number followed by the inter-
pretation of the governing standards.

In this figure the field being edited is a modulation_mode and the current text is
1 (analog).

Type the number, without any text, for the required value. When the changes are
accepted, Multiplexer will display the interpretation in the Section View window.

Alternatively, click the down arrow to select the value from the drop down list.

Deleting an Element in a
Loop

Modifying the Contents of
a Field
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This displays a list of the defined values and their interpretation. The list will
vary depending upon the field being edited.

Enter the required value and select OK to continue. Multiplexer may open a
simple context-sensitive dialog box offering advice and/or asking for more
information or confirmation. An error message is displayed if the number that
was typed in requires more bits than are allocated to the field.

Date and Time. The Modify Time dialog box displays the name of the field. It
displays the time in both interpreted and raw formats; only the interpreted mode
can be edited.

Edit the numbers in any of the fields as required. All fields are updated as each
digit is added, changed or deleted. Select OK to commit the changes or Cancel to
abandon editing and keep the original time.

The Set to all ones check box, when enabled, sets the 40-bit date field to
0xFFFFFFFFF. This may be required when setting the start_date for an event in
a Near Video on Demand (NVOD) reference service.



Multiplexer − Editing in Section View

8−116 MTS400 Series MPEG Test Systems User Manual

Compressed String. The Modify dialog box displays the name of the field, which
is always a compressed string, and the contents of the selected string segment.
Text can be entered, deleted, selected, copied to and pasted from the Windows
clipboard.

Edit the text and select OK to continue. Select Cancel to abandon the edits and
leave the original segment unchanged. Multiplexer checks to ensure that the new
string length does not cause the total section length to exceed the maximum
specified by the standards.

If the total section length exceeds the maximum specified by the standards, an
error message is displayed:

Select OK to return to the Modify dialog box and shorten the string.
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Text. The Modify Text dialog box displays the name of the field and the current
text on a single line. Text can be entered, deleted, copied to and pasted from the
Windows clipboard.

In the following figure, the field being edited is an ISO_639_language_code and
the current text is eng.

View Value As You can choose between viewing the text as an ASCII
character string or a hexadecimal sequence.

Most text strings have a maximum length, specified by the governing standards,
which this dialog box will enforce. Edit the text and select OK to continue.
Select Cancel to abandon the edits and leave the original text unchanged.

Numeric. The Modify dialog box displays the name of the field and the current
value in decimal. Edit the existing value or type in a new value.

In the following figure, the field being edited is a version_number and the
current value is 0xc.

A new value can be entered using either decimal or hexadecimal notation. Values
are assumed to be decimal unless preceded by 0x. The dialog box is not case
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sensitive and values may include zeros after the prefix and before any significant
digits, for example:

Edit or replace the existing value and then select OK to continue. Select Cancel
to abandon any changes made in the field.

Multiplexer will check the new value against the governing standards and for
conflicts with other fields. It may open a simple context-sensitive dialog box
offering advice and/or asking for more information or confirmation. For
example: when changing a version_number, a dialog box is opened to determine
the scope of the change.



MTS400 Series MPEG Test Systems User Manual 8−119

Multiplexing Transport Streams

The Multiplex Engine in the Multiplexer synthesizes a new transport stream and
writes it to an MPEG file. The contents of the new stream are multiplexed
according to the specification currently held in memory, which is shown in the
Navigator and Section views.

The tables that are displayed in the Navigator are synthesized from the current
specification. Elementary streams and other data are acquired from the original
MPEG file and other stream files and remultiplexed according to the specifica-
tion.

Starting the Multiplex Engine

To start the Multiplex Engine, select the Start option from the Multiplex menu.
Alternatively, select the start button on the Toolbar.

Multiplexer opens a standard file browser dialog box to specify the file name and
path for the synthesized transport stream.

A new file can be created or an existing file can be selected to be overwritten.
The program will seek confirmation before overwriting an existing file.

NOTE. The Multiplexer automatically creates 188 byte packets in the transport
stream output file, regardless of the source material size.
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Errors and Reporting

The right pane of the status bar indicates progress as the Multiplex Engine
synthesizes the new transport stream.

Any errors are recorded in the Event Log, which can be opened at any time
before, after and during processing. Here is an example where a table cannot be
multiplexed into the new stream at the specified rate.

Each table has a specification for nominal and maximum interval, in millisec-
onds, between instances of the table. These can be edited using the Navigator.
The multiplex engine will try to multiplex the table into the synthesized transport
stream at the nominal repetition rate. Errors are reported whenever packets for
any PID cannot be encoded at their specified minimum rate.

The complete text may be copied onto the Windows clipboard, using the Copy
option from the shortcut menu. The text can also be cleared with the Clear
command. Both commands are also available from the Edit menu.
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Stopping the Multiplex Engine

The Multiplex Engine can be stopped at any time while it is running. This will
abandon processing and close the file. The file will contain all of the packets
synthesized up to the time the engine was stopped.

To stop the Multiplex Engine, select Multiplex > Stop.

Alternatively, select the stop button on the Toolbar.
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Exporting the Multiplex Configuration File

NOTE. Multiplexer is used for generating both conformant and nonconformant
streams. Use the Export and Export As options to save copies of the specification
for nonconformant streams in a multiplex configuration file. This file does not
include a copy of the transport stream, instead, it refers to the original MPEG
file by name and location.

The multiplex configuration file can be reopened using the Import option 
(see page 8−12).

Select File > Export to save any changes to the current multiplex configuration
file. Alternatively, use the Ctrl+E keyboard shortcut.

If a multiplex configuration file has not been opened, Export opens a standard
file browser dialog box to specify the file. This is the same as selecting the
Export As... option.

Export
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File > Export As exports a file with a user-specified name.

Multiplexer opens a standard file browser dialog box to select an existing file or
specify a new file.

If you are creating a new file, specify the name of the exported file and select
where it will be saved. By default, files are be created with .muxml as the file
extension.

Export As
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Make Seamless

When you loop a transport stream to simulate continuous playout, errors can be
generated at the loop point caused by discontinuities in timing information. The
Seamless option provides the opportunity of creating seamless MPEG-2 files.

The option can be set up and enabled so that all multiplex operations result in
seamless output or none.

Enabling the Seamless option

Toggle the Seamless option by selecting Multiplex > Seamless

or the toolbar button .
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Seamless Settings

Open the Seamless Settings dialog box by selecting Multiplex > Seamless
Settings.... The dialog box shown below is displayed.

First program in PAT has
priority

If this setting is enabled, the first program specified
in the PAT will be given priority in the make
seamless process.

If the setting is disabled, the priority program can be
specified in the Priority Program. The number can
be deduced by inspecting the results of the transport
stream analysis.

Make PSI seamless If enabled, the service information contained in the
transport stream is processed to make it seamless.

If the setting is disabled, the PSI/SI is not processed
but simply copied to the output transport stream.

Make remaining pro-
grams seamless

If enabled, the remaining programs are made
seamless but are constrained by limits defined by
the priority program. This may lead to these
remaining programs having a gap at the beginning
and end of the file.

Priority Program

PSI Settings
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Reference

Abbreviations

AIT Application Information Table

ASCII American Standard Code for Information Inter-
change

ATSC Advanced Television Systems Committee

CAT Conditional Access Table (MPEG

CDT Carrier Definition Table

CVCT Cable Virtual Channel Table (ATSC)

DSM-CC Digital Storage Media - Command and Control

DTS Decoding Time Stamp

EIT Event Information Table (DVB/ATSC)

ES Elementary Stream

ETT Extended Text Table (ATSC)

MGT Master Guide Table (ATSC)

MMT Modulation Mode Table

NIT Network Information Table (DVB)

PAT Program Association Table (MPEG)

PES Packetized Elementary Stream

PID Packet IDentifier

PIT Program Information Table (ATSC)

PMT Program Map Table (MPEG)

PSI Program Specific Information (MPEG)

PSIP Program and System Information Protocol (ATSC)

PTS Presentation Time Stamp

RAID Redundant Array of Independent Disks

RRT Regional Ratings Table (ATSC)

RST Running Status Table (DVB)

SDT Service Description Table (DVB)

SEI Supplemental Enhancement Information (H.264)

SI Service Information (DVB)
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SIT Satellite Information Table

STT System Time Table (ATSC)

TDT Transponder Data Table (ATSC)

TNT Transponder Name Table

TOT Time Offset Table (DVB)

TS Transport Stream

TSTD Transport Streams Description Table

T-STD Transport Stream System Target Decoder

TVCT Terrestrial Virtual Channel Table (ATSC)

UTC Universal Coordinated Time

VCT Virtual Channel Table (ATSC)

VUI Video Usability Information (H.264)

XML Extensible Markup Language
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Transport Stream Editor

The Transport Stream Editor can be used to edit the contents of transport stream
packets contained in a file. It displays the complete contents of each packet in
hexadecimal and provides an interpreted view of the packet header information.

Packet headers can be edited from both the header interpretation and hexadeci-
mal displays. These are referred to as the Header Editor and the Hex Editor,
respectively. All changes made in one view are immediately shown in the other.
The Header Editor is context sensitive, only allowing edits that make sense with
the other fields in the header. It gives full syntax checking of all changes that are
made. The payload and any Reed Solomon data are edited from the Hexadecimal
Editor.

On the right of the Hex Editor pane, the ASCII character is displayed. Unprint-
able characters are shown as a period (dot or full stop).

It is normal to edit a copy of a transport stream. Transport Stream Analyzer can
be used to view the original while editing the copy.
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Starting the Program

The program may be started by selecting the Tektronix TS Editor option from the
Start > Programs menu or by double-clicking on the Tektronix TS Editor
shortcut on the desktop.

Once the program has started and is ready for use, it will open a Main Window
that looks like this:

Initial Appearance
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Options

The Transport Stream Editor has a set of options relating to general use and
opening files. It is a good idea to review the options before opening a file.

The settings can be changed at any time by selecting Options... from the Edit
menu. This opens the Options dialogue box.

Specifies how the program will interpret the packet size of the stream. The
options are mutually exclusive and are as follows:

Always edit copy
When opening a file Editor always makes a copy, without asking.

Always edit original, don’t make copy
Uses the original files without making a copy or asking for confirmation.

Always ask
Before opening a file for editing, asks if it should edit the original or make a
copy.

Only open valid MPEG Transport Stream files
Will open files that have five or more consecutive sync bytes.

Open as ARIB ISDB-S Transport Streams
Opens transport streams encoded as ARIB ISDB-S format (including TMCC
information).

Opening File
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Show Wizard Introduction pages
Causes any wizards invoked by Editor to display their Introduction pages.

Warn about remapping to existing PIDs
Warns if an operation will remap a PID onto one that is already in use.

Opening a File

Any stream that is held in a file can be edited with the Transport Stream Editor.

To edit a file, select the Open ... option from the File menu. If the required file is
in the list of recently edited files, it may be selected from the list to save using
the Open file dialog box.

Alternatively, use the Ctrl+O keyboard shortcut.

There is also a shortcut button available on the Toolbar for opening a file, which
has the standard file open symbol:

General Options

Opening a File from the
Menus and Toolbar
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The program can be started and a file opened (with the last set of program
options) in a single operation from Windows Explorer or a File Browser
Window.

Place the pointer over the file name or icon, press the right mouse button to open
a menu, and then select the Edit option.

TS Editor writes all edits to the file immediately. To avoid accidental changes to
prime data, the application can make a copy of the file and edit that copy. By
default, once a file has been selected for opening, you are prompted to decide
whether to edit the original or make a copy.

If you do not want to be presented with this dialog box each time a file is
opened, set the copy or edit original option as the default.

Opening a File from
Windows Explorer or a

File Browser Window

Copying File before
Editing
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It is recommended that this dialog box be left as the default option.

If someone else has used the MPEG Test System, it is a good idea to look at the
Options before opening a file.

To edit the original (useful when making edits to a file that is already a copy)
select the No, I want to edit the original option, and then select the OK button.

To make a copy, select the Yes option, specify the copy file, and then select OK.
While the copy is being made, the pointer changes to the busy pointer, usually an
hour glass.

When the Edit a copy option is selected, the dialog box suggests a suitable
filename, whihc you can edit. To look for a different directory or filename, select
the Browse… button. This will open a standard file browser window, like this:
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Menus and Controls

The following pages contain descriptions of the different menu options, toolbar
controls, status bar, and slider bar.

Toolbar

The Toolbar provides a set of convenient shortcuts for the more frequently used
menu options. The available commands are:

Opens a file. If a file is currently open, it will be closed when a new
file is selected.

Closes the current file. There is no save option because all changes are
written to file immediately.

Prints  the current packet.

Opens a print preview of the current packet.

Copies the bytes that are currently selected in the Hexadecimal Editor
from the packet to the clipboard. The bytes are copied using the
hexadecimal representation. This button is disabled (grayed out) when
nothing is selected that can be copied.

Copies the entire contents of the current packet to the clipboard.

Pastes any data, held in the TS Editor’s hexadecimal representation,
from the clipboard into the packet starting at the currently selected
byte.

Undoes the last edit, restoring the previous value. Selecting Undo
again undoes the previous change and so on.

Reinstates the previously undone change.

Opens the Options dialog box.
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Status Bar

The Status Bar may be hidden from view, but if it is always visible at the bottom
of the window. It displays the following information about the program and open
file:

When no file is open, the File Size, Packets, and Packet Size fields are all set to
zero or null:
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Slider Bar

The contents of any transport stream packet in the currently open file can be
selected using the Slider bar. Packets are numbered according to their position in
the file, with the first packet being 0 (zero). The controls in the slider bar are:

Move to
previous
packet

Move to
next
packet

Slider
Scrolls through all
packets  in the file.

End
of file

Start
of file

PID Filter

Slider
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It is normal to edit a copy of a transport stream. Transport Stream Analyzer uses
the same packet numbering as Editor. So the packet number can be used to find
and view a packet in Analyzer, and then edit the copy of the same packet in
Editor.

The Slider Bar can be dragged from the edge of the main window into a floating
pallet. To do this, place the mouse pointer on the background (inside the Slider
Bar), hold down the left mouse button, and drag the slider bar away from the
window border. The result is a self contained window that looks like this:

To replace the Slider Bar on the window border drag, it over the border until the
outline changes shape.

Packet Number



Transport Stream Editor - Menus and Controls

MTS400 Series MPEG Test Systems User Manual 9−11

Menu Options

The following pages describe all of the menu options. Since many of the options
are context sensitive, they will be available only when their function is appropri-
ate for the selected window or display element. When a menu option is not
available, the option is grayed out.

Table 9−1 list the File menu options.

Table 9−1: File menu options 

Command Function

Open Opens a file for editing. If a file is currently open, it is closed
when a new file is selected.

Close Closes the current file. There is no need for a save option
because all changes are written to file immediately.

1 <filename>
2 <filename>
3 <filename>
4 <filename>

A list of the four most recently edited files. If the program has
recently been installed, the list may be empty or hold less than
four files.

Print Prints the current packet.

Print Preview Opens a print preview of the current packet.

Print Setup Selects printer and configuration.

Exit Closes any file that is open and terminates execution of the
program.

Table 9−2 list the Edit menu options.

Table 9−2: Edit menu options 

Command Function

Undo Undoes the last edit, restoring the previous value. Selecting
undo again undoes the previous change.

Redo Reinstates the previously undone change.

Copy Copies the bytes that are currently selected in the Hexadecimal
Editor from the packet to the clipboard. The bytes are copied
using the hex representation.

Copy Packet Copies the entire contents of the current packet to the
clipboard.

Paste Pastes hexadecimal from the clipboard into the packet starting
at the currently selected byte.

File Menu Options

Edit Menu Options
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Table 9−2: Edit menu options (Cont.)

Command Function

Select Packet Selects the entire contents of the packet.

Fill Prompts for and fills all selected bytes with a value.

Options … Opens the options dialog.

Table 9−3 list the View menu options.

Table 9−3: View menu options 

Command Function

Toolbar Shows or hides the Toolbar, which provides a set of convenient
shortcuts for the more frequently used menu options.

Status Bar Shows or hides the Status Bar.

The following menu options select which standard is used to interpret the values held in the
Transport Scrambling Code field. Only one standard can be selected at any time.

MPEG2 Selects the MPEG2 interpretation of the Transport Scrambling
Code.

DVB Selects the DVB interpretation of the Transport Scrambling
Code.

ATSC Selects the ATSC interpretation of the Transport Scrambling
Code.

View Menu Options
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Table 9−4 list the Tools menu options.

Table 9−4: Tools menu options 

Command Function

Remap PIDs… Starts the tool to Remap packets from one or more PIDS to
different PIDs.

PCR Recalculation… Opens a Wizard to Recalculate the Program Clock References
(PCR) carried in one or more PIDS.

Table 9−5 list the Help menu options.

Table 9−5: Help menu options 

Command Function

About… Displays the program version number and license number.

Tools Menu Options

Help Menu Options
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Hex Editor

The Hex Editor displays and provides editing facilities for the contents of the
current packet in both hexadecimal representation and ASCII characters.

Color Coding

Color coding is used to show the “footprint” of various header fields, in both the
hexadecimal and ASCII views. The packet payload and any Reed Solomon data
is shown in black. The bytes of the packet header field are shown in magenta
text.
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4 byte Packet
Header colour

coded magenta

When an adaptation field is present it is shown by blue colored text:

4 byte Packet
Header colour

coded magenta

adaptation field
colour coded blue

If transport private data is present it is shown in green:

NOTE. It is possible to define a transport private data area that is not contained
within the adaptation field area specified by the adaptation field length.



Transport Stream Editor - Hex Editor

MTS400 Series MPEG Test Systems User Manual 9−17

Selecting & Editing

One or more bytes can be selected using either the hexadecimal or ASCII view.
Changes are made using options from the menus and by typing new values in the
hexadecimal view.

When the mouse pointer is moved over either of the views in the Hex Editor, the
pointer changes to the Text Select pointer.

To edit a byte or character, position the mouse pointer over the desired character
in either the ASCII or hexadecimal view. Then click the left mouse button. A
flashing inverse video cursor appears to the left of the character.

Alternatively, double-click either view of the byte to select it for use with an
option from the Edit menu operation.

New values can be entered from the keyboard. As each character is typed, the
cursor moves on to the next. It can be repositioned with the mouse or by using
the up, down, left and right cursor keys.

The cursor will not move forward beyond the end or back before the start of the
packet. To select another packet, use the Slider Bar.

A block of bytes can be selected for operations such as copying to the clipboard
or filling with the same value.

Click on the first required byte and hold down the left mouse button. Then drag
the mouse pointer to the last byte to be selected and release the left mouse
button. Both the ASCII and Hex views can be used for selection. The selection is
shown in inverse video in the view from which the it was made, and by an
outline around the selection in the other view. For example, when made from the
ASCII view, a selection looks like this:

Once selected, the block of bytes can be edited with the available options from
the Edit and the Pop-Up menus. Clicking the mouse or pressing a cursor key
clears the selection.

Individual Bytes

Block of Bytes
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To select a block using the cursor keys: position the cursor on the first byte, and
then hold down the Shift key and move the cursor with the cursor keys. The
selection is drawn between the initial and current cursor positions. Release the
Shift key when the cursor has reached the last byte. Clicking the mouse or
pressing a cursor key clears the selection.

The Edit menu, pop-up menu, and toolbar buttons provide a variety of options
for editing the packet contents. The Pop-Up menu is opened by clicking the right
mouse button when the pointer is over the Hex Editor, for example:

Depending on what operations have recently been performed and on what is
selected, the menus and toolbar will offer different commands. The complete set
of menu options and associated buttons are as follows:

Undo TS Editor keeps a list of recent changes. Each Undo
command backs out the most recent change from the
list. That change is moved to the Redo list in case it
needs to be reinstated. As each change is undone the
cursor moves to the appropriate field (in the Hex or
Header Editors) and restores the previous value.

Redo Reinstates the most recently undone operation. When a
new edit is made, the Redo list is cleared.

Copy Copies the currently selected bytes to the clipboard.
From there they may be pasted in to other packets or
used by other applications.

Copy Packet Copies the entire contents of the current packet to the
clipboard. From there it can be pasted into other
packets or used by other applications.

Editing Commands
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Paste Pastes packet contents held on the clipboard into the
current packet, starting at the current cursor position.

Select Packet Selects the entire packet. This is a quick alternative to
selecting all the packets with the mouse or keyboard.

Fill Fills all the selected bytes with a hexadecimal value. 

This option opens the Fill Byte dialog box. Enter the
fill value then select the OK button. The Cancel button
abandons the operation, leaving the bytes in their
original state.

There are no Toolbar buttons for the Select Packet and Fill commands.
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Header Editor

The Header Editor has three tabs. These show and allow editing of the basic
header, adaptation field, and the adaptation field extension contents.  The Hex
editor is immediately updated to show the new values when changes are made in
the Header Editor.

Binary flags are shown with check boxes whose state can be changed by clicking
in the box with the mouse pointer. Multi-bit fields may be edited by typing in the
new values or selecting a value from a drop down list.

NOTE. It is important to remember that changing a flag or field often alters the
structure of the header. The other flags and fields will be reinterpreted according
to the data underlying their new position in the structure.

Header Information Tab

The Header Information Tab interprets the contents of the Packet Header (shown
in magenta text in the Hex Editor) for ease of understanding and editing.

The PID Value field displays, and allows editing of, the 13-bit PID as a decimal
value. (The PID is packed into a pair of bytes with the Flags shown below.)
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The Flags fields display the state of each binary flag in a check box:

 = 0 or false

 = 1 or true

Click in the box to toggle the state of a flag.

The Continuity Count field displays the value of the four bit Continuity Count
field in decimal.

To avoid any typing errors, the drop-down list allows selection of a different
value.

The Transport Scrambling Control displays the two bit Transport Scrambling
Control field as a binary bit pattern, with a text description.

Use the drop-down list to select a different value.
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The text gives the interpretation for the bit pattern according to the standard that
is currently selected: MPEG2, DVB or ATSC. Use the View menu to select the
required option.

The Adaption Field Control displays the two bit Adaptation Field Control as a
binary bit pattern, with a text description.

Use the drop-down list to select a different value.

The Adaptation Field and Adaptation Field Extension Tabs will be empty
(grayed out) when the 01 - Payload Only or 00 -- Reserved values are selected.

Adaptation Field Tab

The Adaptation Field Tab interprets the contents of the Adaptation field (shown
in blue text in the Hex Editor) if one is present in the packet. To be able to edit
an Adaptation Field, the Adaptation Field Control value in the Header Informa-
tion Tab must indicate that an adaptation field is present.
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The Adaption Field Length field shows the length of the Adaptation Field in
bytes and allows it to be edited in decimal.

The Flags fields display the state of the binary flags in check boxes:

 = 0 or false

 = 1 or true

Click in the box to toggle the state of a flag.

The PCR Flag field displays the state of the binary PCR Flag in check boxes:

 = 0 or false

 = 1 or true

When the flag is true the PCR Value is shown and can be edited in decimal
notation.



Transport Stream Editor - Header Editor

MTS400 Series MPEG Test Systems User Manual 9−25

The OPCR field displays the state of the binary OPCR Flag in check boxes:

 = 0 or false

 = 1 or true.

When the flag is true, the OPCR Value is shown and can be edited in decimal
notation.

The Splicing Point Flag fields displays the state of the Splicing Point Flag in
check boxes:

 = 0 or false

 = 1 or true

When the flag is true, the Splice Countdown value is shown and can be edited in
decimal.

The Transport Private Data Flag field displays the state of the Transport Private
Data Flag:

 = 0 or false

 = 1 or true.

When the flag is true, the Data Length is shown in bytes and can be edited in
decimal.
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The Adaptation Field Extension Flag indicates the state of the binary Adaptation
Field Extension flag.

 = 0, no Adaptation Field Extension.
The Adaptation Field Extension Tab can be viewed, but all of the fields will be
grayed out.

 = 1, Adaptation Field Extension present. 
The Adaptation Field Extension Tab will show and enable editing of the
information contained in the Adaptation Field Extension.

Adaptation Field Extension Tab

The Adaptation Field Extension Tab interprets the contents of the Adaptation
Field Extension if one is present in the packet. To be able to edit an Adaptation
Field Extension the Adaptation Field Extension flag must be set to 1 (the box
must be checked) in the Adaptation Field Tab.

Shows the length of the Adaptation Field Extension in bytes and allows it to be
edited in decimal.
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Displays the state of the LTW Flag:

 = 0 or false

 = 1 or true

When LTW is true, the state of the LTW Valid flag and value of the LTW Offset
are shown. The Valid flag may be toggled and new Offsets can be typed in
decimal.

Displays the state of the Piecewise Rate Flag:

 = 0 or false

 = 1 or true

When the flag is true, the Rate is shown and can be edited in decimal notation.

Displays the state of the Seamless Splice Flag:

 = 0 or false

 = 1 or true
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When the DTS Next AU value is shown and it can be edited in decimal notation.

The 4 bit Splice Type is shown as a bit pattern.

It has a drop-down list containing all 16 possible bit patterns.

Use the list to select a different value.
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PID Remapping

NOTE. The packets of one or more PIDS may be remapped (moved to different
PIDs). Only the PID in the packet headers is changed. Any packet payload
contents, such as SI and PSI tables are unaffected. So remapping can break the
references from tables to PIDs, or be used as an investigation to correct broken
references.

To remap packets from one or more PIDs, select the Remap PIDs… option from
the Tools menu.

The program scans the file to build a list of PIDs, displaying the Hourglass
mouse pointer while it is busy. It then opens the Remap PIDs dialog box:

To specify a mapping from a current PID to a new PID, select the current PID
entry from the list by clicking on it.
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Now select the Edit... button, which opens the PID Entry dialog box. (Alterna-
tively, double-click on the required entry in the list.)

Type in the value for the new PID to map to and select OK.

Repeat this process for each PID that is to be remapped.

The Restore button will change the value of the selected  Map to PID back to
that of the Current PID without having to open the PID Entry dialog.

When all the mappings are specified, select the Remap button. (The Remap
button is not enabled unless one or more mappings has been specified.)
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The hourglass mouse pointer is displayed while the program performs the
remapping. On completion, the dialog box closes and control is returned to the
main window.
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PCR Recalculation

The Program Clock References to one or all Programs can be changed. The rate
can be changed and/or any one of six types of jitter added. Uses of PCR
Recalculation include:

� Recalculating the rate at the correct value, without adding jitter, on a
recording of a faulty stream can be used to remove suspected PCR problems.
If the recalculated stream works correctly the problem is in the PCR.

� Creating test data with known deviations in rate for exercising other
equipment.

NOTE. Do not perform PCR Recalculation on an original recording. This
operation is not reversible, so it is strongly recommended that a copy of the
original file is used.

To modify the PCR, select the PCR Recalculation… option from the Tools
menu.

This runs a wizard to analyze the program structure, guide the user through the
available options, and then recalculate the PCR values.. The wizard presents 3, 4
or 5 pages depending upon the chosen options:

By default, the wizard will display this Introduction first.
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It may be disabled for future recalculations by selecting the check box option at
the bottom of the introductory text. Selecting the Next button moves on to the
Select Program page.

The wizard has to analyze the file to extract the relevant Program Information,
which may take a while. When analysis is complete, the Select Program page
shows a list of the programs whose PCR values may be changed (see following
illustration).
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To recalculate the PCR rate for all the programs, check the All programs? option.
Otherwise, select one of the programs from the list. Then select Next to move on
to the Select New Rate page. The Back button moves back to the Introductory
Page.
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Keeping the rate as New Playout = Current Playout and selecting Jitter Function
of <none>, will recalculate the PCR based on the current rate. This could be
used, For example, to investigate a suspected problem with the PCR by playing
the original and recalculated versions to see if there is a difference.

A new playout rate can be specified and/or a Jitter Function can be applied to the
rate. There are seven Jitter Functions available including <none>. The available
functions are:

Each of the jitter functions is described in more detail at the end of this
subsection.

If a Jitter Function is required, choose one of the six functions from the
drop-down list, otherwise leave it set to <none>. Specify any change in the New
Playout rate and select the Next button. Selecting Back returns to the Select
program page.

When no Jitter function, (<none>), was selected, the Select Jitter Parameters
page will not appear. Go on to the Summary page, which shows a picture of a
checkered flag.

With a Jitter Function selected, the next page will be Select Jitter Parameters.
This asks for additional information specific to the chosen Jitter Function. For
example, the Sine Wave function requires the parameters shown in the following
illustration.
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Specify the required parameters and select Next to move on to the Summary
page. Use the Back button to return to the Select New rate page.

The Summary page displays a short list of the specified PCR rate changes.
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NOTE. Select Finish to recalculate the PCR values. Remember, once Finish has
been selected, there is no going back.

Use the Back button to return to the previous pages to make any changes.

The program may take a while to perform the recalculations. The Summary page
will stay on screen and the Hourglass mouse pointer be displayed while the
wizard is processing. When the summary page disappears the calculation is
complete and the file can be closed or edited.

Jitter Functions

Select the required Jitter Function from the Select New rate page, then select
Next to move on to the Select Jitter Parameters page to specify the parameters
for the selected Jitter Function. The following subsections give details about
each function.
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The Impulse Jitter function adds a positive or negative value to a single PCR.

Max Amplitude Specifies the size of the impulse in nano-seconds. Type
a minus sign in front of the value for a negative impulse.

Interval Specifies the time taken from the start of the file at
which the Impulse is to be applied.

The Step Jitter Function adds a positive or negative offset to the ideal PCR
values after a specified time. The offset will be the same for all PCRs.

Max Amplitude Specifies the size of the offset in nano-seconds. Place a
minus sign in front of the value for a negative offset.

Interval Specifies the time taken from the start of the file of the
first PCR to which the offset is to be applied.

Impulse

Step
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An offset that varies according to a sine function is applied to the ideal PCR
value for each PCR.

Max Amplitude Specifies the amplitude of the sine wave in nanoseconds.

Period Specifies the period of the sine wave in milliseconds.

An offset, which varies according to a square wave function is applied to the
ideal PCR value for each PCR. The square wave has an equal mark/space ratio.

Max Amplitude Specifies the amplitude of the square wave in nanosec-
onds.

Period Specifies the period of the square wave in milliseconds.

Sine Wave

Square Wave
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The PCR jitter applies offsets of a uniform random distribution to the ideal
values of the PCRs. Each offset will be within the range of ± the specified
amplitude.

Max Amplitude Specifies the maximum amplitude of the jitter, relative
to the ideal value, that can be added to any PCR. Only a
positive value can be entered. The amplitude is always
from -Max. Amplitude to +Max. Amplitude centered on
the ideal PCR value.

The offsets are applied to the ideal PCR values following a Gaussian distribution
according to the specified standard deviation.

Standard Deviation Specifies the standard deviation to be used by the jitter
function in deriving the offset for each PCR, relative to
the ideal PCR value. Only  a positive value can be
entered for standard deviation.

Random

Gaussian
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MPEG Player - Getting Started

NOTE. This section describes the default MPEG Player installed in all MTS400
Series system. 

The MTX100B MPEG Player is described in the MTX100B User Manual,
Tektronix part number 071−1927−xx.

The MPEG Recorder & Player generates and captures MPEG–2 transport
streams that are compliant with ATSC, DVB, and ARIB standards.

The MPEG Player provides the following features:

� Data rate: 213 Mbps maximum; 250 Kbps minimum.

� Hierarchical display of the stored or captured transport stream.

� 188, 204, 208 bytes packet size.

� Continuous recording of captured streams.

� PCR jitter insertion.

� Triggered stream capture.

� Full remote control using Ethernet interface.

� IP, ASI, SMPTE 310M and DVB SPI (DVB Parallel) interfaces available.

� Playout on one interface at a time, either IP or other interfaces.

� Stream replication (IP) with some attributes of the stream incremented by a
certain value.

Display Elements

There are two types of display screens to operate the MPEG Player; the Play
screen and the Record screen.

� The Play screen is used to output the selected stream. When you open the
application, this screen will display the last screen that was shown before
closing.

� The Record screen is used to record the input stream. 
When you select File > Record, the screen switches to the Record screen.
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This subsection explains the name and functions of the display elements in the
Play or Record screen.

Figure 10−1 shows the location of display elements of the Play screen. The
Record screen display elements are the same.

Menu bar

Toolbar

Hierarchical
display of
transport
stream

Play status
indicator

Status bar

Figure 10−1: Elements of the Play screen

The Menu bar displays the names of the menus that can be used in the Play or
Record screen.

Refer to Menus and Controls on page 10−21 for detailed information about the
menus.

NOTE. The IP interface mode does not support the Record functionality and
hence the Record option is disabled for IP.

Menu Bar
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The toolbar provides shortcut buttons for many of the most often used menu
commands. Click a toolbar button to select the corresponding command. You can
toggle the toolbar display on and off using Toolbar command in the View menu.

Refer to Toolbar Buttons on page 10−55 for detailed information about the func-
tion of each toolbar button.

Each icon in the hierarchy display represents an element of the stream. The
hierarchy text contains a description of the associated icon.

Refer to Hierarchical Display on page 10−8 for detailed information about the
hierarchy icons.

The Play Status indicator (see Figure 10−2) is displayed while the selected
stream is being output. It shows the output status of the selected stream: the
progress of the stream output, the output source, the operational status, and the
elapsed time.

The Record Status indicator is displayed while the input stream is being
recorded. It shows the record status of the input stream: the progress of the
stream record, the record target, and the elapsed time.

Position indicator Output source/
Record target

Operation status Elapsed time

Loop Update PCR 
Accuracy

Advanced
Protocol
Settings

Error 
Inser-
tion

Paramet-
ric Set-
tings

Stream
Replication
Settings

Figure 10−2: Play Status Indicator

Toolbar

Hierarchy Display

Play/Record Status
Indicator
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The Play/Record Status indicator shows the following information:

Position Indicator In the Play screen, this indicator shows the progress of
stream output using the duration gauge. In the Record
screen, this indicator shows the progress of stream re-
cord using the duration gauge.

The duration gauge is updated every second. If you out-
put a stream with a repetition rate of approximately three
seconds, the gauge may not be displayed correctly.

Output Source/Record Target.
In the Play screen, this indicator shows the output source
used to output the selected stream. In the Record screen,
this indicator shows the record target that is used to re-
cord the input stream.

One of each set of icons is displayed, depending on the
selections and status. The icons and their meanings are
as follows:

 The hard disk is being used for the output source or re-
cord target.

 The RAM is being used for the output source or record
target.

Operation Status Shows the current operation status of the instrument.

In the Play screen, the icons and meanings are as follows:

The selected stream is being output.

The selected stream is being read from the hard disk to
the RAM.

In the Record screen, the icons and meanings are as follows:

 (Red) The captured stream is being recorded.

 (Red) The stream record is stopped.

 (Yellow) The Player is waiting for a trigger event.

 (Red) A trigger event has occurred.

The captured stream is being processed on the hard disk.

The captured stream is being saved from the RAM to the
hard disk.
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Elapsed Time In the Play screen, this box displays the elapsed time of
the current stream data output.

In the Record screen, this box displays the elapsed time
since the input stream started recording.

In the Play screen, this icon indicates that the stream is
continuously output using the loop method.

In the Play screen, this icon indicates that the stream
parameters are updated.

In the Play screen, this icon indicates that the PCR accu-
racy is enabled.

In the Play screen, this icon indicates that the Advanced
Protocol Settings is enabled and applied to the stream.

In the Play screen, this icon indicates that the errors are
inserted in the stream.

In the Play screen, this icon indicates that the parametric
settings are enabled and applied to the stream.

In the Play screen, this icon indicates that the Stream
replication settings are enabled and applied to the
stream.

The Option Status bar (see Figure 10−3) and the IP Status bar (see Figure 10−4)
contains several indicators that display general information about the transport
stream output or record status.

Bit Rate

Figure 10−3: Option Card Status bar

Status Bar
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IP Bit Rate Number of
Streams

Figure 10−4: IP Status bar

From left to right, the Status bar shows the following information:

Standard In the Play screen, this indicator shows the standard
used to display the selected stream (MPEG2, ARIB,
DVB, ATSC, S–TMCC, M–TMCC, or Non TS). In the
Record screen, this indicator shows the standard used to
display the input stream.

Packet Size In the Play screen, this indicator displays the packet size
in bytes (188, 204, 208 or Non TS) of the stream output.
In the Record screen, this indicator displays the packet
size in bytes of the input stream.

Clock Source This indicator displays the source of the reference clock
(internal or external) used for the stream output.

Bit Rate In the Play screen when the SPI/ASI/310M option is
selected, this indicator shown in Figure 10−3 displays
the bit rate (Mbps) of the stream output. In the Record
screen, this indicator displays the bit rate (Mbps) of the
input stream.

IP Bit Rate In the Play screen when the IP interface option is se-
lected, this indicator shown in Figure 10−4 displays the
bit rate (Mbps) of the IP stream output. The Record
screen is disabled for the IP interface option.

Number of Streams In the Play screen when the IP interface option with
Stream Replication Settings is selected, this indicator
shown in Figure 10−4 displays the number of replicated
streams.

RAM free space In the Play screen, this indicator shows the RAM free
space that can be used to output the selected stream. In
the Record screen, this indicator shows the RAM free
space that can be used to record the input stream.
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Output Source/Record Target
In the Play screen, this indicator shows the output source
used to output the selected stream. In the Record screen,
this indicator shows the record target used to record the
input stream.

This indicator is the same as the output source/record
target indicator of the Play/Record Status indicator.

The remote connection status icons appear when a TCP/IP connection for remote
control is established. The right icon shows the status of the TCP/IP connection
(this icon is always displayed when the TCP/IP connection is established), and
the left icon shows the lock status of the front-panel buttons and mouse input.

There are two display states:

This shows that the TCP/IP connection for remote con-
trol is established.

This shows that the TCP/IP connection for remote con-
trol is established and the front-panel buttons and mouse
input are locked by the 
:SYSTem:KLOCk:STATe ON command.

To reset the lock status, select the ESC key 
(or send the :SYSTem:KLOCk:STATe OFF command).

When the TCP/IP connection is closed, the remote status icons disappear.

Remote Connection
Status Icons
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Hierarchical Display

The MPEG Player displays the selected transport stream using a hierarchical
structure. This section describes the hierarchical display and defines each icon
you may encounter in the display.

The MPEG Player uses icons displayed in a hierarchical structure to show the
interrelationship of transport stream components (Figure 10−5). Additional
information about each stream component such as PID and Table ID numbers is
displayed next to each icon.

Figure 10−5: Example of the hierarchical display

The ‘+’ symbol displayed to the left of some icons indicates that the item
includes lower-level transport stream components that are not displayed. The
symbol changes to ‘–’ when the lower level components are displayed. To
expand the hierarchy, click on the ‘+’ symbol. Similarly, to collapse the
hierarchy, click on the ‘–’ of the selected upper-level icon.

When a transport stream contains more items than what will be displayed on the
screen at a time, a scroll bar appears at the right of the screen.

Click an element in the hierarchy to select (and highlight) it.
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Table 10−1 describes the icons you may encounter in the hierarchical display of
the MPEG Player for transport streams using the MPEG-2, ARIB, DVB and
ATSC formats.

Table 10−2 describes icons that are specific to transport streams using DVB
format.

Table 10−3 describes icons that are specific to transport streams using ARIB
format.

Table 10−4 describes icons that are specific to transport streams using the ATSC
format.

Refer to Icon Text and Dialog Box on page 10−16 for descriptions of the icon
text and dialog box associated with the hierarchy icon.

Table 10−1: Icons used for MPEG-2, ARIB, DVB, and ATSC formats  

Icon Element type

ISDB−T
Broadcast transport stream that is defined ARIB STD-B31.

S-TMCC
Transport stream to which TMCC information is inserted into 8 bytes in its
Reed-Solomon area (16 bytes).

M-TMCC
Transport stream to which TMCC information is inserted into its sync byte area,
and having super frame structure.

Non TS
Data stream other than transport stream format.

Transport Stream (TS)
This icon represents all transport stream packets that make up the stream.

Program Association Table (PAT)
One or more transport packets with a PID value and table_id value of 0x00.

Transport Stream Description Table (TSDT)
One or more transport packets with a PID value of 0x02 and a table_id value of
0x03.

Network Information Table (NIT)
One or more transport packets with a PID value specified by the network_PID in
the PAT.

Conditional Access Table (CAT)
One or more transport packets with a PID value of 0x01 and a table_id value of
0x0001.

Hierarchical Display Icons
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Table 10−1: Icons used for MPEG-2, ARIB, DVB, and ATSC formats  (Cont.)

Icon Element type

Program Map Table (PMT)
One or more transport packets with a PID value specified by the pro-
gram_map_PID in the PAT and a table_id value of 0x02.

Program Clock Reference (PCR)
One or more transport packets with a PID value specified by the PCR_PID in the
PMT and a PCR_flag value of 1.

Video elementary stream
One or more transport packets with a PID value specified by the elementary_PID in
the PMT and a stream_type value of 0x01, 0x02, or 0x10.

A lock symbol appears in the icon when the transport_scrambling_control value is
set to 01.

Audio elementary stream
One or more transport packets with a PID value specified by the elementary_PID in
the PMT and a stream_type value of 0x03, 0x04, or 0x11.

A lock symbol appears in the icon when the transport_scrambling_control value is
set to 01.

Audio AAC, Audio AC3 (ATSC format)
One or more transport packets with a PID value specified by the elementary_PID in
the PMT and a stream_type value of 0x0F or 0x81 (ATSC format).

A lock symbol appears in the icon when the transport_scrambling_control value is
set to 01.

Data stream
One or more transport packets with a PID value specified by the elementary_PID in
the PMT and a stream_type value of other than 0x01 to 0x05, 0x08, and 0x0F (in
ATSC format, 0x81).

A lock symbol appears in the icon when the transport_scrambling_control value is
set to 01.

Private Section
One or more transport packets with a PID value specified by the elementary_PID in
the PMT and a stream_type value of 0x05.

A lock symbol appears in the icon when the transport_scrambling_control value is
set to 01.

Digital Storage Media Command and Control (DSM-CC)
One or more transport packets with a PID value specified by the elementary_PID in
the PMT and a stream_type value of 0x08.

A lock symbol appears in the icon when the transport_scrambling_control value is
set to 01.
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Table 10−1: Icons used for MPEG-2, ARIB, DVB, and ATSC formats  (Cont.)

Icon Element type

Entitlement Control Message (ECM)
One or more transport packets with a PID value specified by the CA_PID of the
CA_descriptor in the PMT, a payload_start_unit_indicator value of 1, and the
payload does not start 000001 (section) or the payload starts 000001 (PES).

Entitlement Management Message (EMM)
One or more transport packets with a PID value specified by the CA_PID of the
CA_descriptor in the CAT, a payload_start_unit_indicator value of 1, and the
payload does not start 000001 (section) or the payload starts 000001 (PES).

GHOST
One or more transport packets with a PID value not specified in the PSI or Private
Section PID file when the transport stream is downloaded.

NULL
One or more transport packets with a PID value of 0x1FFF.

GARBAGE
One or more transport packets in the section-data structure at the beginning of the
section are not complete.

Adaptation Field Error (ADFERR)
One or more transport packets with an adaptation_field_control value of 0x00.
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Table 10−2: Icons specific to DVB format 

Icon Element type

Service Description Table (SDT)
One or more transport packets with a PID value of 0x0011 and a table_id value of
0x42.

Bouquet Association Table (BAT)
One or more transport packets with a PID value of 0x0011 and a table_id value of
0x4A.

Event Information Table (EIT)
One or more transport packets with a PID value of 0x0012 and a table_id value of
0x4E-0x6F.

Running Status Table (RST)
One or more transport packets with a PID value of 0x0013 and a table_id value of
0x4E-0x71.

Stuffing Table (ST)
One or more transport packets with a PID value of 0x0010-0x0013 and a table_id
value of 0x72.

Discontinuity Information Table (DIT)
One or more transport packets with a PID value of 0x1E and a table_id value of
0x7E.

Selection Information Table (SIT)
One or more transport packets with a PID value of 0x1F and a table_id value of
0x7F.

Time and Data Table (TDT)
One or more transport packets with a PID value of 0x0014 and a table_id value of
0x72.

Time Offset Table (TOT)
One or more transport packets with a PID value of 0x0014 and a table_id value of
0x73.
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Table 10−3: Icons specific to ARIB format 

Icon Element type

Service Description Table (SDT)
One or more transport packets with a PID value of 0x0011 and a table_id value of
0x42.

Bouquet Association Table (BAT)
One or more transport packets with a PID value of 0x0011 and a table_id value of
0x4A.

Event Information Table (EIT)
One or more transport packets with a PID value of 0x0012 and a table_id value of
0x4E-0x6F.

Running Status Table (RST)
One or more transport packets with a PID value of 0x0013 and a table_id value of
0x4E-0x71.

Stuffing Table (ST)
One or more transport packets with a PID value of 0x0010-0x0013 and a table_id
value of 0x72.

Discontinuity Information Table (DIT)
One or more transport packets with a PID value of 0x1E and a table_id value of
0x7E.

Selection Information Table (SIT)
One or more transport packets with a PID value of 0x1F and a table_id value of
0x7F.

Local event Information Table (LIT)
One or more transport packets with a PID value of 0x0020 and a table_id value of
0xD0.
One or more transport packets with a PID value specified by the elementary_PID in
the PMT and a table_id value of 0xD0 when a stream type value is 0x05.

Event Relation Table (ERT)
One or more transport packets with a PID value of 0x0021 and a table_id value of
0xD1.
One or more transport packets with a PID value specified by the elementary_PID in
the PMT and a table_id value of 0xD1 when a stream type value is 0x05.

Index Transmission Table (ITT)
One or more transport packets with a PID value specified by the elementary_PID in
the PMT and a table_id value of 0xD2.

Partial Content Announcement Table (PCAT)
One or more transport packets with a PID value of 0x22 and a table_id value of
0xC2.

Software Download Trigger Table (SDTT)
One or more transport packets with a PID value of 0x23 and a table_id value of
0xC3.
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Table 10−3: Icons specific to ARIB format (Cont.)

Icon Element type

Download Control Table (DCT)
One or more transport packets with a PID value of 0x17 and a table_id value of
0xC0.

DownLoad Table (DLT)
One or more transport packets with a PID value specified by the DL_PID in the
DCT and a stream_type value of 0xC1.
A lock symbol appears in the icon when the transport_scrambling_control value is
set to 01.

Broadcaster Information Table (BIT)
One or more transport packets with a PID value of 0x24 and a table_id value of
0xC4.

Network Board Information Table (NBIT)
One or more transport packets with a PID value of 0x25 and a table_id value of
0xC5 or 0xC6.

Linked Description Table (LDT)
One or more transport packets with a PID value of 0x25 and a table_id value of
0xC7.

Time and Data Table (TDT)
One or more transport packets with a PID value of 0x0014 and a table_id value of
0x72.

Time Offset Table (TOT)
One or more transport packets with a PID value of 0x0014 and a table_id value of
0x73.
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Table 10−4: Icons specific to ATSC format 

Icon Element type

Master Guide Table (MGT)
One or more transport packets with a PID value of 0x1FFB and a table_id value of
0xC7.

Terrestrial Virtual Channel Table (TVCT)
One or more transport packets with a PID value of 0x1FFB and a table_id value of
0xC8.

Cable Virtual Channel Table (CVCT)
One or more transport packets with a PID value of 0x1FFB and a table_id value of
0xC9.

Rating Region Table (RRT)
One or more transport packets with a PID value of 0x1FFB and a table_id value of
0xCA.

Event Information Table (EIT)
One or more transport packets with a PID value specified by the table_type_PID in
the MGT and a table_id value of 0xCB.

Channel Extended Text Table (CETT)
One or more transport packets with a PID value of 0x1FFB and a table_id value of
0xC8.

Event Extended Text Table (EETT)
One or more transport packets with a PID value of 0x1FFB and a table_id value of
0xC9.

Program Identifier Table (PIT)
One or more transport packets with a PID value specified by the elementary_PID in
the PMT and a table_id value of 0xD0 when a stream_type value is 0x85.

System Time Table (STT)
One or more transport packets with a PID value of 0x1FFB and a table_id value of
0xCD.
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To the right of each icon, the MPEG Player displays text that describes each
transport stream component. In addition, for the PCR icon, you can display a
dialog box to change the parameters for the component. Table 10−5 shows the
text that will be displayed with each icon.

Table 10−5: Icon text 

Component Text

ISDB-T Icon �xxx.rmx": Shows the file name.

Packets: Shows the total number of packets in the
broadcast transport stream.

S-TMCC Icon �xxx.trp": Shows the file name.

TC8PSK/xx, BPSK/xx, or QPSK/xx: Shows the
modulation system and the number of contract slots
(xx).

M-TMCC Icon �xxx.trp": Shows the file name.

SF: Shows the number of super frames.

Non TS Icon �xxx.xx": Shows the file name.

FileSize: Shows the file size in byte.

Transport Stream (TS) Icon �xxx.trp": Shows the file name of the transport stream.

Packets: Shows the total number of packets in the
transport stream.

When this icon is used with the S-TMCC or M-TMCC
icon, the following text information is displayed:

TSID: Shows the ID number for the transport stream.

TC8PSK/xx, BPSK/xx, or QPSK/xx: Shows the
modulation system and the number of contract slots
(xx).

Program Allocation Table (PAT) Icon PID: Shows the PID value of the PAT.

TblID: Shows the table_id value of the PAT.

TSID: Shows the transport_stream_id value of the
PAT.

Prg: Shows the number of programs contained in the
transport stream.

Transport Stream Description Table
(TSDT) Icon

PID: Shows the PID value of the TSDT.

TblID: Shows the table_id value of the TSDT.

Network Information Table (NIT) Icon PID: Shows the PID value of the NIT.

TblID: Shows the table_id value of the NIT.

Icon Text and Dialog Box
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Table 10−5: Icon text (Cont.)

Component Text

Conditional Access Table (CAT) Icon PID: Shows the PID value of the CAT.

TblID: Shows the table_id value of the CAT.

Program Map Table (PMT) Icon PID: Shows the PID value of the PMT.

TblID: Shows the table_id value of the PMT.

PrgNo: Shows the program number associated with
the PMT.

Program Clock Reference (PCR) Icon PID: Shows the PID value of the PCR.

See also PCR Inaccuracy Dialog Box, page 10−19.

Video Elementary Stream (VIDEO) Icon PID: Shows the PID value of the video elementary
stream.

StrmTyp: Shows the type of the video elementary
stream (0x01 or 0x02).

Audio Elementary Stream (AUDIO)
Icon

PID: Shows the PID value of the audio elementary
stream.

StrmTyp: Shows the type of the audio elementary
stream (0X03 or 0X04).

AUDIO_AAC and AUDIO_AC3 Icons PID: Shows the PID value of the audio elementary
stream.

StrmTyp: Shows the type of the audio elementary
stream (0X0F or 0x81).

Data Stream (DATA) Icon PID: Shows the PID value of the data stream.

StrmTyp: Shows the type of the data stream.

Private Section (DATA_SECT) Icon PID: Shows the PID value of the private section.

TblID: Shows the table_id value of the private
section.

StrmTyp: Shows the type of the private section.

DSM_CC Icon PID: Shows the PID value of the data DSM-CC.

StrmTyp: Shows the type of the DSM-CC.

Entitlement Control Message (ECM)
Icon

PID: Shows the PID value of the ECM.

TblID: Shows the table_id value of the ECM.

Entitlement Management Message
(EMM) Icon

PID: Shows the PID value of the EMM.

TblID: Shows the table_id value of the EMM.

GHOST Icon PID: Shows the PID value of the GHOST.

Adaptation Field Error (ADFERR) Icon PID: Shows the PID value of the ADFERR.
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Table 10−5: Icon text (Cont.)

Component Text

NULL Icon PID: Shows the PID value of the NULL.

GARBAGE Icon PID: Shows the PID value of the GARBAGE.

SDT, BAT, EIT, RST, ST, DIT, SIT, LIT,
ERT, ITT, PCAT, SDTT, DCT, DLT, BIT,
NBIT, and LDT Icons

PID: Shows the PID value of the SDT, BAT, EIT, RST,
ST, DIT, SIT, LIT, ERT, ITT, PCAT, SDTT, DCT, DLT,
BIT, NBIT, or LDT.

TblID: Shows the table_id value of the SDT, BAT, EIT,
RST, ST, DIT, SIT, LIT, ERT, ITT, PCAT, SDTT, DCT,
DLT, BIT, NBIT, or LDT.

TDT and TOT Icon PID: Shows the PID value of the TDT or TOT.

TblID: Shows the table_id value of the TDT or TOT.

MGT and PIT Icons PID: Shows the PID value of the MGT or PIT.

TblID: Shows the table_id value of the MGT or PIT.

TVCT, CVCT, RRT, EIT, CETT, and
EETT Icons

PID: Shows the PID value of the TVCT, CVCT, RRT,
EIT, CETT, or EETT.

TblID: Shows the table_id value of the TVCT, CVCT,
RRT, EIT, CETT, or EETT.

TblType: Shows the table_type value of the TVCT,
CVCT, RRT, EIT, CETT, or EETT.

System Time Table (STT) Icon PID: Shows the PID value of the STT.

TblID: Shows the table_id value of the STT.
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PCR Inaccuracy Dialog Box. If you press the SELECT button when the PCR icon
is selected, the PCR Inaccuracy dialog box appears as shown in Figure 10−6.
This dialog box allows you to add jitter to the program_clock_reference_base
value and the program_clock_reference_extension value.

Refer to Adding Jitter to PCRs on page 10−58 for more information.

Table 10−6 describes the PCR Inaccuracy dialog box parameters.

Figure 10−6: PCR Inaccuracy dialog box

Table 10−6: PCR Inaccuracy dialog box parameters 

Parameter Description

Pattern Selects the waveform type of the waveform used to add jitter. You can
select Sine, Square, Triangle, Pulse, Sawtooth, Random, or Offset.

Period Sets the period of the waveform used to add jitter. You can set the value
from 5 to 3000 packets in 1 packet steps.

Amplitude Sets the amplitude of the waveform used to add jitter. You can set the
value from 0/27 MHz to 135000000/27 MHz (0 s to 5 s).

Pulse Width Sets the pulse width of the waveform used to add jitter. You can set the
value from 1 to (period − 1) packet(s) in 1 packet steps. This Pulse Width
parameter is available only when the Pattern parameter is set to Pulse.
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Menus and Controls

This section describes the function of each selection available in the menus. This
section is divided into the following subsections:

� Menus in the Play Screen describes all of the menu commands and their
features available in the Play screen.

� Menus in the Record Screen describes all of the menu commands and their
features available in the Record screen.

� Toolbar Buttons describes the toolbar buttons and their functions.

Menus in the Play Screen

This subsection describes the menus in the Play screen.

The File menu in the Play screen contains commands for selecting a stream file
and for loading and saving a preset file. Table 10−7 describes the commands in
the File menu.

Table 10−7: File menu commands (Play screen) 

Command Description

Open Opens a stream file stored in the E: drive (volume E). When a file is
selected, the MPEG Player checks the packet size of the file. When
it is a transport stream file, its data is output in packets. Therefore, if
an incomplete packet is included at the start or end point of the file,
the portion is not output.

The function uses a standard Windows Open… dialog box.

Load Preset Loads the specified preset file (*.set). When a preset file is loaded,
the current instrument settings are changed by the file’s content.
Refer to Preset File, page 10−61, for more information about the
preset file.

Save Preset Saves the current instrument settings as a preset file. Refer to Preset

File, page 10−61, for more information about the preset file.

RECORD When the SPI/ASI/310M interface is selected the Play screen
switches to the Record screen. The Record screen is disabled for IP
interface.

Exit Quits the MPEG Player application. The MPEG Player application
settings are saved.

File Menu



MPEG Player - Menus and Controls

10−22 MTS400 Series MPEG Test Systems User Manual

The View menu contains commands that control the display of the Toolbar and
Status bar. Table 10−8 describes the commands available in the View menu.

Table 10−8: View menu commands (Play screen) 

Command Description

Toolbar Shows or hides the toolbar in the Play screen.

Status Bar Shows or hides the status bar in the Play screen.

The Play menu contains commands for defining output parameters, such as
packet size, output clock rate, and output source. Table 10−9 describes the
commands available in the Play menu.

Table 10−9: Play menu commands (Play screen) 

Command Description

Interface Sets the interface to transmit and receive ethernet packets. You can
select either IP or SPI/ASI/310M interfaces.

Packet Size Sets the packet size (in bytes) for the stream. You can set the packet
size to 188 (188 + 0), 204 (188 + 16), 208 (188 + 20) bytes, or Non
TS.

These packet sizes can only be set for an MPEG2 transport stream.
For an S-TMCC or M-TMCC transport stream, the packet size is
fixed to 204. For a Non TS stream, the packet size is fixed to Non
TS. In addition, if you select 8VSB, the packet size is fixed to 188.

When you select Non TS, the MPEG Player deals with stream data
in a byte unit (not a packet unit) and outputs all of the data in a file. If
a transport stream contains any error, you can output it by selecting
Non TS.

Clock Sets the clock rate of the stream output. When you select this
command, the Clock dialog box appears. Refer to Clock Dialog Box

on page 10−24 for more information.

Update Sets whether to update parameters in the stream when looped. You
can select On or Off. You cannot set to On for a Non TS stream.

You can select which parameters in the stream are updated using
the Others dialog box. Refer to Others Dialog Box on page 10−32 for
more information.

View Menu

Play Menu
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Table 10−9: Play menu commands (Play screen) (Cont.)

Command Description

Sync Sets the format of the PSYNC signal output from the SPI IN/OUT
connector. You can select TS Packet, SF, or Non TS. For TS Packet,
a single pulse signal is output at the start point of each packet. For
SF, a single pulse is output at the start point of the SF appearing
every 204 X 48 X8 bytes. For Non TS, the Set Non-TS Sync dialog
box appears, where you can enable the PSYNC and DVALID
signals.

Refer to Set Non-TS Sync Dialog Box on page 10−28 for more
information.

PCR Initial Value Sets the initial value of the program_clock_reference_base and
program_clock_reference_extension parameters when the transport
stream is output.

When you select this command, the PCR Initial Value dialog box
appears. Refer to PCR Initial Value Dialog Box on page 10−28 for
more information.

Source Selects the source for stream output. You can select RAM or Disk.

Refer to SPI/ASI/310M Interface Menu - Play on page 10−36 and IP
Interface Menu on page 10−36 for detailed information about
differences between the two sources.

Loop Sets whether or not the stream is output using looping method. You
can select On or Off. If you set it to On, the selected stream is
continuously output. If you set it to Off, the selected stream is output
once.

Start/Stop Sets the start and stop position of the stream, and initial start
position of the stream for loop output.

When you select this command, the Start/Stop Position dialog box
appears. Refer to Start/Stop Position Dialog Box on page 10−29 for
more information.

Auto play Sets whether or not the transport stream is automatically output
using the last power-down settings when you turn the MPEG Player
on. You can select On or Off. If you set it to On, take care of the
output level setting used when the MPEG Player was last turned off
and the input level of the instrument (device) currently connected to
the MPEG Player.

Timer Play Sets the date and time used to output a stream automatically.

When you select this command, the Timer Play/Record dialog box
appears. Refer to Timer Play/Record Dialog Box on page 10−31 for
more information.

Other Sets the standard used to display the selected stream and display
radix for the text information.

When you select this command, the Others dialog box appears.
Refer to Others Dialog Box on page 10−32 for more information.
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Clock Dialog Box. When you select the Clock... command from the Play menu,
the Clock dialog box is displayed.

Figure 10−7: Clock dialog box for Option Interface

Figure 10−8: Clock dialog box for IP interface
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Clock Source: Sets the clock that will be used as the reference for the
stream output. You can select the desired clock source
from the following settings:

Internal uses the internal clock of the MPEG Player as
the clock reference.

Ext Ref allows you to input a signal on the Reference
Clock Input connector for use as the clock reference.
When you select the button to the right of the ExtRef
box, the External Reference dialog box is displayed.

� 10 MHz: Selects a 10 MHz signal on the Reference Clock
Input connector.

� 27 MHz: Selects a 27 MHz signal on the Reference Clock
Input connector.

� ISDB-T IFFT Clock: Selects a signal corresponding to
the IFFT sample clock rate (8.126984 MHz) on the
Reference Clock Input connector.

Select the required option:

Ext P Clk (external parallel clock) allows you to input a
clock signal on the Reference Clock Input connector for
use as the parallel clock.

Ext S Clk (external serial clock) allows you to input a
clock signal on the Reference Clock Input connector for
use as the serial clock.

Data Rate: Sets the clock rate for the transport stream output. You
can enter the clock rate using the following methods (the
first method provides greater clock-rate precision):
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Enter values into the numerator and denominator text
boxes (see Figure 10−7). The MPEG Player will then
calculate the clock rate based on the ratio of the numera-
tor and denominator values.

Enter a value into the clock rate text box. The MPEG
Player will then calculate the numerator and denomina-
tor text boxes based on the clock rate.

NOTE. The IP data rate will be automatically calculated based on the TS data
rate available. IP Data Rate is calculated as follows:

IP�Data�Rate � �TS�Data�Rate� IP�Packet�Size)�Payload�Size

When you use the Ext P Clk or Ext S Clk mode, set the
clock rate to the same value as the input clock signal.
Also, when you use the Ext S Clk mode, you cannot set
the value more than 32 Mbps.

IP Data Rate: Sets the clock rate for the IP packet (see Figure 10−8).
In the IP mode, a change in the IP data rate will impact
the TS data rate and a change in the TS data rate will
impact the IP data rate. The packet length changes ac-
cording to the selected protocol.

NOTE. The TS data rate will be automatically calculated based on the IP data
rate available and consequently influence the PCR/PTS/DTS update cycles. TS
Data Rate is calculated as follows:

TS�Data�Rate � �IP�Data�Rate� Payload�Size)�IP�Packet�Size

Fixed ES Rate: Sets whether elementary stream rate is fixed. When it is
checked, the elementary stream rate becomes constant
regardless of the clock rate setting. If you fix the ele-
mentary stream rate, you cannot set the output clock rate
(Data Rate) more than the data rate set when the stream
file was downloaded.

When the Fixed ES Rate check box is enabled, PCR/
PTS/DTS Update Method in the Select Update Item dia-
log box is set to Hardware automatically (see Others
Dialog Box on page 10−32).
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Default Rate: Displays the default clock rate and packet size and then
changes the values. When you select this button, the fol-
lowing Default Clock dialog box appears.

Figure 10−9: Default Clock Dialog box

Default Data Rate: Changes the default clock rate when
the selected stream file was downloaded.

Since the default clock rate is calculated based on the
PCRs in the downloaded stream file, the value can be
different than the original clock rate. When the elemen-
tary stream rate is fixed (refer to the Fixed ES Rate de-
scription), the instrument refers to the default clock rate.
Therefore, if the default clock rate is different than the
original clock rate, you need to set the value to the ap-
propriate value. If you change the value, the clock rate
value in the Data Rate dialog box is also changed.

Packet Size: Changes the default packet size when the
selected stream file is downloaded. If you change the
value, the Packet Size setting in the Play menu will also
change.

Press the OK button to enable all setting changes.
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Set Non-TS Sync Dialog Box. When you select Play > Sync > Non-TS, the Set
Non-TS Sync dialog box is displayed.

� Psync Enable: Sets the status of the PSYNC signal output from the SPI
IN/OUT connector.

� Interval: Sets the output period of the PSYNC signal in the range of 16
to 255 bytes. This value needs to be set equal to or greater than the
Width value in the Dvalid field.

� Dvalid Enable: Sets the status of the DVALID signal output from the SPI
IN/OUT connector.

� Width: Sets the data width of the DVALID signal in the range of 16 to
255 bytes.

Press the OK button to enable all setting changes.

PCR Initial Value Dialog Box. When you select the PCR Initial Value... command
from the Play menu, the PCR Initial Value dialog box is displayed.

Figure 10−10: PCR Initial Value dialog box
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� Base Value: Sets the initial value for the program_clock_reference_base
value. You can set the value from 0 to 8589934591. The bracketed number
represents the number of bits for the program_clock_reference_base field.

� Extension Value: Sets the initial value for the program_clock_reference_ex-
tension value. You can set the value from 0 to 299. The bracketed number
represents the number of bits for the program_clock_reference_extension
field.

Start/Stop Position Dialog Box. When you select the Start/Stop... command from
the Play menu, the Start/Stop Position dialog box is displayed.

Figure 10−11: Start/Stop Position dialog box

� Start: Sets the start position of the stream by time (h:m:s) or the number of
packets (the number of super frames for a M-TMCC file, or the number of
bytes for a Non TS file). Use the Format list box to select the method of
setting the position.

� Stop: Sets the stop position of the stream by time (h:m:s) or the number of
packets (the number of super frames for a M-TMCC file, or the number of
bytes for a Non TS file). Use the Format list box to select the method of
setting the position.

� Initial: Sets the initial start position of the stream for loop output. You can
set the value by time (h:m:s) or the number of packets (the number of super
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frames for a M-TMCC file, or the number of bytes for a Non TS file). Use
the Format list box to select the method of setting the position.

� Play: Shows the actual time or number of packets (the number of super
frames for a M-TMCC file, or the number of bytes for a Non TS file) that is
calculated by the values of the Start and Stop text boxes.

� Format: Specifies the method of setting the start, stop, and initial positions
of the stream. For a transport stream file, you can select Time or Packets. For
a M-TMCC file, you can select Time or SF (super frame). For a Non TS file,
you can select Time or Bytes.

For an ISDB-T file, the start packet is defined as the first-appearing packet
including an OFDM frame start flag after the specified start position. The
stop packet is defined as the packet at the front of the last-appearing packet
including an OFDM frame start flag before the specified stop position. At
this time, if the number of OFDM frames between the start packet and stop
packet is not an even number, the packet in the last OFDM frame becomes
the stop packet.

You can set the start, stop, and initial positions by using either the slider or the
text boxes.

Using the Slider:

Ensure that Packets is selected from the Format drop-down list.

1. For the start and stop positions:

a. Select the Start option button.

b. Using the mouse, drag the slider to the required start position.

c. Select the Stop option button.

This moves the slider to the right end.

d. Drag the slider to the required stop position.

e. Select the OK button to enable the values.

2. For the initial start position for loop output:

a. Enable the Initial check box. A red arrow appears on the slider.

b. Drag the red arrow to the required initial start position.

c. Select the OK button to enable the value.
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Using the text boxes:

Ensure that Time is selected from the Format drop-down list.

1. Select the Start option button.

2. Enter the time in hour/minute/second format.

3. Repeat for the Stop time and the Initial Start Position time.

4. Select the OK button to enable the values.

To reset all of the settings to the values that were in effect when the dialog box
was first displayed, select the Reset button, and then press the OK button.

Timer Play/Record Dialog Box. When you select the Timer Play... command from
the Play menu, the Timer Play/Record dialog box is displayed.

Figure 10−12: Timer Play/Record dialog box

� Start at: Sets the date and time when the stream output or record starts.

When you press the OK button after setting the date and time, the current
date and time and the set date and time are displayed. When the current date
and time coincide with the set date and time, the dialog box closes and
stream output or stream record starts automatically.

If you want to cancel the operation, select the OK button. When the dialog
box that prompts you to confirm the operation is displayed, press the OK
button to execute the operation.
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Others Dialog Box. When you select the Other… command from the Play menu,
the Others dialog box is displayed.

Figure 10−13: Others dialog box

� Standard: Sets the standard used on the hierarchy-display screen. You can
select ARIB, ATSC, DVB, or MPEG2. For a transport stream (ARIB, ATSC,
DVB, or MPEG2), the standard is set to the previous setting as a default. For
an S-TMCC, M-TMCC, or ISDB-T transport stream, you need to select
ARIB for proper display.

� Numeric: Sets the base value used to describe the component information in
the hierarchy display. You can select Decimal, Hex, or Octal.

� Ext Play Start: Sets whether or not to start stream output using a trigger
signal applied to the Trig In/Out connector. You can select Off, Rise, or Fall.
When you select Rise, the stream output is started at the rising edge of the
applied trigger signal. When you select Fall, the stream output is started at
the falling edge of the applied trigger signal.

� SPI Output Enable: Sets whether the signal output from the SPI connector
is enabled or not.

� TDT/TOT or STT: When you select this button, the following TDT/TOT
dialog box appears. The button name changes which standard is selected in
the Standard list box; TDT/TOT for ARIB or DVB, and STT for ATSC. Use
this dialog box to change the initial date and time of the TDT (Time and
Data Table), TOT (Time Offset Table), or STT (System Time Table) in the
selected stream.
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The button is disabled when MPEG2 is selected in the Standard list box.

Figure 10−14: TDT/TOT dialog box

Original: Uses the original (default) value that is already defined in the
selected stream.

System Time: Uses the clock/calendar of the operating system to set the
initial value. When you select this option, the date and time of all the TDTs,
TOTs, or STTs in the selected stream are locked to the clock/calendar of the
operating system.

User Define: Uses the user-defined value to set the initial value. When you
select this option, the list boxes for setting the initial date and time of the
TDT, TOT, or STT are available.
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� ISDB/P-TS: When you select this button, the following ISDB/P-TS dialog
box appears.

Figure 10−15: ISDB/P−TS dialog box

Data Rate Auto Convert (Play Mode): Sets whether to set the clock rate
automatically when the ISDB-Tsb file is loaded. When this option is
enabled, the clock rate is automatically set to (2048/1701) x 27 MHz and the
elementary stream rate becomes constant, regardless of the Fixed ES Rate
setting.

Loop by ISDB-T Frame (Play Mode): Sets whether to output the ISDB-T
transport stream in OFDM frames when looped. When this option is not
enabled, the ISDB-T transport stream is looped in packets.

Treat as Partial TS (Play Mode): Sets whether to output a stream file
consisting of a 192-byte packet as a partial transport stream. When this
option is not enabled, the stream is output in Non TS format.
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� Update: When you select this button, the following Select Update Item
dialog box appears. Use this dialog box to select which parameters in a
stream are updated when looped.

Figure 10−16: Select Update Item dialog box

Continuity Counter: Sets whether to update continuity_counter.

PCR/PTS/DTS: Sets whether to update PCR (Program Clock Reference),
PTS (Presentation Time Stamp), and DTS (Decoding Time-Stamp).

Update Method: Specifies the method to update PCR/PTS/DTS. The
SPI/ASI/310M interface supports both Software and Hardware update
methods but IP interface supports only the Software method.

� Hardware: PCR/PTS/DTS are updated using the counter values of the
27 MHz clock on the output board. Since data output and PCRs are
completely locked, the continuity of PCRs is maintained at the loop
point even if playing long stream loops. However, timing errors occur in
PTS/DTS.

� Software: PCR/PTS/DTS are updated by adding the actual looping time
(defined by the start and stop positions) to the stream every time it is
looped. There are no timing errors in PTS/DTS, however, it is difficult to
maintain the continuity of PCRs at the loop point because the updating is
not synchronized with the 27 MHz clock on the output board. Since this
method is used to update NPT, if you enable the NPT option, Software is
selected automatically.
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TDT/TOT/STT: Sets whether to update TDT (Time & Data Table), TOT
(Time Offset Table), and STT (System Time Table).

NPT: Sets whether to update NPT (Normal Play Time; STC_Reference field
in NPT Reference Descripter defined by ISO/IEC 18318-6).

The NPT check box is only available when PCR/PTS/DTS is enabled and
Update Method is set to Software. When the check box is enabled, PCR/
PTS/DTS becomes enabled and Update Method is set to Software. In
addition, the Fixed ES Rate option in the Clock dialog box becomes
disabled.

Reed Solomon (ISDB-T only): Sets whether to update Reed-Solomon codes
in an ISDB-T transport stream.

Select the OK button to enable all setting changes.

Table 10−10 describes the commands available in the SPI/ASI/310M menu.

Table 10−10:  SPI/ASI/310M menu commands (Play screen)

Command Description

BNC Port Sets the format of the output signal at the ASI/SMPTE Out
connector: ASI, 310M 8VSB.

Through Out Sets whether the signal supplied to the ASI/SMPTE In connector is
looped back to the ASI/SMPTE Out connector when there is no
recording or playout selected.

ASI Format Selects either Byte or Packet when an ASI output is selected at the
BNC Port. For Byte, valid data is output using a burst transmission
mode. For Packet, valid data is output in each transport stream
packet.

Table 10−11 describes the commands available in the IP menu.

Table 10−11: IP menu commands 

Command Description

Configuration Configures the IP interface. The packet size, device name, protocol,
ports, and the transmission mode can be set.

Parametric Settings Sets the player process priority, transmitter thread priority, burst
mode parameters, and jitter parameters.

Error Insertion Inserts errors like packet loss, checksum, and sequence errors in the
transmitted stream.

SPI/ASI/310M Interface
Menu - Play

IP Interface Menu - Play
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Table 10−11: IP menu commands (Cont.)

Command Description

Error Generation Generates errors like packet loss, checksum, and sequence in the
transmitted stream manually.

Statistics Displays details about parameter names, current stream values, and
the history of the previous transmission.

Configuration. When you select Configuration from the IP menu, the IP Playout
Configuration dialog box is displayed as shown in figure 10−17. This dialog box
allows you to configure the following settings:

Figure 10−17: IP Playout Configuration dialog box

� Configuration name: Allows you to enter or select a configuration name
from the drop down list. This list can store up to ten configuration names.
The default value is blank.

� Device Name: Allows you to select the device for the IP playout. The
Device Name lists all the active Network Interface Cards (NIC) in the
system. The first interface that has a valid IP address assigned to it is
automatically selected as the default value.

� Source IP Address: Sets the source IP address for the IP playout. The first
valid IP address of the selected device will be set as the default. A custom-
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ized value can be selected only if a different source address is first set in the
Advanced Protocol Settings dialog box.

� Source Port: Sets the source port for the IP playout. The port value ranges
from 0 to 65535. The default value for UDP protocol is 0 and for RTP
protocol is 16384.

� Transmission Mode: Sets the transmission mode of the protocol. Unicast,
Muticast, and Broadcast are the three transmission modes available in the
drop down list. Multicast is set as the default value.

� Protocol: Sets the protocol (UDP, RTP) for the IP playout. RTP is set as the
default value.

� Destination IP Address: Sets the destination IP address for the IP playout.
239.1.1.1 is set as the default value. Depending on the transmission mode
selected the system will validate the entry based on the following rules:

Unicast Range: Any IP address that does not fall into the Multicast or the
Broadcast range.

Multicast Range: 224.0.0.0 to 239.255.255.255.255

Broadcast Range: Network or node portion of an IP address will be set to
“1”s or “0”s.

� Destination Port: Sets the destination port for the IP playout. The port value
ranges from 0 to 65535. 16384 is set as the default value.

� Enable VLAN: Enables the VLAN layer that is present between the
Ethernet layer and IP layer. You will have to enter the VLAN ID to allow the
identification of 4096 VLANs that is basically used by the 802.1Q standard.

� Advanced Protocol Settings: Click Advanced Protocol Settings to view or
customize the protocol settings of active protocols in the current configura-
tion. All the settings has only header customization for which no validation
will be done.
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Figure 10−18: Advanced Protocol Settings dialog box

The Header Name and Default Value are read only options. The protocol
headers displayed will be limited to headers common to all packets. You can
customize the Current value of the headers which can be specified at packet
creation. The customized valid values are displayed in lavender and the
customized invalid values are displayed in pink.

Click the Reset to Defaults button to reset the current values to default
values. Whenever any of the attributes are set, an icon is displayed in the
status bar during the play.

If VLAN is enabled with VID set to a value, the Advanced Settings dialog
box displays all the VLAN attributes under 802.1Q VLAN Layer header.

� Stream Replication Settings: Click Stream Replication Settings to set the
number of replicated streams and customize the attributes accordingly. This
settings is used to replicate the streams wherein a stream is replicated n times
with certain attributes of the stream incremented by a value with in the n
replicated streams. The customized valid values are displayed in lavender
and customized invalid values are displayed in pink.

You can enter the number of replications in the Number of replicated streams
text box. The table lists the attributes which can be incremented by entering
a number in the Increment Value column. All attributes except for MACs
and IP addresses will accept an integer.

If VLAN is enabled with VID set to a value, the Stream Replication Settings
dialog box displays all the VLAN attributes under 802.1Q VLAN Layer
header.
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Figure 10−19: Stream Replication Settings dialog box

You can click Reset to Defaults to reset the increment values to default
values. Whenever the stream replication is active, an icon is displayed in the
status bar during the play.

� Allow TS Fragmentation: Controls the fragmentation of the transport
stream packets. If this option is selected, the transport stream packets will be
split across the IP packets else all the transport stream packets will be
present in the IP packet. The cleared option is the default option. The IP
Packet size and Number of TS packets option will be enabled only if TS
fragmentation is allowed. When TS fragmentation is not allowed only the
Number of TS packets option is enabled.

� Allow IP Fragmentation: Controls the fragmentation of IP packets. This
option is applicable to packet sizes which are greater than the MTU size of
the interface (typically 1500B). If this option is selected, the IP packets are
fragmented else they will be retained with the same size. The cleared option
is the default option. The maximum packet size is 16128 when IP fragmenta-
tion is selected.

� IP Packet Size: Allows you to set the size of IP packet. This option is
enabled only if TS fragmentation is allowed. When IP fragmentation is
enabled the maximum size of the packet is 16128 bytes and when disabled it
is 1500 bytes..
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The IP packet size includes the headers and hence the payload size is
calculated at runtime using the following equation:

IP�Packet�Size � Payload�Size�Header�Size

where header size is 54 (58 if VLAN is enabled) for RTP and 42 (46 if
VLAN is enabled) for UDP

� Number of TS Packets: Allows you to type the number (integers) of TS
packets that needs to be embedded into an IP packet.

The maximum IP packet size is 1500 bytes or equivalent to TS packets.

A read only text field showing the IP packet size is displayed next to this
option. The IP packet size will be calculated automatically and displayed in
bytes. Based on the number of TS packets, the IP packet size is calculated
using the following equation:

IP�Packet�Size � Payload�Size�Header�Size

where payload size is calculated as follows:

 Payload�Size � Number�of�TS�Packets� TS�Packet�Size

� Store Settings: Stores or updates the entire configuration settings including
the Advanced Protocol Settings. All these settings will be listed out in the
Configuration Name drop down list.

� Delete Settings: Deletes the selected configuration setting that is displayed
in the Configuration Name drop down list and selects the next configuration
in the list. If there are no more configurations stored in the list, the values in
the configuration dialog box will be reset to the default values.

� Clear Settings: Clears the selected configuration setting including the
Advanced Protocol Settings and resets them to the default values.
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Parametric Settings. When you select Parametric Settings from the IP menu, the
Parametric Settings dialog box is displayed as shown in figure 10−20 .

Figure 10−20: Parametric Settings dialog box

The Parametric Settings dialog box allows you set the following:

� Priority: Allows you to set the priority of the player and the transmiiter
thread.

Player: You can set the process priority for the player in IP mode. The
priorities available are Real Time, Normal, Above Normal, Highest. Above
Normal is selected by default.

Transmitter: You can set the priority for the transmitter thread. The
priorities available are Idle, Below Normal, Normal, Above Normal,
Highest, and Real Time. Real Time is selected by default.

� Burst Mode: Allows you to transmit the player thread in the form of bursts.
Burst mode is not selected by default.

Burst Period: You can set the time during which the packets will be
transmitted in the burst mode. Burst period is selected by default.

Burst Size: You can set the burst size which determines the number of
packets being transmitted in every burst.

� Jitter: Inserts jitter during IP playout. There are four types of jitter distribu-
tion namely Fixed, Laplacian, Gaussian, and Sinusoidal. Fixed is the default
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jitter distribution. When Fixed is selected a Duration text box is displayed
wherein you can enter the jitter in microseconds.

When Laplacian, Gaussian, or Sinusoidal is selected a slider is displayed
wherein you can set the jitter as percentage of the interpacket time by
moving the slider. The interpacket gap will follow the selected jitter
distribution.

The overall bit rate of the playout is not affected by jitter insertion.

Error Insertion. When you select Error Insertion from the IP menu, the Error
Insertion dialog box is displayed as shown in Figure 10−21. This dialog box
allows you to insert errors during playout. For Non−TS playout the error
insertions is limited to packet drop and checksum errors.

Figure 10−21: Error Insertion dialog box

� Enable Error Insertion: Enables error insertion. You can have error
insertion in sequential or random order. All error insertions are specified as
X error per Y packets except for jitter.

Sequential: The errors are inserted in sequential packets, that is for every Y
packets the first X packets have errors inserted in them.
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Random: The errors are inserted in random packets, that is for every Y
packets X random packets have errors inserted in them. Random mode is set
as the default.

� Packet Loss: Inserts packet loss. The packets are dropped at a frequency you
specify. You can specify the rate as X packets within Y packets.

� Checksum Error: Inserts checksum error. The checksum error can be
inserted in either UDP or IP layers. The CRC errors are generated in packets
at a frequency you specify. You can specify the rate as X packets within Y
packets.

� Sequence Error: Inserts packet sequence error. This option is enabled only
if RTP protocol is selected in the the IP configuration Playout dialog box.
The packets will be reordered at the frequency specified in the Packets text
box. You can enter the number of packets after which you want the
reordering to happen in the Packets Apart text box. You can specify the rate
as X packets per Y packets after every Z number of packets.

Error Generation.  When you select Error Generation from the IP menu, the Error
Generation dialog box is displayed as shown in Figure 10−22. This dialog box
allows you to insert errors manually.

Figure 10−22: Error Generation dialog box

� Generate Packet Loss: Drops an IP packet during the IP playout. The
number of packets dropped will be equal to the number of times you click
the button.
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� Generate Sequence Error: Generates sequence error manually. When you
click this button the packet will be re−sequenced with another packet within
a 100-packet boundary.

� Generate IP Checksum Error: Generates checksum errors manually in the
IP layer.

� Generate UDP Checksum Error: Generates checksum errors manually in
the UDP layer.

Statistics. When you select Statistics from the IP menu, the Statistics dialog box
is displayed. The player displays the current and historic statistics of IP
parameters, TS parameters, and Errors. These will be retained till the start of
next play or until a new file is opened.

Figure 10−23: Statistics dialog box without Stream Replication
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Figure 10−24: Statistics dialog box with Stream Replication

� Current: Displays the instantaneous statistics of parameters at that time.
Once the play is started, this dialog box is refreshed at the rate of every
second.

IP Parameters: The current bit rate, percentage variation of this current bit
rate from the nominal (set) bit rate, number of IP packets transmitted, and
the IP packet size used for the playout are all displayed. The jitter value
which reflects the insertions done at runtime is also displayed.

TS Parameters: The TS bit rate of the MPEG file being played is displayed.
The number of TS packets and the TS packet size is also displayed. If the
player is in the Non-TS mode then all the statistics will display Non-TS
playout.

Errors: Number of packets dropped, packet loss rate, sequential errors, and
checksum errors for both IP and UDP are all displayed.

Value (per stream): When stream replication is enabled, the Current tab
displays the Value column as shown in figure 10−24. This column gives the
value of each parameter per stream.

Total Value (in n streams): When stream replication is enabled, the Current
tab displays the Total Value column as shown in figure 10−24. This column
gives the total value of each parameter for the set number of streams. Here n
streams is equal to the sum of the replicated streams and the actual stream.
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� Historic: Displays the minimum, maximum, and average values of
parameters (IP, TS) for the current play. When stream replication is enabled,
the history tab signifies that the statistics displayed is per flow.

IP Parameters: The current bit rate, percentage variation of this current bit
rate from the nominal (set) bit rate, and the jitter value are displayed.

TS Parameters: The bit rate and the percentage variation from this bit rate
are displayed.

Table 10−12 describes the commands in the Utility menu.

Table 10−12: Utility menu commands

Command Description

Communication… Sets the port number that is needed to remotely control the MPEG Player
over an Ethernet network and the terminator that is used to communicate
with a controller.

When you select this command, the Communication dialog box appears.
Refer to Communications Dialog Box on page 10−47 for more information.

About… Displays general system information including the software and hardware
versions.

When you select this command, the About dialog box appears. Refer to
About Dialog Box on page 10−49 for more information.

Communication Dialog Box. When you select the Communication command from
the Utility menu, the Communication… dialog box is displayed.

Figure 10−25: Communication dialog box

Utility Menu
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� Port Number: Sets the port number needed to remotely control the MPEG
Player over an Ethernet network. You can set the value from 1024 to 65535.

� Terminator

� Tx: Selects the terminator that is used when the MPEG Player sends
information to a controller. You can select LF (linefeed), CR (carriage
return), CRLF (carriage return and linefeed), or LFCR (linefeed and
carriage return).

� Rx: Selects the terminator that is used when the MPEG Player receives
commands from a controller. You can select LF (linefeed) or CR
(carriage return).

Select the OK button to enable all setting changes.
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About Dialog Box. When you select the About... command from the Utility menu,
the About dialog box is displayed.

This dialog box shows the version of the MPEG Player application and hardware
version of the main and installed interface modules - your versions may differ.
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Menus in the Record Screen

This subsection describes the menus available in the Record screen.

NOTE. The IP interface mode does not support the Record functionality and
hence the Record option is disabled for IP.

The File menu in the Record screen contains commands for setting the save
mode and for saving and loading a preset file.

Table 10−13: File menu commands (Record screen) 

Component Text

Save Specifies the file name used when you save a stream data. When
you select this command, the Save as dialog box appears. By
default, the current data (yymmdd) is used as a file name.

Save Mode Sets the save mode when you save stream data. You can select
Over Write or New File. In the Over Write mode, the existing file is
over written by the new file with the name specified in the Save
command whenever you save a stream data. In the New File mode,
a new file is created whenever you save a stream file. The file name
is the following: the name specified by the Save commands + #
(1,2,3,4...).

Load Preset Loads the specified preset file (*.set). When a preset file is loaded,
the current instrument settings are changed by the file’s content.
Refer to Preset File, page 10−61, for more information about the
preset file.

Save Preset Saves the current instrument settings as a preset file. Refer to Preset
File, page 10−61, for more information about the preset file.

PLAY Switches to the Play screen.

Exit Quits the MPEG Player application. The MPEG Player application
settings are saved.

The View menu contains commands that control the display of the Toolbar and
Status bar. The View menu in the Record screen is the same as that in the Play
screen. Refer to Table 10−8 for the commands available in the View menu.

File Menu

View Menu
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The Record menu contains commands for setting the input interface, record size,
trigger position, and target source. Table 10−14 describes the commands in the
Record menu.

Table 10−14: Record menu commands

Command Description

Source Sets the interface used to input a stream data. You can select SPI (DVB
SPI connector) or SPI/ASI/310M (ASI/SMPTE In BNC connector).

Target… Sets the record size, trigger position, and target source to record the input
stream.

When you select this command, the Target dialog box appears. Refer to
Target Dialog Box on page 10−52 for more information.

Timer Record… Sets the time used to record the input stream automatically.

When you select this command, the Timer Play/Record dialog box
appears. Refer to Timer Play/Record Dialog Box on page 10−31 for more
information.

Other… Sets the standard used to display the input stream and the external trigger
status.

When you select this command, the Others dialog box appears. Refer to
Others Dialog Box on page 10−32 for more information.

Record Menu
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Target Dialog Box. When you select the Target command from the Record menu,
the Target dialog box is displayed.

� Target: Sets the record target - RAM or hard disk.

� Record Size: Sets the recording time (h:m:s) or file size (MB) to record the
input stream. Use the Format list box to select the way to set the record size.

The amount of free space available for the RAM or hard disk is displayed
below the data size text box. You cannot set the record size beyond this
value.

Disable the Limit record size check box to record the input stream to the
full free space in the hard disk or RAM. When the Limit record size check
box is enabled, the size (in MB) or the available recording time and data size
are automatically set. In addition, when the check box is enabled, the
Continuous Recording check box becomes disabled.

NOTE. When you set the pretrigger portion, the same free space as the record
size is required.
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There is a list box in the Record Size field to select which record target
(RAM or hard disk) is used to record the input stream.

� Trigger Position: Sets the trigger position used to record the input stream.
You can set the trigger position by a time (h:m:s) or file size (MB).

� Continuous Recording: Sets whether to enable Continuous Recording.
With Continuous Recording, you can record multiple stream files continu-
ously on the hard disk.

When the check box is enabled, the spin box (at the right side of the check
box) becomes available. Use the spin box to set the number of files to create
before stopping Continuous Recording. After the specified number of files
are created, stream capture stops automatically. You can set the value from 2
to 32767.

When this option is selected, the Without Limit check box becomes disabled.

Refer to Using the Continuous Recording Feature, beginning on page 10−62,
for detailed information about Continuous Recording.

� Ignore Dvalid: Sets whether the MPEG Player ignores the DVALID signal
from the selected interface when a stream data is acquired. When it is
checked, the MPEG Player ignores the DVALID signal, and the stream data
is acquired according to the internal clock signal. This option is not available
for the ASI interface option.

� Format: Specifies the way to set the record size and trigger position. You
can select Time or File Size.

Select the OK button to enable all the settings and to close the dialog box.
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Others Dialog Box When you select the Other... command from the Record
menu, the Others dialog box is displayed.

� Standard: Sets the standard used to display the input stream. You can select
ARIB, ATSC, DVB, or MPEG2.

� Numeric: Sets the base value used to describe the component information in
the hierarchy display. You can select Decimal, Hex, or Octal.

� Ext Record Start: Sets whether or not to start input stream record using a
trigger signal applied to the TRIG IN connector. You can select Off, Rise, or
Fall. When you select Rise, the input stream record is started at the rising
edge of the applied trigger signal. When you select Fall, the input stream
record is started at the falling edge of the applied trigger signal.

When you use the external trigger signal to record the input stream, if the
pretrigger portion is defined, the MPEG Player acquires pretrigger data when
a valid trigger signal occurs and then waits for a trigger. When a valid trigger
signal occurs again, the MPEG Player acquires posttrigger data and then
creates a stream file.

� SPI Output Enable: This item cannot be accessed from the Record screen.

Select the OK button to enable all setting changes.
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Table 10−15: SPI/ASI/310M menu command (Record screen) 

Command Description

Input Port Selects either DVB/SPI In (SPI) or ASI/SMPTE In (BNC)
connector for recording input.

BNC Port Selects either ASI or 310M (SMPTE 310) as BNC input.

The Utility menu contains commands for displaying the system information such
as software and hardware versions. The Utility menu in the Record screen is the
same as that of the Play screen. Refer to Table 10−12 for detailed information.

Toolbar Buttons

The toolbar provides shortcut buttons for many of the most often used menu
commands. Click a toolbar button to select the corresponding command.

Toolbar button

Table 10−16 shows the toolbar buttons and their functions.

Table 10−16: Toolbar button descriptions  

Icon Name Function

LOAD TS file Opens the Select File dialog box. Equivalent to the Open
command in the File menu. This button is available when the
Play screen is displayed.

SAVE TS file Opens the Save as dialog box. Equivalent to the Save
command in the File menu. This button is available when the
Record screen is displayed.

Load Preset Opens the Open dialog box. Equivalent to the Load Preset
command in the File menu.

Save Preset Opens the Save as dialog box. Equivalent to the Save Preset
command in the File menu.

Play Outputs the selected stream. Equivalent to the PLAY button
on the front panel.

SPI/ASI/310M Interface
Menu - Record

Utility Menu
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Table 10−16: Toolbar button descriptions  (Cont.)

Icon FunctionName

Record Records the acquired stream. Equivalent to the RECORD
button on the front panel.

Stop Stops the stream output or stream record. Equivalent to the
STOP button on the front panel.

Clock Opens the Clock dialog box. Equivalent to the Clock
command in the Play menu. This button is available when the
Play screen is displayed.

Target Opens the Target dialog box. Equivalent to the Target
command in the Record menu. This button is available when
the Record screen is displayed.
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Reference

This section contains information about the following MPEG Player features:

� Outputting streams

� Adding jitter to PCRs

� Using Preset files

� Using the Continuous Recording Feature

� Remote control

Interface Card (SPI/ASI/310M Option)

Refer to the MTS400 Technical Reference Manual for detailed specifications of
the interface card connectors.

When you output the selected stream data, you can select either the hard disk or
the RAM as an output source. This subsection describes the operation of the
MPEG Player when each output source is selected.

RAM. When you select the RAM as an output source, the MPEG Player performs
the following:

� When data output rate is less than or equal to 120 Mbps, the MPEG Player
outputs the first stream data while transferring the data from the hard disk to
the RAM and then continuously outputs the data from the RAM using
looping methods.

� When data output rate is more than 120 Mbps, the MPEG Player continuous-
ly outputs a stream data from the RAM using looping methods after the data
is completely transferred from the hard disk to the RAM.

If you select the RAM as an output source, you cannot output data in excess of
the RAM free space for the data output. This RAM free space is displayed on the
status bar.

About the Data Output
Source
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Hard Disk. If you select the hard disk (Disk) as an output source, the MPEG
Player always outputs the selected stream data from the hard disk regardless of
the data output rate. When the reading speed of the hard disk cannot overtake the
data output rate, the error message “Error: Output Buffer Empty” appears.

Use the Source command in the Play menu to select the output source
(see Table 10−22). You can see the currently selected output source in the status
bar.

Adding Jitter to PCRs

The MPEG Player provides the capability to add jitter to PCRs (Program Clock
References). Adding jitter to PCRs allows you to simulate transmission delay
variations and to test the robustness of decoders under various conditions.

The jitter function adds jitter to the program_clock_reference_base value and the
program_clock_reference_extension value in the adaptation field of transport
stream packets. You can use this function to modulate the data values of the
PCRs away from their correct values.

Perform the following procedure to add jitter to PCRs:

1. Highlight a PCR element in the hierarchy display and select PCR Accuracy
Variation... from the right-click menu.

Figure 10−26: PCR Inaccuracy dialog box

Adding Jitter
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2. The PCR Accuracy Variation dialog box lets you set how the parameters for
how jitter will be added to the PCR.

� Pattern: Selects the waveform type of the waveform used to add jitter.
You can select Sine, Square, Triangle, Pulse, Sawtooth, Random, or
Offset.

� Period: Sets the period of the waveform used to add jitter. You can set
the value from 5 to 3000 packets in 1 packet steps.

� Amplitude: Sets the amplitude of the waveform used to add jitter. You
can set the value from 0/27 MHz to 135000000/27 MHz (0 s to 5 s).

� Pulse Width: Sets the pulse width of the waveform used to add jitter.
You can set the value from 1 to (period-1) packet(s) in 1 packet steps.
This Pulse Width parameter is available only when the Pattern parameter
is set to Pulse.

3. After you have set the parameters, press the Apply button to enable the jitter
function.

Note that the PCR icon in the hierarchy display changes.

To disable the jitter function, open the PCR Inaccuracy dialog box and select the
Undo button. Note that the PCR icon in the hierarchy display changes.

Figure 10−27 shows the relationship among the parameters and how the PCR
values (program_clock_reference_base value and program_clock_reference_ex-
tension) change when Sine is selected as a jitter-pattern waveform. The PCR
values vary by the value of sine waveform defined by the amplitude and period.
The PCR period does not change.
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Figure 10−27: Jitter function with a sine jitter pattern applied
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Using Preset Files

You can save the instrument settings that you defined as a preset file, so that you
can later restore those settings.

Preset files can be created for the Play screen and for the Record screen.

� In the Play screen, you can save settings for stream output. All of the
parameter settings available in the Play menu are saved as a preset.

� In the Record screen, you can save settings for stream record. All of the
parameter settings available in the Record menu are saved as a preset.

Use this procedure to save the current instrument settings as a preset file.

Perform the following steps to save a preset file:

1. Make the required instrument settings.

2. Select File > Save Preset. The Save As dialog box is displayed.

In the File name text box, the following default file names are created as
follows:

� Play Screen: A two-digit serial number is added to the selected file name
(for example, if the selected file name is “Test_TS”, the default file name
becomes “Test_TS00”).

� Record Screen: A two-digit serial number is added to the name “Preset”;
for example “Preset01”.

You can change the file name as required.

3. Select OK to save the instrument settings as a preset file.

Perform the following steps to load an instrument setup from a preset file.

1. Select File > Load Preset. The Open dialog box is displayed.

2. Highlight the required file.

3. Press OK to load the preset file into the MPEG Player.

Contents of the Preset File

Saving a Preset File

Loading a Preset File
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Using the Continuous Recording Feature

The Continuous Recording feature allows you to record multiple stream files
continuously on the hard disk.

Continuous Recording has the following features:

� Record multiple stream files continuously on the hard disk

� Variable file size operation

� The time stamp information of the first trigger event in a file is recorded as
the updated date property of the file

� Can be used in disk recording mode

This section describes how files are recorded by the location of the trigger events
in Continuous Recording.

The following explanation requires that both pretrigger and posttrigger sizes to
be set to 500 MB.

� In general, each trigger event occurs intermittently. In this case, each file
contains one trigger event in the file, and the pretrigger and posttrigger areas
have the specified size.

Basic Action of
Continuous Recording
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� If a trigger event occurs while the pretrigger area is filled with data, the
pretrigger area becomes smaller than the specified size. However, the
posttrigger area keeps the specified size. In this case, the size of the File A is
smaller than the specified size.

� If the second trigger event occurs while the posttrigger area is filled with
data, the second trigger event is ignored.

NOTE. If the trigger position is set to 0 (%), each file is created whenever a
trigger event occurs.
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Performing Continuous Recording

Use the following procedure to perform Continuous Recording:

1. Select File > Save... to open the Save dialog box.

2. In the dialog box, select the folder where stream files are to be saved.

3. Select Record > Target... to open the Target dialog box.

4. In the dialog box, select the Continuous Recording check box.

5. To the right of the check box, set the number of files to be continuously
recorded. After the specified number of files are created, stream capture
stops automatically.

6. In the Record Size field, set the file size to be recorded.

7. In the Trigger Position field, set the trigger position.
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8. If you want to start recording by a trigger signal on the External Trigger
connector:

a. Select Record > Other to open the Others dialog box.

b. Select Rise or Fall in the Ext Record Start field.

9. Select the Record button to start continuous recording.

While Continuous Recording is running, the total number of captured files are
displayed in the file counter on the record status indicator.

When the specified number of files are created or you press the front-panel
STOP button, stream capture stops.

After the stream capture stops, recording of the captured streams starts. The file
counter value decreases every time recording of each file is complete. The
recording starts from the last captured file. If you press the STOP button while
the captured streams are recording, the recording process terminates to the file
currently being recorded.

NOTE. The error message Drive Full appears when there is no space to record a
captured file with the specified file size on the hard disk.

Remote Commands

The MPEG Player can be controlled remotely through the 100/10 BASE-T port
on the MTS400 Series rear panel.

The set of remote commands is described in the MTS400 Series Programmer
Manual (071-1725-xx). This is supplied as a PDF file on the MTS400 documen-
tation (063-3857-xx) CD-ROM.

Refer to the Getting Started Manual (071-1505-xx) for information about how to
set up the MTS400 Series for remote operation of the MPEG Player.
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Make Seamless Wizard

This wizard guides you through the process of creating an MPEG-2 file for use
by Stream Player in continuously looped operation.

The wizard is largely self-explanatory. The notes in this section of the manual
provide a slightly more detailed explanation of the wizard and the necessary user
responses.

Starting the Wizard

To start the wizard, select the Make Seamless option from the Start menu.
Alternatively, double-click on the Make Seamless shortcut on the desktop.

The opening window is displayed:

This first page gives a short explanation of the wizard’s activities and offers the
opportunity to skip the page in the future.

Select Next to move to the next screen and specify the input file.
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The Progress and Information log displays messages during the operation of the
wizard. Three types of message can be displayed:

INFO General processing information.

WARNING Messages which may mean that the output stream will contain errors.

ERROR Messages indicating catastrophic information which will cause the wizard to
disable the Next button and prevent further progress.

An icon is displayed in the top right corner of the window and as a prefix to any
messages displayed in the Progress & Information log. The icons are used to
indicate the current processing phase of the Make Seamless Wizard:

Program  Analysis  Multiplex  

Selecting an Input File

The first action is to identify the input or source transport stream.

Enter the filename in the File: field. The browse button (…) can be used to open
a standard Windows Open dialog box and locate files.

Progress and Information
Log
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NOTE. Only the filename will be shown, but by resting the cursor over the
filename, the full path is shown for a short time in a tooltip.

Customized SI scripts are available to the Make Seamless Wizard to enable
custom SI table and descriptor data to be processed successfully. Basic process-
ing of the Standards does not require additional scripts.

If a suitably configured script is selected and enabled before a stream is
analyzed, custom data will be analyzed when the stream is opened. If the script is
not selected or enabled, the stream will not fail to be analyzed, but any custom
data will either be ignored or reported as an error in the stream configuration.

(The underlying principles of scripting are described in the Custom SI Scripting
section of this user manual.)

SI Scripts
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Handling Script Files. To handle SI Scripts, select the general Standard required
by enabling the appropriate radio button and select the Scripts� button.

The Script dialog box displays the scripts currently associated with each standard
and allows them to be added, removed, viewed, and manipulated.
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There is, in effect, one Script File list associated with each mode; script files can
be listed in one or more Script file lists. Script files are designated as MPEG,
DVB or ATSC when they are added to the Script File list. Each mode will
display only those script files associated with that mode. Further script files can
be added as required using the Add New� button.

Note that a script file will not be used for analysis until:

� It is added to the Script File list in the appropriate mode.

� It is enabled (displays a check mark in the Script File list).

Adding a Script File. 

1. In the Script dialog box, select the Mode to which the script is to be added;
for example, DVB.

2. Select the Add New� button. A standard Windows file selection dialog box
is opened. The default file extension is .scp. Select the required file.

Note that the selected script file is now listed in the script file list and is enabled;
it will be used for any analysis.

Enabling a Script File. Select the check mark adjacent to the required script file to
enable the file for analysis.
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Moving a Script File. Script files are applied to analysis in the order that they are
listed; in some circumstances this may be important. To move a file in a list,
highlight the file name and select the Move Up or Move Down button as
required. Each press of the button will move the file up or down one place in the
list until it reaches the top or the bottom.

Viewing a Script File. Script files can be viewed and edited in a text editor
(provided that the scp extension has been associated correctly in Windows
Explorer). To edit a script, highlight the script name and select View. This will
open the script in Notepad or its equivalent. The required edits can then be made
and the script saved.

When the filename is satisfactory and any scripting actions have been performed,
select Next to analyze the file. Progress is indicated by the progress bar and the
appearance of messages in the Progress & Information log.
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Select a Program to Make Seamless

During the input file’s analysis the selected transport stream is analyzed to
determine it’s program content. If analysis is unsuccessful in determining
program content, the stream will not be opened and an appropriate message will
be displayed in the Progress & Information log.

Each program found is displayed in the drop-down list (Program:) accompanied
by an indication of the number of program elements (video, audio, etc.).

At this stage a priority program must be selected in order for it to be analyzed
and tested for suitability for the “make seamless” treatment.
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Program: Highlight the required program from the drop-down list.

Start packet: This value determines from where the primary program
is to be analyzed. Indicates the offset from the original
transport stream start point to start looking for a loop
start point.

Number of Packets: Initially, this value is set to the total number of packets
in the transport stream. It indicates the maximum num-
ber of packets (up to the end of the stream) from the
Start packet point that may be included in the loop.

Make remaining programs seamless
If enabled, the remaining programs are made seamless
but are constrained by limits defined by the priority pro-
gram. This may lead to these remaining programs hav-
ing a gap at the beginning and end of the file.

Make PSI/SI/PSIP seamless
The service information contained in the transport
stream is processed to make it seamless.

If this checkbox is not enabled, the SI is not processed
but simply copied to the output transport stream.
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Select Next. Once again the progress bar will indicate progress. While the stream
is being analyzed, selecting the Abort button will stop the process and allow the
program to be reselected (Note that the Abort button, which replaces the Cancel
button, is only displayed during processing).

When the file has been analyzed, a number of messages will have been posted in
the Progress & Information log.
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Selecting a Multiplex Output File

When a file has been analyzed and found suitable for making seamless, an output
file must be named.

A new filename can be typed or an existing file selected using the Browse button
(…), in which case confirmation of the replacement will be required. Select Next
to create the multiplexed output file.
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The screen shown below is displayed upon completion of the process.

The output file will contain a program which when played out and looped with
the Continuous Time Stamping option enabled will demonstrate minimal picture
disturbances at the loop point.



Make Seamless Wizard

11−12 MTS400 Series MPEG Test Systems User Manual



Transport Stream Cutter





MTS400 Series MPEG Test Systems User Manual i

Table of Contents

Transport Stream Cutter 12−1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Starting the Wizard 12−1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Cutting a File 12−2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 



Table of Contents

ii MTS400 Series MPEG Test Systems User Manual



MTS400 Series MPEG Test Systems User Manual 12−1

Transport Stream Cutter

The Transport Stream Cutter is a wizard that creates a new file from a slice of an
existing file. It is run from the Windows desktop. There are four pages including
the optional introduction page:

Starting the Wizard

The wizard may be started by selecting the Tektronix TS Cutter option from
the Tektronix Utilities submenu of the Start > Programs menu.

Alternatively, double-click on the Tektronix TS Cutter shortcut on the desktop.
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Cutting a File

By default the wizard will display this Introduction first.

The introductory page can be disabled by checking the Skip this page on
startup option. Select the Next button to move on to Step 1.
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Step 1 − Specify the name and location of the source file to copy a slice from:

Select the Browse... button to open a standard file browser window to look for
and choose the required file. Then select the Next button to move on to Step 2.

In step 2 the slice is specified by typing in the first packet and the number of
packets to copy. The total number of packets in the file is also shown.

Selecting the Back button will return to Step 1 so that the source file name and
location may be changed.
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Step 3 is the last. Specify the name and location for the new file.

Select Finish to create the file and copy the required slice of data. Select Back to
go back to change the source file, starting packet and number of packets.

The wizard now creates the new file and copies the selected data to the destina-
tion file specified. While it is working, this dialog box is displayed to indicate
progress.

When the blue progress indicator reaches the right side the dialog box disappears
and the file is ready to use.
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Script Pad - Getting Started

ScriptPad is supplied with a number of Tektronix products to enable users to
create and modify System Information (SI) scripts.

The rationale underlying SI Scripting is described elsewhere in this document;
this section simply provides a guide to using ScriptPad.

It should be noted that script files are saved as ASCII files and that any ASCII
text editor can be used to view and modify the files (for example, Microsoft
Notepad). However, features such as color-coding of keywords and syntax
checking will not be available; also access to encrypted script files will not be
possible.

Setting Up

The ScriptPad utility is installed automatically when the system is set up. There
is no additional specific set up procedure. Simple user interface management is
performed from within the utility.

Starting the Program

ScriptPad is most often started by double-clicking an existing script file. The
necessary file associations (*.scp and *.scx) are made automatically during the
installation process.

Alternatively, you can start ScriptPad by clicking a shortcut placed on the
desktop or by selecting ScriptPad in the Start menu in the taskbar.
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Initial Appearance

When the program has started and is ready for use, the main window is
displayed, as shown below:

The Toolbar (row of buttons above the dark gray area of the empty window) may
be hidden from view, moved to a separate window, either side or the bottom of
the main window.

The Status Line at the very bottom of the window may be hidden from view.

The dark gray area constitutes the Working Area.
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Initial Menu Options

Table 13−1 lists the intial File menu options.

Table 13−1: File menu options 

Option Function

New Opens a new file.

Open… Opens a script file (*.scp) for analysis. Choose the required file.

Print Setup… Select which printer and associated options to use.

1 <filename> 
2 <filename>
3 <filename>
4 <filename>

A list of the four most recently analyzed files. If the program
has recently been installed; the list may be empty or hold less
than four  files.

Selecting a filename opens that file for analysis.

Exit Closes the program.

Table 13−2 lists the intial View menu options.

Table 13−2: File menu options 

Option Function

Toolbar Shows or hides the toolbar.

Status Bar Shows or hides the status bar.

Select an option to change its status.

Script File Appearance

Scripts displayed in Script Pad are color-coded to aid understanding.

Script Pad makes no formatting corrections or changes; it is recommended that
script authors use conventional programming layout.

Single line comments are prefixed with a double slash (//); in ScriptPad they are
colored green. Multi-line comments of the form /*...*/ are also accepted by the
parser.

File Menu Options

View Menu Options
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Opening a File

Any script file (*.scp or *.scx) can be opened for viewing and editing by this
program.

To open a file, select the Open... option from the file menu. If the required file is
in the list of recently analyzed files, then it can be opened from the list.

Alternatively, use the Ctrl+O keyboard shortcut.

There is also a shortcut button available on the Toolbar for opening a file, which
has the standard file open symbol.
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On opening, the script file is displayed in the working area.

Viewing and editing can start immediately. Note that multiple script files can be
open simultaneously.
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Menu and Controls

The following pages contain descriptions of the menu options, toolbar controls,
and status bar.

Menu Bar

Different menus and options are presented before and after file opening and
depending upon whether the file window or the message window is active.

The Menu Bar offers all of the options available currently. Options are context
sensitive; they will only be available where relevant. Some options are also
available through keyboard shortcuts; these are indicated on the menus.

A check mark next to an option indicates that the function is currently visible or
active; no check mark means that it is hidden or inactive.

Table 13−3 list the File menu options.

Table 13−3: File menu options 

Option Function

New Opens a new file.

Open… Opens a script file (*.scp) for analysis. The program opens the file
selection dialog box allowing the user to choose the required file.

Close Closes the active script file window.

Save Saves the active script file window.

Save As… Allows the active script file to be saved under a different file name.

Encrypt When enabled, scripts will be saved in encrypted format (*.scx)
and unencrypted format (*.scp).

Print… Opens Print dialog.

Print Preview Previews print using current print settings.

Print Setup… Opens a dialog for selecting which printer and associated options
to use.

1 <filename> 
2 <filename>
3 <filename>
4 <filename>

A list of the four most recently analyzed files. If the program has
recently been installed the list may be empty or hold less than 4
files.

Selecting a filename opens that file for analysis.

Exit Exits the program. The user is given the opportunity to save any
changed script files.

File Menu Options
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Table 13−4 lists the Edit menu options.

Table 13−4: Edit menu options 

Option Function

Cut Delete the currently highlighted text and move it to the clipboard.

Copy Copy the currently highlighted text to the clipboard.

Paste Paste the contents of the clipboard to the current cursor location.

Find… Finds and highlights the text string entered in the Find dialog.

Replace… Finds and replaces the text string entered in the Replace dialog.

Go To… Places the cursor at the specified line number.

Table 13−5 lists the View menu options.

Table 13−5: View menu options 

Option Function

Toolbar Shows or hides the Toolbar.

Status Bar Shows or hides the Status Bar.

Auto Syntax Highlights When enabled, automatically color-codes keywords in the active
file as they are typed during editing.

Refresh Syntax Colors Refreshes color coding of keywords in the active file.

Table 13−6 lists the Window menu options.

Table 13−6: Window menu options 

Option Function

New Window Opens a new empty window.

Cascade Cascades all open windows in the application.

Tile Tiles all open windows in the application.

Arrange Icons Aligns icons of any minimized windows at the bottom of the
program’s main window.

1 <window title> List the currently open windows. The active (visible) window is
indicated by the checkmark.

Edit Menu Options

View Menu Options

Window Menu Options
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Table 13−7 lists the Script menu options.

Table 13−7: Script menu options 

Option Function

Parse Parses the script file to check for syntax errors.

Script Message Log Opens the parser message window.

Table 13−8 lists the Help menu options.

Table 13−8: Help menu options 

Option Function

About ScriptPad… Opens the About dialog which displays the program version
number.

Toolbar

The Toolbar provides a set of convenient shortcuts for the more frequently used
menu options. The available commands are:

Open a new file.

Allows an existing script file to be selected and opened.

Saves the active script file.

Finds specified text.

Allows the currently selected text to be cut. It can then be pasted to another location.

Allows the currently selected text to be copied. It can then be posted to another location.

Allows text currently held on the clipboard (having been previously cut or copied from
elsewhere) to be pasted to the cursor location.

Allows the active script to be printed.

Script Menu Options

Help Menu Options
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Opens the About ScriptPad dialog.

Parses the currently active script for syntax errors.

Toggles the display of the Script Parser Messages window.

Allows the color-coded highlights in the active script to be refreshed.

Enables encryption. Scripts saved while this function is enabled will be saved in
encrypted format (*.scx) and encrypted format (*.scp).

The Toolbar can be dragged off the edge of the main window into a floating
pallet. To do this click on the background inside the Toolbar, that is, not on one
of the buttons, and drag into the main window area. The result is a self contained
window which looks like this:

To replace the Toolbar on the window border drag it over the border until the
outline changes shape. It can be placed on the top, bottom, left or right edges.

Status Bar

The Status Bar displays an information message when the cursor is placed over
any toolbar button or menu option.
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Script File Editing and Encryption

Because script files are saved as ASCII files, editing follows normal text editing
customs. However, ScriptPad does provide extra features to enhance and verify
the process.

Keyword Color-Coding

When the Auto Syntax Highlights option in the View menu is enabled,
keywords are automatically color-coded as they are typed.

When the Auto Syntax Highlights option is disabled, the color-coding can be
refreshed by selecting the Refresh Syntax Colors option in the View menu.

Parsing

Script files can be syntactically checked by selecting the Parse option from the
Script menu. A message box will indicate that errors were or were not found in
the file. The Script Parser Message window will be automatically opened when
the message is acknowledged.

The Script Parser Messages window logs the parsing activities and provides
errors and warnings when necessary.

The following icons are used in the message window.

  Information   Error   Warning

Double-clicking and error message will bring the associated script file window to
the front of the display.

Messages can be cleared from the window by right-clicking anywhere within the
message window and selecting Clear messages.

Script Parser Message
Window
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Encryption

There are an increasing number of proprietary standards emerging whereby
analysis is allowable (possibly subject to a licence fee), but the owner of the
standard does not want the script file to be viewed by users. This is solved by
using encrypted script files. The ScriptPad utility, which is used for creating and
editing script files has an Encrypt option, such that a script file is saved in an
unreadable encrypted format, that only the ScriptParser can interpret. ScriptPad
is associated with the .scp and .scx suffixes used for unencrypted and encrypted
scripts respectively during the installation process.

The script encryption process employs a robust, 128 bit symmetric-key
algorithm based on the Feistel block cipher, which is similar to that used in the
dongle encryption scheme. Additional functions have been included to increase
the entropy of the cipher text.

Each time a script is encrypted, a unique file is generated. This makes it hard to
determine the algorithm by making small changes to plain-text and then
observing the change made to the cipher-text. In addition the cipher-text is
protected from interference, meaning that changes to the cipher text are detected
on decryption and the altered file will be rejected.

NOTE. A dongle is a security or copy protection device that must be connected to
an I/O port of the computer while the program is run. Programs that use a
dongle may query the port at start-up and at programmed intervals thereafter,
and terminate if it does not respond with the expected validation code.



Glossary





MTS400 Series MPEG Test Systems User Manual Glossary−1

Glossary

Accuracy The closeness of the indicated value to the true value.

AIT Application Information Table

ARIB Association of Radio Industries and Businesses

ASCII American Standard Code for Information Interchange

ATSC Advanced Television Systems Committee

BER Bit Error Rate

BIOP Broadcast Inter-ORB (Object Request Broker) Protocol

CAT Conditional Access Table (MPEG)

CDT Carrier Definition Table

COFDM Coded Orthogonal Frequency Division Multiplexing

CVCT Cable Virtual Channel Table (ATSC)

DDB Download Data Block

DII DownloadInfoIndication message

DSI DownloadServerInitiate message

DSM-CC Digital Storage Media − Command and Control

DTS Decoding Time Stamp

DTV Digital Television

DVB Digital Video Broadcasting

EIT Event Information Table (DVB/ATSC)

ES Elementary Stream

ETT Extended Text Table (ATSC)

EVM Error Vector Magnitude

ID Identity

IOR Interoperable Object Reference

JPEG Joint Photographic Experts Group
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MGT Master Guide Table (ATSC)

MHP Multimedia Home Platform

MMT Modulation Mode Table

MPEG Moving Picture Experts Group

NIT Network Information Table (DVB)

PAT Program Association Table (MPEG)

PES Packetized Elementary Stream

PID Packet IDentifier

PIT Program Information Table (ATSC)

PMT Program Map Table (MPEG)

PSI Program Specific Information (MPEG)

PSIP Program and System Information Protocol (ATSC)

PSK Phase Shift Keying (RF interface)

PTS Presentation Time Stamp

QAM Quadrature Amplitude Modulation (RF interface)

RAID Redundant Array of Independent Disks

RF Radio Frequency

RRT Regional Ratings Table (ATSC)

RST Running Status Table (DVB)

SDT Service Description Table (DVB)

SEI Supplemental Enhancement Information (H.264)

SI Service Information (DVB)

SIT Satellite Information Table

SNR Signal-to-Noise Ratio

STT System Time Table (ATSC)

TDT Time and Date Table (DVB)

TDT Transponder Data Table (ATSC)

TNT Transponder Name Table
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TOT Time Offset Table (DVB)

TS Transport Stream

TSDT Transport Streams Description Table

T-STD Transport Stream System Target Decoder

TVCT Terrestrial Virtual Channel Table (ATSC)

U-N User to Network

U-U User to User

UTC Universal Co−ordinated Time

VCT Virtual Channel Table (ATSC)

VSB Vestigial Side Band (RF interface)

VUI Video Usability Information (H.264)

XML Extensible Markup Language
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